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Section 1 .    NCC 98 Build A/B Integration Test
Procedures

Section Test Case Title

1.1 INCC101 Build Verification Testing

1.2 INCC102 Exception Handling/Restart Recovery

1.3 INCC105 SRIS: Operator Workstation

1.4 INCC107 SPSR: Utilities

1.5 INCC108 SPSR: Space Network Data Base

1.6 INCC109 SPSR: Customer Data Base

1.7 INCC110 SPSR: Input

1.8 INCC112 SPSR: Output

1.9 INCC113 SPSR: Acquisition & Tracking

1.10 INCC114 CCS: Utilities

1.11 INCC115 CCS: Monitor and Control/HSME

1.12 INCC116 SPSR: Schedule Control/Edit SAR/Edit TSW

1.13 INCC117 CCS: Reconfigure Ongoing Services

1.14 INCC118 CCS: Monitor/Disseminate Perf. Data
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1.1 Test Case INCC101 - Build Verification Testing

1.1.1 Detailed Test Procedures for Test Case INCC101

1.1.1.1 Detailed Test Procedure for Test Item INCC101-B1.1
SPSR STARTUP
CSCI 7601

Pass/Fail Criteria:

• The SPSR was successfully started, shutdown, and restarted.

1.0 SETUP

1.1 Take all NCCDS segments down and disconnect all LAN connections.

2.0 SPSR STARTUP

2.1 Boot and cold start the SPSR, selecting Release NCC 98, Build A.

The SPSR comes up to an operational state.  All pertinent processes are active.

2.2 Perform a database query.

An NCC 98 database is available.

2.3 Analyze all printouts generated.

No errors were reported.  All information is accurate.

3.0 SHUTDOWN & RESTART

3.1 Take the SPSR down.

All SPSR processes are terminated gracefully.

3.2 Repeat 2.0.

The SPSR is successfully restarted.  Data base integrity was maintained.
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1.1.1.2 Detailed Test Procedure for Test Item INCC101-B1.2
CCS STARTUP
CSCI 5304, 5305

Pass/Fail Criteria:

• CCS was successfully started, shutdown, and restarted.

1.0 SETUP

1.1 Take all NCCDS segments down and disconnect all LAN connections.

1.2 From the CCS Utilities menu of an operator account, select the RELEASE option and
choose NCC 98, Build A.

1.3 Select the CONFIG option and choose the appropriate configuration?

2.0 CCS STARTUP

2.1 Perform a CCS cold start.

Obsolete host synchronization, configuration control, and FEL/NFE control
messages are not generated.  New messages are received for the SPSR database
accesses and flat file updates, and for the NPG interface.  The cold start
successfully completes.  The NPG socket is configured.

2.2 From the CCS Utilities menu of an operator account, select the MAILBOXES option.

All pertinent processes are active.  The following new processes appear in the list:
ODMC, ServerUtil, GCM, ASSV, SSSV, EVTC, NMSV, ODM, SiteStatus,
DBEG, DBSG, EVCL, CTSV, SDTC, UPD, DBSF, SDCL, CTB, DBEF, ALSV,
and NPG.

Obsolete processes, including, but not limited to RAP, NFE, static data transfer,
host synchronization, and configuration control have been removed from the list.

2.3 Analyze all printouts generated.

No errors were reported.  All information is accurate.
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3.0 SHUTDOWN & RESTART

3.1 Take CCS down.

All CCS processes are halted.

3.2 Repeat 2.0.

CCS is successfully restarted.
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1.1.1.3 Detailed Test Procedure for Test Item INCC101-B1.3
WORKSTATIONS
CSCI 7102

Pass/Fail Criteria:

• The workstations were successfully started, shutdown, and restarted.

1.0 SETUP

1.1 Take all NCCDS segments down and disconnect all LAN connections.

1.2 Configure the workstations to access the correct data base.

2.0 WORKSTATION STARTUP

2.1 Start the workstations.

The workstations are successfully started.  All pertinent processes are active.

2.2 Analyze all printouts generated.

No errors were reported.  All information is accurate.

3.0 SHUTDOWN & RESTART

3.1 Shutdown the workstations.

The workstations are successfully shut down.

3.2 Repeat 2.0.

The workstations are successfully restarted.
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1.1.1.4 Detailed Test Procedure for Test Item INCC101-B1.4
NSM STARTUP
CSCI 7104

Pass/Fail Criteria:

• The NSM was successfully started, shutdown, and restarted.

1.0 SETUP

1.1 Establish the NCCDS development LAN with at least the SPSR in the configuration.

1.2 Establish connectivity with the NCC Automated Configuration Controller (NACC) to
configure the physical connectivity configuration among the NCCDS nodes.

1.3 Establish connectivity with the OpsLAN.

1.4 Establish connectivity with the Domain Names Services (DNS) and Network Information
Services (NIS) to establish and maintain host IP addresses.

1.5 Establish connectivity with the Nascom Protocol Gateway (NPG) to facilitate transport
end point definitions.

2.0 NSM STARTUP

2.1 Startup the NSM.

The startup completes successfully.  The NSM workstation comes up to an
operational state.

2.2 Login to the NSM workstation.

The logon is successful.

2.3 Select an application your operator identification allows you to access.

The application comes up.
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1.1.1.5 Detailed Test Procedure for Test Item INCC101-B1.5
CCS/SPSR/WORKSTATION INTERFACES
CSCI 7103, 5304, 5314

Pass/Fail Criteria:

• The CCS/Workstation interface was successfully established.

• The SPSR/Workstation interface was successfully established.

• The CCS-SPSR/Workstation interface was successfully established.

1.0 SETUP

1.1 Establish the NCCDS test configuration, configuring the workstations to access the
correct data base.

1.2 Logon to workstations as operators that belong to both CCS and SPSR operator groups.

2.0 SPSR/WORKSTATION

2.1 Logon to a workstation as an operator that belongs to an SPSR group.

The logon is successful, indicating that the Workstation/SPSR operator group
interface was successfully established.

2.2 Cause an SPSR alert to be generated for the operator group logged on.

The alert appears at the workstation, indicating that the SPSR/Workstation alert
interface was successfully established.

2.3 Access an SPSR window from a workstation logged on with an SPSR operator account.

The window appears, indicating that the SPSR/Workstation GUI interface was
successfully established.

3.0 CCS/WORKSTATION

3.1 Logon to a workstation as an operator that belongs to a CCS group.

The logon is successful, indicating that the Workstation/CCS operator group
interface was successfully established.

3.2 Access a CCS window from a workstation logged on with a CCS operator account.

The window appears, indicating that the CCS/Workstation interface was
successfully established.
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4.0 CCS-SPSR/WORKSTATION

4.1 Access a CCS window from a workstation logged on with an SPSR operator account.

The window appears, indicating that the CCS-SPSR/Workstation GUI interface
was successfully established.

4.2 Access an SPSR window from a workstation logged on with a CCS operator account.

The window appears, indicating that the CCS-SPSR/Workstation GUI interface
was successfully established.

4.3 Cause a CCS alert to be generated for the operator group logged on.

The alert appears at the workstation, indicating that the CCS/SPSR/Workstation
alert interface was successfully established.
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1.1.1.6 Detailed Test Procedure for Test Item INCC101-B1.6
CCS/SPSR DATA BASE INTERFACE
CSCI 7103, 5304, 5314

Pass/Fail Criteria:

• The CCS/SPSR database interface was successfully established.

1.0 SETUP

1.1 Establish the NCCDS test configuration, configuring the workstations to access the
correct data base.

1.2 Using SQL, add a DQM record to the data base.

1.3 From NTS, transmit a valid SAR to the NCCDS.

2.0 CCS/SPSR

2.1 From a CCS terminal, access DCL and review the DQM.DAT flat file.

The update made in step 1.2 is reflected in the file, indicating that the CCS/SPSR
static data interface was successfully established.

2.2 From a CCS terminal, access DCL and review the EVENT.DAT flat file.

The file contains an event for the SAR submitted in step 1.3, indicating that the
CCS/SPSR event data interface was successfully established.
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1.1.1.7 Detailed Test Procedure for Test Item INCC101-B1.7
NSM-CCS/SPSR/WORKSTATION INTERFACES
CSCI 7103, 5304, 5314

Pass/Fail Criteria:

• The NSM/SPSR interface was successfully established.

• The NSM/CCS interface was successfully established.

• The NSM/Workstation interface was successfully established.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

2.0 NSM

2.1 From an NSM workstation, access the display to review activity on the SPSR.

The display accurately reflects the status of the SPSR, indicating that the
NSM/SPSR interface was successfully established.

2.2 From an NSM workstation, access the display to review activity on the CCS.

The display accurately reflects the status of the CCS, indicating that the
NSM/CCS interface was successfully established.

2.3 From an NSM workstation, access the display to review activity on the Workstations.

The display accurately reflects the status of the Workstations, indicating that the
NSM/Workstation interface was successfully established.
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1.1.1.8 Detailed Test Procedure for Test Item INCC101-B1.8
INPG-CCS/SPSR INTERFACES
CSCI 7103, 5304, 5314

Pass/Fail Criteria:

• The INPG/SPSR interface was successfully established.

• The INPG/CCS interface was successfully established.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

2.0 INPG

2.1 From NTS, transmit a message to CCS.

The message is successfully received, indicating that the NTS/INPG/CCS
interface was successfully established.

2.2 From CCS, generate an outgoing message.

The message reaches NTS, indicating that the CCS/INPG/NTS interface was
successfully established.

2.3 From NTS, transmit a message to the SPSR.

The message is successfully received, indicating that the NTS/INPG/SPSR
interface was successfully established.

2.4 From SPSR, generate an outgoing message.

The message reaches NTS, indicating that the SPSR/INPG/NTS interface was
successfully established.
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1.1.1.9 Detailed Test Procedure for Test Item INCC101-B1.9
CCS WARM START
CSCI 5305

Pass/Fail Criteria:

• A CCS warm start is successfully completed.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

2.0 CCS WARM START

2.1 Perform a CCS warm start.

The warm start completes successfully.  Obsolete host synchronization and
configuration control messages are not generated.  New messages are received for
the SPSR database accesses and flat file updates.

2.2 Analyze all printouts generated.

No errors were reported.  All information is accurate.

2.3 From the CCS Utilities menu of a CCS operator account, select the MAILBOXES option.

All pertinent processes are active.
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1.2 Test Case INCC102 - Exception Handling/Restart Recovery

1.2.1 Detailed Test Procedures for Test Case INCC102

1.2.1.1 Detailed Test Procedure for Test Item INCC102-B1.1
DATA BASE DEADLOCKS/ROLLBACKS
CSCI 1604

NOTE: Identify or create an Oracle/UNIX script to cause two processes to hold database
resources (rows) needed by the other process.

Pass/Fail Criteria:

• The NCCDS successfully recovers from database deadlocks.

• The NCCDS SPSR database updates for the rolled back process are cleaned up.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to several workstations as operators that belong to different groups.

1.3 Use SQL to cause two processes to hold resources (i.e., row) needed by each other in the
database.

2.0 DATABASE DEADLOCK & RECOVERY

2.1 Perform database accesses through windows in an attempt to obtain the same resources
held in step 1.3.  [or attempt to access the same record from two workstations at the same
time]

A database deadlock occurs.  The SPSR automatically and properly recovers from
the database deadlock.  One of the deadlocked processes is rolled back.  The
database does not become corrupted.  The active process that is not rolled back
completes its work.  After the initial process finishes its processing, the rolled
back process restarts and completes its work.

2.2 Perform a database query of the resources held in step 1.3.

The database has not been corrupted.
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3.0 CLEAN UP

3.1 Use SQL to unlock the two processes held in step 1.3.
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1.2.1.2 Detailed Test Procedure for Test Item INCC102-B1.2
SPSR FAILURE DURING RECEIPT OF MESSAGES
CSCI 1601, 1604, 1605

Pass/Fail Criteria:

• Processing resumes for messages being received at the time of a failure and restart.

• The operator is notified of a system failure and restart.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to different groups.

1.3 From NTS, identify or create a timeline that will transmit 100 SARs to the NCCDS.

2.0 SPSR FAILURE DURING RECEIPT OF SARs

2.1 From NTS, start the timeline from step 1.3.

2.2 While the requests are being received, take the SPSR server down.

The operator is notified that processes are terminating, that the server is lost, and
then that the server is down.  The SARs not yet received prior to the server
failure are queued?

2.3 Perform a database query of the Schedule Request information.  [Can you do a database
query if the server’s down?]

The requests received prior to the “failure” are properly stored.

2.4 Restart the SPSR server.

The restart is successful.  The operator receives all expected messages.  No errors
are generated.

2.5 Use a UNIX editor to review the file containing logged SPSR processing/error messages.

The ‘Process %s starting up’ and ‘Process %s completed’ messages were properly
logged at system restart.  The ‘Process %s failure’, and ‘Process %s exiting’
messages were properly logged at the time of the SPSR prime server failure.

2.6 From NTS, transmit a SAR to the NCCDS.

The SAR is properly received, processed, and stored.
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1.2.1.3 Detailed Test Procedure for Test Item INCC102-B1.3
CCS FAILURE DURING RECEIPT OF MESSAGES
CSCI 5304

Pass/Fail Criteria:

• Processing resumes for ODMs being received at the time of a failure and restart.

• The operator is notified by alert after a system failure or restart.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the PA group.

1.3 Schedule an event containing a 10 hour service to start as soon as possible.

1.4 From NTS, transmit ODMs for the event scheduled in step 1.3.

2.0 CCS FAILURE DURING RECEIPT OF ODMs

2.1 Select "ODM" from the Performance subpanel on the Main Panel.  From the TDRS
Summary Menu double-click the TDRS used in step 1.3.

The TDRS Summary window for the selected TDRS appears.

2.2 From the TDRS Summary window, double-click the ODM Status bar for the service
scheduled in step 1.3.

The display indicates the ongoing receipt of ODMs.

2.3 Take CCS down.

The operator is notified that CCS went down.  All CCS processes are stopped.

2.4 From NTS, review the RMSG display.

The display reflects the ongoing transmission of ODMs.

2.5 Monitor the INPG.

The INPG continues to forward the ODMs to CCS.

2.6 Monitor the CCS console.

There is no indication that the messages were received or dropped since CCS is
down.
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3.0 RESTART

3.1 Perform a CCS cold start.

The cold start is successful.  No error messages are received.

3.2 Re-access the ODM display.

The display indicates the ongoing receipt of ODMs.
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1.2.1.4 Detailed Test Procedure for Test Item INCC102-B1.4
LAN FAILURE DURING RECEIPT OF SPSR MESSAGES
CSCI 7103

Pass/Fail Criteria:

• The NCCDS successfully recovers from a LAN failure during receipt of SPSR
messages.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to the Scheduling group.

1.3 From NTS, identify or create a timeline to transmit 100 SARs to the NCCDS.

2.0 LAN FAILURE

2.1 From NTS, start the timeline from step 1.3.

2.2 While the requests are being received, terminate the prime LAN connection to the SPSR
server.

The operator is alerted that the prime LAN connection is lost.  The prime LAN
fails over to the backup LAN.  Message traffic continues to the SPSR server on
the backup LAN.

2.3 While the prime LAN is still down, terminate the backup LAN connection to the SPSR
server.

The operator is alerted that the backup LAN connection is lost.  The incoming
messages are queued?

3.0 RE-ESTABLISH LAN CONNECTIONS

3.1 Re-establish the LAN connections to the SPSR server.

The operator receives all appropriate alerts.

3.2 Perform a database query of Schedule Request information.

The SARs transmitted in step 2.1 are stored in the database.
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1.2.1.5 Detailed Test Procedure for Test Item INCC102-B1.5
LAN FAILURE DURING RECEIPT OF CCS MESSAGES
CSCI 7103

Pass/Fail Criteria:

• The NCCDS successfully recovers from a LAN failure during receipt of CCS messages.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the PA group.

1.3 Schedule an event containing a 10 hour service to start as soon as possible.

1.4 From NTS, transmit ODMs for the event scheduled in step 1.3.

2.0 LAN FAILURE DURING RECEIPT OF ODMs

2.1 Select "ODM" from the Performance subpanel on the Main Panel.  From the TDRS
Summary Menu, double-click the TDRS used in step 1.3.

The TDRS Summary window for the selected TDRS appears.

2.2 From the TDRS Summary window, double-click the ODM Status bar for the service
scheduled in step 1.3.

The display indicates the ongoing receipt of ODMs.

2.3 Terminate the prime LAN connection to the CCS.

The operator is alerted that the prime LAN connection is lost.  The CCS
connection to the prime LAN fails over to the backup LAN.  Message traffic
continues on the backup LAN.

2.4 Review the ODM display.

The display indicates that ODMs are still being received by the CCS.

2.5 While the prime LAN is still down, terminate the backup LAN connection to the CCS.

The operator is alerted that the backup LAN connection is lost.  The incoming
messages are queued?

2.6 Review the ODM display.

ODMs are no longer being received.
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3.0 RE-ESTABLISH LAN CONNECTIONS

3.1 Re-establish the LAN connections.

The operator receives all appropriate alerts.

3.2 Re-access the ODM display.

The display indicates the ongoing receipt of ODMs.
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1.2.1.6 Detailed Test Procedure for Test Item INCC102-B1.6
WORKSTATION FAILURE
CSCI 7102

Pass/Fail Criteria:

• The operator is alerted of local workstation system failures.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to different groups.

2.0 LAN FAILURE

2.1 Break the LAN connection to a workstation.

The operator is alerted of the failure.

2.2 Re-establish the workstation LAN connection.

The operator receives all appropriate alerts.

2.3 Logon to the workstation and perform a CCS function.

The function is successfully completed.

2.4 Logon to the workstation and perform an SPSR function.

The function is successfully completed.

3.0 WORKSTATION FAILURE

3.1 Simulate a workstation crash.

The operator is alerted of the failure.

3.2 Bring the workstation back up.

The workstation is successfully restarted.

3.3 Logon to the workstation and perform a function.

The function is successfully completed.



2/12/97  6:03 PM INCC102-10 530-ITP-NCCDS/1998

1.2.1.7 Detailed Test Procedure for Test Item INCC102-B1.7
CCS FAILURE DURING TRANSMISSION OF MESSAGES
CSCI 5305

Pass/Fail Criteria:

• The NCCDS successfully recovers from a CCS failure during transmission of messages.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the PA group.

1.3 Schedule an event containing a 10 hour service to start as soon as possible.

1.4 From NTS, transmit ODMs for the event scheduled in step 1.3.

1.5 Access the UPD window and enable UPD for the site used in step 1.3.

2.0 CCS FAILURE DURING TRANSMISSION OF MESSAGES

2.1 From NTS, review the RMSG-by-site display.

The site used in step 1.5 is receiving UPD (91/01).

2.2 Take CCS down.

The operator is notified that CCS went down.  All CCS processes are stopped.

2.3 From NTS, review the RMSG-by-site display.

UPD (91/01) is no longer being received for the selected site.

3.0 CCS RESTART

3.1 Perform a CCS cold start.

CCS restarts successfully.

3.2 Re-access the UPD window.

UPD is no longer enabled for the selected site.

3.3 Enable UPD for the selected site.

3.4 From NTS, review the RMSG-by-site display.

The selected site is once again receiving UPD.
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1.2.1.8 Detailed Test Procedure for Test Item INCC102-B1.8
SPSR FAILURE DURING TRANSMISSION OF MESSAGES
CSCI 7103

Pass/Fail Criteria:

• The NCCDS successfully recovers from an SPSR failure during transmission of
messages.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to different groups.

1.3 Schedule events for several MOCs.

1.4 Populate the vector database.

2.0 SPSR FAILURE DURING SCHEDULE AND VECTOR TRANSMISSION

2.1 Transmit the events to the MOCs.

2.2 Transmit the vectors to the ground terminals.

2.3 From NTS, review the RMSG display.

MOC Scheduling messages (94/xx) and vectors (03/10) are being received.

2.4 While the messages are being transmitted, take the SPSR server down.

The operator is notified that processes are terminating, that the server is lost, and
then that the server is down.

2.5 From NTS, review the RMSG display.

The messages are no longer being received.

3.0 SPSR RESTART

3.1 Restart the SPSR server.

The restart is successful.  The operator receives all expected messages.  No errors
are generated.
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3.2 Use a UNIX editor to review the file containing logged SPSR processing/error messages.

The ‘Process %s starting up’ and ‘Process %s completed’ messages were properly
logged at system restart.  The ‘Process %s failure’, and ‘Process %s exiting’
messages were properly logged at the time of the SPSR prime server failure.

3.3 Perform an NTS delog for the timeframe just after the restart.

Messages being transmitted during the SPSR failure are automatically
retransmitted upon restart.

3.4 Transmit the remaining events to the MOCs.

The transmission is successfully completed.

3.5 Transmit the remaining vectors to the ground terminals.

The transmission is successfully completed.
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1.2.1.9 Detailed Test Procedure for Test Item INCC102-B1.9
SPSR FAILURE DURING FULL DATA EXCHANGE
CSCI 5602

Pass/Fail Criteria:

• The software properly handles an attempt to initiate a full data exchange when the SPSR
is down.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to different groups.

2.0 SPSR FAILURE DURING FULL DATA EXCHANGE

2.1 Access the CCS Full Data Exchange window and initiate a full data exchange.

The operator receives all appropriate alerts.  The full data exchange begins
transferring data to CCS.

2.2 Access the CCS Mailbox list.

The appropriate mailboxes are active.

2.3 While the transfer is active, take the SPSR server down.

The server shuts down successfully.

2.4 Review the CCS flat files.

The files are not corrupted.  They appear as they did prior to the full data
exchange?

3.0 SPSR DOWN AT INITIATION OF FULL DATA EXCHANGE

3.1 With the SPSR down, initiate a full data exchange.

The operator is notified that a data transfer cannot be performed when the SPSR
server is down.

3.2 Review the CCS flat files.

The files are not corrupted.  They appear as they did prior to the full data
exchange?
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3.3 Restart the SPSR file server.

No error messages are received.

3.4 Initiate a full data exchange.

The exchange is successfully completed.
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1.2.1.10 Detailed Test Procedure for Test Item INCC102-B1.10
CCS FAILURE DURING FULL DATA EXCHANGE
CSCI 5304

Pass/Fail Criteria:

• The NCCDS successfully recovers from a CCS failure during a full data exchange.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to different user groups.

1.3 Review/print the flat files for schedule and static data.

1.4 Stop running the database trigger client (kill process) so that CCS will not be
automatically notified of updates.

1.5 From SPSR, modify each data type.

1.6 Review/print the flat files for schedule and static data created by the CCS Data File
Builder.

The modifications made in step 1.5 are not reflected.

2.0 CCS FAILURE DURING FULL DATA EXCHANGE

2.1 Access the CCS Full Data Exchange window and initiate a full data exchange.

The operator receives all appropriate alerts.  The full data exchange begins
transferring data to CCS.

2.2 Access the CCS Mailbox list.

The appropriate mailboxes are active.

2.3 While the exchange is active, take CCS down.

The operator is alerted that CCS is now down and that the transfer is aborted
(CORBA timeout).

2.4 Perform a CCS cold start.

The CCS restarted successfully.
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2.5 Review the CCS flat files.

The flat files appear as they did in step 1.3?  Does the data transferred up
until the abort get retained or does it roll back to before any data was
transferred?

2.6 Access the CCS Full Data Exchange window and initiate a full data exchange.

The operator receives all appropriate alerts.  The full data exchange begins
transferring data to CCS.

2.7 Access the CCS Mailbox list.

The appropriate mailboxes are active.  The full data exchange completes
successfully.

3.0 CLEANUP

3.1 Re-enable the database trigger client.
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1.2.1.11 Detailed Test Procedure for Test Item INCC102-B1.11
LAN FAILURE DURING FULL DATA EXCHANGE
CSCI 7103

Pass/Fail Criteria:

• The NCCDS successfully recovers from a LAN failure during a full data exchange.

1.0 SETUP

1.1 Establish the NCCDS test configuration without CCS.

1.2 Logon to workstations as operators that belong to different user groups.

1.3 Review/print the flat files for schedule and static data.

1.4 Stop running the data base trigger client (kill process) so that CCS will not be
automatically notified of updates.

1.5 From SPSR, modify each data type.

1.6 Review/print the flat files for schedule and static data created by the CCS Data File
Builder.

The modifications made in step 1.5 are not reflected.

2.0 LAN FAILURE DURING FULL DATA EXCHANGE

2.1 Access the CCS Full Data Exchange window and initiate a full data exchange.

The operator receives all appropriate alerts.  The full data exchange begins
transferring data to CCS.

2.2 Access the CCS Mailbox list.

The appropriate mailboxes are active.

2.3 While the exchange is active, break the SPSR to CCS LAN connection.

The operator is alerted that the SPSR to CCS LAN connection is now down.

2.4 Access the CCS Mailbox list.

The appropriate mailboxes are no longer active.  The data is spooled?

2.5 Re-establish the SPSR to CCS LAN connection (may have to restart the server).

The operator receives all appropriate alerts.  The full data exchange completes
successfully.  (or is it terminated and rolled back?)
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2.6 Review/print the flat files created by the CCS Data File Builder.

Each flat file contains all applicable data, including the updates from step 1.5.

3.0 CLEANUP

3.1 Re-enable the data base trigger client.
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1.2.1.12 Detailed Test Procedure for Test Item INCC102-B1.12
CCS FAILURE DURING ALERT GENERATION
CSCI 5305

Pass/Fail Criteria:

• The NCCDS recovers from a CCS failure during alert generation.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to different groups.

1.3 Generate a substantial amount of CCS and SPSR alerts.

2.0 CCS FAILURE DURING ALERT GENERATION - COLD START

2.1 While the alerts are being generated, take CCS down.

The operator is notified that CCS went down.  All CCS processes are stopped.

2.2 Perform a CCS cold start.

The CCS cold start is successful.

2.3 Perform a database query of the alert information.

The alerts generated before CCS went down are stored in the database.

3.0 CCS FAILURE DURING ALERT GENERATION - WARM START

3.1 Generate more alerts and take CCS down.

The operator is notified that CCS went down.  All CCS processes are stopped.

3.2 Perform a CCS warm start.

The CCS warm start is successful.

3.3 Perform a database query of the alert information.

The alerts generated before CCS went down are stored in the database.
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1.2.1.13 Detailed Test Procedure for Test Item INCC102-B1.13
SPSR FAILURE DURING ALERT GENERATION
CSCI 5305

Pass/Fail Criteria:

• The NCCDS recovers from an SPSR failure during alert generation.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to different groups.

1.3 Generate a substantial amount of CCS and SPSR alerts.

2.0 SPSR FAILURE DURING ALERT GENERATION

2.1 While the alerts are being generated, take the SPSR server down.

The operator is notified that the SPSR server went down.

2.2 Restart the SPSR server.

The server is successfully restarted.

2.3 Perform a database query of the alert information.

The alerts generated before SPSR went down are stored in the database.
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1.2.1.14 Detailed Test Procedure for Test Item INCC102-B1.14
LAN FAILURE DURING ALERT GENERATION
CSCI 5305

Pass/Fail Criteria:

• The NCCDS recovers from a LAN failure during alert generation.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to different groups.

1.3 Generate a substantial amount of CCS and SPSR alerts.

2.0 LAN FAILURE DURING ALERT GENERATION

2.1 Perform a database query of the alert information.

Both CCS and SPSR alerts are being stored in the database.

2.2 Review the alert queues from a CCS and SPSR operator group.

Both CCS and SPSR alerts are being received at the workstations.

2.3 While the alerts are being generated, break the prime LAN connection.

The operator is notified that the prime LAN connection was broken.  The LAN
connection fails over to the backup LAN.  No data is lost.

2.4 While the prime LAN is down and alerts are still being generated, break the backup LAN
connection.

The operator is notified that the LAN connection was broken.  The alerts
information is no longer getting from CCS to SPSR or from SPSR to the
workstations.

2.5 Perform a database query of the alert information.

The alerts generated before the LAN connection was broken are stored in the
database.

2.6 Re-establish the LAN connections.

The alerts are now being received at the SPSR and the workstations.
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1.3 Test Case INCC105 - SRIS: Operator Workstations

1.3.1 Detailed Test Procedures for Test Case INCC105

1.3.1.1 Detailed Test Procedure for Test Item INCC105-B1.1
MAIN PANEL
CSCI 7102

Pass/Fail Criteria:

• The UTC can always be viewed via the Main Panel.

• Operators have access to the necessary system resources via the Main Panel.

• Window and screen copies can be generated for each segment.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

2.0 MAIN PANEL

2.1 Logon to a workstation as an operator that belongs to a CCS group.

The Main Panel appears and contains the UTC, access to e-mail, and access to the
necessary functions (i.e., CCS, SPSR, NSM, etc.).

2.2 Logon to a workstation as an operator that belongs to an SPSR group.

The Main Panel appears and contains the UTC, access to e-mail, and access to the
necessary functions (i.e., CCS, SPSR, NSM, etc.).

2.3 Logon to a workstation as an operator that belongs to CCS and SPSR groups.

The Main Panel appears and contains the UTC, access to e-mail, and access to the
necessary functions (i.e., CCS, SPSR, NSM, etc.).

2.4 Attempt to logon to another workstation as the operator logged on in step 2.1.

The login in not successful and the operator is notified that multiple logins are not
allowed.

2.5 Repeat step 2.4 for the operator logged on in step 2.2.

2.6 Repeat step 2.4 for the operator logged on in step 2.3.
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3.0 HARD COPY GENERATION

3.1 Obtain window and screen copies from a CCS window, an SPSR window, and an NSM
window.

Hard copies can be generated and are in a presentable format.
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1.3.1.2 Detailed Test Procedure for Test Item INCC105-B1.2
MULTIPLE WINDOWS AT ONE WORKSTATION
CSCI 7102

Pass/Fail Criteria:

• Operators can access multiple windows from one workstation.

• CCS and SPSR windows can be accessed from the same workstation.

• Closing a parent window also closes all associated child windows.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to all groups.

2.0 MULTIPLE WINDOWS - CCS

2.1 Logon to a workstation as an operator that belongs to a CCS group and access several
CCS windows.

2.2 Move the windows so they can be viewed simultaneously.

The operator has the capability to move windows.

2.3 Perform activities in a CCS window.

The activity is successfully performed.

2.4 Attempt to re-size the windows.

The operator can resize windows when appropriate for the window’s content.

2.5 Attempt to scroll through lists within the applicable windows.

The operator has the capability to scroll through lists within the applicable
windows.

2.6 Logon to a workstation as an operator that belongs to multiple CCS groups, access
several CCS windows, and repeat steps 2.2 through 2.5.

2.7 Access several SPSR windows and repeat steps 2.2 through 2.5.
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3.0 MULTIPLE WINDOWS - SPSR

3.1 Logon to a workstation as an operator that belongs to an SPSR group, access several
SPSR windows, and repeat steps 2.2 through 2.5.

3.2 Logon to a workstation as an operator that belongs to multiple SPSR groups, access
several SPSR windows, and repeat steps 2.2 through 2.5.

3.3 Access several CCS windows and repeat steps 2.2 through 2.5.

4.0 MULTIPLE WINDOWS - CCS AND SPSR

4.1 Logon to a workstation as an operator that belongs to both CCS and SPSR groups, access
several CCS and SPSR windows, and repeat steps 2.2 through 2.5.

5.0 CLOSE PARENT WINDOWS WITH CHILD WINDOWS OPEN

5.1 Open several layers of child windows from a CCS parent window, return to the parent
window without closing the child window, and close the parent window.

All of the windows close.  [Per OSF/Motif Style Guide]

5.1 Open several layers of child windows from an SPSR parent window, return to the parent
window without closing the child window, and close the parent window.

All of the windows close.  [Per OSF/Motif Style Guide]
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1.3.1.3 Detailed Test Procedure for Test Item INCC105-B1.3
SIMULTANEOUS DATA BASE UPDATES
CSCI 7102

Pass/Fail Criteria:

• A given data base table can only be accessed for editing once at a time.

• Data base areas are available for viewing while updates are being made.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to two workstations as operators that belong to the DBA group (DB1 & DB2).

2.0 PARENT WINDOWS - SAME WORKSTATIONS

2.1 From a workstation, access the Space Network Summary window and enable editing.

The window appears (SN1).  Editing is enabled.

2.2 From the same workstation, access the same window a second time and attempt to enable
editing.

The window appears (SN2).  Editing is not enabled since SN1 has the data base
table locked.  The operator is appropriately notified.

2.3 From SN1, disable editing.

2.4 From SN2, enable editing.

Editing is enabled, indicating that the data base table was unlocked when editing
was disabled from SN1.

3.0 CHILD WINDOWS - SAME WORKSTATIONS

3.1 From SN2, access the GT Configuration window.

The window appears (GT1).  Editing is enabled.

3.2 From SN1, access the GT Configuration window and attempt to enable editing.

The window appears (GT2).  Editing is not enabled since GT1 has the data base
table locked.  The operator is appropriately notified.
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3.3 From GT1, access the SGLT Resource Availability window.

The window appears (SGLT1).  Editing is not enabled.

3.4 From the GT2, access the SGLT Resource Availability window.

The window appears (SGLT2).  Editing is enabled.

3.5 From the first copy of the SGLT Resource Availability window, attempt to enable
editing.

Editing is not enabled since SGLT2 has the data base table locked.  The operator
is appropriately notified.

3.6 From SGLT2, disable editing.

3.7 From SGLT1, enable editing.

Editing is enabled, indicating that the data base table was unlocked when editing
was disabled from SGLT2.

4.0 PARENT WINDOWS - DIFFERENT WORKSTATIONS

4.1 From DB1, access the Space Network Summary window and enable editing.

The window appears.  Editing is enabled.

4.2 From DB2, access the same window and attempt to enable editing.

The window appears.  Editing is not enabled since DB1 has the data base area
locked.

4.3 From DB1, disable editing.

4.4 From DB2, enable editing.

Editing is enabled, indicating that the data base area was unlocked when DB1
disabled editing.

5.0 CHILD WINDOWS - DIFFERENT WORKSTATIONS

5.1 From DB2, access the GT Configuration window.

The window appears.  Editing is enabled.

5.2 From DB1, access the GT Configuration window and attempt to enable editing.

The window appears.  Editing is not enabled since it is already enabled at DB2.
The operator is appropriately notified.

5.3 From DB1, access the SGLT Resource Availability window.

The window appears.  Editing is not enabled.
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5.4 From DB2, access the SGLT Resource Availability window.

The window appears.  Editing is enabled.

5.5 From DB1, attempt to enable editing.

Editing is not enabled since it is already enabled at DB2.  The operator is
appropriately notified.

5.6 From DB2, disable editing.

5.7 From DB1, enable editing.

Editing is enabled, indicating that the data base table was unlocked when editing
was disabled from DB2.
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1.3.1.4 Detailed Test Procedure for Test Item INCC105-B1.4
DATA BASE LIST UPDATES -
VALID SUPIDEN AND TDRS WINDOW
CSCI 7102

Pass/Fail Criteria:

• Data lists affected by data base updates made from other windows are updated when
editing is enabled.

• Data base updates are successfully accomplished when the applicable areas are being
viewed.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the DBA group.

2.0 DATA LIST UPDATES

2.1 Select “Space Network” from the Data Base subpanel on the Main Panel.

The Space Network Summary window appears.

2.2 Select “TDRS Operational Names and Mappings” from the “Edit” menu.

The TDRS Operational Names and Mappings window appears.  Editing is
disabled.

2.3 Without closing the Space Network windows, select “Customer Data” from the Data
Base subpanel on the main panel.

The Customer Data Base window appears.

2.4 Select “Valid SUPIDENs and TDRSs” from the “Edit” menu.

The Valid SUPIDEN and TDRS window appears.  Editing is disabled.

2.5 From the TDRS Operational Names and Mappings window, enable editing, enter a TDRS
name in the “New Name” field, and click the “Add” button.

The TDRS is added to the list of Existing Operational Names.

2.6 From the Valid SUPIDEN and TDRS window, click the “Close” button.

The window closes and control returns to the Customer Data Base window.
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2.7 Enable editing, select “Valid SUPIDENs and TDRSs” from the “Edit” menu, and attempt
to make a modification.

The Valid SUPIDEN and TDRS window appears.  Editing is enabled.  The TDRS
added in step 2.5 does not appear in the TDRS Operational Names list.

The operator is notified that the applicable data base table is being updated.

2.8 From the TDRS Operational Names and Mappings window, click the “Save” button.

The updated information is reflected in the mappings panel.

2.9 From the Valid SUPIDEN and TDRS window, click the “Enable editing” button.

Editing is enabled and the TDRS added in step 2.5 now appears in the TDRS
Operational Names list.

3.0 FUNCTIONAL IMPACT

3.1 From the TDRS Operational Names and Mappings window, delete the TDRS added in
step 2.5.

3.2 From the Valid SUPIDEN and TDRS window, select a SUPIDEN and add the TDRS
used in step 3.1 to the valid SUPIDEN list.  Click the “Save” button.

The operator is notified that the selected TDRS has been deleted.

3.3 Disable and re-enable editing.

The deleted TDRS no longer appear in the TDRS Operational Names list.
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1.3.1.5 Detailed Test Procedure for Test Item INCC105-B1.5
DATA BASE LIST UPDATES -
INHIBIT/ENABLE TRANSMISSION DESTINATIONS WINDOW
CSCI 7102

Pass/Fail Criteria:

• Data lists affected by data base updates made from other windows are updated when
editing is enabled.

• Data base updates are successfully accomplished when the applicable areas are being
viewed.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the DBA and Scheduling groups.

2.0 DATA LIST UPDATES

2.1 From the Space Network Summary window, select “Valid Destinations” from the
“Edit” menu.

The Valid Destinations window appears.  Editing is disabled.

2.2 Without closing the Valid Destinations window, select “Customer” from the Data Base
subpanel on the Main Panel.

The Customer Data Base window appears.

2.3 Without closing the Valid Destinations or Customer Data Base windows, select
“Transmission” from the Scheduling subpanel on the Main Panel.

The Schedule Transmission window appears.

2.4 Click the “Inhibit/Enable Destinations...” button.

The Inhibit/Enable Transmission Destinations window appears.  Editing is
disabled.  The Destinations list reflects the Destinations list on the Valid
Destinations window and the SICs on the Customer Data Base window..

2.5 From the Valid Destinations window, enable editing, enter a Name, click the appropriate
Type radio button, and click the “Add” button.

The destination Name and Type is added to the Destinations list.
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2.6 From the Customer Data Base window, enable editing, access the SIC Editor window,
and create a new SIC.  Do not save the change yet.

2.7 From the Inhibit/Enable Transmission Destinations window, click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

2.8 Enable editing and click the “Inhibit/Enable Destinations...” button.

The Inhibit/Enable Transmission Destinations window appears.  Editing is
enabled.  The destination added in step 2.5 and the SIC added in step 2.6 do not
appear in the Existing Destinations list.

The operator is notified that modifications are being made to the related data
base tables.

2.9 From the Valid Destinations window, click the “Save” button.

The destination is added to the list.

2.10 From the SIC Editor window, click the “Save” button.

The SIC is added to the list.

2.11 From the Inhibit/Enable Transmission Destinations window, disable and re-enable
editing.

Editing is enabled, the destination added in step 2.5 appears in the Destinations
list, and the SIC deleted in step 2.6 has been removed from the Existing SICs list.

3.0 FUNCTIONAL IMPACT

3.1 From the Valid Destinations window, delete the destination added in step 2.5.

3.2 From the Customer Data Base window, delete the SIC added in step 2.6.

3.3 From the Inhibit/Enable Transmission Destinations window, add the destination and SIC
used in steps 3.1 and 3.2 to the transmission.

The operator is notified that the data has been deleted.

3.4 Disable and re-enable editing.

The deleted destination and SIC no longer appear in the applicable lists.
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1.3.2 Detailed Test Procedures for Test Case INCC105

1.3.2.6 Detailed Test Procedure for Test Item INCC105-B1.6
USER’S GUIDES

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained
in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the SRIS User’s Guide and any related DCNs.

2.0 NORMAL PROCEDURES

2.1 Review the Workstation Subsystem section of the SRIS User’s Guide.

The instructions for performing the major functions of the Operator Workstation
Subsystem are included in the document.

3.0 ERROR CONDITIONS

3.1 The user’s guide includes adequate error recovery actions for the Operator Workstation
Subsystem.
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1.3.2.7 Detailed Test Procedure for Test Item INCC105-B1.7
DYNAMIC UPDATES AT MULTIPLE WORKSTATIONS

Pass/Fail Criteria:

• Updates are successfully applied every 5 seconds when the TDRS Summary and ODM
windows are accessed from multiple workstations simultaneously.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to various groups.

1.3 Schedule events on each TDRS specified in step 2.1 utilizing each service type (including
EET).

1.4 From NTS, start ODMs for the scheduled services.

2.0 TDRS SUMMARY WINDOW

2.1 Access TDRS Summary windows as follows:

Workstation TDRS

1 041
2 041
2 046
3 171
3 174
4 TDW

The information is accurately reflected on each window and is updated every five
seconds.
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3.0 ODM WINDOWS

3.1 Without closing the TDRS Summary windows, access ODM windows as follows:

Workstation Service

1 MAF
2 SSAR
2 KSAF
3 MAR
3 SSAF
4 KSAR
4 SSAR

The information is accurately reflected on each window and is updated every five
seconds.
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1.3.2.8 Detailed Test Procedure for Test Item INCC105-B1.8
ALERT PROCESSING
CSCI 7102

Pass/Fail Criteria:

• The operator is notified of queued action alerts by an audio sound.

• The operator has the capability to turn off the audio sound.

• Repetitive alerts are correctly generated for applicable CCS and SPSR alerts.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to CCS groups, SPSR groups, and both.

2.0 ACTION ALERTS

2.1 Generate CCS and SPSR action alerts that will be routed to the workstations logged on in
step 1.2.  Cause CCS and SPSR alerts to be interleaved at one workstation.

After receipt of the first action alert, the operator is notified by audio sound on
receipt of additional alerts.  The operator has the capability to change the
volume of the audio sound.

2.2 Turn off the audio and generate more action alerts.

Audio is not used to notify the operator.  The pending action alerts display the
time they were generated, the appropriate information, and indicate whether
additional information is available for viewing by the operator.

2.3 Acknowledge action alerts which contain additional information.

The alerts are successfully acknowledged.

2.4 Acknowledge the remaining action alerts.

The alerts are successfully acknowledged.
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3.0 REPETITIVE ALERTS

3.1 Cause a repetitive CCS action alert to be generated 100 times.

An initial alert is received and every 60 seconds thereafter, an information alert
indicating the number of times the alert was generated in the last minute is
received.

3.2 Repeat step 3.1 for a repetitive CCS information alert.

3.3 Repeat step 3.1 for a repetitive SPSR action alert.

3.4 Repeat step 3.1 for a repetitive SPSR information alert.
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1.4 Test Case INCC107 - SPSR: Utilities

1.4.1 Detailed Test Procedures for Test Case INCC107

1.4.1.1 Detailed Test Procedure for Test Item INCC107-B1.1
SPSR/CCS-UTC INTERFACE

Pass/Fail Criteria:

• The SPSR receives the accurate UTC from CCS.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon as an operator that belongs to both CCS and SPSR groups.

2.0 COMPARE TIMES TO UTC

2.1 Run the time command on the VAX.

The time is the same as the UTC clock.

2.2 From a workstation, review the time displayed in the main panel.

The time is the same as the UTC clock.

2.3 Run the time command from the SPSR server.

The time is the same as the UTC clock.

2.4 From the workstation, access a CCS window.

The “As of” time is the same as the UTC clock.

2.5 From the workstation, access an SPSR window.

The “Opened” time is the same as the UTC clock.

3.0 HP TIME CONTROLLED BY CCS

3.1 From the workstation, change the time to five minutes in the future.

The time is updated, but is quickly reset to the UTC time.
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4.0 UTC DEVICE DOWN

4.1 Take the UTC device down and repeat steps 2.1 through 2.5, comparing the time to the
VAX time.

The times are the same as the VAX time.
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1.4.1.2 Detailed Test Procedure for Test Item INCC107-B1.2
OPERATOR ALERTS WINDOW
CSCI

Pass/Fail Criteria:

• The Operator Alerts window appears automatically upon login to a workstation.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

2.0 GENERAL WINDOW FUNCTIONALITY

2.1 Logon to a workstation as an operator that belongs to the TNC group.

The Operator Alerts window appears automatically.  The “Operator Login”
information is accurately reflected in the window.

2.2 Logon to a workstation as an operator that belongs to the DBA group.

The Operator Alerts window appears automatically.  The “Operator Login”
information is accurately reflected in the window.

2.3 Logon to a workstation as an operator that belongs to the PA and SO groups.

The Operator Alerts window appears automatically.  The “Operator Login”
information is accurately reflected in the window.

2.4 From each workstation, attempt to close the Operator Alerts window.

The window does not close.  The operator is notified that this window cannot
be closed.

2.5 From each workstation, attempt to iconify the Operator Alerts window.

Is/should this be allowed?

2.6 Generate additional alerts.

2.7 From each workstation, double click the Operator Alerts icon.

The window appears and contains the alerts generated in step 2.6.
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3.0 INFORMATION ALERTS

3.1 Generate a CCS alert assigned to the TNC group as an information alert.

The information alert appears in the “Information” portion of the Operator Alerts
window ONLY at the workstation logged on in step 2.1.  The alert information is
accurately reflected in the window.

3.2 Generate an SPSR alert assigned to the DBA group as an information alert.

The information alert appears in the “Information” portion of the Operator Alerts
window ONLY at the workstation logged on in step 2.2.  The alert information is
accurately reflected in the window.

3.3 Generate a CCS alert assigned to the PA group as an information alert.

The information alert appears in the “Information” portion of the Operator Alerts
window ONLY at the workstation logged on in step 2.3.  The alert information is
accurately reflected in the window.

3.4 Generate a CCS alert assigned to the SO group as an information alert.

The information alert appears in the “Information” portion of the Operator Alerts
window ONLY at the workstation logged on in step 2.3.  The alert information is
accurately reflected in the window.

3.0 ACTION ALERTS

3.1 Generate a CCS alert assigned to the TNC group as an action alert.

The appropriate operator receives a dialog box with a description of the alert.  The
dialog box contains Acknowledge and Dismiss buttons.

3.2 Close the dialog box without clicking the Acknowledge or Dismiss buttons (use the dash
in the upper-left hand corner).

The dialog box closes.  The alert is listed in the Action Alert window.  The
Acknowledged time field is blank.

3.3 Generate another CCS alert assigned to the TNC group as an action alert and click the
“Dismiss” button in the dialog box.

The dialog box closes.  The alert is accurately reflected in the “Action” portion of
the Operator Alerts window.  The Acknowledged time field is blank.

3.4 From the Operator Alerts window, select the alert dismissed in step 3.3 and click the
“Acknowledge” button.

The Acknowledged field now contains the current time.
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3.5 Generate another CCS alert assigned to the TNC group as an action alert and click the
“Acknowledge” button in the dialog box.

The dialog box closes.  The alert is accurately reflected in the Action Alert
window.  The Acknowledged field contains the current time.

3.6 Repeat steps 3.1 through 3.5 for the DBA group.

3.7 Repeat steps 3.1 through 3.5 for the PA group.

3.8 Repeat steps 3.1 through 3.5 for the SO group.
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1.4.1.3 Detailed Test Procedure for Test Item INCC107-B1.3
CREATE OPERATOR GROUPS
CSCI 1604

Pass/Fail Criteria:

• The capability exists to create operators.

• The capability exists to create groups.

• The capability exists to assign operators to groups.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with the privilege to define operator groups and
assign operators to them.

1.3 Request System Administration support to execute this test item.

2.0 CREATE OPERATORS

2.1 Execute the System Administration Manager (SAM) program.

The System Administration Manager window appears.

2.2 Select the “Users and Groups” option, select “Users”, and click the “Open” button.

The Users and Groups window appears and displays the user information.

2.3 Select “Add” from the “Actions” menu.

The Add a User Account window appears.

2.4 Enter the requested information, click the “OK” button, and select “Exit” from the “File”
menu.

The window closes and control returns to the Users and Groups window.  The
operator just added appears in the list of users.  All associated information is
accurately reflected.

Operator Primary Group

O1 G1
O2 G2
O3 G3
O4 G4
O5 G5
O6 G6
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O7 G7
O8 G8
O9 G9
O10 G9

2.5 Select “Exit” from the “File” menu.

The window closes and control returns to the System Administration Manager
window.

3.0 CREATE GROUPS

3.1 From the System Administration Manager window, select “Groups” and click the “Open”
button.

The Users and Groups window appears and displays the group information.

3.2 Select “Add” from the “Actions” menu.

The Add a Group window appears.

3.3 Enter the requested information for G10 and click the “OK” button.

The group is added to the list.

3.4 Modify groups as follows, assigning more operators to some, deassigning operators from
others.

The modifications are successful.

3.5 Click the “Cancel” button.

The window closes and control returns to the Users and Groups window.  The
group just added appears in the list.  All associated information is accurately
reflected.

4.0 ASSIGN OPERATORS TO GROUPS

4.1 From the System Administration Manager window, select “Groups” and click the “Open”
button.

The Users and Groups window appears and displays the group information.

4.2 Select G1 and select “Modify” from the “Actions” menu.

The Modify a Group window appears for G1.

4.3 Enter operators O3, O4, and O5, and click the “OK” button.

The operators are added to the list.
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1.4.1.4 Detailed Test Procedure for Test Item INCC107-B1.4
ASSIGN WINDOWS TO GROUPS
CSCI 1604

Pass/Fail Criteria:

• The capability exists to assign update privileges to operator groups per window through
the use of access control lists.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as the most privileged operator.

2.0 ASSIGN WINDOWS TO GROUPS

2.1 Using SQL, assign a CCS parent window to group TEST1.

2.2 Using SQL, assign a CCS child window to group TEST2.

2.3 Using SQL, assign an SPSR parent window to group TEST3.

2.4 Using SQL, assign an SPSR child window to group TEST4.

2.5 Using SQL, assign a CCS window and an SPSR window to group TEST5.

2.6 Logon to workstations as operator that belong to groups TEST1 through TEST5.

3.0 WINDOW UPDATE PRIVILEGES

3.1 From TEST1, access the parent window and make a modification.

The modification is successful.

3.2 From TEST1, access a child window and attempt to make a modication.

The operator is alerted that s/he does not have update capabilities for this window.

3.3 From TEST2, access the parent window and attempt to make a modification.

The operator is alerted that s/he does not have update capabilities for this window.

3.4 From TEST2, access the child window and make a modication.

The modification is successful.

3.5 Repeat steps 3.1 through 3.4 for groups TEST3 and TEST4.
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3.6 From TEST5, access the CCS window and make a modification.

The modification is successful.

3.7 From TEST5, access the SPSR window and make a modification.

The modification is successful.

4.0 EFFECTIVE TIME - CCS

4.1 Using SQL, remove the window previously assigned to TEST1 and assign another.

4.2 From TEST1, access the window previously assigned to TEST1 and make a
modification.

The modification is successful.

4.3 From TEST1, access the window now assigned to TEST1 and attempt to make a
modification.

The operator is alerted that s/he does not have update privileges for this window.

4.4 Logoff and back on the workstation logged on as the operator that belongs to TEST1 and
repeat step 4.2.

The operator is alerted that s/he does not have update privileges for this window.

4.5 Repeat step 4.3.

The modification is successful.

5.0 EFFECTIVE TIME - SPSR

5.1 Using SQL, remove the window previously assigned to TEST3 and assign another.

5.2 From TEST3, access the window previously assigned to TEST3 and make a
modification.

The modification is successful.

5.3 From TEST3, access the window now assigned to TEST3 and attempt to make a
modification.

The operator is alerted that s/he does not have update privileges for this window.

5.4 Close and re-access the window and repeat step 5.2.

The operator is alerted that s/he does not have update privileges for this window.

5.5 Repeat step 5.3.

The modification is successful.
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1.4.2 Detailed Test Procedures for Test Case INCC107

1.4.2.5 Detailed Test Procedure for Test Item INCC107-B1.5
USER’S GUIDES

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the SPSR User’s Guide.

The SPSR User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the SPSR Utilities portion of the SPSR User’s Guide.

The instructions for performing the major functions of the SPSR Utilities
Subsystem are included in the document.  Copies of all applicable windows are
included in the document.

3.0 ERROR CONDITIONS

3.1 Review the SPSR Utilities Subsystem error recovery procedures section of the SPSR
User’s Guide.

The user’s guide includes adequate error recovery actions for SPSR Utilities
Subsystem.
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1.4.2.6 Detailed Test Procedure for Test Item INCC107-B1.6
OPERATOR INTERFACE
CSCI 1605

Pass/Fail Criteria:

• The applicable menu options and or icons are operational.

• Pertinent windows can be iconified, can be enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the data base, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numeric in alphabetic fields, special characters, blanks,
etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the SPSR Utilities Subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Logon to a workstation.

The Operator Alerts window appears on the screen in the expected format.

2.2 Select each menu option and icon available on the window.

The applicable menu options and or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.

2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.
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2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with the SPSR Utilities Subsystem.  The
applicable windows are: Action Alert Comments window and Alert Filter window.

The windows meet the general and data entry window validation criteria.
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1.4.2.7 Detailed Test Procedure for Test Item INCC107-B1.7
SPSR EXTERNAL MESSAGE/DEBUG LOG SERVER
CSCI 7104

Pass/Fail Criteria:

• All messages received by the SPSR are logged.

• SPSR (and CCS?) processing/error messages are logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation.

1.3 From NTS, create or identify each type of message supported by the SPSR in this build.

2.0 EXTERNAL MESSAGE LOGGING

2.1 From NTS, transmit the messages created in step 1.3 to the NCCDS.

2.2 Use a UNIX editor to review the file containing logged external messages.

The messages were properly logged.

3.0 DEBUG MESSAGE LOGGING

3.1 Select “Customer Data Base” from the Data Base subpanel on the main panel.

3.2 Close the window.

3.3 Use a UNIX editor to review the file containing logged processing/error messages.

The “Process CustomerDataBase starting up” and “Process CustomerDataBase
completed” were properly logged.
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1.4.2.8 Detailed Test Procedure for Test Item INCC107-B1.8
ALERT FILTER WINDOW
CSCI

Pass/Fail Criteria:

• The operator has the capability to filter action and information alerts.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as an operator that belongs to a CCS group (WS1), and SPSR
group (WS2), and both (WS3).

1.3 Generate CCS and SPSR information and action alerts.

2.0 SPSR ALERTS

2.1 From the Operator Alerts window of WS1, click the “Filter/Sort” button above Action.

The Alert Filter window appears and allows the operator to filter/sort action alerts.
What is the filter/sort criteria?

2.2 Filter/sort action alerts by some specified criteria and close the Alert Filter window.

The Alert Filter window closes, control returns to the Operator Alerts window,
and the action alerts are filtered/sorted by the specified criteria.

2.3 Generate additional SPSR action alerts.

Only alerts that meet the filter criteria set up in step 2.2 are received at WS1.

2.4 Reset the filter/sort criteria.

All applicable alerts now appear in the window.

2.5 Repeat steps 2.1 through 2.4 for information alerts.

3.0 CCS ALERTS

3.1 Repeat 2.0 for WS2.

4.0 SPSR AND CCS ALERTS

4.1 Repeat 2.0 for WS3, including both SPSR and CCS alerts.
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1.4.2.9 Detailed Test Procedure for Test Item INCC107-B1.9
ASSIGN ALERTS TO GROUPS
CSCI 1604

Pass/Fail Criteria:

• The capability exists to assign alerts to operator groups as information or action.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as the most privileged operator.

2.0 ASSIGN ALERTS TO OPERATOR GROUPS

2.1 Assign an alert to one operator group as an action alert and another operator group as an
information alert.

The alerts are properly associated with the given operator group.

2.2 Assign an alert to several operators as an action alert (associated with both CCS and
SPSR groups).  Applicable alerts may include those resulting from TDRS/SGLT
Assignment Changes.

An alert can be assigned to multiple operators.

2.3 Assign an alert to several operators as an information alert (associated with both CCS and
SPSR groups).

An information alert can be assigned to multiple operators.
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1.4.2.10 Detailed Test Procedure for Test Item INCC107-B1.10
OPERATOR GROUP PRIVILEGES - WINDOWS AND ALERTS
CSCI 1604

NOTE: This test item utilizes the data created in test items INCC107-B1.10 through
INCC107-B1.12.

Pass/Fail Criteria:

• Operators are presented with the appropriate toolbar(s) for the group(s) to which they
are assigned.  Are toolbars going to be tailored to individual groups?  Or are all
operators getting the same toolbar at login (with restrictions on updating)?

• Operators are only authorized to perform functions and receive alerts for the groups to
which they are assigned.

• Operators receive alerts as information or action as specified in the data base.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

2.0 SPSR

2.1 Logon to a workstation as an operator assigned to an SPSR group.

2.2 Make an update from a window for which the group has update privileges.

The updates are accepted.

2.3 Attempt to make an update from a window for which the group does not have update
privileges.

The updates are not accepted and the operator is appropriately notified.

2.4 Generate information and action alerts, some of which are associated with the groups
logged on, some that are associated with groups not logged on, and some that are not
associated with any groups.

The operators receive only the appropriate action or information alerts.  The alerts
for which the assigned operators are not logged on, and those not associated with
any operators, are properly handled by the system (sent to printer?).
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3.0 CCS

3.1 Logon to a workstation as an operator assigned to a CCS group.

The operator is presented with the appropriate toolbar for the group to which s/he
is assigned.  The toolbar provides access to the necessary functions.

3.2 Repeat steps 2.2 through 2.4.

4.0 SPSR AND CCS

4.1 Logon to a workstation as an operator assigned to both an SPSR group and a CCS group.

The operator is presented with the appropriate toolbars for the groups to which
s/he is assigned.  The toolbar provides access to the necessary functions.

4.2 Repeat steps 2.2 through 2.4.
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1.5 Test Case INCC108 - SPSR: Space Network Data Base

1.5.1 Detailed Test Procedures for Test Case INCC108

1.5.1.1 Detailed Test Procedure for Test Item INCC108-B1.1
USER’S GUIDES - SPACE NETWORK DATA
CSCI 1605

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the SPSR User’s Guide.

The SPSR User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the Space Network Data portion of the User Interface Subsystem normal
procedures section of the SPSR User’s Guide.

The instructions for performing the major functions of the Space Network Data
portion of the User Interface Subsystem are included in the document.  Copies of
all applicable windows are included in the document.

3.0 ERROR CONDITIONS

3.1 Review the Space Network Data portion of the User Interface Subsystem error recovery
procedures section of the SPSR User’s Guide.

The user’s guide includes adequate error recovery actions for the Space Network
Data portion of the User Interface Subsystem.
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1.5.1.2 Detailed Test Procedure for Test Item INCC108-B1.2
OPERATOR INTERFACE - SPACE NETWORK DATA
CSCI 1605

Pass/Fail Criteria:

• The applicable menu options and or icons are operational.

• Pertinent windows can be iconified, can be enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the data base, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numeric in alphabetic fields, special characters, blanks,
etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the Space Network Data portion of the User
Interface Subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Access the Space Network Summary window.

The Space Network Summary window appears on the screen in the expected
format.

2.2 Select each menu option and icon available on the window.

The applicable menu options and or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.

2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.



2/12/97  6:03 PM INCC108-3 530-ITP-NCCDS/1998

2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with the Space Network Data portion of
the User Interface Subsystem.  The additional applicable windows are:

SGLT Resource Availability,
TDRS Configuration,
TDRS Operational Names and Mappings,
TDRS Resource Characteristics,
MDM Capacities, and
HDRM Capacities.

The windows meet the general and data entry window validation criteria.
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1.5.1.3 Detailed Test Procedure for Test Item INCC108-B1.3
SPACE NETWORK SUMMARY WINDOW - GT
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to view and delete ground terminal data from the
database via the Space Network Summary window.

• Data associated with a ground terminal is automatically deleted along with the ground
terminal.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Using SQL, add a ground terminal and related information to the database.

2.0 DELETE A GROUND TERMINAL

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears.  The "Opened" time reflects the
time the window was opened.  All but the “Close” button are dimmed, indicating
that editing is disabled.

2.2 Select the ground terminal added in step 1.3.

The “View...” button in the Ground Terminal panel is now functional.

2.3 Click the "Enable Editing" toggle button.

All buttons in the Ground Terminal panel are now functional.  All “Add...”
buttons in the window are now functional.

2.4 Click the “Delete” button in the Ground Terminal panel.

A dialog box appears asking you to confirm the deletion.

2.5 Click the "No" button.

The dialog box closes.

2.6 Perform a database query of the Space Network information.

The selected ground terminal appears in the data base.
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2.7 Repeat step 2.4 and click the "Yes" button in the dialog box.

The ground terminal is removed from the list.  The "Last update" information is
updated.

2.8 Perform a database query of the Space Network information.

The selected ground terminal and associated information has been deleted.

2.9 Select “Close” from the “File” menu.

The window closes and control returns to the Main Panel.

3.0 RELATED INFORMATION

3.1 Select “Space Network” from the Data Base subpanel on the mail panel.

The Space Network Summary window appears and does not contain the deleted
ground terminal.  The "Last update" information is the same as in step 2.7.

3.2 Select one of the remaining ground terminals and click the "View..." button.

The Ground Terminal Configuration window appears.

3.3 Click the arrow button in the Ground Terminal combination box.

The ground terminal deleted in step 2.7 does not appear in the list.

3.4 Attempt to enter the ground terminal deleted in step 2.7 in the Ground Terminal
combination box.

The operator is notified of an invalid entry.

3.5 Click the "Close" button.

The window closes and control returns to the Space Network Summary window.
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1.5.1.4 Detailed Test Procedure for Test Item INCC108-B1.4
SPACE NETWORK SUMMARY WINDOW - TDRS
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to delete TDRS data from the data base via the Space
Network Summary window.

• Data associated with a TDRS is automatically deleted along with the TDRS.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Using SQL, add a TDRS and related information to the database (including TDRS Op
Name/TDRS ID/SGLT mappings).

2.0 DELETE A TDRS

2.1 Select “Space Network” from the Data Base subpanel on the main panel.

The Space Network Summary window appears.  All but the “Close” button are
dimmed, indicating that editing is disabled.

2.2 Click the "Enable Editing" toggle button.

All “Add...” buttons in the window are now functional.

2.3 Select the TDRS added in step 1.3.

All buttons in the TDRS panel are now functional.

2.4 Click the “Delete” button in the TDRS panel.

A dialog box appears asking you to confirm the deletion.

2.5 Click the "No" button.

The dialog box closes.

2.6 Perform a database query of the Space Network information.

The selected TDRS has not been deleted.
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2.7 Repeat step 2.4 and click the “Yes” button in the dialog box.

The selected TDRS is removed from the list.  The "Last update" information is
updated.

2.8 Perform a database query of the Space Network information.

The selected TDRS and the related information has been deleted.

2.9 Click the “Close” button.

The window closes and control returns to the Main Panel.

3.0 RELATED INFORMATION

3.1 Select “Space Network” from the Data Base subpanel on the main panel.

The Space Network Summary window appears and does not contain the deleted
TDRS.  The “Last update” information is the same as in step 2.7.

3.2 Select one of the remaining TDRSs and click the "View..." button.

The TDRS Configuration window appears.

3.3 Click the arrow button in the TDRS combination box.

The TDRS deleted in step 2.7 does not appear in the list.

3.4 Attempt to enter the TDRS deleted in step 2.7 in the TDRS combination box.

The operator is notified of an invalid entry.

3.5 Click the "Close" button.

The window closes and control returns to the Space Network Summary window.

3.6 Select “TDRS Operational Names and Mappings” from the “Edit” menu.

The TDRS Operational Names and Mappings window appears.  The TDRS
deleted in step 2.7 does not appear in the Existing Operational Names or
Mappings lists.
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1.5.1.5 Detailed Test Procedure for Test Item INCC108-B1.5
SPACE NETWORK SUMMARY WINDOW - MDM
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to delete MDM data from the data base via the Space
Network Summary window.

• Data associated with an MDM is automatically deleted along with the MDM.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Using SQL, add an MDM and related information to the database.

2.0 DELETE AN MDM

2.1 Select “Space Network” from the Data Base subpanel on the main panel.

The Space Network Summary window appears.  All but the “Close” button are
dimmed, indicating that editing is disabled.

2.2 Select the MDM added in step 1.3.

The “View...” button in the MDM panel is now functional.

2.3 Click the "Enable Editing" toggle button.

All buttons in the MDM panel are now functional.  All “Add...” buttons in the
window are now functional.

2.4 Click the “Delete” button in the MDM panel.

A dialog box appears asking you to confirm the deletion.

2.6 Click the "No" button.

The dialog box closes.

2.7 Perform a database query of the Space Network information.

The selected MDM has not been deleted.



2/12/97  6:03 PM INCC108-9 530-ITP-NCCDS/1998

2.8 Repeat step 2.4 and click the "Yes" button in the dialog box.

The selected MDM is removed from the list.  The "Last update" information is
updated.

2.9 Perform a database query of the Space Network information.

The selected MDM and related information has been deleted.

2.10 Select "Close" from the "File" menu.

The window closes and control returns to the Main Panel.

3.0 RELATED INFORMATION

3.1 Select “Space Network” from the Data Base subpanel on the main panel.

The Space Network Summary window appears and does not contain the deleted
MDM.  The “Last update” information is the same as in step 2.8.

3.2 Select one of the remaining MDMs and click the "View..." button.

The Multiplexer/Demultiplexer Capacities window appears.

3.3 Click the arrow button in the MDM Name combination box.

The MDM deleted in step 2.8 does not appear in the list.

3.4 Attempt to enter the MDM deleted in step 2.8 in the MDM Name combination box.

The operator is notified of an invalid entry.

3.5 Select "Close" from the "File" menu.

The window closes and control returns to the Space Network Summary window.
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1.5.1.6 Detailed Test Procedure for Test Item INCC108-B1.6
SPACE NETWORK SUMMARY WINDOW - HDRM
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to delete HDRM data from the data base via the Space
Network Summary window.

• Data associated with an HDRM is automatically deleted along with the HDRM.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Using SQL, add an HDRM and related information to the database.

2.0 DELETE AN HDRM

2.1 Select “Space Network” from the Data Base subpanel on the main panel and click the
“Enable Editing” toggle button.

The Space Network Summary window appears.  All “Add...” buttons are
functional.  All other buttons, except “Close” are dimmed.

2.2 Select the HDRM added in step 1.3.

All buttons in the HDRM panel are now functional.

2.3 Click the “Delete” button.

A dialog box appears asking you to confirm the deletion.

2.4 Click the "No" button.

The dialog box closes.

2.5 Perform a database query of the Space Network information.

The selected HDRM has not been deleted.

2.6 Repeat step 2.3 and click the "Yes" button in the dialog box.

The selected HDRM is removed from the list.  The "Last update" information is
updated.
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2.7 Perform a database query of the Space Network information.

The selected HDRM and related information has been deleted.

2.8 Select "Close" from the "File" menu.

The window closes and control returns to the Main Panel.

3.0 RELATED INFORMATION

3.1 Select “Space Network” from the Data Base subpanel on the main panel.

The Space Network Summary window appears and does not contain the deleted
HDRM.  The “Last update” information is the same as in step 2.6.

3.2 Select one of the remaining HDRMs and click the "View..." button.

The High Data Rate Multiplexer Capacities window appears.

3.3 Click the arrow button in the HDRM Name combination box.

The HDRM deleted in step 2.6 does not appear in the list.

3.4 Attempt to enter the HDRM deleted in step 2.6 in the HDRM Name combination box.

The operator is notified of an invalid entry.

3.5 Select "Close" from the "File" menu.

The window closes and control returns to the Space Network Summary window.
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1.5.1.7 Detailed Test Procedure for Test Item INCC108-B1.7
SPACE NETWORK SUMMARY WINDOW - INVALID ENTRY
CSCI 1605

Pass/Fail Criteria:

• Invalid entries via the Space Network Summary window are appropriately rejected and
reported to the operator.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Using SQL, add an HDRM of “SGT” to the database.

2.0 INVALID DELETE ATTEMPT

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears and contains the HDRM added in
step 1.3.

2.2 Enable editing, select “SGT” from the Ground Terminals panel, and click the “Delete”
button in the HDRM panel.

No changes are made to this window and the operator is notified that a ground
terminal must first be selected.

2.3 Perform a database query of the Space Network information.

“SGT” has not been deleted from the Ground Terminals or HDRM panel.

3.0 INVALID VIEW ATTEMPT

3.1 Select a TDRS record and click the "View..." button in the MDM panel.

The operator is notified that an MDM must first be selected.

3.2 Select a GT and then an MDM.

The GT is unselected.

3.3 Attempt to select two TDRSs.

Only one TDRS can be selected at a time.
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4.0 CLEANUP

4.1 Delete the records added in step 1.3 from the database.

The test database has been restored to it’s original contents.
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1.5.1.8 Detailed Test Procedure for Test Item INCC108-B1.8
SGLT RESOURCE AVAILABILITY WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to view, add, modify and delete SGLT resource
availability information.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 VIEW SGLT RESOURCE AVAILABILITY INFORMATION

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears.

2.2 Select a ground terminal and click the “View...” button.

The Ground Terminal Configuration window appears.

2.3 Select an SGLT and click the “View...” button.

The SGLT Resource Availability window appears.  The time the window was
opened is displayed.  All but the “Close” button are dimmed, indicating that
editing is disabled.

2.4 Click the “Enable Editing” toggle button.

The “Add” button is now functional.

2.5 Select a resource.

All buttons are now functional.

2.6 Select another SGLT from the SGLT combination box.

The window now reflects that SGLT's information.

2.7 Click the “Close” button.

The window closes and control returns to the Ground Terminal Configuration
window.  Editing is disabled.
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2.8 Click the "Close" button.

The window closes and control returns to the Space Network Summary window.
Editing is disabled.

3.0 ADD SGLT RESOURCE AVAILABILITY INFORMATION

3.1 From the Space Network Summary window, click the “Enable Editing” toggle button,
select a ground terminal (WSC), and click the “Modify...” button.  From the Ground
Terminal Configuration window, click the “Add...” button under the SGLTs list.

The SGLT Resource Availability window appears and displays an empty SGLT
resource availabilities list.

3.2 Enter an SGLT, a Resource, a Start Time, and a Stop Time, and click the “Add” button.

The information appears in the list to the left.

3.3 Without closing the SGLT Resource Availability window, perform a data base query of
the Space Network information.

The new SGLT information does not appear in the data base.

3.4 From the SGLT Resource Availability window, click the “Save” button.

The "Last update" information is updated.

3.5 Click the “Close” button.

The window closes and control returns to the Ground Terminal Configuration
window.  The new SGLT appears in the SGLTs list.

3.6 Select the  SGLT added above and click the “View...” button.

The SGLT Resource Availability window appears and reflects the new SGLT
information.  The "Last update" field is the same as in step 3.4.

3.7 Click the “Close” button on the SGLT Resource Availability and Ground Terminal
Configuration windows.

The windows close and control returns to the Space Network Summary window.

4.0 MODIFY SGLT RESOURCE AVAILABILITY INFORMATION

4.1 From the Space Network Summary window, enable editing, select WSC from the Ground
Terminals panel, and click the “Modify...” button.  From the Ground Terminal
Configuration window select the SGLT added in 3.0 and click the “Modify...” button.

The SGLT Resource Availability window appears and displays the resource
availability information for the selected SGLT.
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4.2 Select the SGLT resource added in 3.0, modify the information, and click the “Modify”
button.

The SGLT resource availability list is updated.

4.3 Select WSC3 from the SGLT combination box and specify the maximum composite
forward and return service data rate for GRGT.  Click the “Modify” button.

The SGLT resource availability list is updated.

4.4 Click the “Save” button.

The "Last update" information is updated.

4.5 Click the “Close” button.

The window closes and control returns to the Ground Terminal Configuration
window.

4.6 Select the SGLT used above and click the “View...” button.

The SGLT Resource Availability window appears and displays the modified
SGLT resource availability.  The "Last update" field maintains the same
information from step 4.4.

4.7 Click the “Close” button on the SGLT Resource Availability and Ground Terminal
Configuration windows.

The windows close and control returns to the Space Network Summary window.

5.0 DELETE SGLT RESOURCE AVAILABILITY INFORMATION

5.1 From the Space Network Summary window, disable editing, select the ground terminal
used in 4.0, and click the “View...” button.  From the Ground Terminal Configuration
window, select the SGLT used in 4.0 and click the “View...” button.

The SGLT Resource Availability window appears and displays the resource
availabilities for the selected SGLT.  All but the “Close” button are dimmed,
indicating that editing is disabled.

5.2 Click the "Enable Editing" toggle button and select the SGLT resource availability
modified in step 4.0.

All buttons are now functional.

5.3 Click the “Delete” button.

A dialog box appears asking you to confirm the deletion.

5.4 Click the “Yes” button in the dialog box.

The SGLT Resource Availability and associated information is deleted.  The
"Last update" information is updated.
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5.5 Click the “Close” button.

The window closes and control returns to the Ground Terminal Configuration
window.

5.6 Select the same SGLT and click the “View...” button.

The SGLT Resource Availability window appears and does not display the
deleted SGLT resource availability.  The "Last update" field maintains the same
information from step 5.4.

5.7 Click the "Close" button.

The window closes and control returns to the Ground Terminal Configuration
window.

5.8 Click the "Close" button.

The window closes and control returns to the Space Network Summary window.
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1.5.1.9 Detailed Test Procedure for Test Item INCC108-B1.9
SGLT RESOURCE AVAILABILITY WINDOW - INVALID SN DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN database entries and properly informs the operator of invalid
configurations of an SGLT’s resource availability.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID SGLT RESOURCE AVAILABILITY

2.1 Access the SGLT Resource Availability window.  Attempt to add an invalid
configuration of an SGLT’s resource availability by specifying an invalid combination of
ground terminal, SGLT, resource, and start and stop times.

The operator is appropriately notified that the data is invalid.  The invalid entry
was not accepted and is not displayed upon refreshing the window.
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1.5.1.10 Detailed Test Procedure for Test Item INCC108-B1.10
TDRS CONFIGURATION WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add, modify, and delete a TDRS resource availability.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 VIEW TDRS INFORMATION

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select a TDRS and click the “View...” button.

The TDRS Configuration window appears and displays the resource availability
for the selected TDRS.  The time the window was opened is displayed.  All but
the “Close” button are dimmed.

2.2 Click the “Enable Editing” toggle button.

The “Add” button is now functional.

2.3 Select a resource from the panel.

All buttons in this window are now functional.

2.4 Disable editing.

All but the “Close” and “Characteristics...” buttons are dimmed.

2.5 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

3.0 ADD A TDRS RESOURCE AVAILABILITY

3.1 From the Space Network Summary window, click the “Enable Editing” toggle button.
Click the “Add...” button in the TDRS panel.

The TDRS Configuration window appears.

3.2 Enter a new TDRS ID, select a SIC (this should be a selection box only), and click the
“Add” button.
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3.3 Click the “Save” button.

The operator is alerted that TDRS resource availability information must be
added.

3.4 Enter the TDRS resource availability information and click the “Add” button.

The TDRS resource availability list is updated.

3.5 Click the “Save” button.

The "Last update" information is updated.

3.6 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
The new TDRS has been added to the TDRS list.

3.7 Select the same TDRS and click the “View...” button.

The TDRS Configuration window appears and displays the new TDRS resource
availability.   The "Last update" field maintains the same information from step
3.5.

3.8 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

4.0 MODIFY A TDRS RESOURCE AVAILABILITY

4.1 From the Space Network Summary window, enable editing, select the TDRS used in 3.0,
and click the “Modify...” button.

The TDRS Configuration window appears.

4.2 Select the TDRS resource added in 3.0 and change the Start Time and Stop Time in the
fields to the right.  Click the “Modify” button.

The TDRS resource availability list is updated.

4.3 Click the “Save” button.

The "Last update" information is updated.

4.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

4.5 Select the same TDRS and click the “View...” button.

The TDRS Configuration window appears and displays the modified TDRS
resource availability.  The "Last update" field is the same as in step 4.3.
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4.6 Click the “Close” button.

The window closes, and control returns to the Space Network Summary window.

5.0 DELETE A TDRS RESOURCE AVAILABILITY

5.1 From the Space Network Summary window, select the same TDRS and click the
“Modify...” button.

The TDRS Configuration window appears.

5.2 Select the TDRS resource availability modified in 4.0 and click the “Delete” button.

A dialog box appears asking you to confirm the deletion.

5.3 Click the “Yes” button in the dialog box.

The TDRS resource availability and information associated is deleted.  The "Last
update" information is updated.

5.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

5.5 Select the same TDRS and click the “View...” button.

The TDRS Configuration window appears and does not display the deleted TDRS
resource availability.  The "Last update" is the same as in step 5.3.

5.6 Click the “Close” button.

The window closes, and control returns to the Space Network Summary window.
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1.5.1.11 Detailed Test Procedure for Test Item INCC108-B1.11
TDRS CONFIGURATION WINDOW - INVALID SN DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN data base entries and properly informs the operator of invalid
TDRS configuration entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID TDRS CONFIGURATION

2.1 Access the TDRS Configuration window and attempt to enter invalid TDRS
configuration information.

The operator is appropriately notified that the entry is invalid.  The invalid entry is
not accepted and is not displayed upon refreshing the window.
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1.5.1.12 Detailed Test Procedure for Test Item INCC108-B1.12
TDRS OPERATIONAL NAMES AND MAPPINGS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to view, add, and delete TDRS Op Names via the TDRS
Operational Names and Mappings window.

• The operator has the capability to view, add, modify, and delete Op Name/TDRS
ID/SGLT mappings via the TDRS Operational Names and Mappings window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 VIEW OPERATIONAL NAME/TDRS ID/SGLT MAPPING INFORMATION

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  Select “TDRS
Operational Names and Mappings...” from the “Edit” menu.

The TDRS Operational Names and Mappings window appears and displays the
list of current TDRS operational names and mapping information.  The time the
window was opened is displayed.  All but the “Close” button are dimmed,
indicating that editing is disabled.

2.2 Click the “Enable Editing” toggle button.

The “Add” buttons are now functional.

2.3 Select an Existing Operational Name.

All buttons for that panel are now functional.

2.4 Select an entry from the second panel.

All buttons for that panel are now functional.

2.5 Disable editing.

All but the “Close” button are again dimmed.

2.6 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

3.0 ADD TDRS OPERATIONAL NAMES
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3.1 From the Space Network Summary window, enable editing, and then select “TDRS
Operational Names and Mappings...” from the "Edit" menu.

The TDRS Operational Names and Mappings window appears and displays the
current TDRS operational names and mapping information.   Editing is enabled.

3.2 Enter a new operational name, "XYZ", in the New Name field and click the “Add” button
under the Existing Operational names list.  Repeat for "123" and "A10".

The Existing Operational Names list is updated with the new entries.

3.3 Click the “Save” button.

The "Last update" information is updated.

3.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

3.5 Select “TDRS Operational Names and Mappings...” from the Edit menu.

The TDRS Operational Names and Mappings window appears and displays the
operational names added in step 3.2.

4.0 DELETE TDRS OPERATIONAL NAMES

4.1 From the TDRS Operational Names and Mappings window, select an operational name
from the Existing Operational Names list and click the “Delete” button.

A dialog box appears.

4.2 Click the “Yes” button.

The selected operational name is deleted.

4.3 Click the “Close” button.

The window closes, and control returns to the Space Network Summary window.

4.4 Select “TDRS Operational Names and Mappings...” from the Edit menu.

The TDRS Operational Names and Mappings window appears and does not
display the deleted operational name mapping information.  The time the window
was opened is displayed.
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5.0 ADD OP NAME/TDRS ID/SGLT MAPPINGS

5.1 From the TDRS Operational Names and Mappings window, select a TDRS operational
name from the Existing Operational Names list, enter a TDRS ID, SGLT, Start Time and
Stop Time, and click the “Add” button.

The new mapping information appears in the mappings list.

5.2 Click the “Save” button.

The "Last update" information is updated.

5.3 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

5.4 Select “TDRS Operational Names and Mappings...” from the Edit menu.

The TDRS Operational Names and Mappings window appears and displays the
new TDRS operational name/TDRS ID/SGLT mapping information.

5.5 Repeat steps 5.1 through 5.4 specifying an indefinite Stop Time.

The Stop field reflects that the stop time is indefinite.

6.0 MODIFY OP NAME/TDRS ID/SGLT MAPPINGS

6.1 From the TDRS Operational Names and Mappings window, select a mapping, modify the
information, and click the “Modify” button.

The TDRS operational name mapping information list is updated.

6.2 Click the “Enable Editing” toggle button.

A dialog box appears asking if you want to save changes.

6.3 Click the “No” button in the dialog box.

The dialog box closes and the update is not reflected in the window.  Editing is
disabled.

6.4 Perform a data base query of the Space Network information.

The update made in step 6.1 is not reflected in the data base.

6.5 Enable editing and repeat steps 6.1 and 6.2.  Answer “Yes” in the dialog box.

The dialog box closes and the mapping update is reflected in the window.  Editing
is disabled.  The "Last update" information is updated.

6.6 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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6.7 Select “TDRS Operational Names and Mappings...” from the Edit menu.

The TDRS Operational Names and Mappings window appears and displays the
modified TDRS operational name / TDRS ID / SGLT mapping information.

7.0 DELETE OP NAME/TDRS ID/SGLT MAPPINGS

7.1 From the TDRS Operational Names and Mappings window, select a mapping and click
the “Delete” button.

A dialog box appears.

7.2 Click the “Yes” button.

The selected TDRS operational name mapping information is deleted.  The "Last
update" information is updated.

7.3 Click the “Close” button.

The window closes, and control returns to the Space Network Summary window.

7.4 Select “TDRS Operational Names and Mappings...” from the Edit menu.

The TDRS Operational Names and Mappings window appears and does not
display the deleted TDRS operational name/TDRS ID/SGLT mapping
information.
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1.5.1.13 Detailed Test Procedure for Test Item INCC108-B1.13
MDM CAPACITIES WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to configure (add, modify, and delete) MDM fixed
overhead settings.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 VIEW MDM INFORMATION

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select a MDM and click the “View...” button.

The Multiplexer/Demultiplexer Capacities window appears.  The time the
window was opened is displayed.  All but the “Close” button are dimmed,
indicating that editing is disabled.

2.2 Click the “Enable Editing” toggle button.

The “Add” button is now functional.

2.3 Select an entry from the Fixed Overhead panel.

All buttons are now available.

2.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

3.0 ADD AN MDM FIXED OVERHEAD

3.1 From the Space Network Summary window, click the “Enable Editing” toggle button,
and click the “Add...” button under the MDM list.

The Multiplexer/Demultiplexer Capacities window appears with the fields empty.
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3.2 Add an MDM Name and add MDM settings by entering values for Overhead, Start Time,
and Stop Time in the fields to the right of the Fixed Overhead list and click the "Add"
button.

The Fixed Overhead list is updated with the new MDM capacities.

3.3 Click the “Save” button.

The "Last update" information is updated.

3.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
The new MDM has been added to the MDM list.

3.5 Select the MDM added above and click the “View...” button.

The Multiplexer/Demultiplexer Capacities window appears and displays the new
MDM fixed overhead settings.  The "Last update" is the same as in step 3.3.

3.6 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

4.0 MODIFY AN MDM FIXED OVERHEAD

4.1 From the Space Network Summary window, select the MDM added in 3.0 and click the
“Modify...” button.

The Multiplexer/Demultiplexer Capacities window appears and displays the
location, bandwidth, and fixed overheads for the selected MDM.

4.2 Select the MDM fixed overhead added in 3.0, modify the information, and click the
“Modify” button.

The Fixed Overhead list is updated with the modified MDM capacities.

4.3 Click the “Save” button.

The “Last update” information is updated.

4.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

4.5 Select the same MDM and click the “View...” button.

The Multiplexer/Demultiplexer Capacities window appears and displays the
modified MDM settings.  The "Last update" field is the same as in step 4.3.

4.6 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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5.0 DELETE AN MDM FIXED OVERHEAD

5.1 From the Space Network Summary window, select the MDM modified in 4.0 and click
the “Modify...” button.

The Multiplexer/Demultiplexer Capacities window appears.

5.2 Select the MDM fixed overhead modified in 4.0 and click the “Delete” button.

A dialog box appears.

5.3 Click the “Yes” button.

The overhead and associated information is updated.

5.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

5.5 Select the same MDM and click the “View...” button in the MDM panel.

The Multiplexer/Demultiplexer Capacities window appears and does not display
the deleted MDM fixed overhead.  The "Last update" is the same as in step 5.3.

5.6 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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1.5.1.14 Detailed Test Procedure for Test Item INCC108-B1.14
MDM CAPACITIES WINDOW - INVALID SN DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN database entries and properly informs the operator of invalid
MDM location entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID MDM LOCATION

2.1 Access the MDM Capacities window and attempt to add an invalid MDM setting.

The operator is appropriately notified that the entry is invalid.  The invalid entry is
not accepted and is not displayed upon refreshing the window.
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1.5.1.15 Detailed Test Procedure for Test Item INCC108-B1.15
HDRM CAPACITIES WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to configure (add and modify) HDRM settings.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 VIEW HDRM INFORMATION

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select an HDRM and click the “View...” button.

The High Data Rate Multiplexer Capacities window appears.  The time the
window was opened is displayed.  The “Save” button is dimmed, indicating that
editing is disabled.

2.2 Click the “Enable Editing” toggle button.

The “Save” button is now functional.

2.3 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

3.0 ADD AN HDRM

3.1 From the Space Network Summary window, click the “Enable Editing” toggle button.

All “Add...” buttons in this window are now functional.

3.2 Click the “Add...” button in the HDRM panel.

The High Data Rate Multiplexer Capacities window appears with the fields
empty.

3.3 Enter an HDRM Name, Location, and Maximum Uplink Bandwidth.

The entry is accepted.
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3.4 Click the “Save” button.

The “Last update” information is updated.

3.5 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
The new HDRM has been added to the HDRM list.

3.6 Select the same HDRM added above and click the “View...” button under the HDRM list.

The High Data Rate Multiplexer Capacities window appears and displays the new
HDRM.   The "Last update" field maintains the same information from step 3.4.

3.7 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

4.0 MODIFY A HDRM

4.1 From the Space Network Summary window, select the HDRM added in step 3.0 and
click the “Modify...” button.

The High Data Rate Multiplexer Capacities window appears and displays the
location and bandwidth for the selected HDRM.

4.2 Modify the Maximum Uplink Bandwidth for the selected HDRM.

The Maximum Uplink Bandwidth is accepted.

4.3 Click the “Save” button.

The date and the name of the operator is updated in the "Last update" field.

4.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

4.5 Select the same HDRM as above and click the “View...” button under the HDRM list.

The High Data Rate Multiplexer Capacities window appears and displays the
modified HDRM settings.  The "Last update" field maintains the same
information from step 4.3.

4.6 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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1.5.1.16 Detailed Test Procedure for Test Item INCC108-B1.16
HDRM CAPACITIES WINDOW - INVALID SN DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN data base entries and properly informs the operator of invalid
HDRM location entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID HDRM LOCATION

2.1 Access the HDRM Capacities window and attempt to select an invalid HDRM setting.

The operator is appropriately notified that the selection was invalid.  The invalid
entry is not accepted and is not displayed upon refreshing the window.
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1.5.2 Detailed Test Procedures for Test Case INCC108

1.5.2.17 Detailed Test Procedure for Test Item INCC108-B1.17
USER’S GUIDES - SPACE NETWORK DATA
CSCI 1605

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the SPSR User’s Guide.

The SPSR User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the Space Network Data portion of the User Interface Subsystem normal
procedures section of the SPSR User’s Guide.

The instructions for performing the major functions of the Space Network Data
portion of the User Interface Subsystem are included in the document.  Copies of
all applicable windows are included in the document.

3.0 ERROR CONDITIONS

3.1 Review the Space Network Data portion of the User Interface Subsystem error recovery
procedures section of the SPSR User’s Guide.

The user’s guide includes adequate error recovery actions for the Space Network
Data portion of the User Interface Subsystem.
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1.5.2.18 Detailed Test Procedure for Test Item INCC108-B1.18
OPERATOR INTERFACE - SPACE NETWORK DATA
CSCI 1605

Pass/Fail Criteria:

• The applicable menu options and or icons are operational.

• Pertinent windows can be iconified, can be enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the data base, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numeric in alphabetic fields, special characters, blanks,
etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the Space Network Data portion of the User
Interface Subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Access the Space Network Configuration window.

The Space Network Configuration window appears on the screen in the expected
format.

2.2 Select each menu option and icon available on the window.

The applicable menu options and or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.

2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.
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2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with the Space Network Data portion of
the User Interface Subsystem.  The additional applicable windows are:

Ground Terminal Configuration,
SGLT Resource Availability Summary,
TDRS Resource Availability Summary,
TDRS Sets,
User Interface Channels,
User Interface Channel Details,
Transmission Control Parameters,
Incrementally Allocated Resource Summary windows, and
Space Network Configuration windows.

The windows meet the general and data entry window validation criteria.



2/12/97  6:03 PM INCC108-37 530-ITP-NCCDS/1998

1.5.2.19 Detailed Test Procedure for Test Item INCC108-B1.19
GT CONFIGURATION WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to view and delete SGLT information via the Ground
Terminal Configuration window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Using SQL, add an SGLT and related information to the database.

2.0 VIEW GROUND TERMINAL INFORMATION

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears.

2.2 Select a ground terminal from the Ground Terminals list and click the “View...” button.

The Ground Terminal Configuration window appears.  All but the “Close” button
are dimmed.  The time the window was opened is displayed.

2.3 From the Ground Terminal combination box, enter a ground terminal not in the Ground
Terminal list.

The operator is notified that the requested ground terminal does not exist.

2.4 From the Ground Termination combination box, enter a ground terminal that is in the
Ground Terminal list.

The window refreshes with the list of SGLTs for the selected ground terminal.

2.5 Click the “Enable Editing” toggle button.

The “Add...” button is now functional.

2.6 Disable editing, and select an SGLT from the SGLTs panel.

The “Add...” button is now dimmed and the “View...” button is functional.

2.7 Click the “Enable Editing” toggle button.

All buttons are now functional.
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2.8 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

3.0 DELETE AN SGLT

3.1 From the Space Network Summary window, select the ground terminal used in step 1.3,
enable editing, and click the “Modify...” button.

The Ground Terminal Configuration window appears.

3.2 Select the SGLT added in step 1.3  and click the “Delete” button.

A dialog box appears asking you to confirm the deletion.

3.3 Click the “Yes” button.

The selected SGLT is removed from the list.  The "Last update" information is
updated.

3.4 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

3.5 Select the same ground terminal as above and click the “View...” button.

The Ground Terminal Configuration window appears and no longer displays the
deleted SGLT.  The "Last update" field maintains the same information from step
3.3.

3.6 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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1.5.2.20 Detailed Test Procedure for Test Item INCC108-B1.20
GT CONFIGURATION WINDOW - INVALID SN DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN data base entries and properly informs the operator of invalid
entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID SGLT CONFIGURATION

2.1 Access the GT Configuration window and attempt to specify an invalid SGLT
configuration.

The operator is appropriately notified that the data is invalid.  The invalid entry
was not accepted and is not displayed upon refreshing the window.
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1.5.2.21 Detailed Test Procedure for Test Item INCC108-B1.21
TDRS RESOURCE DETAIL WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add, modify, and remove TDRS resource parameters.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 VIEW TDRS RESOURCE PARAMETERS

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears.

2.2 Select a TDRS and click the “Modify...” button.

The TDRS Configuration window appears.

2.3 Select a resource from the Resources list and click the “Characteristics...” button.

The TDRS Resource Detail window appears and contains the list of parameters
for the selected resource with corresponding value or range.  The appropriate
TDRS ID, TDRS SIC, and the time the window was opened are displayed.  All
buttons except "Close" are dimmed.

2.4 Click the “Enable Editing” toggle button.

The “Add” button above the “Last update” information is now functional.

2.5 Select a parameter from the Parameter Name panel.

The associated values appear in the fields to the right.  The “Remove” button
under the Parameter Name panel is now functional.

2.6 Click the “Close” button on the TDRS Resource Detail and TDRS Configuration
windows.

The windows close and control returns to the Space Network Summary window.
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3.0 ADD TDRS RESOURCE PARAMETERS

3.1 From the Space Network Summary window, click the “Enable Editing” toggle button,
select a TDRS from the TDRS list, and click the “Modify...” button.  From the TDRS
Configuration window, select a resource and click the “Characteristics...” button.

The TDRS Resource Detail window appears and displays the parameters for the
selected resource.

3.2 Enter a parameter name in the Name combination box and click the range radio button.

The Minimum and Maximum fields are raised indicating the selection of the
range radio button.

3.3 Select “Float” from the Type combination box and enter the minimum and maximum
range in the appropriate fields.

3.4 Click the “Add” button above “Last update”.

The parameter name and new range values now appear in the parameter listing.

3.5 Click the “Save” button.

The “Last update” information is updated.

3.6 Click the “Close” button.

The window closes and control returns to the TDRS Configuration window.

3.7 Select the same resource as above and click the “Characteristics...” button.

The TDRS Resource Detail window appears and displays the new schedulable
parameter information.  The "Last update" field maintains the same information
from step 3.5.

3.8 Click the “Close” button on the TDRS Resource Detail and TDRS Configuration
windows.

The windows close and control returns to the Space Network Summary window.

4.0 MODIFY TDRS RESOURCE PARAMETERS

4.1 From the Space Network Summary window, select the TDRS used in step 3.0 and click
the “Modify...” button.  From the TDRS Configuration window, select the resource used
in step 3.0 and click the “Characteristics...” button.

The TDRS Resource Detail window appears and displays the schedulable
parameters for the selected resource.

4.2 Select from the Parameter Name list the schedulable parameter added in step 3.0.

The “Remove” button under the Parameter Name list and the “Modify” button
will become functional and the Value radio button will become depressed.
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4.3 Enter a range in the Minimum and Maximum fields for the selected parameter and click
the "Modify" button.

The schedulable parameter list is updated with the new values.

4.4 Click the “Save” button.

The date and the name of the operator is updated in the "Last update" field.

4.5 Click the “Close” button.

The window closes, and control returns to the TDRS Configuration window.

4.6 Select the same resource as above and click the “Characteristics...” button.

The TDRS Resource Detail window appears and displays the modified
schedulable parameter information.  The "Last update" field maintains the same
information from step 4.4.

4.7 Click the “Close” button on the TDRS Resource Detail and TDRS Configuration
windows.

The windows close and control returns to the Space Network Summary window.

5.0 REMOVE TDRS RESOURCE PARAMETERS

5.1 From the Space Network Summary window, enable editing, select the TDRS used in step
4.0, and click the “Modify...” button.  From the TDRS Configuration window, select the
resource used in 4.0 and click the “Characteristics...” button.

The TDRS Resource Detail window appears and displays the schedulable
parameter for the selected resource.

5.2 Select from the Parameter Name list, the schedulable parameter modified in step 4.0.

The “Remove” button under the Parameter Name list and the “Modify” button
will become functional and the Value radio button will become depressed.

5.3 Click the "Remove" button.

A dialog box appears.

5.4 Click the “Yes” button.

The resource availability and all information associated with it (Schedulable
Parameter and Value/Range) is deleted from the schedulable parameter list.  The
"Last update" information is updated.

5.5 Click the “Close” button.

The window closes and control returns to the TDRS Configuration window.
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5.6 Select the same resource as above and click the “Characteristics...” button.

The TDRS Resource Detail window appears and does not display the deleted
parameter name information.  The "Last update" field maintains the same
information from step 5.4.

5.7 Click the “Close” button.

The window closes and control returns to the TDRS Configuration window.
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1.5.2.22 Detailed Test Procedure for Test Item INCC108-B1.22
TDRS RESOURCE DETAIL WINDOW -
INVALID SN DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates data entries and properly informs the operator of invalid for a
TDRS resource parameters.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID TDRS RESOURCE PARAMETERS

2.1 Access the TDRS Resource Detail window and enter invalid parameters.

The operator is appropriately notified that the entry is invalid.  The invalid entry is
not accepted.

2.2 Close and re-access the window.

The invalid entry does not appear in the window.
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1.5.2.23 Detailed Test Procedure for Test Item INCC108-B1.23
TDRS SETS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator is able to create a new or modify an existing TDRS set.

• The operator is able to add or remove a member of a TDRS set.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 CREATE TDRS SETS

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select the “TDRS Sets...” option from the Edit menu.

The TDRS Sets window appears and displays a list of all the existing TDRS Sets
in the database.  The time the window was opened is displayed.  The “Add”,
“Delete”, “Remove”, and “Save” buttons are dimmed indicating that editing is
disabled.

2.2 Click the “Enable Editing” toggle button.

Editing is enabled.  All buttons are dimmed with the exception of “Close”.

2.3 Select a Set Member.

The “Add” and “Remove” buttons are no longer dimmed and are functional.

2.4 Enter a New Set Name and click the “Add” button.

The New Set Name is added and selected in the TDRS Set Name list.  The Set
Members list is empty.

2.5 Select a TDRS Operational Name and click the “Add” button next to the Set Members
list.

The selected TDRS Operational Name is added to the Set Members list.

2.6 Click the “Close” button.

The window closes and returns to the Space Network Summary window.
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2.7 Re-access the TDRS Sets window.

The TDRS Sets window appears and does not display the new TDRS Set Name.
Editing is disabled.

2.8 Enable editing, repeat steps 2.3 through 2.6, and click the “Save” button before closing
the window.

The new TDRS set is added to the database.  The “Last update” information is
updated.

2.9 Perform a data base query of the Space Network information.

The new TDRS set has been added to the database.

2.10 Re-access the TDRS Sets window and attempt to add another TDRS Set Name.

Editing is disabled.  The buttons are not available for this window and it is not
possible to enter/select values.  The “Last update” information is not updated.

2.11 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

2.12 Re-access the TDRS Sets window.

The TDRS Sets window appears and displays the new TDRS Set Name.  Editing
is disabled.

3.0 DELETING A TDRS SET

3.1 From the TDRS Sets window, enable editing, and select a TDRS Set Name.

The “Add” and “Delete” keys are functional.  The list of Set Members is updated
with the TDRS Operational Names contained in the set.

3.2 Click the “Delete” button.

A dialog box appears to confirm the deletion.

3.3 Click the “No” button.

The dialog box disappears, the selected TDRS Set Name has not been deleted.
The “Last update” information is not updated.

3.4 Select the same TDRS Set Name from step 3.1 and click the “Delete” button.

The dialog box appears to confirm the deletion.

3.5 Perform a data base query of the Space Network information.

The TDRS set has not been deleted.
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3.6 Click the “Yes” button to confirm the deletion.

The TDRS Set Name and all information associated with it (Set members and
TDRS Operational Names) is deleted.  The “Last update” information is updated.

3.7 Perform a data base query of the Space Network information.

The TDRS set has now been deleted.

3.8 Click the “Enable Editing” toggle button and attempt to delete another TDRS set.

Editing is disabled.  The buttons are not available for this window and it is not
possible to enter/select values.  The “Last update” information is not updated.

3.9 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

3.10 Re-access the TDRS Sets window.

The TDRS Sets window appears and does not display the deleted TDRS Set
Name.  Editing is disabled.

4.0 ADDING A MEMBER TO A TDRS SET

4.1 From the TDRS Sets window, enable editing, and select a TDRS Set Name.

The Set Members list is updated with the TDRS Operational Names contained in
the selected set.

4.2 Select a TDRS Operational Name and click the “Add” button next to the Set Members
list.

The selected TDRS Operational Name is added to the Set Members list.

4.3 Perform a data base query of the Space Network information.

The Set Member has not been added to the TDRS set.

4.4 Click the “Save” button.

The Set Member addition is saved to the database.  The “Last update” information
is updated.

4.5 Perform a data base query of the Space Network information.

The Set Member has now been added to the TDRS set.

4.6 Click the “Enable Editing” toggle button and attempt to add another member to a TDRS
set.

Editing is disabled.  The buttons are not available for this window and it is not
possible to enter/select values.  The “Last update” information is not updated.
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4.7 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

4.8 Re-access the TDRS Sets window.

The TDRS Sets window appears and displays the new TDRS Set Member.
Editing is disabled.

5.0 REMOVING A MEMBER FROM A TDRS SET

5.1 From the TDRS Sets window, enable editing, and select a TDRS Set Name.

The Set Members list is updated with the TDRS Operational Names contained in
the selected set.

5.2 Select a Set Member and click the “Remove” button.

The selected Set Member is removed from the list for the selected TDRS Set.

5.3 Perform a data base query of the Space Network information.

The Set Member has not been removed from the TDRS set.

5.4 Click the “Save” button.

The Set Member deletion is saved to the database.  The “Last update” information
is updated.

5.5 Perform a data base query of the Space Network information.

The Set Member has now been removed from the TDRS set.

5.6 Click the “Enable Editing” toggle button and attempt to remove another member from a
TDRS set.

Editing is disabled.  The buttons are not available for this window and it is not
possible to enter/select values.  The “Last update” information is not updated.

5.7 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

5.8 Re-access the TDRS Sets window.

The TDRS Sets window appears and does not display the TDRS Set Member
removed from the TDRS set.  Editing is disabled.

5.9 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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1.5.2.24 Detailed Test Procedure for Test Item INCC108-B1.24
TDRS SETS WINDOW - INVALID SN DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN data base entries and properly informs the operator of invalid
TDRS set entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID TDRS SET

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select the “TDRS Sets...” option from the “Edit” menu.

The TDRS Sets window appears and displays a list of all the existing TDRS Sets
in the database.  The time the window was opened is displayed.  The “Add”,
“Delete”, “Remove”, and “Save” buttons are dimmed indicating that editing is
disabled.

2.2 Select a TDRS Operational Name.

The “Add” and “Remove” buttons are dimmed.

2.3 Click the “Enable Editing” toggle button.

Editing is enabled.  All buttons are no longer dimmed and are functional.

2.4 Select a set from the TDRS Set Name list.

The Set Members list is updated with the TDRS Operational Names contained in
the selected set.

2.5 Select a TDRS Operational Name and click the “Add” button next to the Set Members
list.

The selected TDRS Operational Name is added to the Set Members list.
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2.6 Select the same TDRS Operational Name added above, click the “Add” button next to the
Set Members list, and attempt to add it a second time.  Click the “Save” button.

The operator is appropriately notified that the entry is invalid and the TDRS
Operational Name is not added to the Set Members list a second time.  The “Last
update” information is not updated.

2.7 Perform a data base query of the Space Network information.

The Set Members list contains one occurrence of the TDRS Operational Name.

2.8 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

2.9 Re-access the TDRS Sets window.

The TDRS Sets window appears and only one occurrence of the new TDRS Set
Member is displayed.  Editing is disabled.

2.10 Enable editing, select a TDRS Operational Name, and click the “Remove” button.

Either a Set Member will be deleted or the operation will not be doable.

2.11 Select a Set Member and click the “Add” button.

Either a TDRS Operational Name will be deleted or the operation will not be
doable.

2.12 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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1.5.2.25 Detailed Test Procedure for Test Item INCC108-B1.25
USER INTERFACE CHANNELS WINDOWS
CSCI 1605

Pass/Fail Criteria:

• The operator is able to add, modify, and delete a user interface channel.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ADDING A USER INTERFACE CHANNEL

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select the “User Interface Channels...” option from the Edit
menu.

The User Interface Channels window appears with all defined user interface
channels in the system.  The operator is able to scroll through the list.  The time
the window was opened is displayed.  All but the “Close” button are dimmed.

2.2 Select a user interface channel.

The “View ...” button is now functional.   All other buttons remain dimmed.

2.3 Click the “Enable Editing” toggle button.

Editing is enabled.  All buttons are no longer dimmed and are functional.

2.4 Click the “Add...” button.

The User Interface Channel Details window appears with empty fields.  The
"Opened" time reflects the time the window was opened.  Editing is enabled.

2.5 Enter an Identifier, select the UIFC Type, click on one of the Flow Direction toggle
buttons and select the appropriate values.  Select a Ground Terminal from the Ground
Terminals list and click the “Add” button.  Select a Valid Ground Terminal from the
Ground Terminals list and click the “Remove” button.

The entries are accepted.  The “Last update” information is not updated.

2.6 Perform a data base query of the Space Network information.

The new UIFC has not been added to the database.
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2.7 Click the “Save” button.

The new UIFC is added to the database.  The “Last update” information is
updated.

2.8 Perform a data base query of the Space Network information.

The new UIFC has now been added to the database.

2.9 Click the “Close” button.

The window closes and control returns to the User Interface Channels window.
The new user interface channel is displayed.

2.10 Re-access the User Interface Channel Details window.

The User Interface Channel Details window appears and contains the user
interface channel information for the new user interface channel.  Editing is
enabled.

2.11 Click the “Close” button.

The window closes and control returns to the User Interface Channels window.

2.12 Click the “Enable Editing” toggle button and attempt to add another user interface
channel.

Editing is disabled.  The buttons are not available for this window and it is not
possible to enter/select values.  The “Last update” information is not updated.

3.0 MODIFYING A USER INTERFACE CHANNEL

3.1 From the User Interface Channels window, enable editing, select a user interface channel
and click the “Modify...” button.

The User Interface Channel Details window appears.  Editing is enabled.

3.2 Modify a user interface channel and click the “Close” button.

A dialog box appears asking you to confirm the modifications.

3.3 Click the “No” button to cancel the modifications.

The window closes and control returns to the User Interface Channels
window.  The changes were not saved.  The “Last update” information is not
updated.

3.4 Perform a data base query of the Space Network information.

The user interface channel modifications have not been saved.
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3.5 Select a user interface channel and click the “Modify...” button.

The User Interface Channel Details window appears and contains the selected
information.  Editing is enabled.

3.6 Select a Ground Terminal and click the “Add” button.  Select a Valid Ground Terminal
and click the “Remove” button.

The entries are accepted.  The “Last update” information is not updated.

3.7 Perform a data base query of the Space Network information.

The user interface channel modifications have not been saved.

3.8 Click the “Save” button.

The modifications are saved to the data base.  The “Last update” information is
updated.

3.9 Perform a data base query of the Space Network information.

The user interface channel modifications have now been saved.

3.10 Click the “Close” button.

The window closes and control returns to the User Interface Channels window.
The modified user interface channel is displayed.

3.11 Re-access the User Interface Channel Details window.

The User Interface Channel Details window appears and contains the user
interface channel updates.  Editing is enabled.

3.12 Click the “Close” button.

The window closes and control returns to the User Interface Channels window.

3.13 Click the “Enable Editing” toggle button and attempt to modify another user interface
channel.

Editing is disabled.  The “Add ...”, “Modify...”  and “Delete” buttons are not
available for this window and it is not possible to enter/select values.  The “Last
update” information is not updated.

4.0 DELETING A USER INTERFACE CHANNEL

4.1 From the User Interface Channels window, enable editing, select a user interface channel
and click the “Delete” button.

A dialog box appears to confirm the deletion.
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4.2 Click the “No” button to abort the deletion.

The deletion is aborted, the “Last update” information is not updated, and control
returns to the User Interface Channels window.

4.3 Select a user interface channel and click the “Delete” button.

A dialog box appears to confirm the deletion.

4.4 Perform a data base query of the Space Network information.

The user interface channel has not been deleted.

4.5 Click the “Yes” button to confirm the deletion.

The user interface channel and all information associated with it (ID, Type, Flow
Direction, Uplink, SDPF Support, LI Subtype) are deleted.  The “Last update”
information is updated.

4.6 Perform a data base query of the Space Network information.

The user interface channel has now been deleted.

4.7 Click the “Enable Editing” toggle button and attempt to delete another user interface
channel.

Editing is disabled.  The buttons are not available for this window and it is not
possible to enter/select values.  The “Last update” information is not updated.

4.8 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

4.9 Re-access the User Interface Channels window.

The User Interface Channels window appears and does not display the deleted
user interface channel.  Editing is disabled.

4.10 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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1.5.2.26 Detailed Test Procedure for Test Item INCC108-B1.26
USER INTERFACE CHANNELS WINDOWS - INVALID SN DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN data base entries and properly informs the operator of invalid
user interface channel entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID USER INTERFACE CHANNEL

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select the “User Interface Channels...” option from the Edit
menu.

The User Interface Channels window appears with all defined user interface
channels in the system.  The time the window was opened is displayed.  The
“Add...”, “View...”, “Modify...”, and “Delete” buttons are dimmed indicating that
editing is disabled.

2.2 Click the “Enable Editing” toggle button.

Editing is enabled.  All buttons are no longer dimmed and are functional.

2.3 Click the “Add...” button.

The User Interface Channel Details window appears with empty fields.  The
"Opened" time reflects the time the window was opened.  Editing is enabled.

2.4 Attempt to specify an invalid user interface channel to be added.  Click the “Save”
button.

The operator is appropriately notified that the entry is invalid.  The invalid entry is
not accepted.  The “Last update” information is not updated.

2.5 Perform a data base query of the Space Network information.

The invalid user interface channel has not been added.
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2.6 Click the “Close” button.

The window closes and control returns to the User Interface Channels window.
The invalid user interface channel is not displayed.  The “Last update”
information is not updated.

2.7 Note the Identifier of an existing user interface channel and click the “Add...” button.

The User Interface Channel Details window appears with empty fields.  Editing is
enabled.

2.8 Enter the Identifier noted above.  Select a Ground Terminal and click the “Add” button.
Select a Valid Ground Terminal and click the “Remove” button.  Click the “Save” button.

A dialog box warns of the attempt to add a duplicate user interface channel and
the changes are not saved.  The “Last update” information is not updated.

2.9 Perform a data base query of the Space Network information.

The user interface channel appears only once.

2.10 Click the “Close” button.

The window closes and control returns to the User Interface Channels window.
Only one occurrence of the user interface channel is displayed.

2.11 Select an existing user interface channel and click the “Modify...” button.

The User Interface Channel Details window appears and contains the selected
information.  Editing is enabled.

2.12 Select a ground terminal from the Ground Terminals subpanel and click “Remove”.

The operator is appropriately notified that this operation will not be doable.

2.13 Select a valid ground terminal from the Valid Ground Terminal(s) subpanel, and click the
“Add” button.

The operator is appropriately notified that this operation will not be doable.

2.14 Select a ground terminal from the Ground Terminals subpanel and click the “Add”
button.

The selected ground terminal is added to the Valid Ground Terminal(s) list.

2.15 Select the same ground terminal added above, click the “Add” button.

The operator is appropriately notified that the entry is invalid and the ground
terminal is not added to the Valid Ground Terminal(s) list.

2.16 Click the “Close” button from the User Interface Channel Details and User Interface
Channels windows.

The windows close and control returns to the Space Network Summary window.
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1.5.2.27 Detailed Test Procedure for Test Item INCC108-B1.27
VALID DESTINATIONS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to specify valid destinations via the Valid Destinations
window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ADD A VALID DESTINATION

2.1 Select “Space Network” from the Data Base subpanel on the main panel.  From the Space
Network Database window, select the "Valid Destinations..." option from the Edit menu.

The Valid Destinations window appears and contains the current destinations and
their appropriate information such as Name and Type.  The "Opened" time
reflects the time the window was opened.  The "Remove", "Add", and "Save"
buttons are dimmed.

2.2 Enable editing, enter a valid destination (Name, Type, Inhibit Schedule/Vector Messages,
Minimum Event Transmission Offset) and click the "Add" button.

The "Add" button is activated upon entering the destination.  The valid destination
is added to the Destinations list.  The "Last Update" information is not updated.

2.3 Perform a database query of the destinations information.

The destination was not added to the data base.

2.4 Click the "Save" button.

The new destination is added to the data base.  The "Last update" information is
updated.

2.5 Perform a database query of the destination information.

The new destination has been added to the data base.

2.6 Click the “Close” button.

The window closes and control returns to the Space Network window.
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2.7 Re-access the Valid Destinations window.

The Valid Destinations window appears and contains the new destination.  The
"Last update" information is the same as in step 2.4.  Editing is disabled.

2.8 Click the "Close" button.

The window closes and control returns to the Space Network window.

3.0 MODIFY A DESTINATION

3.1 From the Space Network Database window, enable editing and select the "Valid
Destinations..." option from the Edit menu.

The Valid Destinations window appears and contains the current destinations with
the appropriate information such as Name and Type.  The "Opened" time reflects
the time the window was opened.  The "Remove", "Add" and "Save" buttons are
dimmed.  Editing is enabled.

3.2 Using the "Find" box, enter destination added in step 2.0 and hit return to select it.

The selected destination and the corresponding information (Name, Type, Inhibit
Schedule/Vector Messages, Minimum Event Transmission Offset) is displayed.
The "Remove", "Modify" and “Add” buttons are activated when the Name was
entered.

3.3 Change the existing destination settings (Type, Inhibit Schedule/Vector Messages), the
Minimum Event Transmission Offset value and click the “Modify” button.

The new list of values for the selected destination is reflected in the Destinations
list.  The “Last Update” information is not updated.

3.4 Perform a database query of the valid destinations.

The valid destinations information have not been updated.

3.5 Click the “Save” button.

The updated valid destination information has been added to the data base.  The
“Last Update” information is updated.

3.6 Perform a database query of the valid destinations.

The valid destinations information now reflects the update.

3.7 Click the “Close” button.

The window closes and control returns to the Space Network window.
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3.8 Re-access the Valid Destinations window and select the destination modified in step 3.3.

The Valid Destinations window appears and contains the updated destination
information.  The "Last update" information is the same as in step 3.5.  Editing is
enabled.

3.9 Click the "Close" button.

The window closes and control returns to the Space Network window.

4.0 REMOVE A VALID DESTINATION

4.1 From the Space Network Database window, select the "Valid Destinations..." option from
the Edit menu.

The Valid Destinations window appears and contains the current destinations with
the appropriate information such as Name and Type.  The "Opened" time reflects
the time the window was opened.  The "Remove", "Add" and "Save" buttons are
dimmed.  Editing is enabled.

4.2 Select destination modified in step 3.0 from the Destinations list and click the "Remove"
button.

The "Remove" button is activated upon selecting a destination.  The list of
destinations is updated.

4.3 Perform a database query of the destination information.

The destination was not removed from the database.

4.4 Click the "Save" button.

The destination is removed from the database.  The "Last update" information is
updated.

4.5 Perform a database query of the destination information.

The destination information now reflects the update.

4.6 Click the "Close" button.

The window closes and control returns to the Space Network window.

4.7 Re-access the Valid Destinations window.

The Valid Destinations window appears and does not contain the removed
destination.  The "Last update" information is the same as in step 4.4.

4.8 Click the "Close" button.

The window closes and control returns to the Space Network window.
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1.5.2.28 Detailed Test Procedure for Test Item INCC108-B1.28
VALID DESTINATIONS WINDOW - INVALID DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN data base entries and properly informs the operator of invalid
destination entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.
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1.5.2.29 Detailed Test Procedure for Test Item INCC108-B1.29
TRANSMISSION CONTROL PARAMETERS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator is able to modify transmission control parameters.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 MODIFYING TRANSMISSION CONTROL PARAMETERS

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select the “Transmission Control Parameters...” option from
the “Edit” menu.

The Transmission Control Parameters window appears and displays the
parameters that control transmissions to the Ground Terminals.  The time the
window was opened is displayed.  The “Save” button is dimmed indicating that
editing is disabled.

2.2 Click the “Enable Editing” toggle button.

Editing is enabled.  All buttons are no longer dimmed and are functional.

2.3 Enter the Maximum Number of SHOs per Transmission and the Delay Between SHO
Segment Transmissions and click the “Close” button.

The window closes and control returns to the Space Network Summary window.

2.4 Re-access the Transmission Control Parameters window.

The changes made above were not saved.  Editing is disabled.

2.5 Enable editing, enter the Maximum Number of SHOs per Transmission and the Delay
Between SHO Segment Transmissions.

The transmission control parameter entries were accepted.  The “Last update”
information is not updated.

2.6 Perform a data base query of the Space Network information.

The transmission control parameters have not been updated.
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2.7 Click the “Save” button.

The transmission control parameter modifications are saved.  The “Last update”
information is updated.

2.8 Perform a data base query of the Space Network information.

The transmission control parameters have now been updated.

2.9 Click the “Enable Editing” toggle button and attempt to modify transmission control
parameters.

Editing is disabled.  The buttons are not available for this window and it is not
possible to enter/select values.  The “Last update” information is not updated.

2.10 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

2.11 Re-access the Transmission Control Parameters window.

The Transmission Control Parameters window appears and displays the modified
transmission control parameters.  Editing is disabled.

2.12 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.



2/12/97  6:03 PM INCC108-63 530-ITP-NCCDS/1998

1.5.2.30 Detailed Test Procedure for Test Item INCC108-B1.30
TRANSMISSION CONTROL PARAMETERS WINDOW - INVALID DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates SN data base entries and properly informs the operator of invalid
transmission control parameter entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID TRANSMISSION CONTROL PARAMETERS

2.1 Select “Space Network” from the Database subpanel on the Main Panel.  From the Space
Network Summary window, select the “Transmission Control Parameters...” option from
the “Edit” menu.

The Transmission Control Parameters window appears and displays the
parameters that control transmissions to the Ground Terminals.  The time the
window was opened is displayed.  The “Save” button is dimmed indicating that
editing is disabled.

2.2 Click the “Enable Editing” toggle button.

Editing is enabled.  All buttons are no longer dimmed and are functional.

2.3 Enter an invalid value for the Maximum Number of SHOs per Transmission and the
Delay Between SHO Segment Transmissions and click the “Save” button.

The operator is appropriately notified that the entry is invalid.  The invalid entry is
not accepted.  The “Last update” information is not updated.

2.4 Perform a data base query of the Space Network information.

The transmission control parameters have not been updated.

2.5 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.

2.6 Re-access the Transmission Control Parameters window.

The Transmission Control Parameters window appears and does not display the
invalid transmission control parameter values.  Editing is disabled.
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2.7 Click the “Close” button.

The window closes and control returns to the Space Network Summary window.
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1.5.2.31 Detailed Test Procedure for Test Item INCC108-B1.31
SGLT RESOURCE AVAILABILITY SUMMARY WINDOW
CSCI 1605

Pass/Fail Criteria:

• Changes to the availability of SGLT resources are reflected on the SGLT Resource
Availability Summary window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 REVIEW GRAPHICAL SGLT RESOURCE AVAILABILITY

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears and displays an overview of the
major components of the Space Network.  The "Opened" time reflects the time the
window was opened.  The "Add...", "Modify....", and "Delete" buttons are
dimmed indicating that editing is disabled.

2.2 Select the “SGLT Resource Availability Summary...” option from the “View” menu.

The SGLT Resource Availability Summary window appears and correctly
displays a graphical representation of the availability and allocations of the SGLT
resources.  Data base changes to these resources are displayed.  The "Opened"
time reflects the time the window was opened.

2.3 Select “Close” from the “File” menu.

The window closes and control returns to the Space Network Summary window.
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1.5.2.32 Detailed Test Procedure for Test Item INCC108-B1.32
TDRS RESOURCE AVAILABILITY SUMMARY WINDOW
CSCI 1605

Pass/Fail Criteria:

• Changes to the availability of TDRS resources are reflected on the TDRS Resource
Availability Summary window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 REVIEW GRAPHICAL TDRS RESOURCE AVAILABILITY

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears and displays an overview of the
major components of the Space Network.  The "Opened" time reflects the time the
window was opened.  The "Add...", "Modify....", and "Delete" buttons are
dimmed indicating that editing is disabled.

2.2 Select the “TDRS Resource Availability Summary...” option from the “View” menu.

The TDRS Resource Availability Summary window appears and correctly
displays a graphical representation of the availability and allocations of the TDRS
resources.  Data base changes to these resources are displayed.  The "Opened"
time reflects the time the window was opened.

2.3 Select “Close” from the “File” menu.

The window closes and control returns to the Space Network Summary window.
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1.5.2.33 Detailed Test Procedure for Test Item INCC108-B1.33
REVIEW INCREMENTALLY ALLOCATED RESOURCE SUMMARY
WINDOW
CSCI 1605

Pass/Fail Criteria:

• Changes to incrementally allocated resources are reflected on the Incrementally
Allocated Resource Summary window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 REVIEW INCREMENTALLY ALLOCATED RESOURCES

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears and displays an overview of the
major components of the Space Network.  The "Opened" time reflects the time the
window was opened.  The "Add...", "Modify....", and "Delete" buttons are
dimmed indicating that editing is disabled.

2.2 Select the “Incrementally Allocated Resources...” option from the “View” menu.

The Incrementally Allocated Resources window appears and correctly displays a
graphical representation of the incrementally allocated resources as a function of
time.  Data base changes to these resources are displayed.  The "Opened" time
reflects the time the window was opened.

2.3 Select “Close” from the “File” menu.

The window closes and control returns to the Space Network Summary window.
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1.5.2.34 Detailed Test Procedure for Test Item INCC108-B1.34
SPACE NETWORK CONFIGURATION WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator is able to review the graphical representation of the current configuration
from the Space Network Configuration window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 REVIEW GRAPHICAL SPACE NETWORK CONFIGURATION

2.1 Select “Space Network” from the Database subpanel on the Main Panel.

The Space Network Summary window appears and displays an overview of the
major components of the Space Network.  The "Opened" time reflects the time the
window was opened.  The "Add...", "Modify....", and "Delete" buttons are
dimmed indicating that editing is disabled.

2.2 Select the “Space Network Configuration...” option from the “View” menu.

The Space Network Configuration window appears and displays a graphical
representation of the current configuration.  All information is accurate.  The
"Opened" time reflects the time the window was opened.

2.3 Select “Close” from the “File” menu.

The window closes and control returns to the Space Network Summary window.
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1.6 Test Case INCC109 - SPSR: Customer Data Base

1.6.1 Detailed Test Procedures for Test Case INCC109

1.6.1.1 Detailed Test Procedure for Test Item INCC109-B1.1
USER’S GUIDE - CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the SPSR User’s Guide.

The SPSR User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the Customer Data portion of the User Interface Subsystem normal procedures
section of the SPSR User’s Guide.

The instructions for performing the major functions of the Customer Data portion
of the User Interface Subsystem are included in the document.  Copies of all
applicable windows are included in the document.

3.0 ERROR CONDITIONS

3.1 Review the Customer Data portion of the User Interface Subsystem error recovery
procedures section of the SPSR User’s Guide.

The user’s guide includes adequate error recovery actions for the Customer Data
portion of the User Interface Subsystem.
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1.6.1.2 Detailed Test Procedure for Test Item INCC109-B1.2
OPERATOR INTERFACE - CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The applicable menu options and/or icons are operational.

• Pertinent windows can be iconified, enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the database, thus only apply to windows that require data entry.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numerical values in alphabetic fields, special characters,
blanks, etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the Customer Data portion of the User Interface
Subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Select “Customer” from the Database subpanel on the main panel.

The Customer Database window appears.

2.2 Select each menu option and icon available on the window.

The applicable menu options and/or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.

2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.
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2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with the Customer Data portion of the
User Interface Subsystem.  The applicable windows are:

Mission Priorities,
SIC Editor,
Nascom Parameters,
Schedule Distribution List,
Customer Information,
Level of Support,
Prototype Events,
Customer User Interface Channels,
Data Quality Monitoring Parameters,
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Valid Customer SUPIDENs and TDRSs,
Customer Services,
Schedulable Parameters, and
Service Parameter Records.

The windows meet the general and data entry window validation criteria.



2/6/97  6:31 PM INCC109-5 530-ITP-NCCDS/1998

1.6.1.3 Detailed Test Procedure for Test Item INCC109-B1.3
CUSTOMER DATABASE WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to delete a SIC from the database via the Customer
Database window.

• Deletes made from the Customer Database window delete all data associated with the
deleted SIC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Using SQL, add a SIC and related information to the database.

2.0 DELETE A SIC

2.1 Select “Customer” from the Database subpanel on the Main Panel.

The Customer Database window appears.  The “Opened” time reflects the time
the window was opened.  All but the “Close” button are dimmed, indicating that
editing is disabled.

2.2 Select the SIC added in step 1.3.

The “View...” button is now functional.

2.3 Click the “Enable Editing” toggle button.

All of the buttons are now functional.

2.4 Click the “Delete” button.

A dialog box appears asking you to confirm the deletion.

2.5 Click the “No” button to cancel the deletion.  Click the “Delete” button.

The dialog box closes and re-appears asking you again to confirm the deletion.

2.6 Perform a database query of the Customer information.

The SIC has not been deleted.
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2.7 Click the “Yes” button to confirm the deletion.

The selected SIC is removed from the list.  The “Last Update” information is
updated.

2.8 Perform a database query of the Customer information.

The SIC and associated information has been deleted.

2.9 Select “Close” from the “File” menu.

The window closes and control returns to the Main Panel.

2.10 Select “Customer” from the Database subpanel on the Main Panel.

The Customer Database window appears and does not contain the deleted SIC.
The “Last Update” information is the same as in step 2.7.

NOTE: The SIC Editor window test item will test the Open, Add, Copy, and Modify
capabilities.
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1.6.1.4 Detailed Test Procedure for Test Item INCC109-B1.4
SIC EDITOR WINDOW
CSCI 1605

Pass/Fail Criteria:

• General parameter information for a customer can be added, copied, or modified.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ADD A NEW CUSTOMER

2.1 Select “Customer” from the Database subpanel on the Main Panel.

The Customer database window appears.

2.2 Enable editing and click the “Add...” button.

The SIC Editor window appears.  The “Opened” time reflects the time the
window was opened.  All buttons are functional.

2.3 Enter the necessary information and click the “Save” button.

The entry is accepted.  The “Last Update” information is not updated.

2.4 Without closing the SIC Editor window, perform a database query of the Customer
information.

The Customer information has not been updated.

2.5 Select “Save” from the “File” menu of the SIC Editor window.

The “Last Update” information is updated.

2.6 Perform a database query of the Customer information.

The new SIC is accurately reflected in the database.

2.7 Select “Close” from the “File” menu.

The window closes and control returns to the Customer Database window.

2.8 Select the customer created above and click the “View...” button.

The SIC Editor window appears and accurately reflects the new SIC info.  The
“Last Update” information is the same as in step 2.5.

2.9 Disable editing.
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All buttons are now dimmed.

2.10 Click the “Close” button.

The window closes and control returns to the Customer Database window.

3.0 COPY EXISTING TO NEW CUSTOMER

3.1 From the Customer Database window, select a SIC and click the “Copy...” button.

The SIC Editor window appears and contains all information for the selected
customer.  All fields contain the same data as the SIC being copied from except
for the Support ID Code (SIC) field.

3.2 Enter the Support ID Code (SIC), Support Name, VIC, VID, Customer Class, and Type
of User of the SIC being copied to.  Modify some of the remaining existing values as
desired.

The entries are accepted.  The “Last Update” information is not updated.

3.3 Perform a database query of the Customer information.

The Customer information has not been updated.

3.4 Disable editing.

All buttons are now dimmed.  A dialog box appears asking if changes should be
saved.

3.5 Click the “Yes” button.

The “Last Update” information is updated.  Editing is disabled.

3.6 Perform a database query of the Customer information.

The update is reflected in the data base.

3.7 Click the “Close” button.

The window closes and control returns to the Customer Database window.

3.8 Select the SIC that was just created and click the “View...” button.

The SIC Editor window appears and contains the information for the created
customer. The “Last Update” information is the same as in step 3.4.

3.9 Access some of the child-windows from the “Edit” menu.

The child-windows appear and indicate that when the SIC was copied, all
parameters (such as Nascom) defined for the SIC are also copied.
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3.10 Select “Close” from the “File” menu.

The window closes and control returns to the Customer Database window.

4.0 MODIFY AN EXISTING CUSTOMER

4.1 From the Customer Database window, enable editing, select a SIC, and click the
“Modify...” button.

The SIC Editor window appears and contains the information for the selected
customer.

4.2 Enter the VIC and VID.  Change the Customer Class from Baseline to Full Support (or
vice versa) and the Type of User from Shuttle to Normal (or vice versa).  Enable and
disable valid services and modify the Minimum Gap Between Events.

The entries are accepted.  The “Last Update” information is not updated.

4.3 Perform a database query of the Customer information.

The customer information has not been updated.

4.4 Select “Save” from the “File” menu.

The information for the selected SIC is modified.  The “Last Update” information
is updated.

4.5 Perform a database query of the Customer information.

The Customer information now reflects the update.

4.6 Select “Close” from the “File” menu.

The window closes and control returns to the Customer Database window.

4.7 Select the SIC that was just modified and click the “View...” button.

The SIC Editor window appears and contains the modified information for the
selected customer.  The “Opened” time reflects the time the window was opened.
The “Last Update” information is the same as in step 4.4.

4.8 Click the “Close” button.

The window closes and control returns to the Customer Database window.

5.0 CLEANUP

5.1 Re-access the applicable windows and delete the two SIC added and any related
information.
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1.6.1.5 Detailed Test Procedure for Test Item INCC109-B1.5
SIC EDITOR WINDOW - INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
invalid SIC general parameter information.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID GENERAL PARAMETERS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select a SIC and click the “Modify...” button.

The SIC Editor window appears and contains the information for the selected
customer.  The “Opened” time reflects the time the window was opened.

2.2 Attempt to enter a Min TSW Duration that is greater than the Max TSW Duration and
select “Save” from the “File” menu.

The operator is appropriately notified that the entry is invalid.  The “Last Update”
information is not updated.

2.3 Perform a database query of the Customer information.

The Min TSW Duration has not been updated.

2.4 Select “Close” from the “File” menu.

The window closes and control returns to the Customer Database window.

2.5 Select the SIC for which invalid data was just entered and click the “View...” button.

The SIC Editor window appears and indicates that the invalid entry was not
accepted and the invalid data is not displayed.  The “Opened” time reflects the
time the window was opened.

2.6 Click the “Close” button.

The window closes and control returns to the Customer Database window.
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2.7 Click the “Add...” button. Attempt to add an already existing SIC.

A dialog box warns the operator that the SIC already exists.

2.8 Click the “Close” button.

The window closes and control returns to the Customer Database window. It does
not reflect the SIC the operator attempted to add.

2.9 Click the “Copy...” button. Attempt to copy to an already existing SIC.

A dialog box warns the operator that the SIC already exists.

2.8 Click the “Close” button.

The window closes and control returns to the Customer Database window. It does
not reflect the SIC the operator attempted to add.
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1.6.1.6 Detailed Test Procedure for Test Item INCC109-B1.6
SCHEDULE DISTRIBUTION LIST WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to modify a schedule distribution list for fixed User
Schedule Messages (USMs) by specifying valid destinations.

• The operator has the capability to select the destination to be the customer’s primary
logical destination for fixed User Schedule Messages (USMs).

• The operator has the capability to select the destinations to receive flexible User
Schedule Messages (USMs) from the Fixed USM Destinations list.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 MODIFY FIXED USM DESTINATIONS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select a SIC, and click the “View...” button.  From the SIC Editor
window, select the “Schedule Distribution List...” option from the “Edit” menu.

The Schedule Distribution List window appears and contains the list of all Valid
Destinations for the selected SIC, the Fixed USM Destinations, and the Flexible
state of those destinations.  The “Opened” time reflects the time the window was
opened.

2.2 Select an entry from the Valid Destinations list and click the “Add” button.

The user is warned that the operation is not executable.  All buttons are dimmed.

2.3 Enable editing.

The “Add” button is now functional.

2.4 Click the “Add” button.

The valid destination is added to the Fixed USM Destinations list.

2.5 Repeat step 2.4 for a different valid destination.

The valid destination is added to the Fixed USM Destinations list.
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2.6 Select the fixed USM destination added in step 2.2 from the Fixed USM Destinations
panel.

The “Remove”, “Make Primary”, and “Toggle Flexible” buttons are now
functional.

2.7 Click the “Remove” button.

The destination is removed from the Fixed USM Destinations list.  The “Last
Update” information is not updated.

2.8 Select the fixed USM destination added in step 2.4 and click the “Remove” button.

The destination is removed from the Fixed USM Destinations list.  The “Last
Update” information is not updated.

2.9 Perform a database query of the schedule distribution list information.

The Fixed USM Destinations panel has not been updated.

2.10 Click the “Save” button.

The “Last Update” information is updated.

2.11 Perform a database query of the schedule distribution list information.

The Fixed USM Destinations now reflect the update.

2.12 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.13 Re-access the Schedule Distribution List window.

The Schedule Distribution List window appears and contains the modified Fixed
USM Destinations panel for the selected SIC.  The destinations added and then
removed above do not appear in the Fixed USM Destinations list.  The “Opened”
time reflects the time the window was opened.  The “Last Update” information is
the same as in step 2.10.

2.14 Make a modification and click the “Close” button.  Re-access the Schedule Distribution
List window.

The updates were not saved.

2.15 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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3.0 DEFINE PRIMARY LOGICAL DESTINATION

3.1 From the SIC Editor window, re-access the Schedule Distribution List window. Disable
editing.

The Schedule Distribution List window appears and contains the list of all Valid
Destinations for the selected SIC, the Fixed USM Destinations, and the Flexible
state of those destinations.  The “Opened” time reflects the time the window was
opened.

3.2 Select a destination from the Fixed USM Destinations list and click the “Make Primary”
button.

The user is warned that the operator is not executable.  All buttons are dimmed.

3.3 Enable editing.

The “Remove”, “Make Primary”, and “Toggle Flexible” buttons are now
functional.

3.4 Click the “Make Primary” button.

The Primary Destination label under the button updates with the destination name
of the primary logical destination.  The “Last Update” information is not updated.

3.5 Perform a database query of the schedule distribution list information.

The fixed USM destination has not been updated.

3.6 Click the “Save” button.

The “Last Update” information is updated.

3.7 Perform a database query of schedule distribution list information.

The fixed USM destination now reflects the update.

3.8 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

3.9 Re-access the Schedule Distribution List window.

The Schedule Distribution List window appears and contains the updated Primary
Destination.  The “Opened” time reflects the time the window was opened.  The
“Last Update” information is the same as in step 3.6.

3.10 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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4.0 MODIFY FLEXIBLE STATE OF FIXED USM DESTINATIONS

4.1 From the SIC Editor window, re-access the Schedule Distribution List window.

The Schedule Distribution List window appears and contains the list of all Valid
Destinations for the selected SIC, the Fixed USM Destinations, and the Flexible
state of those destinations.  The “Opened” time reflects the time the window was
opened.

4.2 Select a Destination from the Fixed USM Destinations list that is not currently set to
receive flexible USMs.  Click the “Toggle Flexible” button.

The flexible state of the selected destination will be changed from “No” to “Yes”
as indicated by a “Yes” in the Flexible column.

4.3 Select a Destination from the Fixed USM Destinations list that is currently set to receive
flexible USMs.  Click the “Toggle Flexible” button.

The flexible state of the selected destination will be changed from “Yes” to “No”
as indicated by a “No” in the Flexible column.  The “Last Update” information is not
updated.

4.4 Perform a database query of the schedule distribution list information.

The flexible USM destinations have not been updated.

4.5 Disable editing.

A dialog box will ask if the changes should be saved.

4.6 Click the “Yes” button.

The “Last Update” information is updated.

4.7 Perform a database query of schedule distribution list information.

The flexible USM destinations now reflect the update.

4.8 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

4.9 Re-access the Schedule Distribution List window.

The Schedule Distribution List window appears and contains the updated
flexibility states of the Fixed USM Destinations.  The “Opened” time reflects the
time the window was opened.  The “Last Update” information is the same as in
step 4.6.

4.9 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

5.0 CLEANUP
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5.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.
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1.6.1.7 Detailed Test Procedure for Test Item INCC109-B1.7
SCHEDULE DISTRIBUTION LIST WINDOW - INVALID CUSTOMER
DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
invalid customer schedule distribution list entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID CUSTOMER SCHEDULE DISTRIBUTION LIST

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select a SIC and click the “View...” button.  From the SIC Editor
window, select the “Schedule Distribution List...” option from the “Edit” menu.

The Schedule Distribution List window appears and contains the list of all Valid
Destinations for the selected SIC, the Fixed USM Destinations, and the Flexible
state of those destinations.  The “Opened” time reflects the time the window was
opened.

2.2 Enable editing, select the destination to be added from the Valid Destinations list, and
click the “Add” button.

The valid destination is added to the Fixed USM Destinations list.

2.3 Attempt to add the same destination a second time and click the “Add” button.  Click the
“Save” button.

The operator is appropriately notified that the entry is invalid.  The “Last Update”
information is not updated.

2.4 Perform a database query of the schedule distribution list information.

The schedule distribution list information has not been updated.

2.5 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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2.6 Re-access the Schedule Distribution List window.

The Schedule Distribution List window appears and indicates that the destination
appears in the Fixed USM Valid Destinations list only once.  The “Opened” time
reflects the time the window was opened.

2.7 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.8 Detailed Test Procedure for Test Item INCC109-B1.8
NASCOM PARAMETERS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to modify the Nascom parameters for a customer.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 MODIFY NASCOM PARAMETERS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “Nascom Parameters...” option from the “Edit” menu.

The Nascom Parameters window appears and contains the Nascom parameters for
the selected SIC.  The “Opened” time reflects the time the window was opened.

2.2 Select a Service Type/Channel Type combination.

All the buttons are now functional.

2.3 Click some of the toggle buttons for the associated Nascom parameters.

The Nascom parameter settings are displayed for the selected combination and the
changes are accepted.  Note the changes.  The “Last Update” information is not
updated.

2.4 Perform a database query of the Nascom parameter information.

The Nascom parameter information has not been updated.

2.5 Click the “Save” button.

The “Last Update” information is updated.

2.6 Perform a database query of the Nascom parameter information.

The Nascom parameter information now reflects the update.

2.9 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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2.10 Re-access the Nascom Parameters window.

The Nascom Parameters window appears and indicates that the Service
Type/Channel Type that was modified contains the updated Nascom parameters.
The “Opened” time reflects the time the window was opened.  The “Last Update”
information is the same as in step 2.5.

2.9 Make a modification and disable editing.

A dialog box asks the operator if the changes should be saved.

2.10 Click the “No” button. Click the “Close” button.  Re-access the Nascom Parameters
window.

The updates are not saved.

2.11 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

3.0 CLEANUP

3.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.
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1.6.1.9 Detailed Test Procedure for Test Item INCC109-B1.9
NASCOM PARAMETERS WINDOW - INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
invalid Nascom parameter entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID NASCOM PARAMETERS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “Nascom Parameters...” option from the “Edit” menu.

The Nascom Parameters window appears and contains the Nascom parameters for
the selected SIC.  The “Opened” time reflects the time the window was opened.

2.2 Attempt to specify invalid Nascom parameter data for the given Service Type/Channel
Type combination (such as a Nascom parameter that can only be toggled on for a forward
service) and click the “Save” button.

The operator is appropriately notified that the selected Nascom parameter is
invalid for the given Service Type.  The “Last Update” information is not
updated.

2.3 Perform a database query of Nascom parameter information.

The Nascom parameter information has not been updated.

2.4 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.5 Re-access the Nascom Parameters window.

The Nascom Parameters window appears and indicates that the invalid entry was
not accepted.  The “Opened” time reflects the time the window was opened.

2.6 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.10 Detailed Test Procedure for Test Item INCC109-B1.10
CUSTOMER INFORMATION WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add, modify, and remove customer information for a
particular SIC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ADD/MODIFY/REMOVE CUSTOMER PERSONNEL

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC and click the “Modify...” button.  From the
SIC Editor window, select the “Customer Information...” option from the “Edit” menu.

The Customer Information window appears and contains customer contact
information such as Customer Personnel, User IDs, and Passwords for the
selected SIC.  The “Opened” time reflects the time the window was opened.
Editing is enabled.

2.3 Click the “Enable Editing” toggle button.

All buttons except “Close” are dimmed.  Editing is disabled.

2.4 Enter the Name, Work Phone, and Home Phone of the Customer Personnel to be added.
Enter comments in the Text Notes list.  Click the “Add” button next to the Customer
Personnel list.

The user is warned that editing is not enabled and the operation is not executable.
All buttons are dimmed.  The “Last Update” information is not updated.

2.5 Enable editing and click the “Add” button.

The “Add”, “Modify”, and “Remove” buttons in the upper portion of the window
are now functional, editing is enabled, and the information is added to the
Customer Personnel list.
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2.6 Select the Name added in step 2.5, modify the Work Phone and Home Phone, and click
the “Modify” button next to the Customer Personnel list.

The Name, Work Phone, and Home Phone of the selected Customer Personnel is
displayed and the modifications are accepted.

2.7 Select the same Name and click the “Remove” button under the Customer Personnel list.

The Name is removed from the Customer Personnel list.  The “Last Update”
information is not updated.

2.8 Perform a database query of the Customer information.

The customer personnel information has not been updated.

2.9 Click the “Save” button.

The “Last Update” information is updated.

2.10 Perform a database query of the Customer information.

The customer personnel information now reflects the update.

2.11 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.12 Re-access the Customer Information window.

The Customer Information window appears and indicates the Name that was
added, modified, and removed does not appear in the Customer Personnel list.
The “Opened” time reflects the time the window was opened.  The “Last Update”
information is the same as in step 2.9.

3.0 ADD/MODIFY/REMOVE USER IDs AND PASSWORDS

3.1 From the Customer Information window, enter the User ID and Password of the user to
be added.  Click the “Add” button next to the User IDs and Passwords lists.

The User ID is added to the User ID list.  The Password is added to the Passwords
list.

3.2 Select the User ID added above, enter a second Password and click the “Add” button.

The second Password is added to the Passwords list.

3.3 Select the User ID and Password added in step 3.1, modify the Password, and click the
“Modify” button next to the User IDs and Passwords lists.

The selected User ID and Password are displayed in the data entry fields and the
modified Password appears in the Passwords list.
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3.4 Select the Password added in step 3.1 and click the “Remove” button under the
Passwords list.

The Password is removed from the Passwords list.  The “Last Update”
information is not updated.

3.5 Select the User ID added in step 3.1 and click the “Remove” button under the User IDs
list.

The User ID is removed from the User IDs list.  The second Password added in
step 3.2 is also removed when its User ID is removed.

3.6 Perform a database query of the Customer information.

The User ID/Password information has not been updated.

3.7 Click the “Save” button.

The “Last Update” information is updated

3.8 Perform a database query of the Customer information.

The User ID/Password information now reflects the update.

3.9 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

3.10 Re-access the Customer Information window.

The Customer Information window appears and indicates the User ID that was
added, modified, and removed does not appear in the User IDs list.  The
Passwords associated with the removed User ID also does not appear.  The “Last
Update” information is the same as in step 3.7.

3.11 Make a modification and click the “Close” button.  Re-access the Customer Information
window.

The updates are not saved.

3.12 Select a User ID from the User IDs list, make modifications, and disable editing.

A dialog box asks the operator if changes are to be saved.

3.13 Click the “No” button followed by the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.11 Detailed Test Procedure for Test Item INCC109-B1.11
CUSTOMER INFORMATION WINDOW - INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
invalid customer information entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID CUSTOMER INFORMATION

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC and click the “Modify...” button.  From the
SIC Editor window, select the “Customer Information...” option from the “Edit” menu.

The Customer Information window appears and contains customer contact
information such as Customer Personnel, User IDs, and Passwords for the
selected SIC.  The “Opened” time reflects the time the window was opened.
Editing is enabled.

2.2 Enter a valid User ID and click the “Add” button next to the User IDs and Passwords
lists.  Click the “Save” button.

The operator is appropriately notified that it is invalid to have a User ID without
an associated Password.  The “Last Update” information is not updated.

2.3 Perform a database query of the Customer information.

The User ID/Password information has not been updated.

2.4 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.5 Re-access the Customer Information window.

The Customer Information window appears and does not contain the User ID that
was not added due to a missing Password.

2.6 Attempt to change a User ID (i.e., from JSC to JSx).

The operator is alerted that this is not a valid modification.
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2.7 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.12 Detailed Test Procedure for Test Item INCC109-B1.12
VALID CUSTOMER SUPIDENs AND TDRSs WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add a valid SUPIDEN to the database for the selected
SIC via the Valid Customer SUPIDENs and TDRSs window.

• The operator has the capability to add a valid TDRS to the database for the selected
SUPIDEN via the Valid Customer SUPIDENs and TDRSs window.

• The operator has the capability to remove a valid SUPIDEN or TDRS from the database
for the selected SIC/SUPIDEN via the Valid Customer SUPIDENs and TDRSs
window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ADD/REMOVE VALID SUPIDEN

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC and click the “Modify...” button.  From the
SIC Editor window, select the “Valid SUPIDENs and TDRSs...” option from the “Edit”
menu.

The Valid Customer SUPIDENs and TDRSs window appears and contains the
Valid SUPIDENs for the selected SIC and the Valid TDRSs for the selected
SUPIDEN.  The “Opened” time reflects the time the window was opened.

2.2 Enter the name of a new SUPIDEN in the New SUPIDEN field.  Click the “Add” button.

The New SUPIDEN is added to the list of Valid SUPIDENs for the selected SIC.

2.3 Select the Valid SUPIDEN added in step 2.3.

The “Remove” button is now functional.

2.4 Click the “Remove” button.

The Valid TDRSs list displays the TDRSs valid for the selected SUPIDEN.  The
selected SUPIDEN is removed from the list of Valid SUPIDENs for the selected
SIC.  The “Last Update” information is not updated.
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2.5 Perform a database query of the SUPIDEN information.

The Valid SUPIDEN list has not been updated.

2.6 Click the “Save” button.

The “Last Update” information is updated.

2.7 Perform a database query of the SUPIDEN information.

The Valid SUPIDEN list now reflects the update, but is unchanged since the
SUPIDEN that was added was immediately removed.

2.8 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.9 Re-access the Valid Customer SUPIDENs and TDRSs window.

The Valid Customer SUPIDENs and TDRSs window appears and contains the
updated list of Valid SUPIDENs for the selected SIC.  The Valid SUPIDEN
added and then removed does not appear.  The “Opened” time reflects the time the
window was opened.  The “Last Update” information is the same as in step 2.5.

2.10 Enter a new SUPIDEN, click the “Add” button, and disable editing.

The new SUPIDEN is added to the Valid SUPIDENs panel. A dialog box asks the
operator if changes should be saved.

2.11 Click the “No” button.

2.12 Enter a New SUPIDEN and click the “Add” button.

The operator is warned that the operation cannot be completed since editing is
disabled.

2.13 Select an entry from the Valid SUPIDENs panel, and click the “Remove” button.

The operator is warned that the operation cannot be completed since editing is
disabled.

2.14 Enable editing, enter a new SUPIDEN, click the “Add” button, and disable editing.

The new SUPIDEN is added to the Valid SUPIDENs panel. A dialog box asks the
operator if changes should be saved.

3.0 ADD/REMOVE VALID TDRS

3.1 From the Valid Customer SUPIDENs and TDRSs window, select a SUPIDEN from the
list of Valid SUPIDENs for the selected SIC.

The Valid TDRSs for the selected SUPIDEN are displayed.



2/6/97  6:31 PM INCC109-29 530-ITP-NCCDS/1998

3.2 Select a TDRS from the TDRS Operational Name list.

The “Add” button is now functional.

3.3 Click the “Add” button next to the Valid TDRSs list.

The selected TDRS is added to the list of Valid TDRSs for the selected
SUPIDEN.

3.4 Select the same SUPIDEN from the list of Valid SUPIDENs for the selected SIC.

The Valid TDRSs for the selected SUPIDEN are displayed.

3.5 Select the Valid TDRS added in step 3.3

The “Remove” button is now functional.

3.6 Click the “Remove” button next to the Valid TDRSs list.

The selected TDRS is removed from the list of Valid TDRSs for the selected
SUPIDEN.  The “Last Update” information is not updated.

3.7 Perform a database query of the TDRS information.

The Valid TDRS list has not been updated.

3.8 Click the “Save” button.

The valid TDRS updates are saved to the database.  The “Last Update”
information is updated.

3.9 Perform a database query of TDRS information.

The Valid TDRS list now reflects the update, but is unchanged since the TDRS
that was added was immediately removed.

3.10 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

3.11 Re-access the Valid Customer SUPIDENs and TDRSs window.

The Valid Customer SUPIDENs and TDRSs window appears and contains the
updated list of Valid TDRSs for the selected SUPIDEN.  The Valid TDRS added
and then removed does not appear.  The “Opened” time reflects the time the
window was opened.  The “Last Update” information is the same as in step 3.8.

3.12 Disable editing, select an entry from the TDRS Operational Name panel, and click the
“Add” button.

The operator is warned that the operation cannot be completed since editing is
disabled.
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3.13 Select an entry from the Valid TDRS panel, and click the “Remove” button.

The operator is warned that the operation cannot be completed since editing is
disabled.

3.14 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.13 Detailed Test Procedure for Test Item INCC109-B1.13
VALID CUSTOMER SUPIDENs AND TDRSs WINDOW -
INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
duplicate SUPIDENs for the same SIC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 DUPLICATE SUPIDEN FOR SELECTED SIC

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “Valid SUPIDENs and TDRSs...” option from the
“Edit” menu.

The Valid Customer SUPIDENs and TDRSs window appears and contains the
Valid SUPIDENs for the selected SIC and the Valid TDRSs for the selected
SUPIDEN.  The “Opened” time reflects the time the window was opened.

2.2 Enter the name of a new SUPIDEN in the New SUPIDEN field and click the “Add”
button.

The New SUPIDEN is added to the list of Valid SUPIDENs for the selected SIC.

2.3 Enter the name of the same SUPIDEN added above in the New SUPIDEN field and
attempt to add it to the Valid SUPIDENs list a second time.  Click the “Add” button
followed by the “Save” button.

The operator is appropriately notified of the attempt to add a duplicate SUPIDEN
for the selected SIC.  The “Last Update” information is not updated.

2.4 Perform a database query of the SUPIDEN information.

The Valid SUPIDEN list has not been updated.

2.5 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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2.6 Re-access the Valid Customer SUPIDENs and TDRSs window.

The Valid Customer SUPIDENs and TDRSs window appears and contains the
updated list of Valid SUPIDENs for the selected SIC.  The New SUPIDEN
appears only once in the Valid SUPIDENs list for the selected SIC.  The
“Opened” time reflects the time the window was opened.

2.7 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.14 Detailed Test Procedure for Test Item INCC109-B1.14
DATA QUALITY MONITORING PARAMETERS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add, modify, and remove DQM parameter records
from the database for the selected SIC via the Data Quality Monitoring Parameters
window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ADD DQM PARAMETER RECORD

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select a SIC, and click the “View...” button.  From the SIC Editor
window, select the “Data Quality Monitoring...” option from the “Edit” menu.

The Data Quality Monitoring Parameters window appears and contains the DQM
parameters for the selected SIC.  The “Opened” time reflects the time the window
was opened.

2.2 Select an entry from the Data Stream ID panel and click both “Remove” buttons.

The user is warned that the operation is not executable.

2.3 Enter a Data Stream ID and Data Rate, and click the “Add” button.

The user is warned that the operation is not executable.  All buttons are dimmed.

2.4 Enable editing.

The “Add” and “Remove” button is now functional.

2.5 Click the “Add” button.

The new values are added to the Data Stream ID and Data Rate list to the left.
The Frame Length, Frame Sync Word Length, Sync Strategy, and Frame Sync Bit
Pattern fields are empty.

2.6 Enter the Frame Length, Frame Sync Word Length, Sync Strategy, and Frame Sync Bit
Pattern.

The entries are accepted.  The “Last Update” information is not updated.



2/6/97  6:31 PM INCC109-34 530-ITP-NCCDS/1998

2.7 Perform a database query of the DQM information.

The DQM information has not been updated.

2.8 Click the “Save” button.

The “Last Update” information is updated.

2.9 Perform a database query of the DQM information.

The DQM information now reflects the update.

2.10 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.11 Re-access the Data Quality Monitoring Parameters window.

The Data Quality Monitoring Parameters window appears and contains the
updated DQM parameter records for the selected SIC.  The “Opened” time
reflects the time the window was opened.  The “Last Update” information is the
same as in step 2.7.

2.12 Select the above Data Stream ID/Data Rate combination from the list.

The DQM parameters for the selected Data Stream ID and Data Rate combination
are displayed and contain the new values.

3.0 MODIFY DQM PARAMETERS

3.1 From the Data Quality Monitoring Parameters window, modify the Frame Length, Frame
Sync Word Length, Sync Strategy, and Frame Sync Bit Pattern of the selected
combination.

The entries are accepted.  The “Last Update” information is not updated.

3.2 Perform a database query of the DQM information.

The DQM information has not been updated.

3.3 Disable editing.

A dialog box asks the operator if the changes should be save.

3.4 Click the “Yes” buttons.

The DQM updates are saved to the database.  The “Last Update” information is
updated.

3.5 Perform a database query of the DQM information.

The DQM information now reflects the update.
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3.6 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

3.7 Re-access the Data Quality Monitoring Parameters window. Enable editing.

The Data Quality Monitoring Parameters window appears and contains the
updated DQM parameters for the selected SIC.  The “Opened” time reflects the
time the window was opened.  The “Last Update” information is the same as in
step 3.5.

3.8 Select the above Data Stream ID/Data Rate combination from the list.

The DQM parameters for the selected Data Stream ID and Data Rate combination
are displayed and contain the updated values.

4.0 REMOVE DQM PARAMETERS

4.1 From the Data Quality Monitoring Parameters window, select from the list the same Data
Stream ID/Data Rate combination added in step 2.3 and modified above.

The DQM parameters for the selected Data Stream ID and Data Rate combination
are displayed.

4.2 Click the “Remove” button.

The DQM parameters associated with the selected Data Stream ID and Data Rate
are removed.  The “Last Update” information is not updated.

4.3 Perform a database query of the DQM information.

The DQM information has not been updated.

4.4 Click the “Save” button.

The DQM updates are saved to the database.  The “Last Update” information is
updated.

4.5 Perform a database query of the DQM information.

The DQM information now reflects the update.

4.6 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

4.7 Re-access the Data Quality Monitoring Parameters window.

The Data Quality Monitoring Parameters window appears and indicates that the
Data Stream ID/Data Rate combination removed above does not appear in the list.
The “Opened” time reflects the time the window was opened.  The “Last Update”
information is the same as in step 4.4.
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4.8 Make a modification and click the “Close” button.  Re-access the Data Quality
Monitoring Parameters window.

The updates are not saved.

4.9 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.15 Detailed Test Procedure for Test Item INCC109-B1.15
DATA QUALITY MONITORING PARAMETERS WINDOW -
INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
invalid DQM parameter entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID DQM PARAMETER VALUES

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select a SIC and click the “Modify” button.  From the SIC Editor
window, select the “Data Quality Monitoring...” option from the “Edit” menu.

The Data Quality Monitoring Parameters window appears and contains the DQM
parameters for the selected SIC.  The “Opened” time reflects the time the window
was opened.

2.2 Attempt to enter a Data Stream ID of “040” and click the “Add” button.  Click the “Save”
button.

The operator is appropriately notified that the entry is invalid.  The “Last Update”
information is not updated.

2.3 Perform a database query of the DQM information.

The Data Stream ID has not been updated.

2.4 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.5 Re-access the Data Quality Monitoring Parameters window.

The Data Quality Monitoring Parameters window appears and indicates that the
invalid Data Stream ID was not accepted.  The “Opened” time reflects the time
the window was opened.
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2.6 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.16 Detailed Test Procedure for Test Item INCC109-B1.16
CUSTOMER USER INTERFACE CHANNELS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to modify the list of valid user interface channels for the
selected SIC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 SELECT CUSTOMER USER INTERFACE CHANNELS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable edit, select a SIC, and click the “Modify...” button.  From the
SIC Editor window, select the “User Interface Channels...” option from the “Edit” menu.

The Customer User Interface Channels window appears and contains the
authorized user interface channels for the selected SIC.  The “Opened” time
reflects the time the window was opened.

2.2 Select an Existing UIFC to be added to the Valid UIFCs list for the selected SIC, and
click the “Add” button.

The selected UIFC is added to the list of valid user interface channels for the
selected SIC.

2.3 Select the Valid UIFC added in step 2.2 and click the “Remove” button.

The selected UIFC is removed from the list of valid user interface channels for the
selected SIC.  The “Last Update” information is not updated.

2.4 Perform a database query of the Customer information.

The Valid UIFCs list has not been updated.

2.5 Click the “Save” button.

The “Last Update” information is updated.

2.6 Perform a database query of the Customer information.

The Valid UIFCs list now reflects the update but is unchanged since the UIFC
that was added was immediately removed.
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2.7 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.8 Re-access the Customer User Interface Channels window.

The Customer User Interface Channels window appears and indicates that the
UIFC added and removed above does not appear in the updated list of authorized
user interface channels (Valid UIFCs).  The “Opened” time reflects the time the
window was opened.  The “Last Update” information is the same as in step 2.5.

2.9 Make a modification and click the “Close” button.  Re-access the Customer User
Interface Channels window.

The updates are not saved.

2.10 Repeat step 2.2

The selected UIFC is added to the list of valid user interface channels for the
selected SIC.

2.11 Disable editing.

The operator is asked if the changes should be saved.

2.11 Click the “No” and “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.17 Detailed Test Procedure for Test Item INCC109-B1.17
CUSTOMER USER INTERFACE CHANNELS WINDOW -
INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
the selection of duplicate user interface channels for the same SIC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 DUPLICATE CUSTOMER USER INTERFACE CHANNELS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “User Interface Channels...” option from the “Edit”
menu.

The Customer User Interface Channels window appears and contains the
authorized user interface channels for the selected SIC.  The “Opened” time
reflects the time the window was opened.

2.2 Select an Existing UIFC to be added to the Valid UIFCs list for the selected SIC and click
the “Add” button.

The selected UIFC is added to the list of valid user interface channels for the
selected SIC.

2.3 Select the same Existing UIFC added above and attempt to add it to the Valid UIFCs list
a second time and click the “Add” button.  Click the “Save” button.

The operator is appropriately notified of the attempt to add a duplicate user
interface channel for the selected SIC.  The “Last Update” information is not
updated.

2.4 Perform a database query of the Customer information.

The Valid UIFCs list has not been updated.

2.5 Click the “Close” button.

The window closes and control returns to the SIC Editor window.



2/6/97  6:31 PM INCC109-42 530-ITP-NCCDS/1998

2.6 Re-access the Customer User Interface Channels window.

The Customer User Interface Channels window appears and contains the updated
list of authorized user interface channels for the selected SIC.  The selected
Existing UIFC appears only once in the Valid UIFCs list for the selected SIC.
The “Opened” time reflects the time the window was opened.

2.7 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.18 Detailed Test Procedure for Test Item INCC109-B1.18
LEVEL OF SUPPORT WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to modify level of support information for Service
Type/Request Priority combinations for the selected SIC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 MODIFY LEVEL OF SUPPORT INFORMATION

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select a SIC, and click the “View...” button.  From the SIC Editor
window, select the “Level of Support...” option from the “Edit” menu.

The Level of Support window appears and contains the level of support
parameters for each Service Type and Request Priority level for the selected SIC.
The “Opened” time reflects the time the window was opened.

2.2 Select the Service Type and Request Priority.

The Level of Support parameters are displayed for the selected combination.

2.3 Attempt to enter the Nominal, Minimum, and Maximum Level of Support parameters.

The user is warned that the operation cannot be executed. All buttons are dimmed.

2.4 Enable editing.

All buttons are now functional.

2.5 Enter the Nominal, Minimum, and Maximum Level of Support parameters.

The entries are accepted.  The “Last Update” information is not updated.

2.6 Perform a database query of the level of support information.

The level of support information has not been updated.

2.7 Click the “Save” button.

The “Last Update” information is updated.
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2.8 Perform a database query of the level of support information.

The level of support information now reflects the update.

2.9 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.10 Re-access the Level of Support window.

The Level of Support window appears and contains the modified level of support
parameters for the Service Type and Request Priority combinations selected
above.  The “Opened” time reflects the time the window was opened.  The “Last
Update” information is the same as in step 2.7.

2.11 Make a modification and click the “Close” button.  Re-access the Level of Support
window.

The updates are not saved.

2.12 Select a Service Type and Request Priority, change some of the service parameters, and
disable editing.

The operator is asked if the changes should be saved.

2.13 Click the “No” and “Close” button.

The window closes and control returns to the SIC Editor window.

3.0 CLEANUP

3.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.
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1.6.1.19 Detailed Test Procedure for Test Item INCC109-B1.19
LEVEL OF SUPPORT WINDOW - INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
invalid level of support information entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID LEVEL OF SUPPORT INFORMATION

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “Level of Support...” option from the “Edit” menu.

The Level of Support window appears and contains the level of support
parameters for each Service Type and Request Priority for the selected SIC.  The
“Opened” time reflects the time the window was opened.

2.2 Select a Service Type and Request Priority and attempt to enter a Minimum value for the
Total Amount of Service Per Week that is greater than the Maximum value for the Total
Amount of Service Per Week.  Click the “Save” button to attempt to commit the invalid
values to the database.

The operator is appropriately notified that the entry is invalid.  The invalid entry is
not accepted.  The “Last Update” information is not updated.

2.3 Perform a database query of the level of support information.

The Minimum Total Amount of Service Per Week has not been updated.

2.4 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.5 Re-access the Level of Support window.

The Level of Support window appears and indicates that the invalid level of
support parameters for the selected Service Type and Request Priority
combination were not saved.  The “Opened” time reflects the time the window
was opened.
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2.6 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.20 Detailed Test Procedure for Test Item INCC109-B1.20
CUSTOMER SERVICES WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to delete an SSC and Service Type for the selected SIC.

• Deletes made from the Customer Services window delete all data associated with the
deleted SSC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Using SQL, add an SSC, Service Type, and related schedulable parameter information to
the database.

2.0 DELETE AN SSC AND SERVICE TYPE

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “Customer Services...” option from the “Edit” menu.

The Customer Services window appears and contains the SSCs, Service Types,
and Service Configuration for which schedulable parameter values can be
specified.  The “Opened” time reflects the time the window was opened.

2.2 Select the SSC added in step 1.3

All buttons are now functional.

2.3 Click the “Delete” button.

A dialog box appears to confirm the deletion.

2.4 Click the “No” button to cancel the deletion.  Click the “Delete” button.

The dialog box closes and re-appears asking you again to confirm the deletion.

2.5 Perform a database query of the SSC information.

The SSC has not been deleted.
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2.6 Click the “Yes” button to confirm the deletion.

The selected SSC is removed from the list.  The “Last Update” information is
updated.

2.7 Perform a database query of the SSC information.

The SSC has now been deleted.

2.8 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.9 Re-access the Customer Services window.

The Customer Services window appears and the SSC and Service Type list
indicates that the SSC has been deleted for the selected SIC.  The “Opened” time
reflects the time the window was opened.  The “Last Update” information is the
same as in step 2.6.

3.0 RELATED INFORMATION

3.1 Perform a database query of customer data related to the deleted SSC.

All information has been deleted.

3.2 From the Customer Services window, disable editing, enter the SSC deleted in step 2.5,
select the Service Type and Service Configuration associated with the SSC.

Only the “View...” button is now functional.

3.3 Click the “View...” button.

The Schedulable Parameters window appears and is empty indicating that the SSC
was deleted.  The “Opened” time reflects the time the window was opened.

3.4 Click the “Close” button on the Schedulable Parameters and Customer Services windows.

The windows close and control returns to the SIC Editor window.

NOTE: The Schedulable Parameters window test item will test the Open, Copy,
Modify, and Add capabilities.
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1.6.1.21 Detailed Test Procedure for Test Item INCC109-B1.21
CUSTOMER SERVICES WINDOW - INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
an invalid attempt to select a shuttle Service Configuration for an MA service.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ENTER INVALID SSC

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “Customer Services...” option from the “Edit” menu.

The Customer Services window appears and contains the SSCs, Service Types,
and Service Configuration for which schedulable parameter values can be
specified.  The “Opened” time reflects the time the window was opened.

2.2 Attempt to select a “Shuttle” Service Configuration for an MA Service Type for the
selected SIC and click the “Add” button.

A dialog box appears to notify the operator of the invalid entry.  Neither the
MAF/SMAF Schedulable Parameters window nor the MAR Schedulable
Parameters windows appear.  The “Last Update” information is not updated.

2.3 Perform a database query of the SSC information.

The SSC information has not been updated.

2.4 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.5 Re-access the Customer Services window.

The Customer Services window appears and indicates that the invalid entry was
not accepted because MA services do not support Shuttle.  The “Opened” time
reflects the time the window was opened.
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2.6 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.22 Detailed Test Procedure for Test Item INCC109-B1.22
SCHEDULABLE PARAMETERS WINDOWS
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add (SSAR/SMAR), copy (KuSAR/KaSAR), and
modify (Tracking) schedulable parameters.

• The operator has the capability to open fixed and respecifiable schedulable parameters
for a particular SSC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ADD/OPEN SSAR/SMAR NORMAL SCHEDULABLE PARAMETERS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC. and click the “Modify...” button.  From
the SIC Editor window, select the “Customer Services...” option from the “Edit” menu.

The Customer Services window appears and contains the SSCs, Service Types,
and Service Configuration for which schedulable parameter values can be
specified.  The “Opened” time reflects the time the window was opened.

2.2 Enter the SSC, select the Service Type (SSAR/SMAR) and Service Configuration
(Normal) for the selected SIC.

A new SSC is created.  All buttons are now available.

2.3 Click the “Add...” button.

 and the SSAR/SMAR Normal Schedulable Parameters window appears
containing the default parameters for the new SSC.

2.4 Disable editing, attempt to enter new parameters, and click the “Return Channels...”
button.

The user is warned that the operations cannot be executed. All buttons are
dimmed.
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2.5 Enable editing. Enter a new SSAR/SMAR fixed and respecifiable schedulable parameter
values, and click the “Return Channels...” button.

The values are accepted, the “Last Update” information is not updated, and the
Return Channel Schedulable Parameters window appears for the new SSC.  The
“Opened” time reflects the time the window was opened.

2.6 Enter new return channel schedulable parameter values.

The entries are accepted.  The “Last Update” information is not updated.

2.7 Perform a database query of return channel schedulable parameter information.

The return channel values have not been updated.

2.8 Disable editing.

A dialog box asks the operator if the changes should be saved.

2.9 Click the “Yes” button.

The return channel value updates are saved to the database.  The “Last Update”
information is updated.

2.10 Perform a database query of the schedulable parameter information.

The return channel values now reflect the update.

2.11 Click the “Close” button.

The window closes and control returns to the SSAR/SMAR Normal Schedulable
Parameters window.

2.12 Perform a database query of the schedulable parameter information.

The schedulable parameter information has not been updated.

2.13 Click the “Save” button.

The schedulable parameter updates are saved to the database.  The “Last Update”
information is updated.

2.14 Perform a database query of the schedulable parameter information.

The schedulable parameter information now reflects the update.

2.15 Click the “Close” button.

The window closes and control returns to the Customer Services window.

2.16 Click the “View...” button for the newly added SSC.

The SSAR/SMAR Normal Schedulable Parameters window appears and contains
the newly added schedulable parameter values.  The “Save” button is dimmed
since the window is view only when accessed via the “View...” button.  The
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“Opened” time reflects the time the window was opened.  The “Last Update”
information is the same as in step 2.13.

2.17 Click the “Return Channels” button.

The Return Channel Schedulable Parameters window appears and contains the
updated values.  The “Opened” time reflects the time the window was opened.
The “Last Update” information is the same as in step 2.9.

2.18 Click the “Close” button from the Return Channels Schedulable Parameters and
SSAR/SMAR Normal Schedulable Parameters windows.

The windows close and control returns to the Customer Services window.

3.0 COPY/OPEN KuSAR/KaSAR SHUTTLE SCHEDULABLE PARAMETERS

3.1 From the Customer Services window, select the SSC and Service Type (KuSAR/KaSAR)
to be copied from the list and click the “Copy...” button.

A new SSC is defined and the KSAR Shuttle Schedulable Parameters window
appears containing the parameters from the existing SSC.  The SSC field will be
editable so that a new SSC value can be specified.  The “Opened” time reflects the
time the window was opened.

3.2 Disable editing and attempt to modify the parameters.

The user is warned that the operation cannot be executed. All buttons are dimmed.

3.3 Enable editing.

All buttons are now functional.

3.4 Specify the new SSC name and modify the KuSAR/KaSAR fixed and respecifiable
schedulable parameter values.

The entries are accepted.  The “Last Update” information is not updated.

3.5 Perform a database query of the schedulable parameter information.

The schedulable parameter information has not been updated.

3.6 Disable editing.

A dialog box asks the operator is the changes should be saved.

3.7 Click the “Yes” button.

The modified parameter values are saved to the database.  The “Last Update”
information is updated.

3.8 Perform a database query of the schedulable parameter information.

The schedulable parameter information now reflects the update.
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3.9 Click the “Close” button.

The window closes and control returns to the Customer Services window.

3.10 Click the “View...” button for the copied SSC.

The KSAR Shuttle Schedulable Parameters window appears and contains the
modified schedulable parameter values for the newly copied SSC and Service
Type.  The “Save” button is dimmed since the window is view only when
accessed via the “View...” button.  The “Opened” time reflects the time the
window was opened.  The “Last Update” information is the same as in step 3.7.

3.11 Click the “Close” button.

The window closes and control returns to the Customer Services window.

4.0 MODIFY/OPEN TRACKING SCHEDULABLE PARAMETERS

4.1 From the Customer Services window, select the SSC and Service Type (Tracking) to be
modified from the list and click the “Modify...” button.

The Tracking Schedulable Parameters window appears containing the editable
parameters for the selected SSC.  The “Opened” time reflects the time the window
was opened.

4.2 Disable editing and attempt to modify the parameters.

The user is warned that the operation cannot be executed. All buttons are dimmed.

4.3 Enable editing.

All buttons are now functional.

4.4 Modify the Tracking fixed and respecifiable schedulable parameter values.

The entries are accepted.  The “Last Update” information is not updated.

4.5 Perform a database query of the schedulable parameter information.

The schedulable parameter information has not been updated.

4.6 Click the “Save” button.

The modified parameter values are saved to the database.  The “Last Update”
information is updated.

4.7 Perform a database query of the schedulable parameter information.

The schedulable parameter information now reflects the update.

4.8 Click the “Close” button.

The window closes and control returns to the Customer Services window.
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4.9 Click the “View...” button for the modified SSC.

The Tracking Schedulable Parameters window appears and contains the modified
schedulable parameters for the selected SSC and Service Type.  The “Save”
button is dimmed since the window is view only when accessed via the “View...”
button.  The “Opened” time reflects the time the window was opened.  The “Last
Update” information is the same as in step 4.6.

4.10 Click the “Close” button.

Control returns to the Customer Services window.

5.0 CLEANUP

5.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.
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1.6.1.23 Detailed Test Procedure for Test Item INCC109-B1.23
SCHEDULABLE PARAMETERS WINDOWS -
INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
invalid fixed and respecifiable MAF/SMAF, MAR, or Playback schedulable parameter
entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ENTER INVALID MAF/SMAF SCHEDULABLE PARAMETERS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “Customer Services...” option from the “Edit” menu.

The Customer Services window appears and contains the SSCs, Service Types,
and Service Configuration for which schedulable parameter values can be
specified.  The “Opened” time reflects the time the window was opened.

2.2 Select the SSC and Service Type (MAF/SMAF) to be modified from the list and click the
“Modify...” button.

The MAF/SMAF Schedulable Parameters window appears containing the editable
parameters for the selected SSC.  The “Opened” time reflects the time the window
was opened.

2.3 Attempt to respecify the Data Rate for the MAF/SMAF service to a value that is higher
than the fixed Maximum Data Rate.  Click the “Save” button.

The operator is appropriately notified of the entry of an invalid value.  The “Last
Update” information is not updated,

2.4 Perform a database query of the schedulable parameter information.

The Data Rate has not been updated.

2.5 Click the “Close” button.

The window closes and control returns to the Customer Services window.
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2.6 Click the “View...” button for the same SSC.

The MAF/SMAF Schedulable Parameters window appears and indicates that the
invalid Data Rate for the selected SSC was not saved.  The “Save” button is
dimmed since the window is view only when accessed via the “View...” button.
The “Opened” time reflects the time the window was opened.

2.7 Click the “Close” button.

Control returns to the Customer Services window.

3.0 ENTER INVALID MAR SCHEDULABLE PARAMETERS

3.1 From the Customer Services window, select the SSC and Service Type (MAR) to be
modified from the list and click the “Modify...” button.

The MAR Schedulable Parameters window appears containing the editable
parameters for the selected SSC.  The “Opened” time reflects the time the window
was opened.

3.2 Attempt to respecify Minimum and Maximum EIRP for the MAR service to a value that
is less than -999 or greater than +999.  Click the “Save” button.

The operator is appropriately notified of the entry of an invalid value.  The “Last
Update” information is not updated.

3.3 Perform a database query of the schedulable parameter information.

The Minimum and Maximum EIRP has not been updated.

3.4 Click the “Close” button.

The window closes and control returns to the Customer Services window.

3.5 Click the “View...” button for the same SSC.

The MAR Schedulable Parameters window appears and indicates that the invalid
Minimum and Maximum EIRP values for the selected SSC were not saved.  The
“Save” button is dimmed since the window is view only when accessed via the
“View...” button.  The “Opened” time reflects the time the window was opened.

3.6 Click the “Close” button.

Control returns to the Customer Services window.
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4.0 ENTER INVALID PLAYBACK SCHEDULABLE PARAMETERS

4.1 From the Customer Services window, select the SSC and Service Type (Playback) to be
modified from the list and click the “Modify...” button.

The Playback Schedulable Parameters window appears containing the editable
parameters for the selected SSC.  The “Opened” time reflects the time the window
was opened.

4.2 Attempt to enter an Original Start time that is greater than the Original Stop time for the
Playback service.  Click the “Save” button.

The operator is appropriately notified of the entry of an invalid value.  The “Last
Update” information is not updated.

4.3 Perform a database query of the schedulable parameter information.

The Original Start time has not been updated.

4.4 Click the “Close” button.

The window closes and control returns to the Customer Services window.

4.5 Click the “View...” button for the same SSC.

The Playback Schedulable Parameters window appears and indicates that the
invalid Original Start and Stop times for the selected SSC were not saved.  The
“Save” button is dimmed since the window is view only when accessed via the
“View...” button.  The “Opened” time reflects the time the window was opened.

4.6 Click the “Close” button.

Control returns to the Customer Services window.
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1.6.1.24 Detailed Test Procedure for Test Item INCC109-B1.24
PROTOTYPE EVENTS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add or delete prototype events to/from the database
via the Prototype Events window.

• The operator has the capability to change the way prototype event information is
displayed.

• Deletes made from the Prototype Events window removes all data associated with the
removed prototype event.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ADD PROTOTYPE EVENTS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select a SIC and click the “View...” button.  From the SIC Editor
window, select the “Prototype Events...” option from the “Edit” menu.

The Prototype Events window appears and contains the existing Prototype Events
for the selected SIC and a list of all Valid SSCs.  The “Opened” time reflects the
time the window was opened.

2.2 Enter a Prototype Event ID and click the “Add” button.

The user is warned that the operation cannot be executed. All buttons are dimmed.

2.3 Select a Prototype Event and click the “Delete” button.

The user is warned that the operation cannot be executed. All buttons are dimmed.

2.4 Select a Valid SSCs and click the “Add to Event” button.

The user is warned that the operation cannot be executed. All buttons are dimmed.

2.5 Select an entry from the lower panel and click the “Remove”, “Move Up”, “Move
Down”, “Remove All”, and “Modify...” buttons.

The user is warned that the operations cannot be executed. All buttons are
dimmed.
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2.6 Enable Editing

All buttons are now functional.

2.7 Enter a Prototype Event ID to be added, and click the “Add” button.

The Prototype Event ID is added to the list of Prototype Events.  The prototype
event information sub-window remains blank until another existing Prototype
Event ID is selected or a Valid SSC is added.  The “Last Update” information is
not updated.

2.8 Select Valid SSCs for the new prototype event and click the “Add to Event” button.

The Valid SSCs are added to the prototype event information sub-window.  The
parameter values associated with the selected SSCs are displayed.  The “Last
Update” information is not updated.

2.9 Select the Service Number, SSC, and Service Type of the service to be modified from the
prototype event information sub-window and click the “Modify...” button.

The Edit Service window appears and contains the service information associated
with the selected service and SSC.

2.10 Click the “Close” button.

The window closes and control returns to the Prototype Events window.

2.11 Perform a database query of prototype event information.

The prototype event information has not been updated.

2.12 Click the “Save” button.

The added prototype event is saved to the database.  The “Last Update”
information is updated.

2.13 Perform a database query of the prototype event information.

The prototype event information now reflects the update.

2.14 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.15 Re-access the Prototype Events window.

The Prototype Events window appears and contains the updated prototype event
information for the selected SIC.  When the added prototype event is selected
from the list, the SSCs are displayed in the prototype event information sub-
window, and the parameter values associated with the selected SSCs remain
unchanged.  The “Opened” time reflects the time the window was opened.  The
“Last Update” information is the same as in step 2.12.
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3.0 MOVE PROTOTYPE EVENT INFORMATION

3.1 From the Prototype Events window, select the prototype event added in step 2.7 from the
Prototype Events list.

The SSCs associated with the selected prototype event appear in the prototype
event information sub-window below.

3.2 In the prototype event information sub-window, select an SSC to be removed and click
the “Remove” button.

The SSC is removed from the list.  The “Last Update” information is not updated.

3.3 For the same prototype event, select an SSC to be moved up and click the “Move Up”
button.  Select an SSC to be moved down and click the “Move Down” button.

The selected SSCs are appropriately moved up and down in the list.  The “Last
Update” information is not updated.

3.4 For the same prototype event, select an SSC for which prototype event information will
be removed without removing the SSC and click the “Remove All” button.

The prototype event information associated with the selected SSC is cleared from
the window, but the Service Number and SSC remain.  The “Last Update”
information is not updated.

3.5 Perform a database query of the prototype event information.

The prototype event information has not been updated.

3.6 Disable editing.

A dialog box asks the user if the changes should be changed.

3.7 Click the “Yes” button.

The “Last Update” information is updated.

3.8 Perform a database query of prototype event information.

The prototype event information now reflects the update.

3.9 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

3.10 Re-access the Prototype Events window.

The Prototype Events window appears and contains the updated prototype event
information for the selected SIC.  The SSCs moved up/down are in the
appropriate position and the SSC for which parameters were removed indicates
that they were removed.  The “Opened” time reflects the time the window was
opened.  The “Last Update” information is the same as in step 3.7.
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4.0 REMOVE PROTOTYPE EVENTS

4.1 From the Prototype Events window, select the prototype event added in step 2.3 from the
Prototype Events list, and click the “Remove” button.

The prototype event information is displayed below.  The prototype event is
removed from the Prototype Events list.  The prototype event information is
removed from sub-window below.  The “Last Update” information is not updated.

4.2 Perform a database query of the prototype event information.

The prototype event has not been removed.

4.3 Click the “Save” button.

The updates are saved to the database.  The “Last Update” information is updated.

4.4 Perform a database query of the prototype event information.

The prototype event has now been removed.

4.5 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

4.6 Re-access the Prototype Events window.

The Prototype Events window appears and contains the updated prototype event
information for the selected SIC.  The prototype event remains removed from the
Prototype Events list.  The “Opened” time reflects the time the window was
opened.  The “Last Update” information is the same as in step 4.3.

4.7 Make a modification and click the “Close” button.  Re-access the Prototype Events
window.

The updates are not saved.

4.8 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.25 Detailed Test Procedure for Test Item INCC109-B1.25
PROTOTYPE EVENTS WINDOW - INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
duplicate Prototype Events for the same SIC.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 DUPLICATE PROTOTYPE EVENTS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC, and click the “Modify...” button.  From
the SIC Editor window, select the “Prototype Events...” option from the “Edit” menu.

The Prototype Events window appears and contains the existing Prototype Events
for the selected SIC and a list of all Valid SSCs.  The “Opened” time reflects the
time the window was opened.

2.2 Enter a Prototype Event ID to be added and click the “Add” button.

The Prototype Event ID is added to the list of Prototype Events.  The prototype
event information sub-window remains blank until another existing Prototype
Event ID is selected or a Valid SSC is added.

2.3 Enter the same Prototype Event ID added above, attempt to add it a second time, and
click the “Add” button.  Click the “Save” button.

The operator is appropriately notified of the attempt to add a duplicate Prototype
Event ID for the selected SIC.  The “Last Update” information is not updated.

2.4 Perform a database query of the prototype event information.

The prototype event information has not been updated.

2.5 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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2.6 Re-access the Prototype Events window.

The Prototype Events window appears and contains the updated list of Prototype
Events for the selected SIC.  The added Prototype Event ID appears only once in
the list.  The “Opened” time reflects the time the window was opened.

2.7 Click the “Close” button.

The window closes and control returns to the SIC Editor window.
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1.6.1.26 Detailed Test Procedure for Test Item INCC109-B1.26
MISSION PRIORITIES WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to modify the mission priorities list.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 MODIFY MISSION PRIORITIES LIST

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select the “Mission Priority List...” option from the “Edit” menu.

The Mission Priorities window appears and contains customers listed in order by
mission priority.  The “Opened” time reflects the time the window was opened.

2.2 Select a SIC and click the “Move”, “Insert Before”, and “Insert After” buttons.

The user is warned that the operations cannot be executed. All buttons are
dimmed.

2.3 Enable editing and click the “Move” button.

The selected customer is marked for moving.  The “SIC being Moved” field
displays the name of the marked SIC.

2.4 Select another SIC in the list at the position you wish to move the customer that was
marked above and click the “Insert Before” button.

The marked customer is moved to the place in the list that is one position before
the selected customer.

2.5 Select a SIC and click the “Move” button.

The selected customer is marked for moving.  The “SIC being Moved” field
displays the name of the marked SIC.

2.6 Select another SIC in the list at the position you wish to move the customer that was
marked above and click the “Insert After” button.

The marked customer is moved to the place in the list that is one position after the
selected customer.  The “Last Update” information is not updated.
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2.7 Perform a database query of the mission priorities information.

The mission priorities information has not been updated.

2.8 Click the “Save” button.

The mission priority updates are saved to the database.  The “Last Update”
information is updated.

2.9 Perform a database query of the mission priorities information.

The mission priorities information now reflects the update.

2.10 Click the “Close” button.

The window closes and control returns to the Customer Database window.

2.11 Re-access the Mission Priorities window.

The Mission Priorities window appears and contains the mission priority list
updates.  The “Opened” time reflects the time the window was opened.  The “Last
Update” information is the same as in step 2.8.

2.12 Make a modification and click the “Close” button.  Re-access the Mission Priorities
window.

The updates are not saved.

2.13 Click the “Close” button.

The window closes and control returns to the Customer Database window.

3.0 CLEANUP

3.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.
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1.6.1.27 Detailed Test Procedure for Test Item INCC109-B1.27
SERVICE PARAMETER RECORDS WINDOW -
PARAMETER RECORD OVERRIDES
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to override SSAF and EET service parameter values for
a selected SIC.

• The operator has the capability to reset a schedulable parameter for a given service type
back to its default.

• The operator has the capability to reset all schedulable parameters for a given service
type back to their default.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 SSAF PARAMETER RECORD OVERRIDES

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC and click the “Modify...” button.  From the
SIC Editor window, select the “Parameter Record Overrides...” option from the “Edit”
menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  Editing
is enabled.

2.2 Click the “Enable Editing” toggle button.

The “Use Defaults”, “Modify”, “Add”, “Remove”, and “Save” buttons are
dimmed.  Editing is disabled.

2.3 Select a Service Type (SSAF), identify a discrete service parameter from the Parameter
Information area, select the Name of that parameter from the Parameters list, enter a
Value, and click the “Add” button.

The “Add” button is not activated when the Name is selected, the function is not
completed, and the operator is notified that editing is not enabled.  The “Last
Update” information is not updated.
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2.4 Enable editing and select an SSAF service from the list of Service Types.

The Parameter Names for the SSAF service and the Parameter Information is
displayed.  Editing is enabled.

2.5 Identify a continuous parameter from the Parameter Information area, select the Name of
that parameter from the Parameters list.

The Discrete radio button is grayed and the current Minimum and Maximum
values are displayed.

2.6 Enter new values for the Minimum and Maximum and click the “Modify” button.

An indicator is placed next to the Parameter Name in the Override column.  The
parameter record overrides for the selected SIC are reflected in the Parameter
Information area.  The “Last Update” information is not updated.

2.7 Perform a database query of the service parameter information.

The service parameter information has not been updated.

2.8 Click the “Save” button.

The SSAF parameter record overrides for the selected SIC (SIC = SIC) are saved
to the database.  The “Last Update” information is updated.

2.9 Perform a database query of the service parameter information.

The service parameter information now reflects the update.

2.10 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

2.11 Select the “Parameter Record Overrides...” option from the “Edit” menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  The
“Last Update” information is the same as in step 2.8.

2.12 Select the same SSAF service from the list of Service Types.

The Parameter Names for the SSAF service and the Parameter Information is
displayed.  The indicator appears in the Override column next to the Name of the
appropriate parameter in the Parameters list.  The Parameter Information area
contains the new values for the modified parameter.
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3.0 RESET SINGLE PARAMETER TO DEFAULT

3.1 From the Service Parameter Records window, select the Name of the same parameter as
above from the Parameters list and click the “Use Defaults” button under the Parameters
list.

The schedulable parameter value for the selected parameter is reset to its default
service parameter value.  The “Last Update” information is not updated.

3.2 Perform a database query of the service parameter information.

The service parameter information has not been updated.

3.3 Click the “Save” button.

The SSAF parameter updates for the selected SIC (SIC = SIC) are saved to the
database.  The “Last Update” information is updated.

3.4 Perform a database query of the service parameter information.

The service parameter information now reflects the update.

3.5 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

3.6 Select the “Parameter Record Overrides...” option from the “Edit” menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  The
“Last Update” information is the same as in step 3.3.

3.7 Select the same SSAF service from the list of Service Types.

The Parameter Names for the SSAF service and the Parameter Information is
displayed.  The Parameter Information area indicates that the value for the
appropriate parameter was reset to its default value.

4.0 EET PARAMETER RECORD OVERRIDES

4.1 From the Service Parameter Records window, select an EET service from the list of
Service Types.

The Parameter Names for the EET service and the Parameter Information is
displayed.

4.2 Identify a continuous parameter from the Parameter Information area, select the Name of
that parameter from the Parameters list.

The Discrete radio button is grayed and the current Minimum and Maximum
values are displayed.
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4.3 Enter new values for the Minimum and Maximum and click the “Modify” button.

An indicator is placed next to the Parameter Name in the Override column.  The
parameter record overrides for the selected SIC are reflected in the Parameter
Information area.  The “Last Update” information is not updated.

4.4 Perform a database query of the service parameter information.

The service parameter information has not been updated.

4.5 Click the “Save” button.

The EET parameter record overrides for the selected SIC (SIC = SIC) are saved to
the database.  The “Last Update” information is updated.

4.6 Perform a database query of the service parameter information.

The service parameter information now reflects the update.

4.7 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

4.8 Select the “Parameter Record Overrides...” option from the “Edit” menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  The
“Last Update” information is the same as in step 4.5.

4.9 Select the same EET service from the list of Service Types.

The Parameter Names for the EET service and the Parameter Information is
displayed.  The indicator appears in the Override column next to the Name of the
appropriate parameter in the Parameters list.  The Parameter Information area
contains the new values for the modified parameter.

4.10 Repeat steps 4.2 through 4.9 for another parameter.

The default values are overridden for the selected parameter.  At least two
parameters now contain default values that were overridden for the selected SIC.

5.0 RESET ALL PARAMETERS TO DEFAULTS

5.1 From the Service Parameter Records window, for the same EET Service Type, click the
“Use Defaults” button under the Service Type list.

All schedulable parameters for the selected EET Service Type  are reset back to
their default service parameter values.  The “Last Update” information is not
updated.

5.2 Perform a database query of the service parameter information.

The service parameter information has not been updated.
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5.3 Click the “Save” button.

The EET parameter updates for the selected SIC (SIC = SIC) are saved to the
database.  The “Last Update” information is updated.

5.4 Perform a database query of the service parameter information.

The service parameter information now reflects the update.

5.5 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

5.6 Select the “Parameter Record Overrides...” option from the “Edit” menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  The
“Last Update” information is the same as in step 5.3.

5.7 Select the same EET service from the list of Service Types.

The Parameter Names for the EET service and the Parameter Information is
displayed.  The Parameter Information area indicates that the values associated
with all of the EET service parameters (including the two that were overridden in
section 4.0) were reset to their default values.

5.8 Make a modification and click the “Close” button.  Re-access the Service Parameter
Records window.

The updates are not saved.

5.9 Click the “Close” button.

The window closes and control returns to the SIC Editor window.

6.0 CLEANUP

6.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.
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1.6.1.28 Detailed Test Procedure for Test Item INCC109-B1.28
SERVICE PARAMETER RECORDS WINDOW - SERVICE DEFAULTS
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to modify SSAR/SMAR and Tracking default service
parameter values for all SICs.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 MODIFY SSAR/SMAR DEFAULTS

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select the “Service Parameter Records...” option from the “Edit”
menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  Editing
is disabled.

2.2 Select a Service Type (SSAR/SMAR), identify a discrete service parameter from the
Parameter Information area, select the Name of that parameter from the Parameters list,
and click the “Remove” button.

The “Use Defaults”, “Modify”, “Add”, “Remove”, and “Save” buttons are
dimmed.  The function is not completed and the operator is notified that editing is
not enabled.

2.3 Enable editing and select an SSAR/SMAR service from the list of Service Types.

The Parameter Names for the SSAR/SMAR service and the associated Parameter
Information is displayed.  Editing is enabled.

2.4 Identify a discrete parameter from the Parameter Information area, select the Name of that
parameter from the Parameters list.

The Continuous radio button is grayed and the list of Discrete values are
displayed.

2.5 Enter a Value and click the “Add” button.  Select a value and click the “Remove” button.

The list of Discrete values is updated.



2/6/97  6:31 PM INCC109-73 530-ITP-NCCDS/1998

2.6 Click the “Modify” button.

The new list of values is reflected in the Parameter Information area.  The “Last
Update” information is not updated.

2.7 Perform a database query of the service parameter information.

The service parameter information has not been updated.

2.8 Click the “Save” button.

The SSAR/SMAR default service parameter value updates for all SICs
(“DEFAULTS” appears in upper left corner of window) are saved to the database.
The “Last Update” information is updated.

2.9 Perform a database query of the service parameter information.

The service parameter information now reflects the update.

2.10 Click the “Close” button.

The window closes and control returns to the Customer Database window.

2.11 Select the “Service Parameter Records...” option from the “Edit” menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  The
“Last Update” information is the same as in step 2.8.  Editing is disabled.

2.12 Enable editing and select the same SSAR/SMAR service from the list of Service Types.

The Parameter Names for the SSAR/SMAR service and the Parameter
Information is displayed and contains the updates.  Editing is enabled.

3.0 MODIFY TRACKING DEFAULTS

3.1 From the Service Parameter Records window, select a tracking service from the list of
Service Types.

The Parameter Names for the tracking service and the associated Parameter
Information is displayed.

3.2 Identify a continuous parameter from the Parameter Information area, select the Name of
that parameter from the Parameters list.

The Discrete radio button is grayed and the current Minimum and Maximum
values are displayed.

3.3 Enter new values for the Minimum and Maximum and click the “Modify” button.

The new range of continuous values is reflected in the Parameter Information
area.  The “Last Update” information is not updated.
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3.4 Perform a database query of the service parameter information.

The service parameter information has not been updated.

3.5 Click the “Save” button.

The tracking default service parameter value updates for all SICs (“DEFAULTS”
appears in upper left corner of window) are saved to the database.  The “Last
Update” information is updated.

3.6 Perform a database query of the service parameter information.

The service parameter information now reflects the update.

3.7 Click the “Close” button.

The window closes and control returns to the Customer Database window.

3.8 Select the “Service Parameter Records...” option from the “Edit” menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  The
“Last Update” information is the same as in step 3.5.  Editing is disabled.

3.9 Enable editing and select the same tracking service from the list of Service Types.

The Parameter Names for the tracking service and the Parameter Information is
displayed and contains the updates.  Editing is enabled.

3.10 Make a modification and click the “Close” button.  Re-access the Service Parameter
Records window.

The updates are not saved.

3.11 Click the “Close” button.

The window closes and control returns to the Customer Database window.

4.0 CLEANUP

4.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.
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1.6.1.29 Detailed Test Procedure for Test Item INCC109-B1.29
SERVICE PARAMETER RECORDS WINDOW -
INVALID CUSTOMER DATA
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates Customer database entries and properly informs the operator of
invalid service parameter values.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ENTER INVALID DEFAULT PARAMETER VALUE

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, select the “Service Parameter Records...” option From the “Edit”
menu.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  Editing
is disabled.

2.2 Enable editing and select an KuSAF/KaSAF service from the list of Service Types.

The Parameter Names for the KuSAF/KaSAF service and the Parameter
Information is displayed.  Editing is enabled.

2.3 Identify a continuous parameter from the Parameter Information area, select the Name of
that parameter from the Parameters list.

The Discrete radio button is grayed and the current Minimum and Maximum
values are displayed.

2.4 Enter a Minimum value that is greater than the Maximum and click the “Modify” button.
Click the “Save” button.

The operator is appropriately notified of the invalid entry.  The invalid value was
not saved to the database for all SICs (“DEFAULTS” appears in upper left corner
of window).  The “Last Update” information is not updated.

2.5 Perform a database query of the service parameter information.

The service parameter information has not been updated.
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2.6 Click the “Close” button.

The window closes and control returns to the Customer Database window.

2.7 From the “Edit” menu, select the “Service Parameter Records...” option.

The Service Parameter Records window appears with the list of Service Types
displayed.  The “Opened” time reflects the time the window was opened.  Editing
is disabled.

2.8 Enable editing and select the same KuSAF/KaSAF service from the list of Service Types.

The Parameter Names for the KuSAF/KaSAF service and the Parameter
Information is displayed and does not contain the invalid entry.  Editing is
enabled.

2.9 Click the “Close” button.

The window closes and control returns to the Customer Database window.
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1.6.1.30 Detailed Test Procedure for Test Item INCC109-B1.30
VALID CCS USER IDs AND PASSWORD WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add user IDs to and remove user IDs from the CCS
User IDs list for a selected SUPIDEN via the CCS UserIDs and Password window.

• The operator has the capability to make one CCS User ID the primary user ID for a
selected SUPIDEN via the CCS UserIDs and Password window.

• The operator has the capability to set one CCS password per SUPIDEN via the CCS
UserIDs and Password window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 SET CCS USER IDs

2.1 Select “Customer” from the Database subpanel on the Main Panel.  From the Customer
Database window, enable editing, select a SIC and click the “Modify...” button.  From the
SIC Editor window, select the “Valid SUPIDENs and TDRSs...” option from the “Edit”
menu.

The Valid Customer SUPIDENs and TDRSs window appears and contains the
Valid SUPIDENs for the selected SIC and the Valid TDRSs for the selected
SUPIDEN.  The “Opened” time reflects the time the window was opened.
Editing is enabled.

2.2 Select a SUPIDEN from the Valid SUPIDENs list and click the “Set CCS Info...” button.

The CCS UserIDs and Password window appears and contains a list of CCS User
IDs for the selected SUPIDEN, a list of  Existing User IDs that can be assigned to
the CCS User IDs list, and a list of Existing Passwords from which one can be set
per SUPIDEN.  The “Opened” time reflects the time the window was opened.
Editing is enabled.

2.3 Click the “Enable Editing” toggle button.

The “Add”, “Remove”, “Set Primary”, “Set Password”, and “Save” buttons are
dimmed.  Editing is disabled.
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2.4 Select an Existing User ID and click the “Add” button.

The “Add” button is not activated when the Existing User ID is selected, the
function is not completed, and the operator is notified that editing is not enabled.
The “Last Update” information is not updated.

2.5 Enable editing, select a user ID from the Existing User IDs list and click the “Add”
button.

The “Add” button is activated when the Existing User ID is selected indicating
that editing is enabled.  The Existing User ID is added to the CCS User IDs list.

2.6 Select additional user IDs (one at a time) from the Existing User IDs list and click the
“Add” button.

The Existing User IDs are added to the CCS User IDs list.

2.7 Select one of the user IDs that was added to the CCS User IDs list above and click the
“Remove” button.

The user ID is removed from the CCS User IDs list.

2.8 Select a user ID from the CCS User IDs list and click the “Set Primary” button.

The Primary field is updated with the name of the selected CCS User ID.

3.0 SET CCS PASSWORDS

3.1 From the CCS UserIDs and Password window, select a password from the Existing
Passwords list and click the “Set Password” button.

The Password field is updated with the name of the selected Existing Password.

3.2 Select a second password from the Existing Passwords list and click the “Set Password”
button.

The operator is notified that only one password can be assigned per SUPIDEN.
The Password field is not updated with the second password.

3.3 Perform a database query of the CCS User ID and Password information.

The CCS User ID and Password information has not been updated.

3.4 Click the “Save” button.

The “Last Update” information is updated.  The CCS User IDs and password
modifications are saved to the data base.

3.5 Perform a database query of the CCS User ID and Password information.

The CCS User ID and Password information now reflects the update.
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3.6 Click the “Close” button.

The window closes and control returns to the Valid Customer SUPIDENs and
TDRSs window.

3.7 Select the same SUPIDEN from the Valid SUPIDENs list and click the “Set CCS Info...”
button.

The CCS UserIDs and Password window appears and contains the user IDs added
to the CCS User IDs list, but does not contain the one that was removed.  The
Primary and Password fields contain the appropriate user ID and password.

3.8 Make a modification and click the “Close” button.  Re-access the CCS UserIDs and
Password window.

The updates are not saved.

3.9 Click the “Close” button.

The window closes and control returns to the Valid Customer SUPIDENs and
TDRSs window.

4.0 CLEANUP

4.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.
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1.7 Test Case INCC110 - SPSR: Input

1.7.1 Detailed Test Procedures for Test Case INCC110

1.7.1.1 Detailed Test Procedure for Test Item INCC110-B1.1
VALID SARS/SRMS [99/10, 99/02]
CSCI 1601

Pass/Fail Criteria:

• The NCCDS receives and stores valid customer-initiated SARs.

• Valid SARs are properly logged.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to schedule requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create a valid SAR (99/10) that does not request the use of TSWs (byte 38 =
0).  Refer to 530-ICD-NCCDS/MOC for the valid format and content of SARs.

1.3 From NTS, create a valid SAR that does request the use of TSWs (byte 38 = 1).
[Associated TSWs should not be defined in the database.]

2.0 VALID REQUESTS - TSWs NOT SPECIFIED

2.1 From NTS, transmit the valid SAR created in step 1.2 to the NCCDS.

2.2 Perform a database query of Schedule Request information.

The SAR transmitted in step 2.1 is stored in the database as a valid request.

2.3 Use a UNIX editor to review the log file of external messages.

The SAR transmitted in step 2.1 was properly logged.

2.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 26:00 was transmitted to the
customer, indicating that the request was placed in the valid queue.  An SRM
containing result/explanation code 26:66 was transmitted to the customer,
indicating that the use of TSWs was not requested.
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3.0 VALID REQUESTS - TSWs SPECIFIED

3.1 From NTS, transmit the valid SAR created in step 1.3 to the NCCDS.

3.2 Perform a database query of Schedule Request information.

The SAR transmitted in step 3.1 is stored in the database as a valid request.

3.3 Use a UNIX editor to review the log file of external messages.

The SAR transmitted in step 3.1 was properly logged.

3.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 26:00 was transmitted to the
customer to indicate that the request was granted.  An SRM containing
result/explanation code 26:67 was transmitted to the customer to indicate that the
use of TSWs was requested, but applicable TSWs are not available.
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1.7.1.2 Detailed Test Procedure for Test Item INCC110-B1.2
INVALID SARS/SRMS [99/10, 99/02]
CSCI 1601

Pass/Fail Criteria:

• The NCCDS receives and partially validates invalid customer-initiated SARs.

• The operator is appropriately alerted when SARs do not pass validation.

• Invalid SARs are stored in the database (except for syntax errors).

• Invalid SARs (except for syntax errors) are properly logged.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to schedule requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create a SAR with a plus tolerance of 006000.

1.3 From NTS, create a SAR that specifies an SSC not defined in the database.

2.0 INVALID REQUESTS - SYNTAX ERROR

2.1 From NTS, transmit the SAR created in step 1.2 to the NCCDS.

The operator receives an alert in the format “Invalid SAR %s: %s”, where the first
%s reflects the request ID and the second the reason the request was rejected.

2.2 Perform a database query of the Schedule Request information.

The SAR transmitted in step 2.1 was not stored in the database.

2.3 Use a UNIX editor to review the log file of external messages.

The SAR transmitted in step 2.1 was not logged.  The “Invalid SAR...” alert was
logged.

2.4 Obtain an NTS delog of 99/02s.

An SRM containing result/explanation code 10:18 was transmitted to the
customer.
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3.0 INVALID REQUESTS

3.1 From NTS, transmit the SAR created in step 1.3 to the NCCDS.

The operator receives an alert in the format “Invalid SAR %s: %s”, where the first
%s reflects the request ID and the second the reason the request was rejected.

3.2 Perform a database query of the Schedule Request information.

The SAR transmitted in step 3.1 is stored in the database as a valid request.

3.3 Use a UNIX editor to review the log file of external messages.

The SAR transmitted in step 3.1 was properly logged.  The “Invalid SAR...” alert
was also logged.

3.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 10:49 was transmitted to the
customer.
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1.7.1.3 Detailed Test Procedure for Test Item INCC110-B1.3
VALID ALTERNATE SARS/SRMS [99/21, 99/02]
CSCI 1601

Pass/Fail Criteria

• The NCCDS receives and stores valid customer-initiated Alternate SARs.

• Valid Alternate SARs are properly logged.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to schedule requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create and submit a valid SAR.

1.3 Run the Oracle script to make the valid SAR declined.

1.4 From NTS, create a valid Alternate SAR (ASAR) that references the declined SAR and
does not request the use of TSWs (byte 38 = 0).  Refer to 530-ICD-NCCDS/MOC for the
valid format and content of ASARs.

1.5 From NTS, create a valid ASAR that references the same declined SAR, but does request
the use of TSWs (byte 38 = 1).  [Associated TSWs should be defined in the database, but
not for the entire timeframe of the request.]

2.0 VALID REQUESTS - TSWs NOT SPECIFIED

2.1 From NTS, transmit the valid ASAR created in step 1.4 to the NCCDS.

2.2 Perform a database query of Schedule Request information.

The ASAR transmitted in step 2.1 is stored in the database as a valid request.

2.3 Use a UNIX editor to review the log file of external messages.

The ASAR transmitted in step 2.1 was properly logged.

2.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 26:00 was transmitted to the
customer, indicating that the request was stored in the valid queue.  An SRM
containing result/explanation code 26:66 was transmitted to the customer,
indicating that the use of TSWs was not requested.
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3.0 VALID REQUESTS - TSWs SPECIFIED

3.1 From NTS, transmit the valid ASAR created in step 1.5 to the NCCDS.

3.2 Perform a database query of Schedule Request information.

The ASAR transmitted in step 3.1 is stored in the database as a valid request.

3.3 Use a UNIX editor to review the log file of external messages.

The ASAR transmitted in step 3.1 was properly logged.

3.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 26:00 was transmitted to the
customer, indicating that the request was stored in the valid queue.  An SRM
containing result/explanation code 26:68 was transmitted to the customer,
indicating that the request cannot be scheduled within the available TSWs.
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1.7.1.4 Detailed Test Procedure for Test Item INCC110-B1.4
INVALID ALTERNATE SARS/SRMS [99/21, 99/02]
CSCI 1601

Pass/Fail Criteria

• The NCCDS receives and partially validates invalid customer-initiated Alternate SARs.

• The operator is appropriately alerted when Alternate SARs do not pass validation.

• Invalid Alternate SARs are stored in the database (except for syntax errors).

• Invalid Alternate SARs (except for syntax errors) are properly logged.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to schedule requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create an ASAR with TDRS T*1.

1.3 From NTS, create an ASAR with TDRS NCC.

2.0 INVALID REQUESTS - SYNTAX ERROR

2.1 From NTS, transmit the ASAR created in step 1.2 to the NCCDS.

The operator receives an alert in the format “Invalid Alternate SAR %s: %s”,
where the first %s reflects the request ID and the second the reason the request
was rejected.

2.2 Perform a database query of Schedule Request information.

The ASAR transmitted in step 2.1 was not stored in the database.

2.3 Use a UNIX editor to review the log file of external messages.

The ASAR transmitted in step 2.1 was not logged.  The “Invalid Alternate
SAR...” alert was logged.

2.4 Obtain an NTS delog of 99/02’s.

An SRM containing the appropriate result/explanation code 10:18 was transmitted
to the customer.
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3.0 INVALID REQUESTS

3.1 From NTS, transmit the ASAR created in step 1.3 to the NCCDS.

The operator receives an alert in the format “Invalid Alternate SAR %s: %s”,
where the first %s reflects the request ID and the second the reason the request
was rejected.

3.2 Perform a database query of the Schedule Request information.

The ASAR transmitted in step 3.1 is stored in the database as a valid request.

3.3 Use a UNIX editor to review the log file of external messages.

The ASAR transmitted in step 3.1 was properly logged.  The “Invalid Alternate
SAR...” alert was also logged.

3.4 Obtain an NTS delog of 99/02’s.

An SRM containing the appropriate result/explanation code 10:19 was transmitted
to the customer.

3.5 From NTS, transmit an ASAR that references an invalid SAR.

The request is rejected.
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1.7.1.5 Detailed Test Procedure for Test Item INCC110-B1.5
VALID REPLACE REQUESTS/SRMS [99/12, 99/02]
CSCI 1601

Pass/Fail Criteria

• The NCCDS receives and stores valid customer-initiated replace requests.

• Valid replace requests are properly logged.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to schedule requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create and submit a valid SAR.

1.3 Run the Oracle script to make the valid SAR declined.

1.4 From NTS, create a valid replace request that references the declined SAR and requests
the use of TSWs (byte 38 = 0).  [Associated TSWs should be defined in the database.]
Refer to 530-ICD-NCCDS/MOC for the valid format and content of Replace Requests.

1.5 From NTS, create a valid replace request that references the same declined SAR, but does
request the use of TSWs (byte 38 = 1).  [Associated TSWs should not be defined in the
database.]

2.0 VALID REQUESTS - TSWs NOT SPECIFIED

2.1 From NTS, transmit the valid replace request created in step 1.4 to the NCCDS.

2.2 Perform a database query of Schedule Request information.

The replace request transmitted in step 2.1 is stored in the database as a valid
request.

2.3 Use a UNIX editor to review the log file of external messages.

The replace request transmitted in step 2.1 was properly logged.
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2.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 26:00 was transmitted to the
customer, indicating that the request was stored in the valid queue.  An SRM
containing result/explanation code 26:69 was transmitted to the customer,
indicating that the request can be scheduled within the available TSWs.

3.0 VALID REQUESTS - TSWs SPECIFIED

3.1 From NTS, transmit the valid replace request created in step 1.5 to the NCCDS.

3.2 Perform a database query of Schedule Request information.

The replace request transmitted in step 3.1 is stored in the database as a valid
request.

3.3 Use a UNIX editor to review the log file of external messages.

The replace request transmitted in step 3.1 was properly logged.

3.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 26:00 was transmitted to the
customer, indicating that the request was stored in the valid queue.  An SRM
containing result/explanation code 26:67 was transmitted to the customer,
indicating that the use of TSWs was requested, but applicable TSWs are not
available.
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1.7.1.6 Detailed Test Procedure for Test Item INCC110-B1.6
INVALID REPLACE REQUESTS/SRMS [99/12, 99/02]
CSCI 1601

Pass/Fail Criteria

• The NCCDS receives and stores and partially validates invalid customer-initiated
replace requests.

• The operator is appropriately alerted when replace requests do not pass validation.

• Invalid replace requests are stored in the database (except for syntax errors).

• Invalid replace requests (except for syntax errors) are properly logged.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to schedule requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create a replace request with Referenced Request ID xxxxxxx.

1.3 From NTS, create a replace request with a Referenced Request ID that is not associated
with a currently stored request.

2.0 INVALID REQUESTS - SYNTAX ERROR

2.1 From NTS, transmit the replace request created in step 1.2 to the NCCDS.

The operator receives an alert in the format “Invalid Replace Request %s: %s”,
where the first %s reflects the request ID and the second the reason the request
was rejected.

2.2 Perform a database query of Schedule Request information.

The replace request transmitted in step 2.1 was not stored in the database.

2.3 Use a UNIX editor to review the log file of external messages.

The  replace request transmitted in step 2.1 was not logged.  The “Invalid Replace
Request...” alert was logged.

2.4 Obtain an NTS delog of 99/02’s.

An SRM containing the appropriate result/explanation code 10:18 was transmitted
to the customer.
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3.0 INVALID REQUESTS

3.1 From NTS, transmit the replace request created in step 1.3 to the NCCDS.

The operator receives an alert in the format “Invalid Replace Request %s: %s”,
where the first %s reflects the request ID and the second the reason the request
was rejected.

3.2 Perform a database query of the Schedule Request information.

The replace request transmitted in step 3.1 is stored in the database as a valid
request.

3.3 Use a UNIX editor to review the log file of external messages.

The replace request transmitted in step 3.1 was properly logged.  The “Invalid
Replace Request...” alert was also logged.

3.4 Obtain an NTS delog of 99/02’s.

An SRM containing the appropriate result/explanation code 10:11 was transmitted
to the customer.
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1.7.1.7 Detailed Test Procedure for Test Item INCC110-B1.7
VALID TSWs 99/25
CSCI 1601

Pass/Fail Criteria

• The NCCDS receives and stores valid customer-initiated TSWs.

• Valid TSWs are properly logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create valid TSW messages according to 530-ICD-NCCDS/MOC.

Include messages for several full-support customers.  Include more than one TSW
message for some customers (some for the same TDRS and some for different
TDRSs).  Include more than one TSW in some of the messages.  This information
is also presented in the following table.

Customer TDRS TSW Set ID    #TSWs

A 041 CustA_1 1
B 041 CustB_1 2
B 171 CustB_2 1
C 041 CustC_1 3
C 041 CustC_2 1
C TDE CustC_3 2
D 171 CustD_1 2

2.0 VALID TSW MESSAGES

2.1 From NTS, transmit the TSWs to the NCCDS.

2.2 Perform a database query of the TSW information.

The TSWs are stored in the database in ascending time order by SIC, TDRS, and
TSW Set ID.  All information is correct.

2.3 Use a UNIX editor to review the log file of external messages.

The TSW messages were properly logged.



2/6/97  6:31 PM INCC110-14 530-ITP-NCCDS/1998

1.7.1.8 Detailed Test Procedure for Test Item INCC110-B1.8
INVALID TSWs 99/25
CSCI 1601

Pass/Fail Criteria

• The NCCDS receives and partially validates invalid customer-initiated TSWs.

• The operator is appropriately alerted when TSWs do not pass validation.

• Invalid TSWs are stored in the database (except for syntax errors).

• Invalid TSWs (except for syntax errors) are properly logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create a TSW message specifying Number of TSWs “XXX”.

1.3 From NTS, create a TSW message specifying TDRS “TSW”.

2.0 INVALID TSW MESSAGES - SYNTAX ERROR

2.1 From NTS, transmit the TSW message created in step 1.2 to the NCCDS.

The operator receives an alert in the format “Invalid TSW message %d from
SIC:%s: %s”, where %d is the message ID, the first %s is the SIC, and the second
%s is the reason the TSW was invalid.

2.2 Perform a database query of the TSW information.

The TSWs transmitted in step 2.1 were not stored in the database.

2.3 Use a UNIX editor to review the log file of external messages.

The TSW messages transmitted in step 2.1 were not logged.  The “Invalid
TSW...” alert was logged.

3.0 INVALID TSW MESSAGES

3.1 From NTS, transmit the TSW message created in step 1.3 to the NCCDS.

The operator receives an alert in the format “Invalid TSW message %d from
SIC:%s: %s”, where %d is the message ID, the first %s is the SIC, and the second
%s is the reason the TSW was invalid.
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3.2 Perform a database query for the TSWs transmitted in step 3.1.

The TSWs transmitted in step 3.1 are stored in the database.

3.3 Use a UNIX editor to review the log file of external messages.

The TSW messages transmitted in step 3.1 were properly logged.  The “Invalid
TSW...” alert was also logged.
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1.7.1.9 Detailed Test Procedure for Test Item INCC110-B1.9
PARTIALLY VALID/OVERLAPPING/EMPTY TSWs 99/25
CSCI 1601

Pass/Fail Criteria

• Only the valid information contained in a partially valid TSW message is stored.

• TSWs that overlap previous TSWs for the same SIC, TDRS, timeframe, and Set ID
replace the previous information.

• Empty TSW messages cause the deletion of TSWs for the same SIC, TDRS, timeframe,
and Set-ID.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create TSW messages as indicated in the table for the same time span,
customer, TSW Set ID, and TDRS.  Specify a time span of 97CCC000000 to
97EEE000000.  “CCC” is 1 day in the past, “EEE” is 3 days in the future, and “DDD” is
2 days in the future.

TSW Message TSW Opening Time TSW Closing Time

1 97DDD000000 97DDD000500
97DDD001100 97DDD001200
97DDD001300 97DDD001400
97DDD001500 97DDD001600

2 97CCC010000 97CCC020000
97DDD000600 97DDD000800
97DDD001030 97DDD001430

3 97DDD000000 97DDD001330
97DDD001530 97DDD001730

4 none none

1.4 From NTS, transmit TSW message 1 to the NCCDS.

2.0 PARTIALLY VALID TSWs

2.1 Perform a database query of the TSW information.

The TSWs for the customer, time span, TSW Set ID, and TDRS used in step 1.3
appear in the database as follows:
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97DDD000000 97DDD000500
97DDD001100 97DDD001200
97DDD001300 97DDD001400
97DDD001500 97DDD001600

2.2 From NTS, transmit TSW message 2 to the NCCDS.

The operator receives an alert in the format “New TSWs update/overlap
previously stored TSWs for SIC:%s, TSW set=%s, TDRS:%s”, where the first %s
if the SIC, the second the TSW Set ID, and the third the TDRS.

2.3 Perform a database query of the TSW information.

The TSWs for the customer, time span, TSW Set ID, and TDRS used in step 1.3
appear in the database as follows:

97DDD000000 97DDD000500
97DDD000600 97DDD000800
97DDD001030 97DDD001430
97DDD001500 97DDD001600

2.4 Use a UNIX editor to review the log file of external messages.

The “New TSWs...” alert was logged.

3.0 OVERLAPPING TSWs

3.1 From NTS, transmit TSW message 3 to the NCCDS.

The operator receives an alert in the format “New TSWs update/overlap
previously stored TSWs for SIC:%s, TSW set=%s, TDRS:%s”, where the first %s
if the SIC, the second the TSW Set ID, and the third the TDRS.

3.2 Perform a database query of the TSW information.

The TSWs for the customer, time span, TSW Set ID, and TDRS used in step 1.3
appear in the database as follows:

97DDD000000 97DDD001430
97DDD001500 97DDD001730

3.3 Use a UNIX editor to review the log file of external messages.

The “New TSWs...” alert was logged.
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4.0 EMPTY TSW MESSAGES

4.1 From NTS, transmit TSW message 4 to the NCCDS.

The operator receives an alert in the format “New TSWs update/overlap
previously stored TSWs for SIC:%s, TSW set=%s, TDRS:%s”, where the first %s
if the SIC, the second the TSW Set ID, and the third the TDRS.

4.2 Perform a database query of the TSW information.

No TSWs appear in the database for the customer, time span, TSW Set ID, and
TDRS used in step 1.3.

4.3 Use a UNIX editor to review the log file of external messages.

The “New TSWs...” alert was logged.
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1.7.1.10 Detailed Test Procedure for Test Item INCC110-B1.10
VALID DELETE REQUESTS 99/11
CSCI 1601

Pass/Fail Criteria:

• The NCCDS receives and stores valid customer-initiated schedule delete requests.

• Valid schedule delete requests result in the cancellation of SARs, ASARs, and replace
requests stored for batch scheduling or wait-list processing.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create valid SARs, ASARs, and replace requests for the automatic and batch
scheduling subphases.  Submit batch requests for the active and schedule generation
periods.

1.3 From NTS, create valid delete requests (99/11) that reference the SARs, ASARs, and
replace requests.  Refer to 530-ICD-NCCDS/MOC for the valid format and content of
Delete Requests.

1.4 From NTS, transmit the SARs, ASARs, and replace requests to the NCCDS.

2.0 BATCH SCHEDULE - ACTIVE PERIOD

2.1 From NTS, transmit the delete requests for the batch scheduling subphase of the active
period to the NCCDS.

The batch schedule process is notified when the delete requests are received.
Operator alert?

2.2 Perform a database query of the Schedule Request information.

The referenced requests appear in the database with an indication that they were
deleted.  The delete requests are also stored in the database.

2.3 Use a UNIX editor to review the log file of external messages.

The delete requests transmitted in step 2.1 were logged.

3.0 BATCH SCHEDULE - SCHEDULE GENERATION PERIOD

3.1 From NTS, transmit the delete requests for the batch scheduling subphase of the schedule
generation period to the NCCDS.
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3.2 Perform a database query of the Schedule Request information.

The referenced requests appear in the database with an indication that they were
deleted.  The delete requests are also stored in the database.

3.3 Use a UNIX editor to review the log file of external messages.

The delete requests transmitted in step 3.1 were logged.

4.0 WAIT LIST PROCESSING

4.1 Populate the wait list queue.

4.2 From NTS, transmit delete requests for requests stored for wait list processing.

4.3 Perform a database query of the Schedule Request information.

The referenced requests appear in the database with an indication that they were
deleted.  The delete requests are also stored in the database.

4.4 Use a UNIX editor to review the log file of external messages.

The delete requests transmitted in step 4.2 were logged.
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1.7.1.11 Detailed Test Procedure for Test Item INCC110-B1.11
INVALID DELETE REQUESTS/SRMs [99/11, 99/02]
CSCI 1601

Pass/Fail Criteria:

• The NCCDS receives invalid customer-initiated schedule delete requests.

• The operator is appropriately alerted when schedule delete requests do not pass
validation.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to delete requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create a delete request for a baseline customer that specifies an Event Start
Time of 97DDD240000, where DDD is 2 days in the future.

1.3 From NTS, create a delete request for a full support customer that specifies a Referenced
Request ID of ABCDEFG.

1.4 From NTS, create a delete request for a baseline customer that specifies a TDRS not
defined in the database.

1.5 From NTS, create a delete request for a full support customer that specifies a Referenced
Request ID not associated with a stored request.

1.6 From NTS, create valid SARs, ASARs, and replace requests for the automatic scheduling
subphase.

1.7 From NTS, create delete requests which reference the requests created in step 1.4.

2.0 INVALID DELETE REQUESTS - SYNTAX ERROR

2.1 From NTS, transmit the delete request created in step 1.2 to the NCCDS.

The operator receives an alert in the format “Invalid Delete Request %s: %s”,
where the first %s is the request ID and the second the reason the request was
rejected.
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2.2 From NTS, transmit the delete request created in step 1.3 to the NCCDS.

The operator receives an alert in the format “Invalid Delete Request %s: %s”,
where the first %s is the request ID and the second the reason the request was
rejected.

2.3 Perform a database query of the Schedule Request information.

The delete requests transmitted in steps 2.1 and 2.2 were not stored in the
database.

2.4 Use a UNIX editor to review the log file of external messages.

The delete requests transmitted in steps 2.1 and 2.2 were not logged.  The “Invalid
Delete Request...” alerts were logged.

2.5 Obtain an NTS delog of 99/02’s.

SRMs containing the appropriate result/explanation codes were transmitted to the
customers.

3.0 INVALID DELETE REQUESTS

3.1 From NTS, transmit the delete request created in step 1.4 to the NCCDS.

The operator receives an alert in the format “Invalid Delete Request %s: %s”,
where the first %s is the request ID and the second the reason the request was
rejected.

3.2 From NTS, transmit the delete request created in step 1.5 to the NCCDS.

The operator receives an alert in the format “Invalid Delete Request %s: %s”,
where the first %s is the request ID and the second the reason the request was
rejected.

3.3 Perform a database query of the Schedule Request information.

The delete requests transmitted in steps 3.1 and 3.2 were stored in the data base as
invalid requests.

3.4 Use a UNIX editor to review the log file of external messages.

The delete requests transmitted in steps 3.1 and 3.2 were logged.  The “Invalid
Delete Request...” alerts were also logged.

3.5 Obtain an NTS delog of 99/02’s.

SRMs containing the appropriate result/explanation codes were transmitted to the
customers.
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4.0 DELETE REQUESTS FOR AUTOMATIC SCHEDULING SUBPHASE

4.1 From NTS, transmit the requests created in step 1.6 to the NCCDS.

The requests are received, validated, and stored as valid requests.

4.2 From NTS, transmit the delete requests created in step 1.7 to the NCCDS.

The operator receives alerts in the format “Invalid Delete Request %s: %s”, where
the first %s is the request ID and the second the reason the requests were rejected.

4.3 Perform a database query of the Schedule Request information.

The referenced requests were not affected since delete requests only affect
requests stored for batch or wait-list processing (see SRD 5.3.2.2.8.2).  The delete
requests were stored in the database as invalid requests.

4.4 Use a UNIX editor to review the log file of external messages.

The delete requests transmitted in step 4.2 were logged.  The “Invalid Delete
Request...” alerts were also logged.

4.5 Obtain an NTS delog of 99/02’s.

SRMs containing the appropriate result/explanation codes were transmitted to the
customers.
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1.7.1.12 Detailed Test Procedure for Test Item INCC110-B1.12
VALID WAIT- LIST REQUESTS/SRMS [99/24, 99/02]
CSCI 1601

Pass/Fail Criteria

• The NCCDS receives and stores valid customer-initiated Wait-List requests.

• Valid Wait-List requests are properly logged.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to Wait-List requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create a valid Wait-List request.  Refer to 530-ICD-NCCDS/MOC for the
valid format and content of Wait-List Requests.

2.0 VALID REQUESTS

2.1 From NTS, transmit the valid Wait-List request to the NCCDS.

2.2 Perform a database query of Schedule Request information.

The Wait-List request transmitted in step 2.1 is stored in the database as a valid
request.

2.3 Use a UNIX editor to review the log file of external messages.

The Wait-List request transmitted in step 2.1 was properly logged.

2.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 26:00 was transmitted to the
customer.
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1.7.1.13 Detailed Test Procedure for Test Item INCC110-B1.13
INVALID WAIT- LIST REQUESTS/SRMS [99/24, 99/02]
CSCI 1601

Pass/Fail Criteria

• The NCCDS receives and partially validates invalid customer-initiated Wait-List
requests.

• The operator is appropriately alerted when Wait-List requests do not pass validation.

• Invalid Wait-List requests are stored in the database (except for syntax errors).

• Invalid Wait-List requests (except for syntax errors) are properly logged.

• SRMs containing the appropriate result/explanation codes are transmitted to the
applicable customers in response to Wait-List requests.  [This is an Output Subsystem
criteria.]

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, create a Wait-List request that specifies a Expiration Time of 97DDD006000,
where DDD is 2 days in the future.

1.3 From NTS, create a Wait-List request that specifies a Referenced Request ID associated
with a delete request.

2.0 INVALID REQUESTS - SYNTAX ERROR

2.1 From NTS, transmit the Wait-List request created in step 1.2 to the NCCDS.

The operator receives an alert in the format “Invalid Wait List Request %s: %s’”,
where the first %s is the request ID and the second the reason the request was
rejected.

2.2 Perform a database query of the Schedule Request information.

The Wait-List request transmitted in step 2.1 was not stored in the database.

2.3 Use a UNIX editor to review the log file of external messages.

The Wait-List request transmitted in step 2.1 was not logged.  The “Invalid Wait
List Request...” alert was logged.
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2.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 10:18 was transmitted to the
customer.

3.0 INVALID REQUESTS

3.1 From NTS, transmit the Wait-List request created in step 1.3 to the NCCDS.

The operator receives an alert in the format “Invalid Wait List Request %s: %s’”,
where the first %s is the request ID and the second the reason the request was
rejected.

3.2 Perform a database query of the Schedule Request information.

The Wait-List request transmitted in step 3.1 is stored in the database as an invalid
request.

3.3 Use a UNIX editor to review the log file of external messages.

The Wait-List request transmitted in step 3.1 was properly logged.  The “Invalid
Wait List Request...” alert was also logged.

3.4 Obtain an NTS delog of 99/02’s.

An SRM containing result/explanation code 10:xx was transmitted to the
customer.
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1.8 Test Case INCC112 - SPSR: Output

1.8.1 Detailed Test Procedures for Test Case INCC112

1.8.1.1 Detailed Test Procedure for Test Item INCC112-B1.1
INITIAL ACTIVATION MODE TRANSMISSION
CSCI 1603

Pass/Fail Criteria:

• Initial activation mode transmissions are successfully accomplished.

• The operator has the capability to select any set of SICs or destinations for which
schedule transmissions can be inhibited or enabled.

• The operator has the capability to add events to or remove events from a schedule
transmission.

• The operator has the capability to add or remove destinations to which schedules can be
transmitted.

• The operator has the capability to delay the transmission of schedules until a specified
time.

• • The operator is able to view the status of transmissions.

• • Completed transmissions are removed from the queue.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Submit SARs for the batch scheduling period.

1.3 Generate a batch schedule containing the requests.

1.4 Select “Batch Schedules” from the Scheduling subpanel on the Main Panel.

The Batch Scheduling window appears and contains the Schedule Name, Earliest
Start Time, Latest Stop Time, Activated Time, #Events, #Requests, #Declined
Requests, and the #Conflicts.  The “Opened” time reflects the time the window
was opened.  Editing is disabled.  All buttons except the “Close” button are
dimmed.

1.5 Enable editing, select the Schedule Name of the batch schedule generated above, and
click the “Activate” button.

The “Activate” button is activated upon schedule selection.  The selected batch
schedule is activated.  The Schedule Activation Omitted Requests and Schedule
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Activation Conflicts windows pop up automatically if there are any omitted
requests or conflicts.  The Schedule Activation Dialog window pops up
automatically with the Schedule Name selected.  Editing is enabled.  All buttons
are active.

1.6 Click the “Activate” button.

The selected batch schedule is activated, the window closes, and control returns to
the Batch Scheduling window.

2.0 INHIBIT/ENABLE SCHEDULE DESTINATIONS

2.1 Select “Transmission” from the Scheduling subpanel on the Main Panel.

The Schedule Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.2 Enable editing, select the batch schedule information to be modified, and click the
“Inhibit/Enable Destinations...” button.

The “Inhibit/Enable Destinations...” button is activated upon batch schedule
selection.  The Inhibit/Enable Transmission Destinations window appears and
contains a list of SICs that can be inhibited for Schedule messages associated with
the selected transmission.  It also contains a list of Destinations to which All
Schedule messages can be inhibited or enabled.  The “Opened” time reflects the
time the window was opened.  Editing is enabled.  All buttons except the “Close”
button are dimmed.

2.3 Select a SIC from the Existing SICs list, and click the “Add” button.  Select a SIC from
the list of SICs and click the “Remove” button.

Existing SICs that are added appear in the list of SICs and SICs that are removed
no longer appear in the list of SICs.  The “Add” and “Remove” buttons are
activated upon selection of SICs.

2.4 Select from the list of SICs a SIC for which schedules are currently enabled and click the
“Toggle Schedule” button.

The selected SIC is inhibited.  An indicator appears in the Schedule column to
indicate that schedules will not be transmitted for the selected SIC.  The “Toggle
Schedule” button is activated after the selection is made.

2.5 Select from the Destinations list, the Name of a destination to which All Schedules are
currently enabled and click the appropriate “Toggle Schedule” button.

The selected Destination is inhibited.  An indicator appears in the All Schedule
column to indicate that the destination will not receive schedule transmissions.
The “Toggle Schedule” button is activated after the selection is made.



2/6/97  6:31 PM INCC112-3 530-ITP-NCCDS/1998

2.6 Repeat steps 2.4 and 2.5 to enable selected SICs and Destinations.

The indicators are updated to reflect that the selected SICs and destinations are
now enabled.

2.7 Click the “Save” button followed by the “Close” button.

The inhibit/enable status updates are saved, the window closes and control returns
to the Schedule Transmission window.

2.8 Re-access the Inhibit/Enable Transmission Destinations window.

The updates have been saved.

2.9 Click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

3.0 ADD/REMOVE EVENTS/DESTINATIONS, DELAY TRANSMISSION

3.1 From the Schedule Transmission window, select the event information to be modified,
and click the “Add...” button.

The “View...” and “Add...” buttons were activated when editing was previously
enabled.  The Schedule Transmission Details window appears and contains a list
of the Events/Requests to be included in the transmission.  The list contains the
Events/Requests submitted above.  The “Opened” time reflects the time the
window was opened.  Editing is enabled.  The “Add...” and “Close” buttons are
active.  Will a “Close” button be added to the window?

3.2 Select the Events/Requests associated with the above batch schedule transmission and
click the “Add...” button.

The Add Transmission Information window appears and contains the default
events selected for the batch schedule transmission.  The “Opened” time reflects
the time the window was opened.  Editing is enabled.  The “Cancel” button is
active.

3.3 Enter the Start and Stop time of the range of events to be added.  Position the cursor over
the Customer box down arrow and click the left button, select the Customer, position the
cursor over the Customer box up arrow and click the left button.

The “Add to Transmission” button is activated when cursor is placed in the Start
time field.  The selected Customer appears in the Customer option menu label.

3.4 Repeat the above step for the desired Function, Class, and TDRS to be included in the
added events and click the “Add to Transmission” button.

The events are added to the transmission, the window closes, and control returns
to the Schedule Transmission Details window.  The Start time, Stop time and
TDRS columns are updated to reflect the additional events.



2/6/97  6:31 PM INCC112-4 530-ITP-NCCDS/1998

3.5 Select an Event/Request to be removed and click the “Remove” button.

The “Remove” button is activated upon selection.  The selected Event/Request is
removed from the transmission.

3.6 Select a destination from the Destinations list and click the “Remove” button next to the
Destinations list.  Repeat for another destination.

The Destinations list contains a list of destinations currently included in the
selected transmission.  The destinations are removed from the Destinations list.
The “Remove” button is activated upon selection of the destination.

3.7 Select from the Existing Destinations list, one of the destinations that was removed above
and click the “Add” button.

The Existing Destination is added to the Destinations list.  The “Add” button is
activated upon selection of the destination.

3.8 Position the cursor over the minutes of the Delay time component and use the arrows to
change the time.  Set the time to 5 minutes in the future.

The time is increased when the UP arrow is clicked and decreased when the
DOWN arrow is clicked.  The execution of the schedule transmission will be
delayed until the specified time.  The arrows are activated when the cursor is
positioned in the Delay time component.

3.9 Click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

3.10 Click the “Close” button.

The window closes and control returns to the Main Panel.

Note: Section 4.0 may not be executable in Build B if Schedule Status window is not
delivered until Build C.

4.0 VIEW SCHEDULE TRANSMISSION STATUS

4.1 Click the “Schedule Status” subpanel on the Main Panel.

The Schedule Transmission Status window appears and contains the transmission
status of selected ongoing transmissions.

4.2 Select the batch schedule to view the status of the schedule transmission.

A list of the transmission’s destinations is displayed.  A status bar shows the
number of bytes that have been sent so far.  The status and progress of the
transmission is correctly displayed.  The initial activation mode transmissions are
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at first delayed, but begin transmitting at the specified time and complete
successfully.

4.3 Monitor alerts for the initial activation mode transmissions.

The operator is alerted upon the transmission completion.

4.4 Review schedule transmission queue.

The completed transmissions are no longer part of the queue.

4.5 Perform an NCC delog for the timespan of the initial activation mode transmissions.

Messages are not sent to the destinations that were inhibited.

4.6 From the Schedule Transmission Status window, click the “Close” button.

The window closes and control returns to the Main Panel.

5.0 CLEANUP

5.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.

6.0 DELOG ANALYSIS

6.1 Using the UNIX editor, review all schedule transmission data.

All schedule data selected is transmitted at the time specified by the Delay.  The
format and content of the applicable messages are correct and indicates that data
was properly logged.
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1.8.1.2 Detailed Test Procedure for Test Item INCC112-B1.2
TRANSMIT NORMAL FIXED USMs (94/01)
CSCI 1603

Pass/Fail Criteria:

• Normal Fixed USMs are successfully transmitted to the customer.

• The format and content of a Normal Fixed USM to the customer is correct.

• Outgoing messages are successfully logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following groups: SCHXMIT
(edit privilege to all the schedule transmission windows), REQEDIT (edit privilege to all
the schedule request windows), and SCHALRT (schedule alert messages).

1.3 Schedule fixed events with start times more than 45 minutes in the future.  The events
should include:

Baseline and full-support customers

TDRSs supported by both ground terminals

Several service types (including MAF, SSAR, and KuSAF, excluding EET)

2.0 TRANSMIT NORMAL FIXED USMs

2.1 Select “Transmission” from the Scheduling subpanel on the Main Panel.

The Schedule Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.2 Select the schedule submitted above and click the “View...” button.

The “View...” button is activated upon schedule selection.  The Schedule
Transmission Details window appears and contains a list of the Events/Requests
to be included in the transmission.  The list contains the Events/Requests
submitted above.  The “Opened” time reflects the time the window was opened.
Editing is disabled.  All buttons except the “Close” button are dimmed.  Will a
“Close” button be added to the window?
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2.3 Enable editing, select the Events/Requests scheduled above for transmission to the
customer (the Destinations list should contain the name of the customer).  Click the
“Execute” button.

The “Execute” button is activated upon selection of the Events/Requests.  The
schedule is transmitted to the destinations in the Destinations list.  The schedule is
not transmitted to the destinations that are not selected.  Acknowledgments are
properly received.  The operator is alerted when transmission is initiated
(‘Transmission initiated’) and completed (‘Transmission completed’).

2.4 Click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

2.5 Use a UNIX editor to review the log file of outgoing messages.

The Normal Fixed USMs were successfully logged.

2.6 Perform NCC and NTS delogs of 94/01s.

A 94/01 was transmitted to the customer for each event.  The format and content
of each message is correct and consistent between delogs.
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1.8.1.3 Detailed Test Procedure for Test Item INCC112-B1.3
TRANSMIT PREMIUM FIXED USMs (94/02)
CSCI 1603

Pass/Fail Criteria:

• Premium Fixed USMs are successfully transmitted to the customer.

• The format and content of a Premium Fixed USM to the customer is correct.

• Outgoing messages are successfully logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following groups: SCHXMIT
(edit privilege to all the schedule transmission windows), REQEDIT (edit privilege to all
the schedule request windows), and SCHALRT (schedule alert messages).

1.3 Schedule fixed events with start times less than 45 minutes in the future.  The events
should include:

Baseline and full-support customers

TDRSs supported by both ground terminals

Several service types (including SSAF, KuSAR and KaSAR, excluding EET)

2.0 TRANSMIT PREMIUM FIXED USMs

2.1 Select “Transmission” from the Scheduling subpanel on the Main Panel.

The Schedule Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.2 Select the schedule submitted above and click the “View...” button.

The “View...” button is activated upon schedule selection.  The Schedule
Transmission Details window appears and contains a list of the Events/Requests
to be included in the transmission.  The list contains the Events/Requests
submitted above.  The “Opened” time reflects the time the window was opened.
Editing is disabled.  All buttons except the “Close” button are dimmed.  Will a
“Close” button be added to the window?
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2.3 Enable editing, select the Events/Requests scheduled above for transmission to the
customer (the Destinations list should contain the name of the customer).  Click the
“Execute” button.

The “Execute” button is activated upon selection of the Events/Requests.  The
schedule is transmitted to the destinations in the Destinations list.  The schedule is
not transmitted to the destinations that are not selected.  Acknowledgments are
properly received.  The operator is alerted when transmission is initiated
(‘Transmission initiated’) and completed (‘Transmission completed’).

2.4 Click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

2.5 Use a UNIX editor to review the log file of outgoing messages.

The Premium Fixed USMs were successfully logged.

2.6 Perform NCC and NTS delogs of 94/02s.

A 94/02 was transmitted to the customer for each event.  The format and content
of each message is correct and consistent between delogs.
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1.8.1.4 Detailed Test Procedure for Test Item INCC112-B1.4
TRANSMIT SIMULATION FIXED USMs (94/03)
CSCI 1603

Pass/Fail Criteria:

• Simulation Fixed USMs are successfully transmitted to the customer.

• The format and content of a Simulation Fixed USM to the customer is correct.

• Outgoing messages are successfully logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following groups: SCHXMIT
(edit privilege to all the schedule transmission windows), REQEDIT (edit privilege to all
the schedule request windows), and SCHALRT (schedule alert messages).

1.3 Schedule fixed events of no specific length requirement, with start times that are no
specific amount of time in the past or future.  The events should include:

Baseline and full-support customers

TDRSs supported by both ground terminals

EET services

Tracking and Playback services

Local and DIS services

2.0 TRANSMIT SIMULATION FIXED USMs

2.1 Select “Transmission” from the Scheduling subpanel on the Main Panel.

The Schedule Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.2 Select the schedule submitted above and click the “View...” button.

The “View...” button is activated upon schedule selection.  The Schedule
Transmission Details window appears and contains a list of the Events/Requests
to be included in the transmission.  The list contains the Events/Requests
submitted above.  The “Opened” time reflects the time the window was opened.
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Editing is disabled.  All buttons except the “Close” button are dimmed.  Will a
“Close” button be added to the window?

2.3 Enable editing, select the Events/Requests scheduled above for transmission to the
customer (the Destinations list should contain the name of the customer).  Click the
“Execute” button.

The “Execute” button is activated upon selection of the Events/Requests.  The
schedule is transmitted to the destinations in the Destinations list.  The schedule is
not transmitted to the destinations that are not selected.  Acknowledgments are
properly received.  The operator is alerted when transmission is initiated
(‘Transmission initiated’) and completed (‘Transmission completed’).

2.4 Click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

2.5 Use a UNIX editor to review the log file of outgoing messages.

The Simulation Fixed USMs were successfully logged.

2.6 Perform NCC and NTS delogs of 94/03s.

A 94/03 was transmitted to the customer for each event.  The format and content
of each message is correct and consistent between delogs.
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1.8.1.5 Detailed Test Procedure for Test Item INCC112-B1.5
TRANSMIT NORMAL FLEXIBLE USMs (94/04)
CSCI 1603

Pass/Fail Criteria:

• Normal Flexible USMs are successfully transmitted to the customer.

• The format and content of a Normal Flexible USM to the customer is correct.

• Outgoing messages are successfully logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the Scheduling group.

1.3 Schedule flexible events with start times more than 45 minutes in the future.  The events
need not specify flexibility for a particular resource.  The events should include:

Baseline and full-support customers

TDRSs supported by both ground terminals

Several service types (including KaSAF, excluding EET)

1.4 Schedule flexible events with start times more than 45 minutes in the future.  The events
should specify:

Baseline and full-support customers

A TDRS Set rather than a specific TDRS

SA Antenna flexibility

Several service types (including MAR, SMAR, excluding EET)

An SSC that provided a list of User Interface Channel IDs rather than an
individual one

2.0 TRANSMIT NORMAL FLEXIBLE USMs - RESOURCE NOT SPECIFIED

2.1 Select “Transmission” from the Scheduling subpanel on the Main Panel.

The Schedule Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.



2/6/97  6:31 PM INCC112-13 530-ITP-NCCDS/1998

2.2 Select the schedule submitted in step 1.3 and click the “View...” button.

The “View...” button is activated upon schedule selection.  The Schedule
Transmission Details window appears and contains a list of the Events/Requests
to be included in the transmission.  The list contains the Events/Requests
submitted above.  The “Opened” time reflects the time the window was opened.
Editing is disabled.  All buttons except the “Close” button are dimmed.  Will a
“Close” button be added to the window?

2.3 Enable editing, select the Events/Requests scheduled in step 1.3 for transmission to the
customer (the Destinations list should contain the name of the customer).  Click the
“Execute” button.

The “Execute” button is activated upon selection of the Events/Requests.  The
schedule is transmitted to the destinations in the Destinations list.  The schedule is
not transmitted to the destinations that are not selected.  Acknowledgments are
properly received.  The operator is alerted when transmission is initiated
(‘Transmission initiated’) and completed (‘Transmission completed’).  Editing is
enabled.

2.4 Click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

2.5 Use a UNIX editor to review the log file of outgoing messages.

The Normal Flexible USMs were successfully logged.

2.6 Perform NCC and NTS delogs of 94/04s.

A 94/04 was transmitted to the customer for each event.  The format and content
of each message is correct and consistent between delogs.

3.0 TRANSMIT NORMAL FLEXIBLE USMs - RESOURCE PARAMETERS SPECIFIED

3.1 From the Schedule Transmission window, select the schedule submitted in step 1.4 and
click the “View...” button.

The “View...” button is activated upon schedule selection.  The Schedule
Transmission Details window appears and contains a list of the Events/Requests
to be included in the transmission.  The list contains the Events/Requests
submitted above.  The “Opened” time reflects the time the window was opened.
Editing is disabled.  All buttons except the “Close” button are dimmed.  Will a
“Close” button be added to the window?
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3.2 Enable editing, select the Events/Requests scheduled in step 1.4 for transmission to the
customer (the Destinations list should contain the name of the customer).  Click the
“Execute” button.

The “Execute” button is activated upon selection of the Events/Requests.  The
schedule is transmitted to the destinations in the Destinations list.  The schedule is
not transmitted to the destinations that are not selected.  Acknowledgments are
properly received.  The operator is alerted when transmission is initiated
(‘Transmission initiated’) and completed (‘Transmission completed’).  Editing is
enabled.

3.3 Click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

3.4 Use a UNIX editor to review the log file of outgoing messages.

The Normal Flexible USMs were successfully logged.

3.5 Perform NCC and NTS delogs of 94/04s.

A 94/04 was transmitted to the customer for each event.  The TDRS Set rather
than a specific TDRS, a specific SA antenna, and a specific User Interface
Channel ID are specified in the flexible USM.  The MAR and SMAR Link ID
parameters are filled with spaces.
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1.8.1.6 Detailed Test Procedure for Test Item INCC112-B1.6
TRANSMIT SIMULATION FLEXIBLE USMs (94/05)
CSCI 1603

Pass/Fail Criteria:

• Simulation Flexible USMs are successfully transmitted to the customer.

• The format and content of a Simulation Flexible USM to the customer is correct.

• Outgoing messages are successfully logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following groups: SCHXMIT
(edit privilege to all the schedule transmission windows), REQEDIT (edit privilege to all
the schedule request windows), and SCHALRT (schedule alert messages).

1.3 Schedule flexible events of no specific length requirement, with start times that are no
specific amount of time in the past or future.  The events should include:

Baseline and full-support customers

TDRSs supported by both ground terminals

EET services

Tracking and Playback services

Local and DIS services

2.0 TRANSMIT SIMULATION FLEXIBLE USMs

2.1 Select “Transmission” from the Scheduling subpanel on the Main Panel.

The Schedule Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.2 Select the schedule submitted above and click the “View...” button.

The “View...” button is activated upon schedule selection.  The Schedule
Transmission Details window appears and contains a list of the Events/Requests
to be included in the transmission.  The list contains the Events/Requests
submitted above.  The “Opened” time reflects the time the window was opened.
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Editing is disabled.  All buttons except the “Close” button are dimmed.  Will a
“Close” button be added to the window?

2.3 Enable editing, select the Events/Requests scheduled above for transmission to the
customer (the Destinations list should contain the name of the customer).  Click the
“Execute” button.

The “Execute” button is activated upon selection of the Events/Requests.  The
schedule is transmitted to the destinations in the Destinations list.  The schedule is
not transmitted to the destinations that are not selected.  Acknowledgments are
properly received.  The operator is alerted when transmission is initiated
(‘Transmission initiated’) and completed (‘Transmission completed’).

2.4 Click the “Close” button.

The window closes and control returns to the Schedule Transmission window.

2.5 Use a UNIX editor to review the log file of outgoing messages.

The Simulation Flexible USMs were successfully logged.

2.6 Perform NCC and NTS delogs of 94/05s.

A 94/05 was transmitted to the customer for each event.  The format and content
of each message is correct and consistent between delogs.
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1.9 Test Case INCC113 - SPSR: Acquisition & Tracking

1.9.1 Detailed Test Procedures for Test Case INCC113

1.9.1.1 Detailed Test Procedure for Test Item INCC113-B1.1
RECEIVE VALID VECTORS (03/10)
CSCI 1601

Pass/Fail Criteria:

• The NCCDS can receive, validate, and store vectors.

• The operator is alerted on receipt of valid vectors.

• Vectors are properly logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following Acquisition and
Tracking (ACQ/TRK) groups: IIRVXMIT (edit privilege to all the vector transmission
windows), IIRVDATA (edit privilege to all the vector storage windows), and IIRVALRT
(vector alert messages).

2.0 RECEIVE, VALIDATE, AND STORE VECTORS

2.1 From NTS, transmit valid IIRVs (03/10) to the NCCDS.

The operator receives all expected alerts upon receipt of vectors (‘Spacecraft State
Vector Transmission was received for SIC:%s from %s’) and when 30 seconds
pass without receipt of an IIRV from the same source.  The alerts contain the
contents of the transmission.  The IIRV messages are validated by the SPSR.

2.2 Select “Vector Transmission” from the Data Dissemination subpanel on the Main Panel.

The Vector Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.3 Select the appropriate IIRV transmission and click the “View...” button.

The “View...” button is activated upon IIRV selection.  The Vector Transmission
Details window appears and contains the Mode of the transmission and the
Transmission Contents.  The Transmission Contents contain the appropriate
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vector information.  The “Opened” time reflects the time the window was opened.
Editing is disabled.  All buttons except the “Close” button are dimmed.  Will a
“Close” button be added to the window?

2.4 Select “Vector Storage” from the Data Dissemination subpanel on the Main Panel.

The Vector Storage window appears and contains the SIC, Type of vector,
Storage Area, Epoch Time, Received time, and other vector data associated with
the selected transmission.  The vector data is presented to the operator in
ascending time order.  The Storage Area indicates primary.  The “Opened” time
reflects the time the window was opened.  Editing is disabled.  All buttons except
the “Close” button are dimmed.

2.5 From the Vector Storage window, click the “Close” button.  From the Vector
Transmission Details window, click the “Close” button.  Will a “Close” button be
added to the window?

All windows close and control returns to the Vector Transmission window.

2.6 Click the “Close” button.

The window closes and control returns to the Main Panel.

3.0 DELOG ANALYSIS

3.1 Use a UNIX editor to review all vectors.

The format and content of the logged messages is correct and indicates that
vectors are properly logged.
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1.9.1.2 Detailed Test Procedure for Test Item INCC113-B1.2
RECEIVE INVALID VECTORS (03/10)
CSCI 1601

Pass/Fail Criteria:

• The NCCDS can receive and validate vectors.

• The operator is alerted on receipt of invalid vectors.

• The NCCDS does not store invalid vectors.

• Vectors are properly logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following Acquisition and
Tracking (ACQ/TRK) groups: IIRVXMIT (edit privilege to all the vector transmission
windows), IIRVDATA (edit privilege to all the vector storage windows), and IIRVALRT
(vector alert messages).

2.0 INVALID VECTORS

2.1 From NTS, transmit invalid IIRVs (03/10) with a Vector Type other than 1-8 to the
NCCDS.

The IIRV messages are validated by the SPSR.  The operator receives all expected
alerts upon receipt of vectors (‘Invalid %s has been received: %s’) stating the
reason the IIRV messages are invalid.  The alerts contain the contents of the
transmission.

2.2 Select “Vector Transmission” from the Data Dissemination subpanel on the Main Panel.

The Vector Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.3 Select the appropriate IIRV transmission and click the “View...” button.

The “View...” button is activated upon IIRV selection.  The Vector Transmission
Details window appears and contains the Mode of the transmission and the
Transmission Contents.  The “Opened” time reflects the time the window was
opened.  Editing is disabled.  All buttons except the “Close” button are dimmed.
Will a “Close” button be added to the window?
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2.4 Select “Vector Storage” from the Data Dissemination subpanel on the Main Panel.

The Vector Storage window appears.  The invalid IIRV messages received above
are not stored by the SPSR data base.  The “Opened” time reflects the time the
window was opened.  Editing is disabled.  All buttons except the “Close” button
are dimmed.

2.5 From the Vector Storage window, click the “Close” button.  From the Vector
Transmission Details window, click the “Close” button.  Will a “Close” button be
added to the window?

All windows close and control returns to the Vector Transmission window.

2.6 Click the “Close” button.

The window closes and control returns to the Main Panel.

3.0 DELOG ANALYSIS

3.1 Using the UNIX editor, review all vectors.

The format and content of the logged messages is correct and indicates that
vectors are properly logged.
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1.9.1.3 Detailed Test Procedure for Test Item INCC113-B1.3
RECEIVE VALID MANEUVER SEQUENCES (03/15)
CSCI 1601

Pass/Fail Criteria:

• The NCCDS can receive, validate, and store maneuver sequences.

• The operator is alerted on receipt of valid maneuver sequences.

• Maneuver sequences are properly logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following Acquisition and
Tracking (ACQ/TRK) groups: IIRVXMIT (edit privilege to all the vector transmission
windows), IIRVDATA (edit privilege to all the vector storage windows), and IIRVALRT
(vector alert messages).

2.0 RECEIVE, VALIDATE, AND STORE MANEUVER SEQUENCES

2.1 From NTS, transmit valid maneuver sequences (03/15) to the NCCDS.

The operator receives all expected alerts upon receipt of maneuver sequences
(‘Spacecraft State Vector Transmission was received for SIC:%s from %s’).  The
alerts contain the contents of the transmission.  The maneuver sequences are
validated by the SPSR.

2.2 Select “Vector Transmission” from the Data Dissemination subpanel on the Main Panel.

The Vector Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.3 Select the appropriate maneuver sequence transmission and click the “View...” button.

The “View...” button is activated upon maneuver sequence selection.  The Vector
Transmission Details window appears and contains the Mode of the transmission
and the Transmission Contents.  The Transmission Contents contain the
appropriate maneuver sequence vector information.  The “Opened” time reflects
the time the window was opened.  Editing is disabled.  All buttons except the
“Close” button are dimmed.  Will a “Close” button be added to the window?
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2.4 Select “Vector Storage” from the Data Dissemination subpanel on the Main Panel.

The Vector Storage window appears and contains the SIC, Type of vector,
Storage Area, Epoch Time, Received time, and other vector data associated with
the selected transmission.  The maneuver sequence data is presented to the
operator in ascending time order.  The Storage Area indicates primary.  The
“Opened” time reflects the time the window was opened.  Editing is disabled.  All
buttons except the “Close” button are dimmed.

2.5 From the Vector Storage window, click the “Close” button.  From the Vector
Transmission Details window, click the “Close” button.  Will a “Close” button be
added to the window?

All windows close and control returns to the Vector Transmission window.

2.6 Click the “Close” button.

The window closes and control returns to the Main Panel.

3.0 DELOG ANALYSIS

3.1 Using the UNIX editor, review all maneuver sequences.

The format and content of the logged messages is correct and indicates that
maneuver sequences are properly logged.
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1.9.1.4 Detailed Test Procedure for Test Item INCC113-B1.4
RECEIVE INVALID MANEUVER SEQUENCES (03/15)
CSCI 1601

Pass/Fail Criteria:

• The NCCDS can receive and validate maneuver sequences.

• The operator is alerted on receipt of invalid maneuver sequences.

• The NCCDS does not store invalid maneuver sequences.

• Maneuver sequences are properly logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following Acquisition and
Tracking (ACQ/TRK) groups: IIRVXMIT (edit privilege to all the vector transmission
windows), IIRVDATA (edit privilege to all the vector storage windows), and IIRVALRT
(vector alert messages).

2.0 INVALID MANEUVER SEQUENCES

2.1 From NTS, transmit an invalid maneuver sequence (03/15) containing less than 7 vectors
to the NCCDS.

The maneuver sequence is validated by the SPSR.  The operator receives all
expected alerts upon receipt of the maneuver sequence (‘Invalid %s has been
received: %s’) stating the reason it was invalid.  The alerts contain the contents of
the transmission.

2.2 Select “Vector Transmission” from the Data Dissemination subpanel on the Main Panel.

The Vector Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.3 Select the appropriate maneuver sequence transmission and click the “View...” button.

The “View...” button is activated upon maneuver sequence selection.  The Vector
Transmission Details window appears and contains the Mode of the transmission
and the Transmission Contents.  The “Opened” time reflects the time the window
was opened.  Editing is disabled.  All buttons except the “Close” button are
dimmed.  Will a “Close” button be added to the window?
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2.4 Select “Vector Storage” from the Data Dissemination subpanel on the Main Panel.

The Vector Storage window appears.  The invalid maneuver sequence received
above is not stored by the SPSR data base. The “Opened” time reflects the time
the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.5 From the Vector Storage window, click the “Close” button.  From the Vector
Transmission Details window, click the “Close” button.  Will a “Close” button be
added to the window?

All windows close and control returns to the Vector Transmission window.

2.6 Click the “Close” button.

The window closes and control returns to the Main Panel.

3.0 DELOG ANALYSIS

3.1 Using the UNIX editor, review all maneuver sequences.

The format and content of the logged messages is correct and indicates that
maneuver sequences are properly logged.
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1.9.1.5 Detailed Test Procedure for Test Item INCC113-B1.5
MOVE STORED VECTORS
CSCI 1601

Pass/Fail Criteria:

• The operator can move stored vectors between primary and secondary storage.

• Duplicate vectors are automatically moved from primary to secondary storage.

• The operator is alerted upon a change in vector storage area.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following Acquisition and
Tracking (ACQ/TRK) groups: IIRVXMIT (edit privilege to all the vector transmission
windows), IIRVDATA (edit privilege to all the vector storage windows), and IIRVALRT
(vector alert messages).

2.0 MOVING STORED VECTOR DATA

2.1 Select “Vector Storage” from the Data Dissemination subpanel on the Main Panel.

The Vector Storage window appears and contains the SIC, Type of vector,
Storage Area, Epoch Time, Received time, and other vector data associated with
stored vectors and maneuver sequences.  The vector data is presented to the
operator in ascending time order.  The “Opened” time reflects the time the
window was opened.  Editing is disabled.  All buttons except the “Close” button
are dimmed.

2.2 Enable editing, select a primary Storage Area vector, and click the “Modify...” button.

The “View...”, “Add...”, and “Close” buttons are activated when editing is
enabled.  The remaining buttons are activated upon vector selection.  The Vector
Editor window appears and contains detailed vector information such as the Type
of storage, and the X, Y, and Z Component Position and Velocity for the selected
vector.  The Type toggle button for Primary storage is depressed.  The “Opened”
time reflects the time the window was opened.  Editing is enabled.  All buttons are
active.
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2.3 Click the Type toggle button for Secondary storage.  Click the “Save” button.

The operator is alerted of the move.  The window closes and control returns to
the Vector Storage window.  The Storage Area field indicates that the data for the
selected vector was successfully moved from primary to secondary storage.

2.4 Select the same vector for the same SIC and click the “View...” button.

The Vector Editor window appears and contains detailed vector information such
as the Type of storage, and the X, Y, and Z Component Position and Velocity for
the selected vector.  The vector data previously moved from primary to secondary
storage appears.  The Type toggle button for Secondary storage is depressed.

2.5 Click the “Cancel” button.

The window closes and control returns to the Vector Storage window.

2.6 Select a secondary Storage Area vector whose Epoch Time conflicts with any same SIC
primary Storage Area vector (epoch time of primary storage vector is >= that of earliest
vector within moved set and <= latest vector within moved set).  Click the “Modify...”
button.

The Vector Editor window appears and contains detailed vector information such
as the Type of storage, and the X, Y, and Z Component Position and Velocity for
the selected vector.  The Type toggle button for Secondary storage is depressed.

2.7 Click the Type toggle button for Primary storage.  Click the “Save” button.

The operator is alerted (Vectors moved from secondary for SIC:%s have
conflicting epoch time with previously stored vectors’) of the conflict.  The
window closes and control returns to the Vector Storage window.  The vector data
for the vector with the conflicting Epoch Time still appears.

2.8 Select the vector moved to secondary storage in step 2.3 and click the “Modify...” button.

The Vector Editor window appears and contains detailed vector information such
as the Type of storage, and the X, Y, and Z Component Position and Velocity for
the selected vector.  The Type toggle button for Secondary storage is depressed.

2.9 Click the Type toggle button for Primary storage.  Click the “Save” button.

The operator is alerted that the data was moved back to the primary storage
area.  The window closes and control returns to the Vector Storage window.  The
Storage Area field indicates that the data for the selected vector was successfully
moved from the secondary to the primary storage area.

2.10 Click the “Close” button.

The window closes and control returns to the Main Panel.
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3.0 TRANSMIT DUPLICATE VECTORS

3.1 From NTS, transmit vectors to the NCCDS with epoch times that are duplicates of
primary storage vectors.  The earliest vector in the transmission should have an epoch
time less than or equal to the epoch time of a previously stored vector.

An alert (‘Epoch time for newly stored transmission for SIC:%s less than
previously stored vectors in primary.  Previous vectors moved to secondary’) is
received stating that the new vectors received have a duplicate epoch time.

3.2 Select “Vector Storage” from the Data Dissemination subpanel on the Main Panel.

The Vector Storage window appears and contains the SIC, Type of vector,
Storage Area, Epoch Time, Received time, and other vector data associated with
the selected transmission.  All same SIC (Customer) vectors previously stored in
the primary Storage Area with an Epoch Time greater than or equal to the earliest
vector received are automatically moved to the secondary Storage Area.  The
duplicate primary Storage Area vectors that were transmitted are now stored in the
primary Storage Area.

3.3 From NTS, transmit another vector with an epoch time that is a duplicate of vectors
stored in secondary storage.

3.4 From the Vector Storage window, click the “Close” button.

The window closes and control returns to the Main Panel.

3.5 Re-access the Vector Storage window.

The Vector Storage window appears and contains the SIC, Type of vector,
Storage Area, Epoch Time, Received time, and other vector data associated with
the selected transmission.  The duplicate secondary storage vector transmitted
above is stored in the secondary Storage Area, indicating that duplicate Epoch
Times in secondary storage are allowed.

3.6 Click the “Close” button.

The window closes and control returns to the Main Panel.
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1.9.1.6 Detailed Test Procedure for Test Item INCC113-B1.6
MANUAL TRANSMISSION OF ACQ/TRK DATA
CSCI 1603

Pass/Fail Criteria:

• The operator can select any set of vectors or maneuver sequences for immediate
transmission to the ground terminals.

• The operator is alerted upon transmission initiation and completion of vectors or
maneuver sequences to the ground terminals.

• Manually transmitted acquisition and tracking data is properly logged.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following Acquisition and
Tracking (ACQ/TRK) groups: IIRVXMIT (edit privilege to all the vector transmission
windows), IIRVDATA (edit privilege to all the vector storage windows), and IIRVALRT
(vector alert messages).

2.0 MANUAL TRANSMISSION OF VECTORS

2.1 Select “Vector Transmission” from the Data Dissemination subpanel on the Main Panel.

The Vector Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.2 Select an IIRV transmission and click the “View...” button.

The “View...” button is activated upon IIRV selection.  The Vector Transmission
Details window appears and contains the Mode of the transmission and the
Transmission Contents.  The Transmission Contents contain the appropriate
vector information.  The “Opened” time reflects the time the window was opened.
Editing is disabled.  All buttons except the “Close” button are dimmed.  Will a
“Close” button be added to the window?

2.3 Enable editing, select a SIC (and associated vectors), and transmission destinations (the
Destinations list should contain both ground terminals).  Click the “Execute” button.

The “Execute” button is activated upon selection of the vectors.  The vectors for
selected SICs are manually transmitted to the destinations in the Destinations list
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in ascending vector epoch time order.  No vectors are transmitted for the SICs and
destinations that are not selected.  Acknowledgments are properly received.  The
operator is alerted when transmission is initiated (‘Transmission initiated’) and
completed (‘Transmission completed’).  Editing is enabled.

2.4 Click the “Close” button.

The window closes and control returns to the Vector Transmission window.

3.0 MANUAL TRANSMISSION OF MANEUVER SEQUENCES

3.1 From the Vector Transmission window, select any transmission containing a maneuver
sequence and click the “View...” button.

The “View...” button is activated upon maneuver sequence selection.  The Vector
Transmission Details window appears and contains the Mode of the transmission
and the Transmission Contents.  The Transmission Contents contain the
appropriate maneuver sequence vector information.  All buttons except the
“Close” button are dimmed.  Will a “Close” button be added to the window?

3.2 Enable editing, select any vector in the maneuver sequence, and transmission destinations
(the Destinations list should contain both ground terminals).  Click the “Execute” button.

The “Execute” button is activated upon selection of the maneuver sequence
vector.  The maneuver sequence is manually transmitted to the destinations in the
Destinations list.  No maneuver sequence vectors are transmitted for the SICs and
destinations that are not selected.  Acknowledgments are properly received.  The
operator is alerted when transmission is initiated (‘Transmission initiated’) and
completed (‘Transmission completed’).  Editing is enabled.

3.3 Click the “Close” button.

The window closes and control returns to the Vector Transmission window.

3.4 Click the “Close” button.

The window closes and control returns to the Main Panel.

4.0 DELOG ANALYSIS

4.1 Using the UNIX editor, review all acquisition and tracking data.

All vector and maneuver sequence data selected is transmitted to the destinations
in the Destinations list.  The format and content of the applicable messages are
correct and indicates that data was properly logged.
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1.9.1.7 Detailed Test Procedure for Test Item INCC113-B1.7
MODIFY MANUAL TRANSMISSION OF ACQ/TRK DATA
CSCI 1603

Pass/Fail Criteria:

• The operator has the capability to select any set of SICs or destinations for which
manual transmission of vectors can be inhibited or enabled.

• The operator has the capability to add vectors to or remove vectors from a manual
transmission.

• The operator has the capability to add or remove destinations to which vectors can be
manually transmitted.

• The operator has the capability to delay the manual transmission of vectors until a
specified time.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the following Acquisition and
Tracking (ACQ/TRK) groups: IIRVXMIT (edit privilege to all the vector transmission
windows), IIRVDATA (edit privilege to all the vector storage windows), and IIRVALRT
(vector alert messages).

2.0 INHIBIT/ENABLE VECTOR DESTINATIONS

2.1 Select “Vector Transmission” from the Data Dissemination subpanel on the Main Panel.

The Vector Transmission window appears and contains the creation time, State,
Mode, #Msgs, completion status, and the Creator.  The “Opened” time reflects the
time the window was opened.  Editing is disabled.  All buttons except the “Close”
button are dimmed.

2.2 Enable editing, select the vector information to be modified, and click the “Inhibit/Enable
Destinations...” button.

The “Inhibit/Enable Destinations...” button is activated upon vector selection.
The Inhibit/Enable Transmission Destinations window appears and contains a list
of SICs that can be inhibited for Vectors associated with the selected
transmission.  It also contains a list of Destinations to which All Vector messages
can be inhibited or enabled.  The “Opened” time reflects the time the window was
opened.  Editing is enabled.  All buttons except the “Close” button are dimmed.
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2.3 Select a SIC from the Existing SICs list, and click the “Add” button.  Select a SIC from
the list of SICs and click the “Remove” button.

Existing SICs that are added appear in the list of SICs and SICs that are removed
no longer appear in the list of SICs.  The “Add” and “Remove” buttons are
activated upon selection of SICs.

2.4 Select from the list of SICs a SIC for which vectors are currently enabled and click the
“Toggle Vector” button.

The selected SIC is inhibited.  An indicator appears in the Vector column to
indicate that vectors will not be transmitted for the selected SIC.  The “Toggle
Vector” button is activated after the selection is made.

2.5 Select from the Destinations list, the Name of a destination to which All Vectors are
currently enabled and click the appropriate “Toggle Vector” button.

The selected Destination is inhibited.  An indicator appears in the All Vector
column to indicate that the destination will not receive vector transmissions.  The
“Toggle Vector” button is activated after the selection is made.

2.6 Repeat steps 2.4 and 2.5 to enable selected SICs and Destinations.

The indicators are updated to reflect that the selected SICs and destinations are
now enabled.

2.7 Click the “Save” button followed by the “Close” button.

The inhibit/enable status updates are saved, the window closes and control returns
to the Vector Transmission window.

2.8 Re-access the Inhibit/Enable Transmission Destinations window.

The updates have been saved.

2.9 Click the “Close” button.

The window closes and control returns to the Vector Transmission window.

3.0 ADD/REMOVE VECTORS/DESTINATIONS, DELAY TRANSMISSION

3.1 From the Vector Transmission window, select the vector information to be modified, and
click the “Add...” button.

The “View...” and “Add...” buttons were activated when editing was previously
enabled.  The Vector Transmission Details window appears and contains the
Mode of the transmission and the Transmission Contents.  The “Opened” time
reflects the time the window was opened.  Editing is enabled.  The “Add...” and
“Close” buttons are active.  Will a “Close” button be added to the window?
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3.2 Select the SIC associated with the above IIRV transmission to the NCCDS, and click the
“Add...” button.  Note the Epoch Times of vectors.

The Add Transmission Vectors window appears and contains the vectors currently
included in the selected transmission.  The “Opened” time reflects the time the
window was opened.  Editing is enabled.  The “Cancel” button is active.

3.3 Select additional vectors to be included in the transmission by entering the Epoch Start
Time and Epoch Stop Time of the range of vectors to be added.  Click the “Add to
Transmission” button.

The “Add to Transmission” button is activated when cursor is placed in the Epoch
Start Time field.  The vectors are added to the transmission, the window closes
and control returns to the Vector Transmission Details window.  The Epoch Time
and the # Vectors columns are updated to reflect the additional vectors.

3.4 Select a vector to be removed from the Transmission Contents list and click the
“Remove” button.

The “Remove” button is activated upon selection.  The selected vector is removed
from the transmission.  The # Vectors column is updated to reflect the removed
vector.

3.5 Select one of the ground terminals from the Destinations list and click the “Remove”
button.  Repeat for the other ground terminal.

The Destinations list contains a list of destinations currently included in the
selected transmission.  The destinations are removed from the Destinations list.
The “Remove” button is activated upon selection of the destination.

3.6 Select one of the ground terminals from the Existing Destinations list and click the “Add”
button.

The Existing Destination (ground terminal) is added to the Destinations list.  The
“Add” button is activated upon selection of the destination.

3.7 Position the cursor over the minutes of the Delay time component and use the arrows to
change the time.  Set the time to 5 minutes in the future.

The time is increased when the UP arrow is clicked and decreased when the
DOWN arrow is clicked.  The execution of the vector transmission will be
delayed until the specified time.  The arrows are activated when the cursor is
positioned in the Delay time component.

3.8 Review the outgoing transmission (From where?  Vector Status window not
delivered until Build C).

The vectors are transmitted in ascending vector epoch time order.  No vectors are
transmitted for the SICs or to the destinations that are inhibited.  The vectors that
were added are transmitted and those that were removed are not.  No vectors are
transmitted to the destinations that were removed.  The execution of the vector
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transmission is delayed until the specified time.  Acknowledgments are properly
received.  The operator is alerted when transmission is initiated (‘Transmission
initiated’) and completed (‘Transmission completed’).

3.9 Click the “Close” button.

The window closes and control returns to the Vector Transmission window.

3.10 Click the “Close” button.

The window closes and control returns to the Main Panel.

4.0 CLEANUP

4.1 Re-access the applicable windows and restore all data to its original state prior to any
modifications.

All added data was removed and all modified data was returned to the original
values.

5.0 DELOG ANALYSIS

5.1 Using the UNIX editor, review all acquisition and tracking data.

All vector data selected is transmitted at the time specified by the Delay.  The
format and content of the applicable messages are correct and indicates that data
was properly logged.
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1.10 Test Case INCC114 - CCS Utilities

1.10.1 Detailed Test Procedures for Test Case INCC114

1.10.1.1 Detailed Test Procedure for Test Item INCC114-B1.1
CCS STARTUP - SIC UPDATES
CSCI 5305, 5302

Pass/Fail Criteria:

• CCS retrieves all SIC information from the SPSR data base during CCS startup.

• The CCS Data File Builder translates data from SPSR into flat file format for CCS
application software.

1.0 SETUP

1.1 Establish the NCCDS configuration without CCS.

1.2 Using SQL, add a SIC to the SPSR data base.

1.3 Using SQL, delete the SIC added above.

1.4 Using SQL, add a different SIC.

1.5 Using SQL, copy the SIC added above.

1.6 Using SQL, modify the copied SIC.

1.7 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$SICS” to find the
path for SICS.DAT.  Type DUMP/REC/OUT = FILENAME.DAT SICS.DAT (use path)
to dump SICS.DAT file to an output file in ASCII readable format.  Print the output file.
[Or print directly by typing DUMP/REC/PRINTER SICS.DAT]

The updates made in steps 1.2 through 1.6 are not reflected.

2.0 CCS COLD START

2.1 Perform a CCS cold start.

The CCS Data File Builder kicks off during the cold start.  The cold start
completes successfully.  All expected messages are received.

2.2 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
SICS.DAT (use path) to dump SICS.DAT file to an output file in ASCII readable format.
Review the output file and compare to the hardcopy obtained in step 1.7.

The file contains the updates made in steps 1.2 through 1.6.
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2.3 Perform a database query of the SIC information.

2.4 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

3.0 CCS WARM START

3.1 Repeat steps 1.2 - 1.7 for different data.

3.2 Perform a CCS warm start.

The CCS Data File Builder kicks off during the warm start.  The warm start
completes successfully.  All expected messages are received.

3.3 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
SICS.DAT (use path) to dump SICS.DAT file to an output file in ASCII readable format.
Review the output file and compare to the hardcopy obtained in steps 3.1/1.7.

The file contains the updates made in step 3.1 and steps 1.2 - 1.6.

3.4 Perform a database query of the SIC information.

3.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

4.0 CLEANUP

4.1 Restore the data modified for this test item.

4.2 Perform cold starts as necessary.

The original test environment has been re-established.



2/6/97  6:31 PM INCC114-3 530-ITP-NCCDS/1998

1.10.1.2 Detailed Test Procedure for Test Item INCC114-B1.2
CCS STARTUP - TDRS ASSIGNMENT UPDATES
CSCI 5305, 5302

Pass/Fail Criteria:

• CCS retrieves all TDRS Mapping data from the SPSR data base during CCS startup.

• The CCS Data File Builder translates data from SPSR into flat file format for CCS
application software.

1.0 SETUP

1.1 Establish the NCCDS configuration without CCS.

1.2 Using SQL, assign 041 to a different TDRS ID.

1.3 Using SQL, assign 046 to a different SGLT.

1.4 Using SQL, assign TDE to a different TDRS ID and SGLT.

1.5 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$TDID” to find the
path for TDID.DAT.  Type DUMP/REC/OUT = FILENAME.DAT TDID.DAT (use
path) to dump TDID.DAT file to an output file in ASCII readable format.  Print the
output file.  [Or print directly by typing DUMP/REC/PRINTER TDID.DAT]

The updates made in steps 1.2 through 1.4 are not reflected.

2.0 CCS COLD START

2.1 Perform a CCS cold start.

The CCS Data File Builder kicks off during the cold start.  The cold start
completes successfully.  All expected messages are received.

2.2 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
TDID.DAT (use path) to dump TDID.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.5.

The file contains the updates made in steps 1.2 through 1.4.

2.3 Perform a database query of the TDRS Mapping data.

2.4 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.
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3.0 CCS WARM START

3.1 Repeat steps 1.2 through 1.5 for different data.

3.2 Perform a CCS warm start.

The CCS Data File Builder kicks off during the warm start.  The warm start
completes successfully.  All expected messages are received.

3.3 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
TDID.DAT (use path) to dump TDID.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in steps 3.1/1.5.

The file contains the updates made in steps 3.1 and steps 1.2 through 1.4.

3.4 Perform a database query of the TDRS Mapping data.

3.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

4.0 CLEANUP

4.1 Restore the data modified for this test item.

4.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.1.3 Detailed Test Procedure for Test Item INCC114-B1.3
CCS STARTUP - DQM PARAMETER UPDATES
CSCI 5305, 5302

Pass/Fail Criteria:

• CCS retrieves all DQM Parameters from the SPSR data base during CCS startup.

• The CCS Data File Builder translates data from SPSR into flat file format for CCS
application software.

1.0 SETUP

1.1 Establish the NCCDS configuration without CCS.

1.2 Using SQL, add a Data Stream ID and Data Rate for 1419.

1.3 Using SQL, remove the same Data Stream ID and Data Rate for 1419.

1.4 Using SQL, add a Data Stream ID and Data Rate for 2008.

1.5 Using SQL, remove a Data Stream ID and Data Rate for 1311.

1.6 Using SQL, modify DQM parameters (Frame Length, etc...) for 2009.

1.7 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$DQM” to find the
path for DQM.DAT.  Type DUMP/REC/OUT = FILENAME.DAT DQM.DAT (use
path) to dump DQM.DAT file to an output file in ASCII readable format.  Print the
output file.  [Or print directly by typing DUMP/REC/PRINTER DQM.DAT]

The updates made in steps 1.2 through 1.6 are not reflected.

2.0 CCS COLD START

2.1 Perform a CCS cold start.

The CCS Data File Builder kicks off during the cold start.  The cold start
completes successfully.  All expected messages are received.

2.2 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
DQM.DAT (use path) to dump DQM.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.7.

The file contains the updates made in steps 1.2 through 1.6.
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2.3 Perform a database query of the DQM Parameters.

2.4 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

3.0 CCS WARM START

3.1 Repeat steps 1.2 through 1.7 for different data.

3.2 Perform a CCS warm start.

The CCS Data File Builder kicks off during the warm start.  The warm start
completes successfully.  All expected messages are received.

3.3 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
DQM.DAT (use path) to dump DQM.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in steps 3.1/1.7.

The file contains the updates made in steps 3.1 and steps 1.2 through 1.6.

3.4 Perform a database query of the DQM Parameters.

3.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

4.0 CLEANUP

4.1 Restore the data modified for this test item.

4.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.1.4 Detailed Test Procedure for Test Item INCC114-B1.4
CCS STARTUP - AUTHORIZED USERS UPDATES
CSCI 5305, 5302

Pass/Fail Criteria:

• CCS retrieves all Authorized Users data from the SPSR data base during CCS startup.

• The CCS Data File Builder translates data from SPSR format into flat file format for
CCS application software.

1.0 SETUP

1.1 Establish the NCCDS test configuration without CCS.

1.2 Using SQL, modify the 1st password for JSC.

1.3 Using SQL, modify the 2nd password for LSM.

1.4 Using SQL, modify the 1st and 2nd passwords for HST.

1.5 Using SQL, modify a User ID.

1.6 Using SQL, remove a User ID.

1.7 Using SQL, add a User ID.

1.8 Using SQL, add a new Authorized User record.

1.9 Using SQL, delete an Authorized User record.

1.10 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$AUSR” to find the
path for AUSR.DAT.  Type DUMP/REC/OUT = FILENAME.DAT AUSR.DAT (use
path) to dump AUSR.DAT file to an output file in ASCII readable format.  Print the
output file.  [Or print directly by typing DUMP/REC/PRINTER AUSR.DAT]

The updates made in steps 1.2 through 1.9 are not reflected.

2.0 CCS COLD START

2.1 Perform a CCS cold start.

The CCS Data File Builder kicks off during the cold start.  The cold start
completes successfully.  All expected messages are received.
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2.2 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
AUSR.DAT (use path) to dump AUSR.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.8.

The file contains the updates made in steps 1.2 through 1.7.

2.3 Perform a database query of the Authorized Users data.

2.4 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the SPSR Oracle data base records were properly converted to flat file
format.

3.0 CCS WARM START

3.1 Bring CCS up and repeat steps 1.2 through 1.8 for different data.

3.2 Perform a CCS warm start.

The CCS Data File Builder kicks off during the warm start.  The warm start
completes successfully.  All expected messages are received.

3.3 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
AUSR.DAT (use path) to dump AUSR.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in steps 3.1/1.8.

The file contains the updates made in steps 3.1 and 1.2 through 1.7.

3.4 Perform a database query of the Authorized Users data.

3.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

4.0 CLEANUP

4.1 Restore the data modified for this test item.

4.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.1.5 Detailed Test Procedure for Test Item INCC114-B1.5
AUTOMATIC UPDATES - SIC DATA
CSCI 5302

Pass/Fail Criteria:

• SIC updates made on SPSR while CCS is also up are automatically sent to CCS.

• The CCS Data File Builder translates data from SPSR into flat file format for CCS
application software.

• CCS is alerted when pertinent updates are made to the SPSR data base.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the SSALERT group.

1.3 Using SQL, add a SIC.

1.4 Using SQL, delete the SIC added above.

1.5 Using SQL, add a different SIC.

1.6 Using SQL, copy the SIC added above.

1.7 Using SQL, modify the copied SIC.

2.0 AUTOMATIC UPDATES

2.1 Logon to a CCS Operator account and select “Mail” from the CCS Utilities menu.

The CCS Data File Builder process is active.

2.2 Review the alerts at the workstation.

CCS is alerted that SIC data was updated.

2.3 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$SICS” to find the
path for SICS.DAT.  Type DUMP/REC/OUT = FILENAME.DAT SICS.DAT (use path)
to dump SICS.DAT file to an output file in ASCII readable format.  Print the output file.
[Or print directly by typing DUMP/REC/PRINTER SICS.DAT]

The file contains the updated SIC information.
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2.4 Perform a database query of the SIC information.

2.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

3.0 CLEANUP

3.1 Restore the data modified for this test item.

3.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.1.6 Detailed Test Procedure for Test Item INCC114-B1.6
AUTOMATIC UPDATES - TDRS MAPPING
CSCI 5302

Pass/Fail Criteria:

• TDRS Assignment updates made on SPSR while CCS is also up are automatically sent
to CCS.

• The CCS Data File Builder translates data from SPSR format into flat file format for
CCS application software.

• CCS is alerted when pertinent updates are made to the SPSR data base.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the SSALERT group.

1.3 Using SQL, assign 041 to a different TDRS ID.

1.4 Using SQL, assign 046 to a different SGLT.

1.5 Using SQL, assign TDE to a different TDRS ID and SGLT.

2.0 AUTOMATIC UPDATES

2.1 Logon to a CCS Operator account and select “Mail” from the CCS Utilities menu.

The CCS Data File Builder process is active.

2.2 Review the alerts at the workstation.

CCS is alerted that TDRS Mapping data was updated.

2.3 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$TDID” to find the
path for TDID.DAT.  Type DUMP/REC/OUT = FILENAME.DAT TDID.DAT (use
path) to dump TDID.DAT file to an output file in ASCII readable format.  Print the
output file.  [Or print directly by typing DUMP/REC/PRINTER TDID.DAT]

The file contains the updated TDRS mapping information.

2.4 Perform a database query of the TDRS Mapping data.

2.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.
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3.0 CLEANUP

3.1 Restore the data modified for this test item.

3.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.1.7 Detailed Test Procedure for Test Item INCC114-B1.7
AUTOMATIC UPDATES - DQM PARAMETERS
CSCI 5302

Pass/Fail Criteria:

• DQM Parameter updates made on SPSR while CCS is also up are automatically sent to
CCS.

• The CCS Data File Builder translates data from SPSR format into flat file format for
CCS application software.

• CCS is alerted when pertinent updates are made to the SPSR data base.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the SSALERT group.

1.3 Using SQL, add a Data Stream ID and Data Rate for 1419.

1.4 Using SQL, remove the same Data Stream ID and Data Rate for 1419.

1.5 Using SQL, add a Data Stream ID and Data Rate for 2008.

1.6 Using SQL, remove a Data Stream ID and Data Rate for 1311.

1.7 Using SQL, modify DQM parameters (Frame Length, etc...) for 2009.

2.0 AUTOMATIC UPDATES

2.1 Logon to a CCS Operator account and select “Mail” from the CCS Utilities menu.

The CCS Data File Builder process is active.

2.2 Review the alerts at the workstation.

CCS is alerted that DQM data was updated.

2.3 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$DQM” to find the
path for DQM.DAT.  Type DUMP/REC/OUT = FILENAME.DAT DQM.DAT (use
path) to dump DQM.DAT file to an output file in ASCII readable format.  Print the
output file.  [Or print directly by typing DUMP/REC/PRINTER DQM.DAT]

The file contains the updated DQM information.

2.4 Perform a database query of the DQM Parameter information.
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2.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

3.0 CLEANUP

3.1 Restore the data modified for this test item.

3.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.1.8 Detailed Test Procedure for Test Item INCC114-B1.8
AUTOMATIC UPDATES - AUTHORIZED USERS
CSCI 5302

Pass/Fail Criteria:

• Authorized Users updates made on SPSR while CCS is also up are automatically sent to
CCS.

• The CCS Data File Builder translates data from SPSR format into flat file format for
CCS application software.

• CCS is alerted when pertinent updates are made to the SPSR data base.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the SSALERT group.

1.3 Using SQL, modify the 1st password for JSC.

1.4 Using SQL, modify the 2nd password for LSM.

1.5 Using SQL, modify the 1st and 2nd passwords for HST.

1.6 Using SQL, modify a User ID.

1.7 Using SQL, remove a User ID.

1.8 Using SQL, add a User ID.

2.0 AUTOMATIC UPDATES

2.1 Logon to a CCS Operator account and select “Mail” from the CCS Utilities menu.

The CCS Data File Builder process is active.

2.2 Review the alerts at the workstation.

CCS is alerted that Authorized Users data was updated.

2.3 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$AUSR” to find the
path for AUSR.DAT.  Type DUMP/REC/OUT = FILENAME.DAT AUSR.DAT (use
path) to dump AUSR.DAT file to an output file in ASCII readable format.  Print the
output file.  [Or print directly by typing DUMP/REC/PRINTER AUSR.DAT]

The file contains the updated Authorized Users information.

2.4 Perform a database query of the Authorized Users information.
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2.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

3.0 CLEANUP

3.1 Restore the data modified for this test item.

3.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.2 Detailed Test Procedures for Test Case INCC114

1.10.2.9 Detailed Test Procedure for Test Item INCC114-B1.9
USER’S GUIDES

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the CCS User’s Guide.

The CCS User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the CCS Utilities normal procedures section of the CCS User’s Guide.

The instructions for performing the major functions of the CCS Utilities are
included in the document.  Copies of all applicable windows are included in the
document.

3.0 ERROR CONDITIONS

3.1 Review the CCS Utilities error recovery procedures section of the CCS User’s Guide.

The user’s guide includes adequate error recovery actions for the CCS Utilities.
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1.10.2.10 Detailed Test Procedure for Test Item INCC114-B1.10
OPERATOR INTERFACE
CSCI 1605

Pass/Fail Criteria:

• The applicable menu options and or icons are operational.

• Pertinent windows can be iconified, can be enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the data base, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numeric in alphabetic fields, special characters, blanks,
etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the CCS Utilities Subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Access the Full Data Exchange window.

The Full Data Exchange window appears on the screen in the expected format.

2.2 Select each menu option and icon available on the window.

The applicable menu options and or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.

2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.
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2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with the CCS Utilities Subsystem.  The
applicable windows are:  Review Events and Event Services.

The windows meet the general and data entry window validation criteria.
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1.10.2.11 Detailed Test Procedure for Test Item INCC114-B1.11
CCS STARTUP - EVENT DATA UPDATES
CSCI 5305, 5302

Pass/Fail Criteria:

• All applicable event data updates since the last time CCS and SPSR were up at the same
time are retrieved during CCS Startup.

• The CCS Data File Builder translates data from SPSR format into flat file format for
CCS application software.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Submit schedule requests such that they become resident on CCS.

1.3 Take CCS down.

1.4 Use SQL commands to modify service parameter, Nascom parameter, and Authorized
User’s records for the events CCS has.

1.5 Submit a schedule request that has associated DQM and Nascom parameters defined in
the SPSR data base.

1.6 Submit a schedule request on an STGT-supported TDRS containing a service that
specifies the use of the HDRM equipment.

1.7 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$EVENT” to find
the path for EVENT.DAT.  Type DUMP/REC/OUT = FILENAME.DAT EVENT.DAT
(use path) to dump EVENT.DAT file to an output file in ASCII readable format.  Print
the output file.

The file does not contain the updates made in steps 1.4 through 1.6.

2.0 CCS COLD START

2.1 Perform a CCS cold start.

The CCS Data File Builder kicks off during the cold start.  The cold start
completes successfully.  All expected messages are received.
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2.2 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
EVENT.DAT (use path) to dump EVENT.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.7.

The file contains the updates made in steps 1.4 through 1.6.  All of the
information accurately reflects that of the SPSR.

2.3 Perform a database query of the event data information.

2.4 Compare the contents of the CCS flat file to the SPSR Oracle data base table(s).

Ensure that the SPSR Oracle data base records were properly converted to flat file
format.

3.0 CCS WARM START

3.1 Repeat steps 1.2 through 1.7 for different data.

3.2 Perform a CCS warm start.

The CCS Data File Builder kicks off during the warm start.  The warm start
completes successfully.  All expected messages are received.

3.3 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
EVENT.DAT (use path) to dump EVENT.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in steps 3.1/1.7.

The file contains the updates made in step 3.1 and steps 1.4 - 1.6.

3.4 Perform a database query of the event data information.

3.5 Compare the contents of the CCS flat file to the Oracle data base table(s).

Ensure that the Oracle data base records were properly converted to flat file
format.

4.0 CLEANUP

4.1 Restore the data modified for this test item.

4.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.2.12 Detailed Test Procedure for Test Item INCC114-B1.12
CCS STARTUP - EVENT DELETIONS
CSCI 5305, 5302

Pass/Fail Criteria:

• All applicable event deletions since the last time CCS and SPSR were up at the same
time are retrieved during CCS Startup.

• The CCS Data File Builder translates data from SPSR format into flat file format for
CCS application software.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Submit schedule requests such that they become resident on CCS.  Include services that
will cause EVENT.DAT to be updated with DQM and Nascom parameter information.

1.3 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$EVENT” to find
the path for EVENT.DAT.  Type DUMP/REC/OUT = FILENAME.DAT EVENT.DAT
(use path) to dump EVENT.DAT file to an output file in ASCII readable format.  Print
the output file.

The file does not contain the update made in step 1.2.

2.0 CCS COLD START

2.1 Once CCS has the event data, take CCS down.

2.2 Delete some of the events from SPSR.

2.3 Perform a CCS cold start.

The CCS Data File Builder kicks off during the cold start.  The cold start
completes successfully.  All expected messages are received.

2.4 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
EVENT.DAT (use path) to dump EVENT.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.3.

The events deleted since the last time both segments were up at the same time
have been removed from the file.  The associated Nascom and DQM Parameters
have also been deleted.
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3.0 CCS WARM START

3.1 Repeat steps 1.2 and 1.3 using different data.

3.2 Once CCS has the event data, take CCS down.

3.3 Delete some of the events from SPSR.

3.4 Perform a CCS warm start.

The CCS Data File Builder kicks off during the warm start.  The warm start
completes successfully.  All expected messages are received.

3.5 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
EVENT.DAT (use path) to dump EVENT.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 3.1.

The events deleted since the last time both segments were up at the same time
have been removed from the file.  The associated Nascom and DQM Parameters
have also been deleted.

4.0 CLEANUP

4.1 Restore the data modified for this test item.

4.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.2.13 Detailed Test Procedure for Test Item INCC114-B1.13
CCS STARTUP - NO SERVICE PARAMETER UPDATES
CSCI 5305, 5302

Pass/Fail Criteria:

• No Service Parameter data is exchanged during CCS startup.

• • The SRVP.DAT files are no longer used.???

1.0 SETUP

1.1 Establish the NCCDS configuration without CCS.

1.2 Use SQL commands to add a dummy service parameter record.

1.3 Use SQL commands to delete the dummy service parameter record added above.

1.4 Use SQL commands to add a different service parameter record.

1.5 Use SQL commands to copy the service parameter record added above.

1.6 Use SQL commands to modify the copied service parameter record.

1.7 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$SRVP” to find the
path for SRVP.DAT (or verify that it’s been deleted).  Type DUMP/REC/OUT =
FILENAME.DAT SRVP.DAT (use path) to dump SRVP.DAT file to an output file in
ASCII readable format.  Print the output file (if SRVP.DAT has not been deleted).

If the file has not been deleted, it does not contain the updates made in steps 1.2
through 1.6.

2.0 CCS COLD START

2.1 Perform a CCS cold start.

The CCS Data File Builder does not kick off and CCS does not attempt to retrieve
Service Parameter updates during the cold start.  The cold start completes
successfully.  No error messages are generated.

2.2 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
SRVP.DAT (use path) to dump SRVP.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.7.

The file has not been updated.
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3.0 CCS WARM START

3.1 Repeat steps 1.2 - 1.7 with different data.

3.2 Perform a CCS warm start.

The CCS Data File Builder does not kick off and CCS does not attempt to access
Service Parameter updates during the warm start.  The warm start completes
successfully.  No error messages are received.

3.3 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
SRVP.DAT (use path) to dump SRVP.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 3.1.

The file has not been updated.

4.0 CLEANUP

4.1 Restore the data modified for this test item.

4.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.2.14 Detailed Test Procedure for Test Item INCC114-B1.14
AUTOMATIC UPDATES - EVENT DATA
CSCI 5302

Pass/Fail Criteria:

• Applicable event data updates made on SPSR while CCS is also up are automatically
sent to CCS.

• The CCS Data File Builder translates data from SPSR format into flat file format for
CCS application software.

• CCS is alerted when pertinent updates are made to the SPSR data base.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the SSALERT group.

1.3 Submit schedule requests for 2009, 1294, and 1311 such that they become resident on
CCS.

1.4 Take CCS down.

1.5 Use SQL commands to modify service parameter and Nascom parameter records for the
1294 events.

1.6 Submit a schedule request that has associated DQM and Nascom parameters defined in
the SPSR data base.

1.7 Submit a schedule request on an STGT-supported TDRS containing a service that
specifies the use of the HDRM equipment.

1.8 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$EVENT” to find
the path for EVENT.DAT.  Type DUMP/REC/OUT = FILENAME.DAT EVENT.DAT
(use path) to dump EVENT.DAT file to an output file in ASCII readable format.  Print
the output file.

The file does not contain the updates made in steps 1.4 through 1.6.

2.0 AUTOMATIC UPDATES

2.1 Logon to a CCS Operator account and select “Mail” from the CCS Utilities menu.

The CCS Data File Builder process is active.
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2.2 Review the alerts at a workstation logged on to the appropriate operator group.

CCS is alerted that event data was updated.

2.3 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
EVENT.DAT (use path) to dump EVENT.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.8.

The file contains the updated event information.  The associated Nascom and
DQM parameter data is also updated.

2.4 Perform a database query of the event data information.

2.5 Compare the contents of the CCS flat file to the SPSR Oracle data base table(s).

Ensure that the SPSR Oracle data base records were properly converted to flat file
format.

3.0 CLEANUP

3.1 Restore the data modified for this test item.

3.2 Perform cold starts as necessary.

The original test environment has been re-established.
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1.10.2.15 Detailed Test Procedure for Test Item INCC114-B1.15
AUTOMATIC UPDATES - EVENT DELETIONS
CSCI 5302

Pass/Fail Criteria:

• Applicable event deletions made on SPSR while CCS is also up are automatically sent
to CCS.

• The CCS Data File Builder translates data from SPSR format into flat file format for
CCS application software.

• CCS is alerted when pertinent updates are made to the SPSR data base.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Submit schedule requests that will become resident on CCS.  Include services that will
cause EVENT.DAT to be updated with DQM and Nascom parameter information.

1.3 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$EVENT” to find
the path for EVENT.DAT.  Type DUMP/REC/OUT = FILENAME.DAT EVENT.DAT
(use path) to dump EVENT.DAT file to an output file in ASCII readable format.  Print
the output file.

2.0 EVENT DELETION

2.1 Delete events from SPSR.

The CCS Data Client receives a delete trigger.

2.2 Logon to a CCS Operator account and select “Mail” from the CCS Utilities menu.

The CCS Data File Builder process is active.

2.3 Review the alerts at a workstation logged on to the appropriate operator group.

CCS is alerted that event data was deleted.

2.4 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
EVENT.DAT (use path) to dump EVENT.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.3.

The deleted events have been removed from the flat file.  The associated Nascom
and DQM parameter data is also deleted.
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1.10.2.16 Detailed Test Procedure for Test Item INCC114-B1.16
SERVICE PARAMETER ACCESS
CSCI 5302

Pass/Fail Criteria:

• CCS directly accesses the SPSR data base to validate service parameter values.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to the TNC and DBA groups.

1.3 Submit a schedule request containing an MAF service such that it becomes resident on
CCS.

1.4 Submit a schedule request containing a KSAR service such that it becomes resident on
CCS.  Use a shuttle SIC.

2.0 RECONFIGURATIONS

2.1 After the event starts, access the applicable window and submit a request to reconfigure
the data rate for the MAF service.  Note the amount of time required to complete the
request.

The request is successfully completed in a reasonable amount of time.

2.2 From NTS, submit a request to reconfigure the data rate for the MAF service.  Note the
amount of time required to complete the request.

The request is successfully completed in a reasonable amount of time.

2.3 Submit a request to reconfigure all possible parameters for the KSAR service.  Note the
amount of time required to complete the request.

The request is successfully completed in a reasonable amount of time.

3.0 SIMULTANEOUS ACCESS

3.1 From the DBA, access the Despun Antenna service parameter record associated with the
MAF service.  Do not enable editing.

3.2 Submit a request to reconfigure the Despun Antenna.

The request is successfully completed.
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3.3 From the DBA, enable editing.

3.4 Repeat step 3.2.

The operator is notified that the data base area is locked.

3.5 Delete the service parameter record and disable editing.

3.6 Repeat step 3.2.

The operator is notified that the service parameter record was not found.  The
request is not successful.  No adverse affects occur.

3.7 Submit a request to reconfigure all possible parameters for the KSAR service.  At the
same time, using SQL commands and data base windows, attempt to modify the
corresponding service parameter records.

One of the requests are denied or held temporarily.  The operator is appropriately
notified of either condition.

4.0 SERVICE PARAMETER VALIDATION

4.1 Submit a request to reconfigure several parameters to invalid values.

The operator is appropriately notified that the request did not pass validation.  The
response is received in a reasonable amount of time.  No adverse affects occur.
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1.10.2.17 Detailed Test Procedure for Test Item INCC114-B1.17
FULL DATA EXCHANGE
CSCI 5302

Pass/Fail Criteria:

• The operator has the capability to initiate a full data exchange.

• All applicable schedule and static data is sent to CCS.

• The CCS Data File Builder translates data from SPSR format into flat file format.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From a CCS terminal, access DCL and type “SHOW LOGICAL CCS$XXXX” to find
the path for XXXX.DAT.  Type DUMP/REC/OUT = FILENAME.DAT XXXX.DAT
(use path) to dump XXXX.DAT file to an output file in ASCII readable format.  Print the
output file.  (Note:  XXXX = SICS, TDID, DQM, AUSR, EVENT for the respective
files.)

1.3 Stop running the data base trigger client (kill process) so that CCS will not be
automatically notified of updates.

1.4 From SPSR, modify each data type.

1.5 From a CCS terminal, access DCL and type DUMP/REC/OUT = FILENAME.DAT
XXXX.DAT (use path) to dump XXXX.DAT file to an output file in ASCII readable
format.  Review the output file and compare to the hardcopy obtained in step 1.2. (Note:
XXXX = SICS, TDID, DQM, AUSR, EVENT for the respective files.)

The modifications made in step 1.4 are not reflected.

2.0 INITIATE FULL DATA EXCHANGE - SCENARIO 1

2.1 Logon to a CCS Operator account and select “Mail” from the CCS Utilities menu.

The CCS Data File Builder process is active.  The appropriate CCS application
processes are active.

2.2 Access the appropriate CCS GUI and initiate a full data exchange.

The operator receives all appropriate alerts.  The full data exchange completes
successfully.



2/6/97  6:31 PM INCC114-32 530-ITP-NCCDS/1998

2.3 Review/print the flat files created by the CCS Data File Builder (using the method
explained in the setup).

Each flat file contains all applicable data, including the updates from step 1.4.

3.0 INITIATE FULL DATA EXCHANGE - SCENARIO 2

3.1 Erase the contents of the flat files (without deleting them).

3.2 From the CCS GUI, initiate a full data exchange.

3.3 Monitor the appropriate mailbox to ensure that the data is being transferred.

The operator receives all appropriate alerts.  The full data exchange completes
successfully.

3.4 Review/print the flat files created by the CCS Data File Builder (using the method
explained in the setup).

Each flat file contains all applicable data, including the updates from step 1.4.
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1.10.2.18 Detailed Test Procedure for Test Item INCC114-B1.18
CCS ALERT CLIENT
CSCI 5302

Pass/Fail Criteria:

• CCS alerts are routed to the CCS ALSV alert server residing on the SPSR.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstations as operators that belong to the appropriate operator groups.

2.0 GENERATE ALERTS

2.1 Generate various CCS information and action alerts.

The CCS Alert Client receives the alert messages from the application and
properly routes them to the CCS ALSV alert server residing on the SPSR.

2.2 Logon to a CCS Operator account and select “Mail” from the CCS Utilities menu.

The process ALQ1 counter for messages sent/received is increased by one for
each CCS alert sent to the SPSR.

2.3 Review the alert area of the SPSR data base.

The CCS alerts were properly stored in the SPSR data base.
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1.10.2.19 Detailed Test Procedure for Test Item INCC114-B1.19
CCS REVIEW EVENTS -SELECTION CRITERIA
CSCI 5302

Pass/Fail Criteria:

• • Event information is properly reflected in the CCS Review Events window.

• • Service information is properly reflected in the CCS Event Services window.

• Events are displayed in the CCS Review Events window based on the specified criteria.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Submit valid schedule requests such that they become resident on CCS.  Some of the
events should start and some should end during this test item.

SUPIDEN TDRS GT Relative Start Time Relative Stop Time
---------------- ------- --- ---------------------- ----------------------
1)B1294MS TDE WSC1 000:00:20:00 000:01:20:00
2) M2009MS 041 WSC2 000:00:30:00 000:01:30:00
3) A1446MS TDW SGT1 000:00:30:00 000:01:30:00
4) B1294MS TDS SGT2 000:01:45:00 000:02:30:00
5) M2009MS TDS SGT2 000:01:45:00 000:02:30:00
6) A1446MS 041 WSC2 000:01:45:00 000:02:40:00

1.3 From a workstation, access the CCS Review Events window from the Main Panel, and
the Event Services windows to view the events and services scheduled in step 1.2.
Request hardcopies of these displays.

The event SUPIDENS, start and stop times, GT, TDRS Name, TDRS ID, SGLT,
GT status, IFL status, and the services for each event are displayed.

1.4 At a CCS console run the "@REVIEW_EVENT".  Obtain a listing of the scheduled
events and services sent to the CCS printer.

The scheduled events and services correspond to the hardcopy generated in step
1.3.

1.5 Review the alert area of the SPSR data base.

The CCS start alerts were properly stored in the SPSR data base and reflect the
correct event/service data.
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2.0 SELECTION CRITERIA

2.1 From the CCS Review Events window, enter valid start and stop times, click the “SGT”
toggle button and click the “Get Events” button.

The Events List updates to reflect all of the scheduled events between the period
of time entered for the selected "SGT".

2.2 Select "A1446MS" from the SUPIDEN combination box.  The TDRS Name, ground
terminal, Start and Stop times are not part of the selection criteria.  Click the “Get
Events” button.

The Events List is updated and only displays events 3 and 6.

2.3 Select "TDE" from the TDRS Name combination box.  The ground terminal, SUPIDEN,
Start and Stop times are not part of the selection criteria.  Click the “Get Events” button.

The Events List is updated and only displays event number 1.

2.4 Select "TDS" for the TDRS Name.  The ground terminal, SUPIDEN, Start and Stop times
are not part of the selection criteria.  Click the “Get Events” button.

The Events List is updated and only displays event numbers 4 and 5.

2.5 Select "TDW" for the TDRS Name.  The ground terminal, SUPIDEN, Start and Stop
times are not part of the selection criteria.  Click the “Get Events” button.

The Events List is updated and only displays event number 1.

2.6 Select "041" for the TDRS Name.  The ground terminal, SUPIDEN, Start and Stop times
are not part of the selection criteria.  Click the “Get Events” button.

The Events List is updated and only displays event number 6.

2.7 Select "All" for the TDRS Name.  The ground terminal, SUPIDEN, Start and Stop times
are not part of the selection criteria.  Click the “Get Events” button.

The Events List is updated and displays all the events scheduled in step 1.2.

2.8 Select “WSC” for the ground terminal location.  The TDRS Name, SUPIDEN, Start and
Stop times are not part of the selection criteria.  Click the “Get Events” button.

The Events List is updated and displays event numbers 1, 2, and 6.

2.9 Select “SGT” for the ground terminal location.  The TDRS Name, SUPIDEN, Start and
Stop times are not part of the selection criteria.  Click the “Get Events” button.

The Events List is updated and displays event numbers 3 through 5.

2.10 Close the window.

The window closes and control returns to the Main Panel.
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2.11 Return to the CCS Review Events window.  Click the "Get Events" button.

The Events List is updated and displays all the events scheduled in step 1.2.  The
events are accurately reflected.

3.0 COMBINATIONS OF VALID SELECTION CRITERIA

3.1 Return to the CCS Review Events window and select "WSC" for the ground terminal
location and enter a valid start and stop time ranging from current UTC to 1.5 hours into
the future.  The TDRS Name and SUPIDEN are not part of the selection criteria.  Click
the "Get Events" button.

The Events List is updated and displays event numbers 1 and 2.

3.2 Select "WSC" for the ground terminal and select "M2009MS" as the valid SUPIDEN.
The TDRS Name,  Start and Stop times are not part of the selection criteria.  Click the
"Get Events" button.

The Events List is updated and displays event number 2.

3.3 Select "WSC" for the ground terminal and select "TDE" as the TDRS Name.  The
SUPIDEN, Start and Stop times are not part of the selection criteria.  Click the "Get
Events" button.

The Events List is updated and displays event number 1.

3.4 Select "WSC" for the ground terminal and select "041" as the TDRS Name.   The
SUPIDEN, Start and Stop times are not part of the selection criteria.  Click the "Get
Events" button.

The Events List is updated and displays event numbers 2 and 6.

3.5 Select "WSC" for the ground terminal and select "All" as the TDRS Name.  The
SUPIDEN, Start and Stop times are not part of the selection criteria.  Click the "Get
Events" button.

The Events List is updated and displays event numbers 1, 2, and 6.

3.6 Select "SGT" for the ground terminal and select "TDW" as the TDRS Name.   The
SUPIDEN, Start and Stop times are not part of the selection criteria.  Click the "Get
Events" button.

The Events List is updated and displays event number 3.

3.7 Select "SGT" for the ground terminal and select "TDS" as the TDRS Name.   The
SUPIDEN, Start and Stop times are not part of the selection criteria.  Click the "Get
Events" button.

The Events List is updated and displays event numbers 4 and 5.
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3.8 Select "SGT" for the ground terminal and select "All" as the TDRS Name.  The
SUPIDEN, Start and Stop times are not part of the selection criteria.  Click the "Get
Events" button.

The Events List is updated and displays event numbers 3 through 5.

3.9 Enter a valid start and stop time ranging from current UTC time to 3 hours into the future
and select "A1446MS" as the SUPIDEN.  The ground terminal and TDRS Name fields
are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event numbers 3 and 6.

3.10 Enter a valid start and stop time ranging from current UTC to 30 minutes into the future
and select "TDE" as the TDRS Name.  The ground terminal and SUPIDEN fields are not
part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event number 1.

3.11 Enter a valid start and stop time ranging from 1.5 hours (relative start time) to 2.5 hours
(relative stop time) and select "TDS" as the TDRS Name.  The ground terminal and
SUPIDEN fields are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event numbers 4 and 5.

3.12 Enter a valid start and stop time ranging from 30 minutes (relative start time) to 45
minutes (relative stop time) and select "041" as the TDRS Name.  The ground terminal
and SUPIDEN fields are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event number 2.

3.13 Enter a valid start and stop time ranging from 30 minutes (relative start time) to 35
minutes (relative stop time) and select "TDW" as the TDRS Name.  The ground terminal
and SUPIDEN fields are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event number 3.

3.14 Enter a valid start and stop time ranging from 1.5 hours (relative start time) to 2 hours
(relative stop time) and select "TDS" as the TDRS Name.  The ground terminal and
SUPIDEN fields are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event numbers 4 and 5.

3.15 Enter a valid start and stop time ranging from 30 minutes (relative start time) to 40
minutes (relative stop time) and select "041" as the TDRS Name.  The ground terminal
and SUPIDEN fields are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event number 2.

3.16 Enter a valid start and stop time ranging from 2.5 hours (relative start time) to 3 hours
(relative stop time) and select "ALL" as the TDRS Name.  The ground terminal and
SUPIDEN fields are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event numbers 4, 5, and 6.
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3.17 Enter a valid start and stop time ranging from 30 minutes (relative start time) to 3 hours
(relative stop time) and select "WSC" as the ground terminal.  The TDRS Name and
SUPIDEN fields are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event numbers 1, 2, and 6.

3.18 Select "041" as the TDRS Name, "WSC" as the ground terminal and "M2009MS" as the
SUPIDEN.  The start and stop times are not part of the selection criteria.  Click the "Get
Events" button.

The Events List is updated and displays event number 2.

3.19 Enter a valid start and stop time ranging from 30 minutes (relative start time) to 45
minutes (relative stop time) and select "A1446MS" as the SUPIDEN.  The TDRS Name
and ground terminal fields are not part of the selection criteria.  Click the "Get Events"
button.

The Events List is updated and displays event number 3.

3.20 Enter a valid start and stop time ranging from 2 hours (relative start time) to 2.5 hours
(relative stop time) and select a TDRS Name.  The SUPIDEN and ground terminal fields
are not part of the selection criteria.  Click the "Get Events" button.

The Events List is updated and displays event numbers 1, 2, and 6.

3.21 Select  "A1446MS" as the SUPIDEN and "TDE" as the TDRS Name. The ground
terminal, start and stop time fields are not part of the selection criteria.  Click the "Get
Events" button.

An advisory box is received indicating that there are no events to be displayed.

3.23 Close the window.

The window closes and control returns to the Main Panel.

3.24 Return to the CCS Review Events window.  Do not select or enter any criteria.  Click the
"Get Events" button.

The Events List is updated and displays all the events scheduled in step 1.2.  The
events are accurately reflected.
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4.0 NO EVENTS MEET SPECIFIED CRITERIA

4.1 Return to the CCS Review Events window and enter invalid start and stop time
combinations (e.g. letters, a time in the past, days > 366, hours > 24, stop time < start
time).  Click the "Get Events" buttons.

The operator receives an Advisory box indicating an invalid entry was made.  The
Events List is not updated.

4.2 Select a SUPIDEN that is not currently scheduled.  The start times, stop times, ground
terminal and TDRS Name are not part of the selection criteria.  Click the "Get Events"
button.

The operator receives an Advisory box indicating that there are no events which
meet the specified criteria.

4.3 Delete events 4 through 6 (step 1.2).

4.4 From the CCS Review Events window, enter the time frame, TDRS and SUPIDEN
corresponding to the events deleted in step 4.3.  Click the "Get Events" button.

The operator receives an Advisory box indicating that there are no events which
meet the specified criteria.

4.5 Click the "All" toggle button followed by the "Get Events" button.

The Events List is updated and displays the events scheduled on either GT that are
resident on CCS.  The events deleted in step 4.3 are not displayed.

4.6 Close the window.

The window closes and control returns to the Main Panel.
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1.10.2.20 Detailed Test Procedure for Test Item INCC114-B1.20
CCS REVIEW EVENTS & SERVICES - COLOR CODING
CSCI 5302

Pass/Fail Criteria:

• The color coding of event information is properly reflected in the CCS Review Events
window.

• The color coding of service information is properly reflected in the CCS Event Services
window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Submit valid schedule requests such that they become resident on CCS.  Some of the
events should start and some should end during this test item.  Include an event on an
STGT-supported TDRS that uses the HDRM.

2.0 REVIEW/MODIFY EVENTS & SERVICES

2.1 Select "CCS Sched" from the Main Panel.

The CCS Review Events window appears.  The top portion of the window
contains data entry fields and the bottom portion of the window is blank.  The "As
of" time reflects the time the window was opened.

2.2 Click the "Get Events" button.

The Events List is updated and displays all events currently resident on CCS.  The
events scheduled in step 1.2 are accurately reflected.

2.3 Select an event from the Events List and click the left mouse button.

The Event Services window appears and contains the services for the selected
event.  The "As of" time reflects the time the window was opened.

2.4 Close the Event Services window.

The window closes and control returns to the CCS Review Events window.

2.5 From NTS, transmit SHO Status Rejects from both ground terminals containing normal
and IFL SHO IDs.

2.6 From NTS, transmit SLRs from both ground terminals containing normal SHO IDs and
an SLR from WSGT containing IFL SHO IDs.  Do a normal and IFL SHO ID for one of
the events.
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2.7 From the TDRS Operational Names and Mappings window, modify the TDRS/SGLT
assignments such that some of the events are impacted (modify the TDRS Op Name for
one, the SGLT for one, the TDRS ID for one, and combinations thereof for others).

3.0 CCS REVIEW EVENTS AND SERVICES

3.1 From the CCS Review Events window, click the “Get Events” button.

The Events List accurately reflects the events resident on CCS.  The “SLR Flag”
column accurately reflects the events as affected by a “N”ormal SHO, an “I”FL
SHO, or “B”oth.  The following color scheme is used:

-Ongoing events appear in gray
-Inactive events appear in blue
-Events rejected by the ground terminal appear in red
-SHO IDs and IFL SHO IDs rejected by the ground terminal and affected
 by SLRs are displayed in yellow
-TDRS Op Names/TDRS IDs/SGLTs impacted by assignment changes are
 displayed in yellow

3.2 Position the cursor over an event and double-click.

The Event Services window appears and contains the services for the selected
event.  The following color scheme is used:

-Ongoing services appear in gray
-Inactive services appear in blue
-IFL SHO IDs rejected by the ground terminal and affected by SLRs are
 displayed in yellow

3.3 Repeat step 3.2 for the other events.

3.4 Click the Pane button and drag the Services portion (bottom pane) of the window over the
Event Parameters portion (top pane).

The Services portion is re-sized and overlays the Event Parameters portion up to
the "As of" field.  The scroll bar is removed from the Services list and all
applicable data is displayed.

3.5 Close the window.

The window closes and control returns to the CCS Review Events window.

4.0 RESET EVENTS

4.1 From NTS, transmit SHO Status Accept messages for the SHO IDs and IFL SHO IDs set
to “Reject” in step 1.5.
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4.2 From NTS, transmit SLRs from both ground terminals without any SHO IDs or IFL SHO
IDs.

4.3 Simulate a retransmission of the events impacted by the TDRS/SGLT Assignment
changes to the ground terminals.

4.4 From the CCS Review Events window, click the “Get Events” button.

The Events List accurately reflects the events resident on CCS.  The color scheme
and impact indicators from 3.0 do not appear in the window.

4.5 Select an event and click the left mouse button.

The Event Services window appears and contains the services for the selected
event.  The color scheme and impact indicators from 3.0 do not appear in the
window.
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1.11 Test Case INCC115 - CCS: Monitor and Control/HSME

1.11.1 Detailed Test Procedures for Test Case INCC115

1.11.1.1 Detailed Test Procedure for Test Item INCC115-B1.1
USER’S GUIDE
CSCI 5304

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the CCS User’s Guide.

The CCS User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the CCS Monitor and Control and System Supervisor Subsystems normal
procedures section of the CCS User’s Guide.

The instructions for performing the major functions of the CCS Monitor and
Control and System Supervisor Subsystems are included in the document.  Copies
of all applicable windows are included in the document.

3.0 ERROR CONDITIONS

3.1 Review the CCS Monitor and Control and System Supervisor Subsystems error recovery
procedures section of the CCS User’s Guide.

The user’s guide includes adequate error recovery actions for the CCS Monitor
and Control and System Supervisor Subsystems.
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1.11.1.2 Detailed Test Procedure for Test Item INCC115-B1.2
OPERATOR INTERFACE
CSCI 5304

Pass/Fail Criteria:

• The applicable menu options and/or icons are operational.

• Pertinent windows can be iconified, enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the database, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numerical values in alphabetic fields, special characters,
blanks, etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the CCS Monitor and Control Subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Access the Network Site Status window.

The Network Site Status window appears on the screen in the expected format.

2.2 Select each menu option and icon available on the window.

The applicable menu options and/or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.

2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.

2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.
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2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for the Communication Test Block window.

The Communication Test Block window meets the general and data entry window
validation criteria.
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1.11.1.3 Detailed Test Procedure for Test Item INCC115-B1.3
REMOVAL OF OBSOLETE SOFTWARE
CSCI 5304

Pass/Fail Criteria:

• The INIT_TIME_TAG, ENTITY UP, and ENTITY DOWN options have been removed
from the CCS Utilities menu of the operator account.

• Obsolete processes have been removed from the CCS mailbox list.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to a System Supervisor group.

2.0 OBSOLETE OPERATOR ACCOUNT MENU OPTIONS

2.1 Logon to a CCS operator account.

The Delogger option has been removed from the main menu?

2.2 Select “CCS Utilities” from the main menu.

The ENTITY UP, ENTITY DOWN, and INIT_TIME_TAG options have been
removed from the menu.

2.3 Select the remaining options.

The remaining options are fully functional.

3.0 CCS MAILBOXES

3.1 Select the “Mail” option from the CCS utilities menu.

Obsolete processes, such as CCPR, DSSB, DSSR, DSST, FELC, ISLC, UTAS,
and UTSD have been removed from the list of CCS mailboxes.
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1.11.1.4 Detailed Test Procedure for Test Item INCC115-B1.4
NETWORK SITE STATUS
CSCI 5304

Pass/Fail Criteria:

• The operator can up and down sites (with respect to CCS) from the Network Site Status
window.

• The operator can enable and disable pre-event CTMs for unsecured sites from the
Network Site Status window.

• The operator can turn on automatic CTMs for the secure MOC, the ground terminals,
and up to two unsecured sites from the Network Site Status window.

• The operator receives all expected alerts.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a System Supervisor group.

1.3 Logon to other workstations as operators that belong to different groups.

1.4 Submit schedule requests in the automatic scheduling update period for SUPIDENs found
on the User Performance Data window.

2.0 MODIFY NETWORK SITE STATUS

2.1 Select "Site Status" from the Site Status subpanel on the Main Panel.

The Network Site Status window appears with the "As of" time indicating when
the window was requested.

2.2 Select a site associated with an ongoing event's SUPIDEN, click the Site Status toggle
button, and click the “O.K.” button.

The Site Status field now indicates that the site is down and the row's background
for that site is red.  The "As of" time reflects the time the modifications to the
window was saved.  The operator is alerted that the site went down.

2.3 From the Network Site Status window, click the appropriate site status toggle button.
Click the “O.K.” button.

The Site Status field now indicates that the site is up and the row's background for
that site is green.  The "As of" time reflects the time the window was saved.  The
operator is alerted that the site went up.
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3.0 MODIFY THROTTLING RATE

3.1 From the Network Site Status window, select and modify the throttling rate for a site, hit
“Enter”, and click the “O.K.” button.

The Throttling Rate field now indicates the new entry.  The "As of" time reflects
the time the window was saved.

4.0 MODIFY PRE-EVENT CTM FLAGS

4.1 From the Network Site Status window, select sites associated with soon to be active
scheduled SUPIDENs and click the "Event CTM Enable" toggle button to enable pre-
event CTMs for the sites.  Click the “O.K.” button.

The Event CTM Enable field shows that the pre-event CTMs for the selected sites
have been enabled.  The operator is notified through an alert that pre-event CTMs
have been enabled.  The "As of" time reflects the time the window was saved.

4.2 From NTS, enter the “OUT” command.

Approximately five minutes prior to event start the display of outgoing blocks
indicates CTMs are transmitted to selected sites.

4.3 From the Network Site Status window, click the Event CTM Enable field toggle button to
disable pre-event CTMs for sites previously enabled.  Click the “O.K.” button.

The Event CTM Enable field shows that the pre-event CTMs for the selected sites
have been disabled.  The operator is notified through an alert that CTMs have
been disabled.  The "As of" time reflects the time the window was saved.

5.0 MODIFY AUTOMATIC CTM FLAGS

5.1 From the Network Site Status window; select sites to be updated; turn on the Automatic
CTM Flag for the secure MOC, the ground terminals, and up to two unsecured sites
including SDPF; and click the “O.K.” button.

The Automatic CTM Flag field shows that automatic CTMs for the selected sites
have been turned on.  The "As of" time reflects the time the window was saved.

5.2 From NTS, enter the “OUT” command.

The display of outgoing blocks indicates that CTMs are transmitted to selected
sites.

5.3 From the Network Site Status window, turn off the Automatic CTM Flag for a site
previously turned on, and click the “O.K.” button.

The Automatic CTM Flag field shows that automatic CTMs for the selected site
has been turned off.  The "As of" time reflects the time the window was saved.
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5.4 From NTS, enter the “OUT” command.

The display of outgoing blocks indicates that CTMs to the selected site have
stopped.

6.0 HELP MENU

6.1 Use the HELP menu on the Network Site Status window to find out how to enable pre-
event CTMs.

HELP clearly and correctly explains how to enable pre-event CTMs.

6.2 Select Close from the File menu.

The  Network Site Status window closes.
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1.11.1.5 Detailed Test Procedure for Test Item INCC115-B1.5
CCS DBA UTILITY
CSCI 5304

Pass/Fail Criteria:

• Site updates made via the CCS DBA Utility are reflected on the Network Site Status
window.

• The operator receives all expected alerts.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to a System Supervisor group.

1.3 Logon to other workstations as operators that belong to different groups.

2.0 MODIFY SITE RECORDS

2.1 Logon to a CCS DBA account, access the DBAUTILS main menu, select the “Perform
database utilities” option, enter the system level and select the test level option for “Site
table maintenance".  Enter the applicable system level and print the report.

2.2 Delete a site record.

The record is deleted after confirmation.

2.3 Return to the Site Table Maintenance main menu, add a new site and store the record.

The record was successfully stored.

2.4 Return to the Site Table Maintenance main menu and delete a site record.

The record is deleted after confirmation.

2.5 Return to the Site Table Maintenance main menu and select the option to modify the
CTM monitoring value, CTM interval, or the block throttling rate.

The record to be modified is displayed and after confirming the modifications
they are saved back to the site table.

2.6 Make corresponding site status changes to the NTS and Interim NPG.

Site records for the CCS site table, NTS, and NPG match.
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3.0 VALIDATE SITE MODIFICATIONS

3.1 Perform a CCS Cold Start.

3.2 Select "Site Status" from the Site Status subpanel on the Main panel to view changes to
the site records.

The updates made from the DBA Utility are reflected on the Network Site Status
window.

3.3 From the Network Site Status window, turn on the Automatic CTM Enable Flag for the
sites that were added, deleted, and modified.  Click the "O.K." button.

The Automatic CTM Flag field shows that automatic CTMs for the selected sites
have been turned on.  The "As of" time reflects the time the window was saved.

3.4 From NTS, enter the “OUT” command.

The display of outgoing blocks indicates that CTMs are transmitted to sites that
were added and modified.  Automatic CTMs are not being transmitted to the site
that was deleted.

4.0 CLEANUP

4.1 Return to the Site Table Maintenance main menu and restore the sites, and their
associated information, to the state prior to the execution of steps 2.2 through 2.6.

The site table information is restored and matches the report generated in step 2.1.
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1.11.1.6 Detailed Test Procedure for Test Item INCC115-B1.6
MANUAL COMMUNICATION TEST BLOCKS
CSCI 5304

Pass/Fail Criteria:

• The operator has the ability to manually send communication test blocks (CTBs).

• The operator receives all expected alerts when a CTB is manually transmitted and when
the ACK is received.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to a System Supervisor group.

1.3 Logon to other workstations as operators that belong to different groups.

1.4 From NTS, clean the RMSG counter.

[ NOTE:  At the time these DTPs were written the CTB window was not developed.  Hence,
these DTPs were based on the current (operational) CTB display as described in the 95.1
Console Operator's Users Guide/Revision 2. ]

2.0 VALID MANUAL CTBs

2.1 Select "CTB" from the site status subpanel on the main panel.  From the Communication
Test Block window, select a site, and enter a SUPIDEN.  Click the "O.K." button.

The operator is alerted that a CTB was successfully transmitted to and
acknowledged by the site.

2.2 From the NTS terminal, access the RMSG display.

The display indicates that a CTB (91/03) was transmitted.

3.0 INVALID MANUAL CTBs

3.1 From the NTS terminal, reset the RMSG counters.

3.2 From the Communication Test Block window, select a site, and attempt to enter an
invalid formatted SUPIDEN.  Click the “O.K.” button.

The operator is notified through an alert that the SUPIDEN was not in correct
format.
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3.3 From the Communication Test Block window, attempt to select an invalid non-secure site
name, and a valid SUPIDEN.  Click the “O.K.” button.

The operator is notified through an alert that the site was not valid.

3.4 From the Network Site Status window, down a site.

3.5 From the Communication Test Block window, select the site downed in the previous
step, and enter a corresponding SUPIDEN.  Click the “O.K.” button.

The operator is notified through an alert that the CTB transmission to the site
failed.

3.6 From an NTS terminal, access the RMSG display.

The display indicates that CTBs (91/03) were not transmitted.
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1.12 Test Case INCC116 - SPSR: Schedule Control/Edit SAR

1.12.1 Detailed Test Procedures for Test Case INCC116
SCHEDULE CONTROL DATA/SAR EDIT/TSW EDIT

1.12.1.1 Detailed Test Procedure for Test Item INCC116-B1.1
USER’S GUIDES - SCHEDULING CONTROL DATA/
EDIT SAR WINDOWS

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the SPSR User’s Guide.

The SPSR User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the Scheduling Control Data and Edit SAR portions of the SPSR User’s Guide.

The instructions for performing the major functions of the Scheduling Control
Data and Edit SAR portions of the User Interface Subsystem are included in the
document.  Copies of all applicable windows are included in the document.

3.0 ERROR CONDITIONS

3.1 Review the Scheduling Control Data portion of the User Interface Subsystem error
recovery procedures section of the SPSR User’s Guide.

The user’s guide includes adequate error recovery actions for the Scheduling
Control Data portion of the User Interface Subsystem.
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1.12.1.2 Detailed Test Procedure for Test Item INCC116-B1.2
OPERATOR INTERFACE - SCHEDULING CONTROL DATA/
EDIT SAR WINDOWS
CSCI 1605

Pass/Fail Criteria:

• The applicable menu options and or icons are operational.

• Pertinent windows can be iconified, can be enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the data base, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numeric in alphabetic fields, special characters, blanks,
etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the Scheduling Control Data portion of the User
Interface Subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Access the Schedule Maintenance Control Parameters window.

The Schedule Maintenance Control Parameters window appears on the screen in
the expected format.

2.2 Select each menu option and icon available in the window.

The applicable menu options and or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.

2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.
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2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with the Scheduling Control Data
portion of the User Interface Subsystem.  The applicable windows are: Retention Control
Parameters and Schedule Priorities Lists windows.

The windows meet the general and data entry window validation criteria.
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1.12.1.3 Detailed Test Procedure for Test Item INCC116-B1.3
SCHEDULE MAINTENANCE CONTROL PARAMETERS WINDOW:
ENABLE EDITING
CSCI 1605

Pass/Fail Criteria:

• The ability of an authorized operator to update the data base via the Schedule
Maintenance Control Parameters window is controlled by the Enable Editing toggle
button.

• The enable/disable status of a window called by another window is the same as the
calling window.

• The enable/disable status of a window called by another window does not affect the
calling window.

• The default enable/disable status on initial access of a parent window is disabled.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ENABLE EDITING

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The Enable
Editing toggle button is raised, indicating that editing is disabled.  All buttons
except “Close” are dimmed and non-functional.

2.2 Modify the Automatic Scheduling Update time and attempt to click the “Save” button.

The Save function is not successful.

2.3 Click the Enable Editing toggle button.

The button is now depressed, indicating that editing is enabled.  All of the buttons
are available.

2.4 Select “Retention Control Parameters” from the “Edit” menu.

The Retention Control Parameters window appears.  The Enable Editing toggle
button is depressed, indicating that editing is enabled.  All of the buttons are
available.
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2.5 Modify the Schedule Events and Associated Messages time component and click the
“Save” button.

The update is accepted.

2.6 Click the “Close” button.

The Retention Control Parameters window closes and control returns to the
Schedule Maintenance Control Parameters window.  The Enable Editing toggle
button is depressed, indicating that editing is enabled.

3.0 DISABLE EDITING

3.1 From the Schedule Maintenance Control Parameters window, click the Enable Editing
toggle button.

The button is now raised, indicating that editing is disabled.

3.2 Select “Retention Parameters” from the “Edit” menu.

The Retention Control Parameters window appears.  The Enable Editing toggle
button is raised, indicating that editing is disabled.  The “Save” button is dimmed.

3.3 Attempt to modify the Schedule Requests time component.

The operator is notified that editing is not enabled.  The function is not completed.

3.4 Enable editing, modify a time field, and click the disable editing.

A dialog box appears giving the operator the option to save the changes.

3.5 Click the “No” button in the dialog box.

The dialog box closes.  The window is refreshed with the previous values.

3.6 Repeat step 3.4 and click the “Yes” button in the dialog box.

The dialog box closes.  The window reflects the new information.

3.7 Perform a data base query of the Schedule Control information.

The update made in step 3.6 is reflected in the data base.

3.8 Click the “Close” button.

The Retention Control Parameters window closes and control returns to the
Schedule Maintenance Control Parameters window.  The Enable Editing toggle
button is raised, indicating that editing is disabled.
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4.0 CALLED WINDOWS DON’T AFFECT CALLING WINDOWS

4.1 From the Schedule Maintenance Control Parameters window, with editing disabled,
select “Scheduling Priorities Lists” from the “Edit” menu.

The Scheduling Priorities List window appears.  The Enable Editing toggle button
is raised, indicating that editing is disabled.  All but the “Close” button are
dimmed.

4.2 Click the Enable Editing toggle button.

The button is now depressed, indicating that editing is enabled.  All of the buttons
are available.

4.3 Click the “Close” button.

The Scheduling Priorities Lists window closes and control returns to the Schedule
Maintenance Control Parameters window.  The Enable Editing toggle button is
raised, indicating that editing is disabled.

4.4 Click the Enable Editing toggle button.

The button is now depressed, indicating that editing is enabled.

4.5 Select “Scheduling Priorities Lists” from the “Edit” menu.

The Scheduling Priorities Lists window appears.  The Enable Editing toggle
button is depressed, indicating that editing is enabled.

4.6 Click the Enable Editing toggle button.

The button is now raised, indicating that editing is disabled.

4.7 Click the “Close” button.

The Scheduling Priorities Lists window closes and control returns to the Schedule
Maintenance Control Parameters window.  The Enable Editing toggle button is
depressed, indicating that editing is enabled.

4.8 Click the “Close” button.

The window closes and control returns to the Main Panel.

4.9 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The “Enable
Editing” toggle button is raised, indicating that editing is disabled.

4.10 Click the “Close” button.

The window closes and control returns to the Main Panel.
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1.12.1.4 Detailed Test Procedure for Test Item INCC116-B1.4
SCHEDULE MAINTENANCE CONTROL PARAMETERS WINDOW:
ALERT PERIOD PARAMETERS
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to specify the amount of time from the current time
during which alerts are generated on receipt of schedule requests for automatic
processing.

• The operator has the capability to specify the amount of time from the current time
during which alerts are generated on receipt of schedule request for batch processing.

• The operator has the capability to specify the amount of time from the current time
during which alerts are generated on receipt of schedule requests for automatic
processing during a lockout.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA and Scheduling capabilities.

2.0 AUTOMATIC SCHEDULE UPDATE ALERT

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The “Opened”
time reflects the time the window was opened.  Note the “Last update” date and
operator in the Alert Period Parameters portion of the window.

2.2 Enable editing, position the cursor in the Automatic Scheduling Update time component,
and click the left button.

The time component is highlighted.

2.3 Change the time by clicking the arrow buttons.

The time is increased when the UP arrow button is clicked and decreased when
the DOWN arrow button is clicked.  The “Last update” information is the same as
in step 2.1.

2.4 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control information.

The Automatic Scheduling Update time has not been updated.
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2.5 From the Schedule Maintenance Control Parameters window, click the “Save” button.

The “Last update” information has been updated.

2.6 Perform a data base query of the Schedule Control information.

The Automatic Scheduling Update time now reflects the update.

2.7 Click the “Close” button.

The Schedule Maintenance Control Parameters window closes and control returns
to the Main Panel.

2.8 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears and contains the
update made in step 2.3.  The “Last update” information is the same as in step 2.5.

2.9 From NTS, transmit a SAR with a start time prior to the Automatic Scheduling Update
time specified in step 2.3.

The operator with Scheduling capabilities is alerted that a request was received for
automatic processing.

3.0 BATCH REQUEST RECEIPT ALERT

3.1 From the Schedule Maintenance Control Parameters window, enable editing, position the
cursor in the Batch Request Receipt time component, and click the left button.

The time component is highlighted.  Note the “Last update” date and operator in
the Alert Period Parameters portion of the window.

3.2 Change the time by typing a new value.

The “Last update” information is not updated.

3.3 Select “Close” from the “File” menu.

The window closes and control returns to the Main Panel.

3.4 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The update
made in step 3.2 is not reflected in the window.

3.5 Enable editing, position the cursor in the Batch Request Receipt time component, click
the left button, and enter a new value.

The “Last update” information is the same as it was in step 3.1.

3.6 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control information.

The Batch Request Receipt time has not been updated.
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3.7 Select “Save” from the “File” menu of the Schedule Maintenance Control Parameters
window.

The “Last update” information now reflects the time of the save.

3.8 Perform a data base query of the Schedule Control information.

The Batch Request Receipt time now reflects the update.

3.9 Select “Close” from the “File” menu.

The Schedule Maintenance Control Parameters window closes and control returns
to the Main Panel.

3.10 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears and contains the
update made in step 3.5.  The “Last update” information is the same as in step 3.5.

3.11 From NTS, transmit a SAR with a start time between the Automatic/Batch boundary and
the Batch Request Receipt time specified in step 3.5.

The operator is alerted that a request was received for batch processing.

4.0 AUTOMATIC REQUEST RECEIPT DURING LOCKOUT ALERT

4.1 From the Schedule Maintenance Control Parameters window, position the cursor in the
Automatic Request Receipt during Lockout time component, and click the left button.

The time component is highlighted.

4.2 Enable editing and change the time by clicking the arrow buttons.

The time is increased when the UP arrow button is clicked and decreased when
the DOWN arrow button is clicked.

4.3 Click the “Close” button.

The window closes and control returns to the Main Panel.

4.4 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The update made in step 4.2 is not reflected in the window.

4.5 Enable editing, position the cursor in the Automatic Request Receipt during Lockout alert
time component, click the left button, and enter a new value.

The “Last update” information is not updated.

4.6 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control information.

The Automatic Request Receipt During Lockout time has not been updated.
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4.7 From the Schedule Maintenance Control Parameters window, click the “Save” button.

The “Last update” information now reflects the time of the save.

4.8 Perform a data base query of the Schedule Control information.

The Automatic Request Receipt During Lockout time now reflects the update.

4.9 Select “Close” from the “File” menu.

The Schedule Maintenance Control Parameters window closes and control returns
to the Main Panel.

4.10 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The update made in step 4.5 is reflected in the window.

4.11 From NTS, transmit a SAR with a start time prior to the Automatic Request Receipt
during Lockout time specified in step 4.5.

The operator is alerted that a request was received for automatic processing during
a lockout.
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1.12.1.5 Detailed Test Procedure for Test Item INCC116-B1.5
SCHEDULE MAINTENANCE CONTROL PARAMETERS WINDOW:
SCHEDULE BOUNDARY PARAMETERS
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to specify the boundary between the automatic and batch
scheduling subphases.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 ABSOLUTE BOUNDARY

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The “Opened”
time reflects the time the window was opened.

Note the “Last update” date and operator in the Schedule Boundary Parameters
portion of the window.

Note the Current Batch Boundary and Active Period End times.

2.2 Enable editing, position the cursor in the Absolute Boundary time component and click
the left button.

The time component is highlighted.

2.3 Change the time by clicking the arrow buttons.

The time is increased when the UP arrow button is clicked and decreased when
the DOWN arrow button is clicked.  The “Last update” information is the same as
in step 2.1.

2.4 Select “Close” from the “File” menu.

The window closes and control returns to the Main Panel.

2.5 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The update made in step 2.3 is not reflected in the window.
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2.6 Enable editing, position the cursor in the Absolute Boundary time component, click the
left button, enter a time one hour later than the current value, and click the “Save” button.

The “Last update” information is updated.

2.7 Click the “Close” button.

The window closes and control returns to the Main Panel.

2.8 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The update made in step 2.6 is reflected in the window.

2.9 Position the cursor in the Absolute Boundary time component, click the left button, enter
a time one hour earlier than the current value, and click the “Save” button.

The operator is prevented from setting the time earlier than the previous time.

3.0 RELATIVE INTERVAL

3.1 From the Schedule Maintenance Control Parameters window, enable editing, position the
cursor in the Relative Interval time component, and click the left button.

The time component is highlighted.  Note the “Last update” information.

3.2 Position the cursor in the Relative Interval time component, click the left button, and
enter a different time value.

The “Last update” information is the same as in step 3.1.

3.3 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control information.

The Relative Interval has not been updated.

3.4 Select “Save” from the “File” menu of the Schedule Maintenance Control Parameters
window.

The “Last update” information is updated.

3.5 Change the time by clicking the arrow buttons.

The time is increased when the UP arrow button is clicked and decreased when
the DOWN arrow button is clicked.  The “Last update” information is not
updated.

3.6 Select “Close” from the “File” menu.

The window closes and control returns to the Main Panel.

3.7 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The modification made in step 3.2 is not reflected in the window.
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4.0 ADD “RESET RELATIVE BOUNDARY AT” TIMES

4.1 From the Schedule Maintenance Control Parameters window, enable editing, position the
cursor over the time component to the right of the “Reset Relative Boundary at” list, and
click the left button.

The time component is highlighted.  Note the “Last update” information.

4.2 Use the arrow buttons to enter a time.

The time is increased when the UP arrow is clicked and decreased when the
DOWN arrow is clicked.  The “Last update” information is the same as in step
4.1.

4.3 Click the “Add” button.

The entry is accepted and appears in the “Reset Relative Boundary at” list.  The
“Last update” information is not updated.

4.4 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control information.

The “Reset Relative Boundary at” information has not been updated.

4.5 Select “Save” from the “File” menu.

The “Last update” information reflects the time of the save.

4.5 Perform a data base query of the Schedule Control information.

The “Reset Relative Boundary at” information now reflects the modification made
in step 4.3.

4.6 Click the “Close” button.

The window closes and control returns to the Main Panel.

4.7 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The modification made in step 4.3 is reflected in the window.  The “Last update”
information is the same as in step 4.5.

4.8 Enable editing, position the cursor over the time component to the right of the “Reset
Relative Boundary at” list, click the left button, type in a new time value, and click the
“Add” button.

The entry is accepted and appears in the “Reset Relative Boundary at” list.  The
“Last update” information is not updated.

4.9 Repeat steps 4.4 through 4.7.

The results are the same.
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5.0 MODIFY “RESET RELATIVE BOUNDARY AT” TIME

5.1 From the Schedule Maintenance Control Parameters window, enable editing, select the
“Reset Relative Boundary at” value added in step 4.8 and click the “Remove” button.

The entry is removed from the list.  The “Last update” field is not updated.

5.2 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control information.

The “Reset Relative Boundary at” value removed in step 5.1 has not been
removed from the data base.

5.3 From the Schedule Maintenance Control Parameters window, click the “Save” button.

The “Last update” information is updated.

5.4 Perform a data base query of the Schedule Control information.

The “Reset Relative Boundary at” value removed in step 5.1 does not appear in
the data base.

5.5 Select “Close” from the “File” menu.

The window closes and control returns to the Main Panel.

5.6 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The “Reset Relative Boundary at” value removed in step 5.1 does not appear in
the list.
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1.12.1.6 Detailed Test Procedure for Test Item INCC116-B1.6
INVALID SCHEDULE MAINTENANCE CONTROL PARAMETERS
CSCI 1605

Pass/Fail Criteria:

• The NCCDS correctly validates scheduling control data entries and properly informs the
operator of invalid entries.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID SMC PARAMETERS

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The Enable
Editing toggle button is raised, indicating that editing is disabled.  All buttons
except “Close” are dimmed and non-functional.  The “Opened” time reflects the
time the window was opened.

2.2 Enable editing and attempt to add invalid parameters to the data base.  Click the “Save”
button.

The operator is appropriately notified that the entry is invalid.  The invalid entry is
not accepted.

2.3 Click the “Close” button.

The window closes and control returns to the Main Panel.
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1.12.1.7 Detailed Test Procedure for Test Item INCC116-B1.7
DATA RETENTION AND PURGE - SCHEDULE REQUESTS
CSCI 1604

Pass/Fail Criteria:

• The capability exists to specify retention criteria for schedule requests and schedule
messages.

• The capability exists to manually purge schedule requests and schedule messages from
the data base based on the operator-specified retention criteria.

• Purged data is no longer accessible.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Submit schedule requests as indicated below.  “R is the purge time minus the retention
value, which will be 5 minutes at the time of the purge (per step 2.13); “P” is the time the
purge is done (i.e., if P = 01:00:00, R = 00:55:00).  Leave enough time to execute 2.0
prior to the purge.

|-------------R---------------P-----------| Rel. Open        Duration

1. |--| 00:30:00 00:20:00
2. |-----| 00:30:00 00:25:00
3. |-----------| 00:30:00 00:27:00
4. |----------------------| 00:30:00 00:30:00
5. |-----------------------------| 00:30:00 00:35:00
6.         |------------| 00:55:00 00:03:00
7.         |----------------| 00:55:00 00:05:00
8.         |--------------------| 00:55:00 00:07:00
9.     |------| 00:57:00 00:01:00
10.     |----------| 00:57:00 00:03:00
11.     |-----------------| 00:57:00 00:08:00
12.       |-------| 01:00:00 00:05:00
13.             |--| 01:02:00 00:03:00

The requests are successfully validated and stored.
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2.0 SPECIFY RETENTION CRITERIA

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  Editing is
disabled.

2.2 Select “Retention Parameters...” from the “Edit” menu.

The Retention Control Parameters window appears.  Editing is disabled.

2.3 Enable editing and click in the Schedule Requests time component.

The time component is highlighted.

2.4 Use the arrow buttons to increase and decrease the retention criteria for schedule requests.

The UP arrow causes the time to increase and the DOWN arrow causes the time to
decrease.  The units are reflected in the window (i.e., HH:MM:SS or x
hours/minutes)  The “Last update” information is not updated.

2.5 Position the cursor in the Schedule Requests time component and enter the time such that
schedule requests will be retained for 72 hours after their start time.

The entry is accepted.  The “Last update” information is not updated.

2.6 Perform a data base query of the Schedule Control information.

The updates made in steps 2.4 and 2.5 are not reflected in the data base.

2.7 Click the “Close” button.

The window closes and control returns to the Schedule Maintenance Control
Parameters window.

2.8 Select “Retention Parameters” from the “Edit” menu.

The updates made in steps 2.4 and 2.5 are not reflected in the window.

2.9 Enable editing, specify the retention criteria for schedule requests to be as low as
possible, and click the “Save” button.  [Is there a minimum allowed value for this?]

The update is accepted and the “Last update” information is updated.

2.10 Click the “Close” button.

The window closes and control returns to the Schedule Maintenance Control
Parameters window.

2.11 Select “Retention Parameters” from the “Edit” menu.

The update made in step 2.10 is reflected in the window.  The “Last update”
information is the same as in step 2.10.
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2.13 Enable editing, change the Schedule Requests retention time to 5 minutes, and click the
“Save” button.

The update is accepted and  the “Last update” information is updated.

3.0 MANUAL PURGE

3.1 After the start times of some of the requests submitted in step 1.3 are more than 5 minutes
in the past, access UNIX and perform a manual purge of schedule requests.

Requests 1 through 8 from step 1.3 are purged.  Requests 9 through 13 are not
purged.  Schedule Requests associated with ongoing events with start times
more than 5 minutes in the past are not purged??

3.2 Review the alert queue.

The operator received an alert indicating that a manual purge was performed.

3.3 Perform a data base query of schedule requests.

The purged requests are resident on the data base with an indication that they have
been purged.  [When are these actually cleaned out of the data base?]  The
other requests are unaffected.

3.4 Access the Schedule Requests window.

The purged requests are not displayed.  The other requests are unaffected.
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1.12.1.8 Detailed Test Procedure for Test Item INCC116-B1.8
DATA RETENTION AND PURGE - TSWS
CSCI 1604

NOTE: This test item will need to be repeated when the TSW windows are
implemented.

Pass/Fail Criteria:

• The capability exists to specify retention criteria and manually purge TSWs from the
data base.

• The capability exists to manually purge TSWs from the data base based on the operator-
specified retention criteria.

• Purged data is no longer available.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

1.3 Submit TSWs as indicated below.  “R” is the purge time minus the retention value, which
will be 5 minutes at the time of the purge (per step 2.12); “P” is the time the purge is done
(i.e., if P = 01:00:00, R = 00:55:00).  Leave enough time to execute 2.0 prior to the purge.

|-------------R---------------P-----------| Rel. Open        Rel. Close

1. |--| 00:30:00 00:50:00
2. |-----| 00:30:00 00:55:00
3. |-----------| 00:30:00 00:57:00
4. |----------------------| 00:30:00 01:00:00
5. |-----------------------------| 00:30:00 01:05:00
6.         |------------| 00:55:00 00:58:00
7.         |----------------| 00:55:00 01:00:00
8.         |--------------------| 00:55:00 01:02:00
9.     |------| 00:57:00 00:58:00
10.     |----------| 00:57:00 01:00:00
11.     |-----------------| 00:57:00 01:05:00
12.       |-------| 01:00:00 01:05:00
13.             |--| 01:02:00 01:05:00

The TSWs are successfully validated and stored.
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1.4 Submit schedule requests associated with the TSWs.  [Any point in doing this?  Is there
any connection between events/requests that use TSWs and the purging of those
TSWs?]

2.0 SPECIFY RETENTION CRITERIA

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.

2.2 Enable editing and select “Retention Parameters...” from the “Edit” menu.

The Retention Control Parameters window appears.  Editing is enabled.

2.3 Click in the TDRS Scheduling Windows time component.

The time component is highlighted.

2.4 Enter the time such that TSWs will be retained for 24 hours after their start time.

The entry is accepted.  The “Last update” information is not updated.

2.5 Position the cursor in the TDRS Scheduling Windows time component and use the arrow
buttons to increase and decrease the retention criteria for TSWs.

The UP arrow causes the time to increase and the DOWN arrow causes the time to
decrease.  The “Last update” information is not updated.

2.6 Perform a data base query of the Schedule Control information.

The updates made in steps 2.4 and 2.5 are not reflected in the data base.

2.7 Click the “Close” button.

The window closes and control returns to the Schedule Maintenance Control
Parameters window.

2.8 Select “Retention Parameters” from the “Edit” menu.

The Retention Control Parameters window appears.  The updates made in steps
2.4 and 2.5 are not reflected in the window.

2.9 Specify the retention criteria for schedule requests to be as low as possible and click the
“Save” button.  [Is there a minimum allowed value for this?]

The update is accepted and the “Last update” information is updated.

2.10 Click the “Close” button.

The window closes and control returns to the Schedule Maintenance Control
Parameters window.

2.11 Select “Retention Parameters” from the “Edit” menu.

The update made in step 2.9 is reflected in the window.
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2.12 Change the TSW retention time to 5 minutes and click the “Save” button.

The update is accepted and the “Last update” information is updated.

3.0 MANUAL PURGE

3.1 After the start times of some of the TSWs submitted in step 1.3 are more than 5 minutes
in the past, access UNIX and perform a manual purge of TSWs.

TSWs 1 and 2 from step 1.3 are purged.  TSWs 3 through 13 are not purged.
TSWs associated with ongoing events with start times more than 5 minutes in
the past are not purged??

3.2 Review the alert queue.

The operator is alerted that a manual purge was performed.

3.3 Perform a data base query of TSWs.

The purged TSWs are resident on the data base with an indication that they have
been purged.  [When are these actually cleaned out of the data base?]  The
other TSWs are unaffected.
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1.12.1.9 Detailed Test Procedure for Test Item INCC116-B1.9
INVALID RETENTION CONTROL PARAMETERS
CSCI 1605

Pass/Fail Criteria:

• The NCCDS validates entries and properly informs the operator of invalid retention
times for schedule requests, schedule events and associated messages, and TSWs.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 INVALID RETENTION CONTROL DATA

2.1 Access the Retention Control window and enter invalid retention criteria.  [60 minutes,
etc.?]

The operator is appropriately notified that the entries are invalid.  The invalid
entries are not accepted.



2/6/97  6:31 PM INCC116-23 530-ITP-NCCDS/1998

1.12.1.10 Detailed Test Procedure for Test Item INCC116-B1.10
SCHEDULING PRIORITIES LISTS WINDOW
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to add, activate, and delete a scheduling priority list.

• The operator has the capability to modify a customer’s relative priority in a list.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 VIEW/ADD SCHEDULING PRIORITY LISTS

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.

2.2 Select “Scheduling Priority Lists” from the “Edit” menu.

The Scheduling Priorities List window appears.  The names of the currently
defined scheduling priority lists, along with an indication of their status (active or
not), appear in the left portion of the window.  The right portion of the window is
blank.  Editing is disabled.

2.3 Select a Scheduling Priority List.

The associated information appears in the right portion of the window.

2.4 Click the “Activate” button.

The function is not completed and the operator is notified that editing is not
enabled.  The “Last update” information is not updated.

2.5 Enable editing, position the cursor in the “List Name” component, enter a name, and click
the “New” button.

The name is added to the list in the left portion of the window.  The corresponding
information appears in the right portion of the window.  [Where does this
information come from ??]

2.6 Click the “Save” button.

The “Last update” information is updated.  Note the information in the test log.
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2.7 Click the “Close” button.

The window closes and control returns to the Schedule Maintenance Control
Parameters window.

2.8 Select “Scheduling Priority Lists” from the “Edit” menu.

The list added in step 2.5 is displayed.  The “Last update” information is the same
as in step 2.6.

3.0 ACTIVATE SCHEDULING PRIORITY LISTS

3.1 From the Scheduling Priorities List window, select a list, and click the “Activate” button.

The status in the “Active” field is correctly reflected.  The previously active list is
no longer listed as active.

3.2 Perform a data base query of the Schedule Control information.

The change made in step 3.1 is not reflected in the data base.

3.3 Click the “Save” button.

The “Last update” information is updated.

3.4 Perform a data base query of the Schedule Control information.

The change made in step 3.1 has been written to the data base.

4.0 DELETE SCHEDULING PRIORITY LISTS

4.1 From the Scheduling Priorities List window, select a Scheduling Priority List, click the
“Delete” button, and answer NO in the confirmation dialog box.

The selected list is not affected by the attempted delete.  The “Last update”
information is not updated.

4.2 Click the “Close” button.

The window closes and control returns to the Schedule Maintenance Control
Parameters window.

4.3 Select “Scheduling Priority Lists” from the “Edit” menu.

The list selected in step 4.1 was not affected by the attempted delete.

4.4 Repeat step 4.1, answering YES in the confirmation dialog box.

All information related to the selected list is removed from the window.  The
“Last update” information is updated.
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4.5 Click the “Close” button

The window closes and control returns to the Schedule Maintenance Control
Parameters window.

4.6 Select “Scheduling Priority Lists” from the “Edit” menu.

The list deleted in step 4.4 does not appear in the window.  The “Last update”
information is the same as in step 4.4.

5.0 ASSOCIATED INFORMATION

5.1 From the Scheduling Priority Lists window, enable editing, and select a Scheduling
Priority List.

The customers, mission priorities, and request priorities appear in the right portion
of the window.

5.2 Select a customer and click the “Move” button.  Select another customer and click the
“Insert Before” button.

The first customer selected is moved to just before the second customer selected.

5.3 Perform a data base query of the Scheduling Priorities List information.

The update made in step 5.2 is not reflected in the data base.

5.4 Click the “Close” button.

The window closes and control returns to the Schedule Maintenance Control
Parameters window.

5.5 Perform a data base query of the Scheduling Priorities List information.

The update made in step 5.2 is not reflected in the data base.

5.6 Select “Scheduling Priority Lists” from the “Edit” menu, enable editing, select a list,
select a customer, and click the “Move” button.  Select another customer and click the
“Insert After” button.

The first customer selected is moved to just after the second customer selected.

5.7 Click the “Save” button.

The “Last update” information is updated.

5.8 Select the list modified in step 5.6 and click the “Restore” button.

The list is updated to the default order - request priority, then mission priority.

5.9 Click the “Close” button.

The window closes and control returns to the Schedule Maintenance Control
Parameters window.
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5.10 Re-access the window and select the list modified in step 5.6.

The updates made in step 5.6 are reflected.  The list is not in the default order.
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1.12.1.11 Detailed Test Procedure for Test Item INCC116-B1.11
SCHEDULE REQUESTS WINDOW
CSCI 1602

Pass/Fail Criteria:

• Customer-initiated schedule requests are accurately displayed in the Schedule Requests
window.

• The operator has the capability to delete requests via the Schedule Requests window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, submit valid and invalid SARs, ASARs, Replace Requests, Delete Requests,
and Wait-List Requests.

2.0 REVIEW REQUESTS

2.1 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears and indicates that the requests submitted
in step 1.2 are accurately reflected in the window.  The Version is “0” for each
request.  The Request IDs indicate that the requests were submitted from the
MOC.

The “Enable Editing” toggle button is raised and all but the “View...” and “Close”
buttons are dimmed and not functional.  The “Opened” time is accurately
reflected.

2.2 Select a schedule request submitted in step 1.2 and click the “View...” button.

The Edit SAR window appears with editing disabled.  All buttons are dimmed
except “Close”.  The SAR submitted in step 1.2 is accurately reflected in the
window.

2.3 Click the “Close” button.

The window closes and control returns to the Schedule Requests window.
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3.0 DELETE REQUESTS

3.1 From the Schedule Requests window, enable editing, select a request submitted in step
1.2, and click the “Delete” button.

A dialog box appears to confirm the deletion.

3.2 Without closing the Schedule Requests window, perform a data base query of the
Schedule Request information.

The request selected in step 3.1 appears in the data base.

3.3 From the Schedule Requests window, click the “YES” button.

The dialog box closes, the status of the request is now “Deleted”, and the “Last
update” information is updated.

3.4 Perform a data base query of the Schedule Request information.

The request selected in step 3.1 no longer appears in the data base.

3.5 Click the “Close” button.

The window closes and control returns to the Main Panel.

3.6 Re-access the Schedule Requests window.

The request deleted in step 3.3 does not appear in the window.

3.7 Select the replace request submitted in step 1.2, and click the “Delete” button.  Answer
YES in the confirmation dialog box to delete the replace request.

The dialog box closes, the Status of the request is now “Deleted”, and the “Last
update” information is updated.  Does Ops really want deleted requests to
appear on the Schedule Requests window?

3.8 Select the deleted request and click the “Modify...” button.

The operator is notified that this request cannot be modified.

3.9 Select the deleted request and click the “Generate Alternate...” button.

The operator is notified that an Alternate SAR cannot be generated for this
request.
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1.12.1.12 Detailed Test Procedure for Test Item INCC116-B1.12
SCHEDULE REQUESTS WINDOW - INVALID ENTRIES
CSCI 1602

Pass/Fail Criteria:

• Attempts to generate requests other than SARs without first selecting a referenced
request via the Schedule Requests window are denied.

• Attempts to generate requests based on erroneous requests (e.g., Replace based on
Delete) from the Schedule Requests window are denied.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 From NTS, submit a delete request.

2.0 INVALID SELECTIONS

2.1 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears and contains the delete request submitted
in step 1.2.  The “Opened” time reflects the time the window was opened.

2.2 Without selecting a request, click the “Generate Replace...” button.  Is the first request
in the window selected by default on access?

The operator is notified that a request must first be selected.

2.3 Select the delete request submitted in step 1.2 and click the “Generate Alternate...”
button.

The operator is notified that an Alternate SAR cannot be generated based on the
selected request.

3.0 NO REQUESTS IN WINDOW

3.1 Remove all requests from the Schedule Requests window.

3.2 Click the “Close” button.

The window closes and control returns to the Main Panel.

3.3 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears without any requests.
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1.12.1.13 Detailed Test Procedure for Test Item INCC116-B1.13
EDIT SAR WINDOW - VALID SARS
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to view, add, and modify SARs via the Edit SAR
window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with Scheduling capabilities.

2.0 GENERATE SARs

2.1 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears with editing disabled.  All buttons are
dimmed except “View...” and “Close”.  The “Opened” time reflects the time the
window was opened.

2.2 Click the “Generate SAR...” button.

The Edit SAR window appears with editing disabled.  All buttons are dimmed
except “Close”.  The “Opened” time reflects the time the window was opened.
The window appears without any data.

2.3 Make an entry and click the “Save Request” button.

The function is not completed and the operator is notified that editing is not
enabled.  The “Last update” information is not updated.

2.4 Click the “Enable Editing” toggle button.

All buttons are no longer dimmed and are functional.

2.5 Enter the requested information, specifying several services.

The entries are accepted.  The “Last update” information is not updated.

2.6 Without closing the Edit SAR window, perform a data base query of the Schedule
Request information.

The SAR from step 2.5 does not appear in the data base.
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2.7 From the Edit SAR window, click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  Editing is disabled.  The SAR is accurately
reflected in the Schedule Requests window.

2.8 Select the request submitted in step 2.7, and click the “View...” button.

The Edit SAR window appears with editing disabled.  All buttons are dimmed
except “Close”.  The SAR submitted in step 2.7 is accurately reflected in the
window.

2.9 Click the “Close” button.

The window closes and control returns to the Schedule Requests window.

3.0 MODIFY SARs

3.1 From the Schedule Requests window, enable editing, select the SAR submitted in step
2.7, note it’s version number, and click the “Modify...” button.

The Edit SAR window appears and accurately reflects the selected request.
Editing is enabled.

3.2 Edit the request (using the “Remove”, “Move Up”, “Move Down”, and “Remove All”
buttons) and click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value of the selected request is
one higher than it was in step 3.1.

3.3 Select the SAR modified in step 3.2 and click the “Modify...” button.

The updates made in step 3.2 are reflected in the resulting Edit SAR window.

3.4 Repeat steps 3.1 and 3.2, clicking the “Close” button instead of the “Save Request”
button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value for the selected SAR is
the same as it was in step 3.2.

3.5 Disable editing, select the SAR, and click the “View...” button.

The updates made in step 3.3 are not reflected on the resulting Edit SAR window.
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1.12.1.14 Detailed Test Procedure for Test Item INCC116-B1.14
EDIT SAR WINDOW - VALID ASARS
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to view, add, and modify ASARs via the Edit SAR
window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with Scheduling capabilities.

1.3 From NTS, transmit a valid SAR containing several services to the NCCDS.

2.0 GENERATE ASARs

2.1 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears with editing disabled.  All buttons are
dimmed except “View...” and “Close”.  The “Opened” time reflects the time the
window was opened.  The window contains the SAR submitted in step 1.3.  Note
the Request ID of the SAR.

2.2 Select the SAR submitted in step 1.3 and click the “Generate Alternate...” button.

The Edit SAR window appears with editing disabled.  All buttons are dimmed
except “Close”.  The “Opened” time reflects the time the window was opened.
The window reflects the information associated with the selected SAR.  The
“Referenced Request ID” field contains the SAR’s Request ID.  The “Request ID”
field contains a different Request ID.

2.3 Make an entry and click the “Save Request” button.

The function is not completed and the operator is notified that editing is not
enabled.  The “Last update” information is not updated.

2.4 Click the “Enable Editing” toggle button.

All buttons are no longer dimmed and are functional.

2.5 Enter a valid plus tolerance.

The entries are accepted.  The “Last update” information is not updated.
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2.6 Without closing the Edit SAR window, perform a data base query of the Schedule
Request information.

The ASAR from step 2.5 does not appear in the data base.

2.7 From the Edit SAR window, click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  Editing is disabled.  The ASAR is accurately
reflected on the Schedule Requests window.  The “Referenced Request ID” field
contains the SAR’s Request ID.  The “Request ID” field contains the same value
as on the Edit SAR window.

2.8 Select the ASAR submitted in step 2.7 and click the “View...” button.

The Edit SAR window appears with editing disabled.  All buttons are dimmed
except “Close”.  The ASAR submitted in step 2.7 is accurately reflected.

2.9 Click the “Close” button.

The window closes and control returns to the Schedule Requests window.

3.0 MODIFY ASARs

3.1 From the Schedule Requests window, enable editing, select the ASAR submitted in step
2.7, and click the “Modify...” button.

The Edit SAR window appears and accurately reflects the selected request.
Editing is enabled.

3.2 Edit the request (using the “Remove”, “Move Up”, “Move Down”, and “Remove All”
buttons) and click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value of the selected request is
one higher than it was in step 3.1.

3.3 Select the ASAR modified in step 3.2 and click the “Modify...” button.

The updates made in step 3.2 are reflected in the resulting Edit SAR window.

3.4 Repeat steps 3.1 and 3.2, clicking the “Close” button instead of the “Save Request”
button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value for the selected ASAR is
the same as it was in step 3.2.

3.5 Select the ASAR and click the “Modify...” button.

The updates made in step 3.3 are not reflected on the resulting Edit SAR window.
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1.12.1.15 Detailed Test Procedure for Test Item INCC116-B1.15
EDIT SAR WINDOW - VALID REPLACE REQUESTS
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to view, add, and modify Replace Requests via the Edit
SAR window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with Scheduling capabilities.

1.3 From NTS, transmit a valid SAR containing several services to the NCCDS.

2.0 GENERATE REPLACE REQUESTs

2.1 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears with editing disabled.  All buttons are
dimmed except “View...” and “Close”.  The “Opened” time reflects the time the
window was opened.  The window contains the SAR submitted in step 1.3.  Note
the Request ID of the SAR.

2.2 Select the SAR submitted in step 1.3 and click the “Generate Replace...” button.

The Edit SAR window appears with editing disabled  All buttons are dimmed
except “Close”.  The “Opened” time reflects the time the window was opened.
The window reflects the information associated with the selected SAR.  The
“Referenced Request ID” field contains the SAR’s Request ID.  The “Request ID”
field contains a different Request ID.

2.3 Make an entry and click the “Save Request” button.

The function is not completed and the operator is notified that editing is not
enabled.  The “Last update” information is not updated.

2.4 Click the “Enable Editing” toggle button.

All buttons are no longer dimmed and are functional.

2.5 Remove one of the services and click the “Remove” button.

The entries are accepted.  The “Last update” information is not updated.
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2.6 Without closing the Edit SAR window, perform a data base query of the Schedule
Request information.

The replace request from step 2.5 does not appear in the data base.

2.7 From the Edit SAR window, click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  Editing is disabled.  The replace request is
accurately reflected on the Schedule Requests window.  The “Referenced Request
ID” field contains the SAR’s Request ID.  The “Request ID” field contains the
same value as on the Edit SAR window.

2.8 Select the replace request submitted in step 2.7 and click the “View...” button.

The Edit SAR window appears with editing disabled.  All buttons are dimmed
except “Close”.  The replace request submitted in step 2.7 is accurately reflected.

2.9 Click the “Close” button.

The window closes and control returns to the Schedule Requests window.

3.0 MODIFY REPLACE REQUESTs

3.1 Access the Schedule Requests window, enable editing, select the replace request
submitted in step 2.7, and click the “Modify...” button.

The Edit SAR window appears and accurately reflects the selected request.
Editing is enabled.

3.2 Edit the replace request (using the “Remove”, “Move Up”, “Move Down”, and “Remove
All” buttons) and click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value of the selected request is
one higher than it was in step 3.1.

3.3 Select the replace request modified in step 3.2 and click the “Modify...” button.

The updates made in step 3.2 are reflected in the resulting Edit SAR window.

3.4 Repeat steps 3.1 and 3.2, clicking the “Close” button instead of the “Save Request”
button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value for the selected replace
request is the same as it was in step 3.2.

3.5 Select the replace request and click the “Modify...” button.

The updates made in step 3.3 are not reflected on the resulting Edit SAR window.
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1.12.1.16 Detailed Test Procedure for Test Item INCC116-B1.16
EDIT SAR WINDOW - INVALID REQUESTS
CSCI 1602

Pass/Fail Criteria:

• Operator-initiated schedule requests submitted via the Edit SAR window are
successfully validated.

• The operator is appropriately alerted of attempts to submit invalid schedule requests.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with Scheduling capabilities.

1.3 From NTS, transmit a valid and SAR to the NCCDS.

1.4 From NTS, transmit a valid ASAR that references the SAR submitted in step 1.3 to the
NCCDS.

1.5 From NTS, transmit a SAR that specifies a TDRS not defined in the data base.

1.6 From NTS, transmit an ASAR that specifies an invalid SUPIDEN.  [will this be stored?]

1.7 From NTS, transmit a Replace Request that specifies a minus tolerance of 00:00:60.

2.0 GENERATE INVALID REQUESTS

NOTE: An assumption is being made that invalid operator-initiated requests are not
saved.

2.1 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears and contains the SARs submitted in steps
1.3 through 1.7.  The Status is “Valid” for the requests submitted in steps 1.3 and
1.4 and “Invalid” the for the requests submitted in steps 1.5 through 1.7.  The
“Opened” time reflects the time the window was opened.

2.2 Enable editing and click the “Generate SAR...” button.

The Edit SAR window appears without any data.  The “Opened” time reflects the
time the window was opened.
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2.3 Enter the requested information, specifying an event start time more than 28 days in the
future, and click the “Save Request” button.

The operator is accurately notified that the request is invalid and why.  The “Last
update” information is not updated.

2.4 From the Schedule Requests window, click the “Generate Replace...” button without
selecting a request.

The operator is notified that a request must first be selected.  The Edit SAR
window does not appear.

2.5 Select the SAR submitted in step 1.3 and click the “Generate Alternate...” button.

The Edit SAR window appears and contains the selected request.

2.6 Enter an SSC that’s not defined in the data base for the SIC and click the “Save Request”
button.

The operator is notified that the request was rejected because it contains an invalid
SSC.  The “Last update” information is not updated.  The window does not close.

2..7 Perform data base query of the Schedule Request information.

The invalid ASAR submitted in step 2.6 does not appear in the data base.

2.8 From the Schedule Requests window, select the ASAR submitted in step 1.4 and click the
“Generate Replace...” button.

The Edit SAR window appears and contains the selected request.

2.9 Enter a TDRS that’s not valid for the SUPIDEN and click the “Save Request” button.

The operator is notified that the request was rejected because the TDRS is not
valid for the SUPIDEN.  The “Last update” information is not updated.

2.10 Submit a Replace Request that references an invalid request.

The request is rejected.

3.0 MODIFY INVALID REQUESTS

3.1 Access the Schedule Requests window, enable editing, select the SAR submitted in step
1.5, and click the “Modify...” button.

The Edit SAR window appears and accurately reflects the selected request.

3.2 Enter a valid TDRS and click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The Status is now “Valid”.
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3.3 Select the SAR modified in step 3.2 and click the “Modify...” button.

The update made in step 3.2 is reflected in the resulting Edit SAR window.

3.4 Repeat steps 3.1 and 3.2, clicking the “Close” button instead of the “Save Request”
button.

The window closes and control returns to the Schedule Requests window.  The
Status of the SAR selected in step 3.3 is still “Invalid”.

3.5 Select the SAR and click the “Modify...” button.

The update made in step 3.4 is not reflected in the window.

3.6 Repeat steps 3.1 and 3.2 for the Replace Request submitted in step 1.6, entering a valid
SUPIDEN.

3.7 Repeat steps 3.1 and 3.2 for the ASAR submitted in step 1.7, entering a valid minus
tolerance.
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1.12.1.17 Detailed Test Procedure for Test Item INCC116-B1.17
EDIT SERVICE WINDOW
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to modify service information for schedule requests.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with Scheduling capabilities.

1.3 Submit valid and invalid schedule requests.

2.0 MODIFY SERVICE INFORMATION

2.1 Select “Schedule Requests” from the Scheduling subpanel.  From the Schedule Requests
window, enable editing, select a valid request, and click the “Modify...” button.

The Edit SAR window appears and contains the selected request.  The “Opened”
time reflects the time the window was opened.

2.2 Select a service, and click the “Modify Service...” button.

The Edit Service window appears and contains the selected service.  All
information is accurate.  The “Opened” time reflects the time the window was
opened.

2.3 Modify the service information and click the “Close” button.

The window closes and control returns to the Edit SAR window.

2.4 Select the same service and click the “Modify Service...” button.

The modifications made in step 2.3 are not reflected in the window.

2.5 Modify the service information and click the “Save” button.

The “Last update” information is updated.  The window closes and control returns
to the Edit SAR window.

2.6 Select the same service and click the “Modify Service...” button.

The updates made in step 2.5 are reflected in the window.

2.7 Click the “Close” button.

The window closes and control returns to the Edit SAR window.
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2.8 Click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.

2.9 Re-access the Edit Service window for the same service.

The updates previously made are reflected in the window.

2.10 Modify service information to valid for a request that has valid service information.

2.11 Modify service information to valid for a request that has invalid service information.

2.12 Modify service information to invalid for a request that has valid service information.

2.13 Modify service information to invalid for a request that has invalid service information.

2.14 Click the “Close” button on the Edit Service and Edit SAR windows.

The windows close and control returns to the Schedule Requests window.

3.0 MODIFY INVALID SERVICE INFORMATION

3.1 From the Schedule Requests window, select an invalid request and click the “Modify...”
button.  From the Edit SAR window, select a service and click the “Modify Service...”
button.

The Edit Service window appears and correctly reflects the requested service
information.

3.2 Modify the service information and click the “Save” button.  Re-access the Edit Services
window for the same service.

The “Last update” information is updated.  The window closes and the updates are
retained upon re-access of the window.

3.3 Click the “Close” button.

The window closes and control returns to the Edit SAR window.

3.4 Click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.

3.5 Re-access the Edit Services window for the same service.

The updates previously made are reflected in the window.

3.6 Modify the service information and click the “Close” button.  Re-access the Edit Services
window for the same service.

The window closes and the updates are not retained upon re-access of the
window.
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1.12.1.18 Detailed Test Procedure for Test Item INCC116-B1.18
EDIT SAR WINDOW - MODIFY PARAMETERS
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to add prototype events to the service scheduling
information of a SAR.

• The operator has the capability to add service specification codes (SSC) to the service
scheduling information of a SAR.

• The operator has the capability to modify service parameter information for schedule
requests.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with Scheduling capabilities.

1.3 Submit valid schedule requests.

2.0 ADDING PROTOTYPE EVENTS TO SAR

2.1 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears with editing disabled.  All buttons are
dimmed except “View...” and “Close”.  The “Opened” time reflects the time the
window was opened.

2.2 Click the “Enable Editing” toggle button.

The “View...” button label is changed to “Modify...”.  The other buttons are no
longer dimmed.

2.3 Select a SAR submitted in step 1.3, note it’s version number, and click the “Modify...”
button.

The Edit SAR window appears and accurately reflects the selected request.  The
“Opened” time reflects the time the window was opened.

2.4 Position the cursor over the Prototype Events radio button in the Service Scheduling
Information area and click the left button.

The Prototype Events button is depressed and the list below the button is
populated with the prototype events defined for the SIC.
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2.5 Select a prototype event from the list and click “Add” button above the list.

The list that starts with Service Number populates with the service information
included in the selected prototype event.  Any previous information contained in
this list is replaced.

2.6 Click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value of the selected request is
one higher than it was in step 2.3.

3.0 ADDING SERVICE SPECIFICATION CODE TO SAR

3.1 From the Schedule Requests window, select a SAR submitted in step 1.3, note it’s
version number, and click the “Modify...” button.

The Edit SAR window appears and accurately reflects the selected request.

3.2 Position the cursor over the Service Specification Codes radio button in the Service
Scheduling Information area and click the left button.

The Service Specification Codes button is depressed and the list below the button
is populated with the SSCs defined for the SIC.

3.3 Select an SSC from the list and click “Add” button above the list.

The selected SSC is added to the bottom of the list that starts with Service
Number.

3.4 Click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value of the selected request is
one higher than it was in step 3.1.

4.0 MODIFY SERVICE PARAMETERS

4.1 From the Schedule Requests window, select a SAR submitted in step 1.3, note it’s
version number, and click the “Modify...” button.

The Edit SAR window appears and accurately reflects the selected request.

4.2 Select a service from the list that starts with Service Number in the Scheduling
Information area.  Click the “Parameters...” button

The Schedulable Parameters window for the selected service appears and contains
the service parameter information for the selected SAR.
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4.3 Modify the fixed and reconfigurable parameters for the selected service and click the
“Save” button.

The “Last update” information is updated.  The Schedulable Parameters window
closes and control returns to the Edit SAR window.

4.4 Click the “Save Request” button.

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The “Version” value of the selected request is
one higher than it was in step 4.1.
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1.12.1.19 Detailed Test Procedure for Test Item INCC116-B1.19
EDIT DELETE REQUEST WINDOW
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to enter new delete requests.

• The operator has the capability to edit delete requests.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with Scheduling capabilities.

1.3 From NTS, submit a valid SAR, ASAR, Replace Request, Wait-List Request, and delete
request.

2.0 GENERATE DELETE REQUESTS

NOTE: Will Ops ever use this capability?  It seems much more straightforward to
select a request from the Schedule Requests window and click the “Delete”
button.  Maybe this window should only be used for editing existing delete
requests.

2.1 Select “Schedule Requests” from the Scheduling subpanel.  From the Schedule Requests
window, enable editing, select the SAR submitted in step 1.3, and click the “Generate
Delete ...” button.

The Edit Delete Request window appears and accurately reflects the selected
request.  Editing is enabled.  The “Opened” time reflects the time the window was
opened.

2.2 Click the “Enable Editing” toggle button and click the “Save Request” button.

The operator is notified that editing is disabled.  The “Save Request” button is
dimmed and non-functional.  The “Last update” information is not updated.

2.3 Without closing the Edit Delete Request window, perform a data base query of the
Schedule Requests information.

The SAR selected in step 2.1 appears in the data base.
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2.4 Click the “Close” button.

The window closes and control returns to the Schedule Requests window.  The
Status of the request selected in step 2.1 is still “Valid”.

2.5 Select the SAR submitted in step 1.3, click the “Generate Delete...” button.

The Edit Delete Requests window appears (editing enabled) and reflects the
selected request.

2.6 Click the “Save Request” button.  Is the referenced request deleted when you click the
“Save Request” button?

The “Last update” information is updated.  The window closes and control returns
to the Schedule Requests window.  The Status of the selected request is
“Deleted”.  The delete request submitted in step is reflected (?) in the window
with Status “?”.

2.7 Perform a data base query of the Schedule Requests information.

The SAR selected in step 2.1 no longer appears in the data base?

3.0 MODIFY DELETE REQUESTS

3.1 Modify a valid operator-initiated delete request.

3.2 Modify a valid MOC-initiated delete request.

3.3 Modify an invalid operator-initiated delete request.

3.4 Modify an invalid MOC-initiated delete request.
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1.12.1.20 Detailed Test Procedure for Test Item INCC116-B1.20
EDIT WAIT-LIST REQUEST WINDOW
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to enter new wait-list requests.

• The operator has the capability to edit wait-list requests.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with Scheduling capabilities.

1.3 From NTS, transmit a valid SAR to the NCCDS.

2.0 GENERATE WAIT-LIST REQUESTS

2.1 Select “Schedule Requests” from the Scheduling subpanel.  From the Schedule Requests
window, enable editing, select the request submitted in step 1.3, and click the “Generate
Wait List...” button.

The Edit Wait List Request window appears and contains the selected request.
Editing is enabled.  The “Opened” time reflects the time the window was opened.

2.2 Click the “Enable Editing” toggle button, enter an expiration time, and click the “Save
Request” button.

The operator is notified that editing is disabled.  The “Save Request” button is
dimmed and non-functional.  The “Last update” information is not updated.

2.3 Without closing the Edit Wait List window, perform a data base query of the Schedule
Requests information.

The wait-list request does not appear in the database.

2.4 From the Edit Wait List Request window, enable editing, enter an expiration time, and
click the “Save Request” button.

The “Last update” information is updated.  The window closes and the wait-list
request appears in the resulting Schedule Requests window.  The Reference
Request ID is the Request ID of the SAR.

2.5 Perform a data base query of the Schedule Requests information.

The wait-list request now appears in the database.
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3.0 MODIFY WAIT-LIST REQUESTS

3.1 From the Schedule Requests window, select the Wait-List request submitted in step 2.4
and click the “Modify...” button.

The Edit Wait-List Request window appears and contains the selected request.

3.2 Modify the Expiration time.

The entry is accepted.

3.3 Perform a data base query of the Schedule Requests information.

The wait-list request has not been updated.

3.4 From the Edit Wait-List Request window, click the “Close” button.

The window closes and control returns to the Schedule Requests window.

3.5 Select the same Wait-List request and click the “Modify...” button.

The Edit Wait-List Request window appears and contains the selected request.

3.6 Click the “Save Request” button.

The edited request is successfully validated and stored.  The “Last update”
information is updated.  The window closes and control returns to the Schedule
Requests window.

3.7 Perform a data base query of the Schedule Requests information.

The wait-list request now reflects the update.
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1.12.1.21 Detailed Test Procedure for Test Item INCC116-B1.21
SCHEDULE MAINTENANCE CONTROL PARAMETERS WINDOW:
TUT CONTROL PARAMETERS
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to specify the intervals for TUT generation and
distribution.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 TUT CONTROL PARAMETERS

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The “Inhibit
TUT Generation” radio button is raised, indicating that TUT is not inhibited.  The
"Opened" time reflects the time the window was opened.  Editing is disabled.

2.2 Attempt to enter new values in the “Generate TUT at” and “Generate TUT every” fields.

All fields may be highlighted, but no new values may be entered.  The operator is
warned by a “beep” whenever a new entry is attempted.

2.3 Enable editing and position the cursor over the “Generate TUT at” time component.  Use
the arrows for one time component (such as hours) and the keyboard for another (such as
minutes) to change the time.

The time is increased when the UP arrow is clicked and decreased when the
DOWN arrow is clicked.  Time may also be changed using the keyboard.  The
“Last update” information in the TUT Control Parameters area is not updated.

2.4 Position the cursor over the “Generate TUT every” time component and enter a new
value.

The “Last update” information in the TUT Control Parameters area is not updated.

2.5 Click the “Generate TUT” button.

TUT information is generated at the specified times.
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2.6 Click the “Save” button.

The “Last update” information in the TUT Control Parameters area reflects the
time of the save.

2.7 Click the “Close” button.

The window closes and control returns to the Main Panel.

2.8 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The changes made in steps 2.3 and 2.4 are reflected in the window.  The “Last
update” information in the TUT Control Parameters area is the same as in step
2.6.  Editing is disabled.

2.9 Repeat steps 2.3 and 2.4 and disable editing.

A dialog box asks the operator if the changes should be saved.

2.10 Click the “Yes” button, followed by the “Close” button.

The “Last update” information in the TUT Control Parameters area reflects the
time of the save.  The dialog box and the window closes and control returns to the
Main Panel.

2.11 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The changes made in step 2.9 are reflected in the window.  The “Last update”
information in the TUT Control Parameters area is the same as in step 2.10.
Editing is disabled.

2.12 Enable editing and click the “Inhibit TUT Generation” radio button.

The button is now depressed, indicating that TUT generation is inhibited.

2.13 Attempt to enter new values in the “Generate TUT at” and “Generate TUT every” fields.

All fields may be highlighted, but no new values may be entered.  The operator is
warned by a “beep” whenever a new entry is attempted.
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1.12.1.22 Detailed Test Procedure for Test Item INCC116-B1.22
SCHEDULE MAINTENANCE CONTROL PARAMETERS WINDOW:
WAIT LIST PROCESSING PARAMETERS
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to enable/disable wait-list processing and specify the
mode as automatic or semi-automatic.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 WAIT LIST PROCESSING PARAMETERS

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The “Enabled”
toggle button in the Wait List Processing Parameters area is raised indicating that
wait list processing is disabled (assuming that it was not previously enabled).  The
"Opened" time reflects the time the window was opened.  Editing of the window
is disabled.

2.2 Click the “Enable Editing” toggle button.  Click the “Automatic” radio button under
“Mode”.

The button is not functional since wait list processing is disabled.

2.3 Click the “Enabled” toggle button in the Wait List Processing Parameters area.

The toggle button is now depressed, indicating that wait list processing is enabled.
The “Last update” information in the Wait List Processing Parameters area is not
updated.

2.4 Click the “Close” button.

The window closes and control returns to the Main Panel.

2.5 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The “Enabled” toggle button is raised, indicating that the modification made in
step 2.3 was not saved.  Editing of the window is disabled.
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2.6 Enable editing, click the “Enabled” toggle button in the Wait List Processing Parameters
area, and click the “Semi-Automatic” radio button under “Mode”.

The “Enabled” and “Semi-Automatic” buttons are depressed, indicating that semi-
automatic mode is selected.  The “Automatic” radio button is raised, indicating
that it is not selected.

2.7 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control data.

Wait List Processing is disabled (since changes have yet to be saved).

2.8 From the Schedule Maintenance Control Parameters window, click the “Automatic” radio
button under “Mode”.

The button is now depressed and the “Semi-Automatic” button is raised.

2.9 Select “Save” from the “File” menu.

The “Last update” information in the Wait List Processing Parameters area now
reflects the time of the save.

2.10 Perform a data base query of the Schedule Control data.

Wait List Processing is enabled in automatic mode.

2.11 Click the “Enabled” toggle button in the Wait List Processing Parameters area.

The button is raised, indicating that wait-list processing is disabled.  The “Mode”
radio buttons are disabled.
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1.12.1.23 Detailed Test Procedure for Test Item INCC116-B1.23
SCHEDULE MAINTENANCE CONTROL PARAMETERS WINDOW:
MISCELLANEOUS PARAMETERS
CSCI 1605

Pass/Fail Criteria:

• The operator has the capability to specify the SA Slew Time and the SAR Start Time
Interval.

• The operator has the capability to Inhibit SN Schedule Access.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA capabilities.

2.0 SA SLEW TIME

2.1 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  The "Opened"
time reflects the time the window was opened.  Editing is disabled.

2.2 Enable editing, position the cursor in the “SA Slew Time” time component, and click the
left mouse button.

The time component is highlighted.  Editing is enabled.

2.3 Use the arrows for one time component (such as hours) and the keyboard for another
(such as minutes) to change the time.

The time is increased when the UP arrow button is clicked and decreased when
the DOWN arrow button is clicked.  The “Last update” information in the
Miscellaneous Parameters area is not updated.

2.4 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control information.

The SA Slew Time has not been updated.

2.5 From the Schedule Maintenance Control Parameters window, click the “Save” button.

The “Last update” information in the Miscellaneous Parameters area now reflects
the time of the save.
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2.6 Perform a data base query of the Schedule Control information.

The SA Slew Time now reflects the update.

2.7 Click the “Close” button.

The window closes and control returns to the Main Panel.

2.8 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The update made in step 2.3 is reflected in the window.  The “Last update”
information in the Miscellaneous Parameters area is the same as in step 2.5.
Editing is disabled.

3.0 SAR START TIME INTERVAL

3.1 From the Schedule Maintenance Control Parameters window, enable editing, position the
cursor in the “SAR Start Time Interval” time component, and click the left button.

The time component is highlighted.

3.2 Use the arrows for one time component (such as hours) and the keyboard for another
(such as minutes) to change the time.

The time is increased when the UP arrow button is clicked and decreased when
the DOWN arrow button is clicked.  The “Last update” information in the
Miscellaneous Parameters area is not updated.

3.3 Click the “Close” button.

The window closes and control returns to the Main Panel.

3.4 Perform a data base query of the Schedule Control information.

The update made in step 3.2 does not appear in the data base.

3.5 Select “Schedule Control” from the Data Base subpanel on the Main Panel.

The Schedule Maintenance Control Parameters window appears.  Editing is
disabled.

3.6 Enable editing, position the cursor in the SAR Start Time Interval time component, and
enter a new time.

The “Last update” information in the Miscellaneous Parameters area is not
updated.

3.7 Without closing the Schedule Maintenance Control Parameters window, perform a data
base query of the Schedule Control information.

The SAR Start Time Interval has not been updated.
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3.8 From the Schedule Maintenance Control Parameters window, select “Save” from the
“File” menu.

The “Last update” information in the Miscellaneous Parameters area of the
window now reflects the time of the save.

3.9 Perform a data base query of the Schedule Control information.

The SAR Start Time Interval now reflects the update.

4.0 INHIBIT SN SCHEDULE ACCESS

4.1 From the Schedule Maintenance Control Parameters window, click the “Inhibit SN
Schedule Access” toggle button.

The “Inhibit SN Schedule Access” toggle button is depressed indicating that
access to Nascom information displayed on the Web is inhibited for the given
customer.

4.2 Click the “Save” button.

The “Last update” information in the Miscellaneous Parameters area of the
window is updated.

4.3 Click the “Close” button.  Re-access the Schedule Maintenance Control Parameters
window.

The window closes and re-opens and indicates that the changes to SN Schedule
Access were saved.

4.4 Enable editing and repeat the above steps to enable SN Schedule Access to the customer.

The “Inhibit SN Schedule Access” toggle button is raised indicating that access to
Nascom information displayed on the Web is enabled for the given customer.  The
window closes and re-opens and indicates that the changes were saved.
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1.12.1.24 Detailed Test Procedure for Test Item INCC116-B1.24
SCHEDULE REQUESTS WINDOW - FILTER/SORT OPTION
CSCI 1602

Pass/Fail Criteria:

• Operator and customer-initiated schedule requests are accurately displayed in the
Schedule Requests window.

• The operator has the capability to filter/sort requests in the Schedule Requests window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the Scheduling group.

1.3 From NTS, submit valid and invalid SARs, ASARs, Replace Requests, Delete Requests,
and Wait-List Requests.

1.4 From the workstation, submit valid and invalid SARs, ASARs, Replace Requests, Delete
Requests, and Wait-List Requests.

2.0 REVIEW REQUESTS

2.1 Select “Schedule Requests” from the Scheduling subpanel on the Main Panel.

The Schedule Requests window appears and indicates that the requests submitted
in steps 1.3 and 1.4 are accurately reflected in the window.  The Version is “0” for
each request.  The Request IDs indicate that the requests were submitted from the
MOC.

The “Enable Editing” toggle button is raised and all buttons are dimmed and not
functional.  The “Opened” time is accurately reflected.

2.2 Select a request submitted in step 1.3 and click the “View...” button.

The Edit SAR window appears with editing disabled.  All buttons are dimmed
except “Close”.  The SAR submitted in step 1.3 is accurately reflected in the
window.

2.3 Click the “Close” button.

The window closes and control returns to the Schedule Requests window.

2.4 Repeat steps 2.2 and 2.3 for a request submitted in step 1.4.
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3.0 FILTER/SORT OPTION

3.1 From the Schedule Requests window, click the “Filter/Sort” button.

The Request Filter window appears and contains options to Filter By Time, Hide
for Alternate SARs and Replace Requests, and Show All Versions.  It also
contains the ability to Order By SIC, Request ID, Priority, or Time.  The selection
criteria is appropriate for the given data.

3.2 Create a batch name and enter the information in the Filter Name field.

3.3 Click the “Time” radio button and enter a Start and Stop time.  Click the “SIC” radio
button and select a SIC from the list.  Click the “Save” button.

The Schedule Requests window appears only with the data that fits the specified
Time and SIC criteria.

3.4 Return to the Filter/Sort window.  Click the Hide “Alternate SARs” radio button and the
Show All Versions “No” toggle button.  Click the “TDRS” radio button and select a
TDRS from the list.  Click the “Save” button.

The Schedule Requests window appears only with the data that fits the specified
Hide, Show All Versions, and TDRS criteria.  No Alternate SARs are displayed.
The Version field of other requests indicates only one version is displayed.

3.5 Return to the Filter/Sort window and click the Order By “Request ID” and “Priority”
radio buttons.

The Schedule Requests window appears only with the data Ordered By Request
ID and Priority.

3.6 Return to the Filter/Sort window, specify filter/sort criteria, and click the “Close” button.

The Schedule Requests window appears but does not display the requests by the
specified criteria.
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1.12.1.25 Detailed Test Procedure for Test Item INCC116-B1.25
USER’S GUIDES - TSW WINDOWS

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the SPSR User’s Guide.

The SPSR User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the TSW Windows section of SPSR User’s Guide.

The instructions for performing the major functions of the TSW Windows are
included in the document.  Copies of all applicable windows are included in the
document.

3.0 ERROR CONDITIONS

3.1 Review the TSW Windows error recovery procedures section of the SPSR User’s Guide.

The user’s guide includes adequate error recovery actions for the TSW Windows.
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1.12.1.26 Detailed Test Procedure for Test Item INCC116-B1.26
OPERATOR INTERFACE - TSW WINDOWS
CSCI 1605

Pass/Fail Criteria:

• The applicable menu options and or icons are operational.

• Pertinent windows can be iconified, can be enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the data base, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numeric in alphabetic fields, special characters, blanks,
etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the Scheduling Control Data portion of the User
Interface Subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Access the TSW Sets window.

The TSW Sets window appears on the screen in the expected format.

2.2 Select each menu option and icon available in the window.

The applicable menu options and or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.

2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.



2/6/97  6:31 PM INCC116-59 530-ITP-NCCDS/1998

2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Enable editing, and move the cursor using the mouse and click on a data entry field.
Perform the same action using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with the Scheduling Control Data
portion of the User Interface Subsystem.  The applicable windows are: TSW Set Details.

The windows meet the general and data entry window validation criteria.
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1.12.1.27 Detailed Test Procedure for Test Item INCC116-B1.27
VIEW/UPDATE TIMES/COPY TSWs
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to view TSW Sets stored in the data base via the TSW
Sets and TSW Set Details windows.

• The operator has the capability to update the Timespan for TSW Sets stored in the data
base via the TSW Sets window.

• The operator has the capability to copy TSW Sets stored in the data base via the TSW
Sets window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with TSW editing capabilities.

1.3 From NTS, create TSW messages for several customers.  Include more than one TSW
message for some customers (some for the same TDRS and some for different TDRSs).
Include more than one TSW in some of the messages.

1.4 From NTS, transmit the TSW messages to the NCCDS.

2.0 VIEW TSW SETS

2.1 Select “TSW Sets” from the Scheduling subpanel on the Main Panel.

The TSW Sets window appears.  The "Opened" time reflects the time the window
was opened.  The “Enable Editing” toggle button is raised, indicating that editing
is disabled.  All but the Close button are dimmed.

The SIC, Set ID, and #TSWs information is accurately reflected for the TSW
messages transmitted in step 1.4 (as well as any other TSWs stored in the data
base).

2.3 Disable editing.

All buttons remain dimmed.

2.4 Select an entry from the panel, and enter valid values in the two time entry slots.

All buttons remain dimmed.
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2.5 Attempt to change the Increment/Decrement Time.

The time slot may be highlighted, but not changed.

2.6 Enable editing.

All the buttons are now functional.

2.7 Click the down arrow in the SIC combination box.

The SICs currently defined in the data base for scheduling appear in the list.

2.8 Select a TSW Set and click the “Modify...” button.

The TSW Set Details window appears.  The "Opened" time reflects the time the
window was opened.  The “Enable Editing” toggle button is depressed, indicating
that editing is enabled.  All buttons remain dimmed.

The Timespan and Open/Close times for the TSWs submitted in step 1.4 (as well
as any other TSWs stored in the data base) are accurately reflected in the window.

2.9 Disable editing and select an entry from the panel and an entry from the TDRS slot.

All buttons remain dimmed.

2.10 Enabled editing.

The “Remove”, “Select All”, “Add”, and “Modify” buttons are now functional.

2.11 Attempt to change the time slots using both keyboard and mouse.

All times can be changed.

2.12 Disable editing.

A dialog box appears and asks the operator if the changes should be saved.

2.13 Click the “No” button, followed by “Close” button.

The window closes and control returns to the TSW Sets window.

3.0 UPDATE TIME

3.1 From the TSW Sets window, select a TSW Set, position the cursor over the seconds field
in the Increment/Decrement Time box, and click the down arrow 3 times.

The time is decreased by 3 seconds.

3.2 Click the up arrow in the Increment/Decrement Time box 10 times.

The time is increased by 10 seconds.
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3.3 Without closing the TSW Sets window, perform a data base query of the TSW
information.

The Open and Close times of the TSWs in the TSW Set selected in step 3.1
appear as they did in step 2.1.

3.4 From the TSW Sets window, click the “Update Time” button.

All of the TSWs contained in the selected set will be incremented by 7 seconds
(down arrow 3 times and up arrow 10 times).

3.5 Without closing the TSW Sets window, perform a data base query of the TSW
information.

The Open and Close times of the TSWs in the TSW Set selected in step 3.1
appear as they did in step 2.1.

3.6 From the TSW Sets window, click the “Save” button and repeat step 3.5.

The Open and Close times of the TSWs in the TSW Set selected in step 3.1 have
been incremented by 7 seconds (down arrow 3 times and up arrow 10 times).  The
“Last update” information is updated.

4.0 COPY TSW SETS

4.1 From the TSW Sets window, select a TSW Set, enter a new Set ID, and click the “Copy”
button.

The SIC, Set ID, and #TSWs of the new TSW Set is accurately reflected in the
list.

4.2 Without closing the TSW Sets window, perform a data base query of the TSW
information.

The new TSW Set does not appear in the data base.

4.3 From the TSW Sets window, click the “Save” button.

The “Last update” information is updated.

4.4 Without closing the TSW Sets window, perform a data base query of the TSW
information.

The new TSW Set now appears in the data base.

4.5 From the TSW Sets window, click the “Close” button.

The window closes and control returns to the Main Panel.



2/6/97  6:31 PM INCC116-63 530-ITP-NCCDS/1998

4.6 Re-access the TSW Sets window.

The TSW Sets window appears and indicates that the TSW Set copied in step 4.3
is reflected in the window.  The “Enable Editing” toggle button is raised,
indicating that editing is disabled.

4.7 Click the “Enable Editing” toggle button, select a TSW Set, enter a new Set ID, and click
the “Copy” button.

The SIC, Set ID, and #TSWs of the new TSW Set is accurately reflected in the
list.

4.8 Disable editing.

A dialog box asks the operator if the changes should be saved.

4.9 Click the “No” button, followed by the “Close” button.

The window closes and control returns to the Main Panel.

4.10 Re-access the TSW Sets window.

The TSW Sets window appears and indicates that the update made in step 4.7 is
not reflected in the window.  The “Last update” information is not updated.

4.11 Click the “Close” button.

The window closes and control returns to the Main Panel.
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1.12.1.28 Detailed Test Procedure for Test Item INCC116-B1.28
ADD/MODIFY/REMOVE TSWs
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to create new TSWs via the TSW Sets and TSW Set
Details windows.

• The operator has the capability to modify existing TSWs via the TSW Sets and TSW
Set Details windows.

• The operator has the capability to remove existing TSWs via the TSW Sets and TSW
Set Details windows.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with TSW editing capabilities.

2.0 ADD TSW SETS

2.1 Select “TSW Sets” from the Scheduling subpanel on the Main Panel.

The TSW Sets window appears.  The "Opened" time reflects the time the window
was opened.  The “Enable Editing” toggle button is raised, indicating that editing
is disabled.  All but the Close button are dimmed.  The SIC, Set ID, and #TSWs
information is accurately reflected for any TSWs stored in the data base.

2.2 Enable editing, select a SIC from the SIC combination box, enter a Set ID, and click the
“Add...” button.

The TSW Set Details window appears and contains default values where
applicable.  The "Opened" time reflects the time the window was opened.

2.3 Enter valid Timespan Start and End times using the keyboard and mouse

The entries are accepted.  The “Last update” information is not updated.

2.4 Enter Open and Close times (in the applicable time boxes) that fall within the Timespan,
select a TDRS from the TDRS combination box, and click the “Add” button.

The new TSW information appears in the window to the left of the time boxes.
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2.5 Without closing the TSW Set Details window, perform a data base query of the TSW
information.

The TSW information entered in steps 2.2 through 2.4 does not appear in the data
base.

2.6 From the TSW Set Details window, select the TSW added in step 2.4, use the arrow
buttons to increase the times, and click the “Add” button.

The new TSW appears in the window to the left of the time boxes, along with the
one added in step 2.4.

2.7 Repeat step 2.6, using the arrow buttons to decrease the times.

The new TSW appears in the window to the left of the time boxes, along with the
ones added in steps 2.4 and 2.6.

2.8 Click the “Save” button, followed by the “Close” button.

The “Last update” information is updated.  The window closes and control returns
to the TSW Sets window.  The set just added is accurately reflected in the
window.  The #TSWs is “3”.

2.9 Select the TSW Set just added and click the “Modify...” button.

The TSW Set Details window appears and accurately reflects the TSW
information added in steps 2.2 through 2.7

2.10 Click the “Close” button.

The window closes and control returns to the TSW Sets window.

3.0 ADD TSW SET FOR DIFFERENT SIC WITH SAME SET ID

3.1 From the TSW Sets window, select a different SIC than in step 2.2 from the SIC
combination box, enter the same Set ID as in step 2.2, and click the “Add...” button.

The TSW Set Details window appears.

3.2 Enter valid Timespan Start and End times by clicking the up and down arrows and using
the keyboard and mouse.

Clicking the up arrows cause the times to increase and clicking the down arrows
cause the times to decrease.

3.3 Enter Open and Close times (in the applicable time boxes) that fall within the Timespan,
select a TDRS from the TDRS combination box, and click the “Add” button.

The TSW appears in the window to the left.
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3.4 Without closing the TSW Set Details window, perform a data base query of the TSW
information.

The TSW information entered above does not appear in the data base.

3.5 From the TSW Set Details window, disable editing.

A dialog box asks the operator if the changes should be saved.

3.6 Click the “Yes” button.

The “Last update” information is updated.

3.7 Without closing the TSW Set Details window, perform a data base query of the TSW
information.

The TSW information entered above now appears in the data base.

3.8 From the TSW Set Details window, click the “Close” button.

The window closes and control returns to the TSW Sets window.  The TSW Set
just added is accurately reflected in the window.  The #TSWs is “1”.  The same
TSW Set ID can be used for different SICs.

4.0 MODIFY TSW SETS

4.1 From the TSW Sets window, select a TSW Set and click the “Modify...” button.

The TSW Set Details window appears and contains the information for the
selected TSW Set.

4.2 Modify the Timespan Start and End times by clicking the up and down arrows.

The times are increased and decreased as expected.

4.3 Modify the Timespan Start and End by entering new values.

The entries are accepted.  The “Last update” information is not updated.

4.4 Select a TSW.

The associated information appears in the boxes to the right of the list.

4.5 Modify the Open and Close times by entering new values and click the “Modify” button.

The modification is reflected in the list to the left of the boxes.

4.6 Select another TSW, modify the Open and Close times by clicking the up and down
arrows.

The times are increased and decreased as expected.

4.7 Click the “Modify” button.

The modification is reflected in the list to the left of the boxes.
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4.8 Without closing the TSW Set Details window, perform a data base query of the TSW
information.

The updates made in steps 4.2 through 4.6 are not reflected in the data base.

4.9 From the TSW Set Details window, click the “Save” button and repeat the data base
query.

The “Last update” information is updated.  The updates are now reflected in the
data base.

5.0 REMOVE TSW SETS

5.1 From the TSW Set Details window, click the Filter/Sort button to narrow down the list of
TSWs.

Only the requested information is displayed.

5.2 Click the “Select All” button followed by the “Remove” button.

The selected TSWs are removed.

5.3 Without closing the TSW Set Details window, perform a data base query of the TSW
information.

The removal of the TSWs is not reflected in the data base.

5.4 From the TSW Set Details window, click the “Save” button.

The TSW updates are saved.  The “Last update” information is updated.

5.5 Without closing the TSW Set Details window, perform a data base query of the TSW
information.

The removal of the TSWs is now reflected in the data base.

5.6 From the TSW Set Details window, click the “Close” button.

The window closes and control returns to the TDRS Sets window.

5.7 Re-access the TDRS Set Details window.

The updates are retained.  All TSWs have been removed for the selected SIC and
Set ID.

5.8 Click the “Close” button on the TDRS Set Details and TDRS Sets windows.

The windows close and control returns to the Main Panel.
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1.12.1.29 Detailed Test Procedure for Test Item INCC116-B1.29
TSW UPDATES
CSCI 1602

Pass/Fail Criteria:

• The operator has the capability to update previously stored TSW information via the
TSW Sets and TSW Set Details windows.

• The operator is alerted when previously stored TSW information for the same
Timespan, SIC, TSW Set ID, and TDRS is updated.

• When updated TSW information is stored, the NCCDS shall delete the previous TSWs.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with TSW editing capabilities.

2.0 STORE TSW

2.1 Select “TSW Sets” from the Scheduling subpanel on the Main Panel.

The TSW Sets window appears.  The Opened field reflects the current time.  The
“Enable Editing” toggle button is raised, indicating that editing is disabled.  All
but the Close button are dimmed.  The SIC, Set ID, and #TSWs information is
accurately reflected for any TSWs stored in the data base.

2.2 Enable editing, select a SIC from the SIC combination box, enter a Set ID.

The “Add...” button is now functional.

2.3 Click the “Add...” button.

The TSW Set Details window appears and contains default values where
applicable.  The "Opened" time reflects the time the window was opened.

2.4 Enter valid Timespan Start and End times by typing new values.

The entries are accepted.  The “Last update” information is not updated.

2.5 Enter Open and Close times (in the applicable time boxes) that fall within the Timespan,
select a TDRS from the TDRS combination box, and click the “Add” button.

The new TSW information appears in the window to the left of the time boxes.
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2.6 Click the “Save” button, followed by the “Close” button.

The TSW Set is saved and the “Last update” information is updated.  The window
closes and control returns to the TSW Sets window.  The set just added is
accurately reflected in the window.  The #TSWs is “1”.

2.7 Select the TSW Set just added and click the “Modify...” button.

The TSW Set Details window appears and accurately reflects the TSW
information added above.

2.8 Click the “Close” button.

The window closes and control returns to the TSW Sets window.

3.0 TSW UPDATES

3.1 From the TSW Sets window, select the same SIC from the SIC combination box, enter
the same Set ID, and click the “Add...” button.

The TSW Set Details window appears and contains default values where
applicable.

3.2 Enter the same Timespan Start and End times.

The entries are accepted.  The “Last update” information is not updated.

3.3 Enter different Open and Close times (in the applicable time boxes) that fall within the
Timespan, select the same TDRS from the TDRS combination box, and click the “Add”
button.

The new TSW information appears in the window to the left of the time boxes.

3.4 Click the “Save” button.

The “Last update” information is updated.  The operator is alerted of the TSW
updates.

3.5 Click the “Close” button.

The window closes and control returns to the TSW Sets window.  The TSW Set
update is accurately reflected in the window.  The #TSWs remains “1”.

3.6 Select the TSW Set just added and click the “Modify...” button.

The TSW Set Details window appears and contains the TSWs for the selected
SIC.  The previous TSW (added in step 2.5) for the same Timespan, SIC, TSW
Set ID, is deleted and replaced with the new TSW (from step 3.4) information.

3.7 Click the “Close” button on the TDRS Set Details and TDRS Sets windows.

The windows close and control returns to the Main Panel.
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1.12.1.30 Detailed Test Procedure for Test Item INCC116-B1.30
TSW WINDOWS - INVALID ENTRIES
CSCI 1602

Pass/Fail Criteria:

• The operator is appropriately notified of attempts to make invalid entries on the TSW
Sets and TSW Set Details windows.

• The invalid entries are not accepted.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator with DBA/Scheduling capabilities.

2.0 TSW SETS WINDOW

2.1 Select “TSW Sets” from the Scheduling subpanel on the Main Panel.

The TSW Sets window appears.  The Opened field reflects the current time.  The
“Enable Editing” toggle button is raised, indicating that editing is disabled.  All
but the Close button are dimmed.  The SIC, Set ID, and #TSWs information is
accurately reflected for any TSWs stored in the data base.

2.2 Enable editing. Enter an existing Set ID and SIC and click the “Modify” button.

The “Modify” button remained dimmed since nothing was selected in the panel.

2.3 Select a TSW Set, and enter a Set ID of “XYZ*123”.

The operator is notified that the entry is invalid.  The entry is not accepted.  The
“Last update” information is not updated.

2.4 Enter a Set ID that is already defined for a selected SIC.

The operator is notified that duplicate Set IDs are not allowed.  The entry is not
accepted.  The “Last update” information is not updated.

3.0 TSW SET DETAILS WINDOW

3.1 From the TSW Sets window, select a TSW Set, and click the “Modify...” button.

The TSW Set Details window appears and contains the information for the
selected TSW Set.  The "Opened" time reflects the time the window was opened.
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3.2 Enter a Timespan End time that is earlier than the Timespan Start time and click the
“Save” button.

The operator is alerted of the invalid TSW with Timespan End time that is earlier
than the Timespan Start time.  The “Last update” information is not updated.

3.3 Enter a Close time that is in the past and click the “Add” button.

The operator is alerted of the invalid TSW with window closing times in the past.

3.4 Enter an Open time that is more than 28 days in the future and click the “Add” button.

The operator is alerted of the invalid TSW with window opening time more than
28 days in the future.

3.5 Enter Open and Close times (in the applicable time boxes) that fall within the Timespan,
but overlap the times of an existing TSW within the set and click the “Add” button.

The operator is alerted of the invalid TSW that overlaps a previously added TSW.

3.6 Select a TSW.

The associated information appears in the boxes to the right of the list.

3.7 Enter a Close time that is earlier than the Open time and click the “Modify” button.

The operator is alerted of the invalid TSW with window closing time that is
earlier than the window opening time.

3.8 Enter an Open and Close time that lies outside the Timespan of the TSW Set and click the
“Modify” button.

The operator is alerted of the invalid TSW with Open and Close times outside the
Timespan.

3.9 Click the “Close” button on the TDRS Set Details and TDRS Sets windows.

The windows close and control returns to the Main Panel.
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1.13 Test Case INCC117 - CCS: Reconfigure Ongoing Services

1.13.1 Detailed Test Procedures for Test Case INCC117

1.13.1.1 Detailed Test Procedure for Test Item INCC117-B1.1
OPERATOR INTERFACE
CSCI 2305

Pass/Fail Criteria:

• The applicable menu options and or icons are operational.

• Pertinent windows can be iconified, enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the database, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numerical values in alphabetic fields, special characters,
blanks, etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with the Event Monitor subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Access the Reconfiguration OPM Status Time-out window.

The Reconfiguration OPM Status Time-out window appears on the screen in the
expected format.

2.2 Select each menu option and icon available on the window.

The applicable menu options and/or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.
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2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.

2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numerical value in an alphabetic field,
special characters and blanks in any field, and any other values not in the allowed format
for the given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with the Event Monitor subsystem.  The
applicable windows are the GCM Menu, and a subset of: MAF Reconfiguration, MAR
reconfiguration, Normal SSAF Reconfiguration, Shuttle SSAF Reconfiguration, Normal
SSAR Reconfiguration, Shuttle SSAR Reconfiguration, Normal KSAF Reconfiguration,
Shuttle KSAF Reconfiguration, Normal KSAR Reconfiguration, and Shuttle KSAR
Reconfiguration windows.

The windows meet the general and data entry window validation criteria.
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1.13.1.2 Detailed Test Procedure for Test Item INCC117-B1.2
USER’S GUIDE
CSCI 2305

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the CCS User’s Guide.

The CCS User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the Event Monitor Subsystem normal procedures section of the CCS User’s
Guide.

The instructions for performing the major functions of the Event Monitor
Subsystem are included in the document.  Copies of all applicable windows are
included in the document.

3.0 ERROR CONDITIONS

3.1 Review the Event Monitor Subsystem error recovery procedures section of the CCS
User’s Guide.

The user’s guide includes adequate error recovery actions for the Event Monitor
Subsystem.
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1.13.1.3 Detailed Test Procedure for Test Item INCC117-B1.3
GCM MENU WINDOW
CSCI 2305

Pass/Fail Criteria:

• The TDRS, Service Type, SUPIDEN, and GCM Type lists contain the appropriate
selections.

• The Help menu defines the function of each field and explains how to initiate TDRS-
unique and service reconfiguration requests.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Submit schedule requests to start as soon as possible.  Access the CCS Review Events
window.

CCS receives the events.

2.0 VIEW AND MODIFY SELECTABLE LISTS

2.1 Select “GCM Menu” from the Reconfiguration subpanel on the Main Panel.

The GCM Menu appears and contains the TDRS, Service Type, SUPIDEN, and
GCM Type.

2.2 Select the TDRS list and compare it against the list of assigned TDRSs.

The GCM Menu window TDRS list contains a list of currently assigned TDRSs.

2.3 Select the Service Type list and compare against the list of valid service types.

The GCM Menu window Service Type list contains a list of all known non TDRS
H, I, J service types.

2.4 Select the SUPIDEN list and compare against the list of frequently used SUPIDENs.

The GCM Menu window SUPIDEN list contains a list of all commonly used
SUPIDENs.
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2.5 Select the GCM Type list.

The GCM Menu window GCM Type list contains a list of all valid GCM Types
including: Expanded User Frequency Uncertainty, Forward Link Sweep, Link
Reacquisition, Forward Link EIRP (Normal and High), Doppler Compensation
Inhibit (not SSA Shuttle, Carrier Only, PN Rate Only, and both PN Rate and
Carrier), and Reconfigure.

2.6 Access the Space Network Summary window and delete a TDRS.

After confirmation the TDRS is removed from the list.

2.7 From the GCM Menu window, select the TDRS list.

The TDRS list no longer contains the TDRS that was deleted above.

3.0 HELP MENU

3.1 From the GCM Menu window, use the Help menu to find out how to submit a TDRS-
unique reconfiguration request and how to open service reconfiguration request windows.

Help gives an explanation of how to select a TDRS, Service Type, SUPIDEN, and
GCM Type.  Help also indicates that you have to click the “O.K.” button to
submit a TDRS-unique reconfiguration request or open a service reconfiguration
request window.

3.2 Select “Close” from the “File” menu.

The GCM Menu window closes and control returns to the Main Panel.
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1.13.1.4 Detailed Test Procedure for Test Item INCC117-B1.4
VALID OPERATOR-INITIATED SRR WITH DQM PARAMETERS
CSCI 2305

Pass/Fail Criteria:

• The User Reconfiguration Request OPM includes DQM setup parameters for a valid
SRR that reconfigures the data rate and data stream ID.

• The operator receives all expected alerts.

• The Help menu defines the function of each button and explains how to submit service
reconfiguration requests.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Access the Data Quality Monitoring Parameters window and identify a SIC that has
associated DQM parameters defined.  Submit a schedule request containing a Normal
KSAR service for the selected SIC to start as soon as possible.  Access the CCS Review
Events window.

CCS receives the event.

2.0 SERVICE RECONFIGURATION REQUEST

2.1 Select “GCM Menu” from the Reconfiguration subpanel on the Main Panel.

The GCM Menu appears and contains the TDRS, Service Type, SUPIDEN, and
GCM Type.

2.2 After the events starts, select the TDRS, Service Type (KSAR), SUPIDEN, and GCM
Type (Reconfigure...) for the scheduled service and click the “O.K.” button.

The Normal KSAR Reconfiguration window appears with the correct service
information.

2.3 Specify a data rate and data stream ID combination corresponding to the selected DQM
record.  Click the “Clear” button.

All values that have been entered or selected are cleared.  The Normal KSAR
Reconfiguration window remains open.
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2.4 Obtain a hardcopy and submit a service reconfiguration request by respecifying the same
values that were cleared above.  Click the “Reconfigure” button.

The Normal KSAR Reconfiguration window closes when the request passes
validation.  The appropriate operator receives alerts indicating that the
reconfiguration was acknowledged and accepted.

2.5 From the GCM Menu, select the TDRS, Service Type, SUPIDEN (enter), and GCM Type
requested above and click the “O.K.” button.  Obtain a hardcopy and compare to the
previous hardcopy.

The Normal KSAR Reconfiguration window appears and contains the updated
values.

2.6 Perform a delog for the timeframe of step 2.4.

The NCCDS sent a correctly formatted OPM (03/03) to the ground terminal.  The
OPM message contains the appropriate DQM setup parameters.

3.0 HELP MENU

3.1 Use the Help menu to find out how to submit a service reconfiguration request.

Help indicates that you have to click the “Reconfigure” button to submit the
request.  Help indicates that you can click the “Clear” button to blank out any
values you have entered up to that point.

3.2 From the Normal KSAR Reconfiguration window, select “Close” from the “File” menu.

The Normal KSAR Reconfiguration window closes and control returns to the
GCM Menu.

3.3 Select “Close” from the “File” menu.

The GCM Menu window closes and control returns to the Main Panel.
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1.13.1.5 Detailed Test Procedure for Test Item INCC117-B1.5
INVALID OPERATOR-INITIATED SRR
CSCI 2305

Pass/Fail Criteria:

• Operator-initiated SRRs are properly validated.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Submit a schedule request containing a Normal SSAF service to start as soon as possible.
Access the CCS Review Events window.

CCS receives the event.

2.0 INVALID SERVICE RECONFIGURATION REQUEST

2.1 Select “GCM Menu” from the Reconfiguration subpanel on the Main Panel.

The GCM Menu appears and contains the TDRS, Service Type, SUPIDEN, and
GCM Type.

2.2 After the event starts, select the TDRS, Service Type (SSAF), SUPIDEN, and GCM Type
(Reconfigure...) for the scheduled service, and click the “O.K.” button.

The Normal SSAF Reconfiguration window appears with the correct service
information.

2.3 Obtain a hardcopy and attempt to submit a service reconfiguration request specifying a
data rate above the maximum rate allowed by the service parameter.  Click the
“Reconfigure” button.

The invalid data rate is highlighted and a dialog box accurately informs the
operator of the invalid condition.  No alerts are received.

2.4 Click the “O.K.” button in the dialog box.

The dialog box closes.  The invalid values in the Normal SSAF Reconfiguration
window remain highlighted until the invalid condition is corrected.

2.5 Select “Close” from the “File” menu without correcting the invalid condition.

The Normal SSAF Reconfiguration window closes and control returns to the
GCM Menu.
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2.6 From the GCM Menu, select the TDRS, Service Type, SUPIDEN (enter), and GCM Type
requested above and click the “O.K.” button.  Obtain a hardcopy and compare to the
previous hardcopy.

The Normal SSAF Reconfiguration window appears and indicates that the
parameters were not updated.

2.7 Select “Close” from the “File” menu.

The Normal SSAF Reconfiguration window closes and control returns to the
GCM Menu.

2.8 Select “Close” from the “File” menu.

The GCM Menu window closes and control returns to the Main Panel.
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1.13.1.6 Detailed Test Procedure for Test Item INCC117-B1.6
VALID USER-INITIATED GCMR
CSCI 2305

Pass/Fail Criteria:

• The NCCDS properly receives, validates, and processes a user-initiated GCMR (98/04).

• The NCCDS formats and transmits a User Reconfiguration Request OPM (03/03) to the
appropriate ground terminal in response to a 98/04.

• The NCCDS formats and transmits an NRR (90/06) to the SDPF.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Identify a spacecraft which has SDPF support.

1.4 Submit a schedule request containing a Normal SSAR service to start as soon as possible.
Access the CCS Review Events window.

CCS receives the event.

Note: The SDPF flag is set after SDPF receives the schedule and the GT accepts the
schedule.  J.R. says that there is an issue as to whether SDPF will receive schedules
in build 1.  He said currently either the SDPF flag can always be on or always be off.

2.0 VALID USER SERVICE RECONFIGURATION REQUEST

2.1 Select “GCM Menu” from the Reconfiguration subpanel on the Main Panel.

The GCM Menu appears and contains the TDRS, Service Type, SUPIDEN, and
GCM Type.

2.2 After the event starts, select the TDRS, Service Type (SSAR), SUPIDEN, and GCM
Type (Reconfigure...) for the scheduled service and click the “O.K.” button.  Obtain a
hardcopy.

The Normal SSAR Reconfiguration window appears with the correct service
information.
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2.3 From NTS, transmit a GCMR (98/04) reconfiguring the data stream ID for the same
service.

The appropriate operator receives an alert upon receipt of the GCMR and an alert
indicating that the reconfiguration was acknowledged and accepted.  The operator
who has the Normal SSAR Reconfiguration window open receives an alert
indicating their request was canceled when the user request was validated.

2.4 From the open Normal SSAR Reconfiguration window, ignore the canceled alert and
attempt to submit a service reconfiguration request.

The operator is warned (exact text unknown) that he cannot submit a request
without closing and re-opening the window.

2.5 Select “Close” from the “File” menu.

The Normal SSAR Reconfiguration window closes and control returns to the
GCM Menu.

2.6 Select the TDRS, Service Type, SUPIDEN (enter), and GCM Type requested above and
click the “O.K.” button.  Obtain a hardcopy and compare to the previous hardcopy.

The Normal SSAR Reconfiguration window appears and contains the updated
values submitted from the NTS and not the failed attempt by the operator.

2.7 Select “Close” from the “File” menu.

The Normal SSAR Reconfiguration window closes and control returns to the
GCM Menu.

2.8 Select “Close” from the “File” menu.

The GCM Menu window closes and control returns to the Main Panel.

2.9 Perform a delog for the timeframe of step 2.3.

The NCCDS correctly receives the GCMR (98/04) from the user.

The NCCDS correctly formatted and transmitted a corresponding User
Reconfiguration Request OPM (03/03) to the appropriate ground terminal.

The ground terminal responded with an acknowledgment (03/60) of the OPM.

The NCCDS transmitted a GCM Disposition (98/02) message to the user.

The NCCDS received an OPM Status (03/62) message from the ground terminal
indicating acceptance of the OPM.

The NCCDS responded with an acknowledgment (03/14) message.



2/6/97  6:31 PM INCC117-12 530-ITP-NCCDS/1998

The NCCDS transmitted a GCM Status (98/01) message to the user.

The NCCDS transmitted a correctly formatted NRR (90/06) to the SDPF.

The NCCDS receives an acknowledgment (03/60) from the SDPF.
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1.13.1.7 Detailed Test Procedure for Test Item INCC117-B1.7
INVALID USER-INITIATED GCMR
CSCI 2305

Pass/Fail Criteria:

• The NCCDS properly receives, validates, and processes a user-initiated GCMR (98/04).

• The operator receives all expected alerts.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Submit a schedule request containing a Normal KSAF service to start as soon as possible.
Access the CCS Review Events window.

CCS receives the event.

2.0 INVALID USER SERVICE RECONFIGURATION REQUEST

2.1 Select “GCM Menu” from the Reconfiguration subpanel on the Main Panel.

The GCM Menu appears and contains the TDRS, Service Type, SUPIDEN, and
GCM Type.

2.2 After the event starts, select the TDRS, Service Type (KSAF), SUPIDEN, and GCM
Type (Reconfigure...) for the scheduled service, and click the “O.K.” button.

The Normal KSAF Reconfiguration window appears with the correct service
information.

2.3 Obtain a hardcopy.  Select “Close” from the “File” menu.

The Normal KSAF Reconfiguration window closes and control returns to the
GCM Menu.

2.4 From NTS, transmit a GCMR (98/04) for the same service, reconfiguring the data rate to
a value above the maximum defined in the corresponding service parameter.

The appropriate operator receives an alert upon receipt of the GCMR and another
alert indicating rejection of the GCMR.
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2.5 From the GCM Menu window, select the TDRS, Service Type, SUPIDEN (enter), and
GCM Type requested above and click the “O.K.” button.  Obtain a hardcopy and compare
it to the previous hardcopy.

The Normal KSAF Reconfiguration window appears and indicates that the
parameters were not updated.

2.6 Select “Close” from the “File” menu.

The Normal KSAF Reconfiguration window closes and control returns to the
GCM Menu.

2.7 Select “Close” from the “File” menu.

The GCM Menu window closes and control returns to the Main Panel.

2.8 Perform a CCS delog of the GCMR (98/04) and the GCM status message (98/01).

The NCCDS received a GCMR and correctly formatted and transmitted an
appropriate GCM status message to the customer.
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1.13.1.8 Detailed Test Procedure for Test Item INCC117-B1.8
VALID OPERATOR-INITIATED TDRS-UNIQUE GCMR
CSCI 2305

Pass/Fail Criteria:

• The operator can submit TDRS-unique GCMRs.

• Operator-initiated TDRS-unique GCMRs are properly validated.

• The operator receives all expected alerts.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Submit a schedule request containing a Shuttle SSAF service to start as soon as possible.
Access the CCS Review Events window.

CCS receives the event.

2.0 FORWARD LINK SWEEP REQUEST

2.1 Select “GCM Menu” from the Reconfiguration subpanel on the Main Panel.

The GCM Menu appears and contains the TDRS, Service Type, SUPIDEN, and
GCM Type.

2.2 After the event starts, select the TDRS, Service Type (SSAF), SUPIDEN (enter), and
GCM Type (Forward Link Sweep) for the scheduled service, and click the “O.K.” button.

The GCM Menu selections are cleared (Service Type and GCM Type selections
are unhighlighted).  Alerts are received by the operator indicating that the OPM
was acknowledged and accepted by the ground terminal.

2.3 Select “Close” from the “File” menu.

The GCM Menu window closes and control returns to the Main Panel.

2.4 Perform a delog for the timeframe of step 2.2.

The NCCDS correctly formatted and transmitted a corresponding Forward Link
Sweep Request OPM (03/04) to the appropriate GT.  The GT responded with an
acknowledgment (03/60) of the OPM.  The NCCDS received an OPM Status
(03/62) message from the ground terminal indicating acceptance of the OPM.
The NCCDS responded with an acknowledgment (03/14) message.
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1.13.1.9 Detailed Test Procedure for Test Item INCC117-B1.9
OPM STATUS (03/62) - GT REJECTS
CSCI 2305

Pass/Fail Criteria:

• The NCCDS is notified when the ground terminal rejects a user service reconfiguration
request.

• The NCCDS is notified when the ground terminal rejects a TDRS-unique
reconfiguration request.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Submit a schedule request containing a Shuttle KSAF service to start as soon as possible.
Access the CCS Review Events window.

CCS receives the event.

1.4 From NTS, use GAR (Generic Automatic Responses) files to set the Val_0 field of the
trigger message OPM (03/03) so that the OPM Status (03/62) from the ground terminal
indicates the OPM was rejected.

1.5 From NTS, use GAR files to set the Val_0 field of the trigger message OPM (03/06) so
that the OPM Status (03/62) from the ground terminal indicates the OPM was rejected.

2.0 GROUND TERMINAL REJECTION OF USER SERVICE RECONFIGURATION

2.1 Select “GCM Menu” from the Reconfiguration subpanel on the Main Panel.

The GCM Menu appears and contains the TDRS, Service Type, SUPIDEN, and
GCM Type.

2.2 After the event starts, select the TDRS, Service Type (KSAF), SUPIDEN, and GCM
Type (Reconfigure...) for the scheduled service, and click the “O.K.” button.

The Shuttle KSAF Reconfiguration window appears with the correct service
information.

2.3 Obtain a hardcopy.  Select “Close” from the “File” menu.

The Shuttle KSAF Reconfiguration window closes and control returns to the
GCM Menu.



2/6/97  6:31 PM INCC117-17 530-ITP-NCCDS/1998

2.4 From NTS, transmit a valid user service reconfiguration request (98/04) for the same
service.

The operator receives an alert indicating the reject condition that was set in the
GAR file.

2.5 From the GCM Menu, select the TDRS, Service Type, SUPIDEN (enter), and GCM Type
requested above and click the “O.K.” button.  Obtain a hardcopy and compare to the
previous hardcopy.

The Shuttle KSAF Reconfiguration window appears and indicates that the
reconfigurable parameters were not updated.

2.6 Select “Close” from the “File” menu.

The Shuttle KSAF Reconfiguration window closes and control returns to the
GCM Menu.

2.7 Perform a CCS delog for the timeframe of step 2.4.

The NCC received an OPM Status (03/62) message indicating the appropriate
reject condition and transmitted a correctly formatted GCM Status (98/01)
message to the customer.  The GCM Status message also contains the appropriate
reject code.

3.0 GROUND TERMINAL REJECTION OF TDRS-UNIQUE RECONFIGURATION

3.1 From the GCM Menu window, select the TDRS, Service Type (KSAF), SUPIDEN, and
GCM Type (Reconfigure...) for the scheduled service, and click the “O.K.” button.

The Shuttle KSAF Reconfiguration window appears with the correct service
information.

3.2 Note the value of Power Mode and obtain a hardcopy.  Select “Close” from the “File”
menu.

The Shuttle KSAF Reconfiguration window closes and control returns to the
GCM Menu.

3.3 From NTS, transmit a valid Forward Link EIRP Reconfiguration (98/06).

The operator receives an alert indicating the reject condition that was set in the
GAR file.

3.4 From the GCM Menu, select the TDRS, Service Type, and SUPIDEN (enter) requested
above.  Select “Reconfigure...” as the GCM Type and click the “O.K.” button.  Obtain a
hardcopy and compare to the previous hardcopy.

The Shuttle KSAF Reconfiguration window appears and indicates that no TDRS-
unique reconfiguration occurred.  Power Mode was not reconfigured.
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3.5 Select “Close” from the “File” menu.

The Shuttle KSAF Reconfiguration window closes and control returns to the
GCM Menu.

3.6 Select “Close” from the “File” menu.

The GCM Menu window closes and control returns to the Main Panel.

3.7 Perform a CCS delog for the timeframe of step 3.3.

The NCC received an OPM Status (03/62) message indicating the appropriate
reject condition and transmitted a correctly formatted GCM Status (98/01)
message to the customer.  The GCM Status also contains the appropriate reject
code.

4.0 CLEANUP

4.1 From NTS, use GAR to reset the trigger messages modified in this test item so the
ground terminal will accept them.

A message is received indicating that the GAR file was activated.
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1.13.1.10 Detailed Test Procedure for Test Item INCC117-B1.10
OPM STATUS TIME-OUT VALUE
CSCI 2305

Pass/Fail Criteria:

• Event Monitor assumes ground terminal acceptance of an OPM when the ground
terminal fails to respond within the operator-specified OPM Status Time-out value.

• The operator is able to modify the OPM Status Time-out value.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Submit a schedule request containing a Shuttle KSAR service to start as soon as possible.
Access the CCS Review Events window.

CCS receives the event.

1.4 Select “OPM Time-out” from the Reconfiguration subpanel on the Main Panel and note
the time-out value.

The Reconfiguration OPM Status Time-out window appears and contains the
current time-out value.

1.5 From NTS, use GAR files to delay the ground terminal’s OPM Status (03/62) response
time by setting the Resp_Delay field of the trigger message OPM (03/03) to a value that
is greater than the operator-specified OPM Status Time-out for the ground terminal that
the event is scheduled on.

2.0 OPM STATUS TIME-OUT PROCESSING

2.1 After the event starts, transmit a valid GCMR (98/04) request from NTS.

After the amount of time specified by the time-out value has passed, the operator
receives an alert indicating “Assumed Acceptance”.

2.2 Access the Shuttle KSAR Reconfiguration window for the service.

The Shuttle KSAR Reconfiguration window appears and contains the updated
values.
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3.0 MODIFYING OPM STATUS TIME-OUT VALUE

3.1 From the Reconfiguration OPM Status Time-out window, modify the OPM Status Time-
out value, and click the “O.K.” button.

The operator receives an alert indicating that the time-out value was updated.

3.2 Select “Close” from the “File” menu.

The Reconfiguration OPM Status Time-out window closes.

3.3 Select “OPM Time-out” from the Reconfiguration subpanel on the Main Panel.

The Reconfiguration OPM Status Time-out window appears and indicates that the
new time-out value was accepted.

3.4 Select “Close” from the “File” menu.

The Reconfiguration OPM Status Time-out window closes.

3.5 From NTS, use GAR files to delay the ground terminal’s OPM Status (03/62) response
time by setting the Resp_Delay field of the trigger message OPM (03/03) to a value that
is greater than the new time-out value for the ground terminal that the event is scheduled
on.

3.6 From NTS, transmit a valid GCMR (98/04) request.

After the amount of time specified by the time-out value has passed, the operator
receives an alert indicating “Assumed Acceptance”.

3.7 Access the Shuttle KSAR Reconfiguration window for the service.

The Shuttle KSAR Reconfiguration window appears and contains the updated
values.

4.0 CLEANUP

4.1 From NTS, use GAR to reset the trigger messages modified in this test item so the
ground terminal will respond in the normal amount of time.

A message is received indicating that the GAR file was activated.
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1.13.1.11 Detailed Test Procedure for Test Item INCC117-B1.11
RETAIN OPM STATUS TIME-OUT VALUE AFTER CCS COLD START
CSCI 2305

Pass/Fail Criteria:

• The OPM Status Time-out value is retained across CCS cold starts.

• Event Monitor uses the retained OPM Status Time-out value in determining how long to
wait prior to assuming ground terminal acceptance of an OPM when the ground terminal
fails to respond.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Submit a schedule request containing a Shuttle SSAR service to start as soon as possible.
Access the CCS Review Events window.

CCS receives the event.

2.0 MODIFYING OPM STATUS TIME-OUT VALUE

2.1 Select “OPM Time-out” from the Reconfiguration subpanel on the Main Panel and note
the time-out value.

The Reconfiguration OPM Status Time-out window appears and contains the
current time-out value.

2.2 Modify the OPM Status Time-out value, and click the “O.K.” button.

The operator receives an alert indicating that the time-out value was updated.

2.3 From NTS, use GAR files to delay the ground terminal’s OPM Status (03/62) response
time by setting the Resp_Delay field of the trigger message OPM (03/03) to a value that
is greater than the new time-out value for the ground terminal that the event is scheduled
on.

3.0 PERFORM CCS COLD START

3.1 Perform a CCS cold start.

CCS is cold started and all processes are restarted.
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3.2 From the Reconfiguration OPM Status Time-out window, select “Close” from the “File”
menu.

The Reconfiguration OPM Status Time-out window closes.

3.3 Select “OPM Time-out” from the Reconfiguration subpanel on the Main Panel.

The Reconfiguration OPM Status Time-out window appears and indicates that the
time-out value was retained across the CCS cold start.

3.4 Select “Close” from the “File” menu.

The Reconfiguration OPM Status Time-out window closes.

3.5 After the event starts, transmit a valid GCMR (98/04) from NTS.

After the amount of time specified by the time-out value has passed, the operator
receives an alert indicating “Assumed Acceptance”.

3.6 Access the Shuttle SSAR Reconfiguration window for the service.

The Shuttle SSAR Reconfiguration window appears and contains the updated
values.

4.0 CLEANUP

4.1 From NTS, use GAR to reset the trigger messages modified in this test item so the
ground terminal will respond in the normal amount of time.

A message is received indicating that the GAR file was activated.
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1.13.1.12 Detailed Test Procedure for Test Item INCC117-B1.12
ALERT FILTERING BY TDRS & SIC
CSCI 2305

Pass/Fail Criteria:

• The operator has the capability to filter alerts received by TDRS and SIC.

• The operator receives alerts based on the specified filtering criteria.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to three workstations as operators belonging to the group.

1.3 From the Alert Filter window, configure one workstation to support all TDRSs/SICs and
the other two to specify unique TDRS/SIC combinations.

1.4 Submit schedule requests to start as soon as possible that specify the unique TDRS/SIC
combinations used in step 1.3.

1.5 Submit a schedule request to start as soon as possible that does not specify the unique
TDRS/SIC combinations used in step 1.3.

2.0 START ALERTS

2.1 Review the alert queues at each workstation.

The operators assigned to support the unique TDRS/SIC combinations receive
only the start alert for the applicable event.  The operator assigned to support all
TDRSs/SICs receive start alerts for all three events.

3.0 GCMR ALERTS

3.1 After the events start, submit reconfiguration requests for each event.

The operators assigned to support the unique TDRS/SIC combinations receive
only the reconfiguration alerts for the applicable event.  The operator assigned to
support all TDRSs/SICs receive reconfiguration alerts for all three events.
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4.0 STOP ALERTS

4.1 Review the alert queues of each operator belonging to the group with TNC capabilities.

The operators assigned to support the unique TDRS/SIC combinations receive
only the stop alert for the event containing their assigned TDRS/SIC.  The
operator assigned to support all TDRS/SICs will receive stop alerts for all events.
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1.13.1.13 Detailed Test Procedure for Test Item INCC117-B1.13
EVENT START/STOP ALERTS
CSCI 2305

Pass/Fail Criteria:

• Start alerts are received approximately 5 minutes prior to the start of an event.

• Emergency stop alerts are received for events terminated by the operator or customer.

• Stop alerts are received for events that terminate normally.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator belonging to a group with TNC capabilities.

1.3 Submit schedule requests containing MAR services, some of which contain HDRM
services (for both ground terminals).  Access the CCS Review Events window.

CCS receives the event.

2.0 START ALERTS

2.1 Review the alert queues of each operator belonging to the group with TNC capabilities.

Approximately 5 minutes prior to the start of each event, the operator receives an
appropriate start alert.  The start alerts for the events scheduled on STGT and
containing HDRM services, include the IFL SHO IDs.

3.0 EMERGENCY STOP ALERTS

3.1 From NTS, transmit a Schedule Delete Request for an ongoing event.

The operator receives an emergency stop alert for the event.

3.2 Delete another event from the appropriate window.

The emergency stop alert is generated.



2/6/97  6:31 PM INCC117-26 530-ITP-NCCDS/1998

4.0 STOP ALERTS AT EVENT STOP TIME

4.1 Review the alert queues of each operator belonging to the group with TNC capabilities as
the events terminate normally.

The operator receives normal stop alerts for the events that terminate normally.
The stop alerts for the events scheduled on STGT and containing HDRM services,
include the IFL SHO IDs.
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1.14 Test Case INCC118 - CCS: Monitor/Disseminate Performance
Data

1.14.1 Detailed Test Procedures for Test Case INCC118

1.14.1.1 Detailed Test Procedure for Test Item INCC118-B1.1
OPERATOR INTERFACE
CSCI 2306, 3302

Pass/Fail Criteria:

• The applicable menu options and or icons are operational.

• Pertinent windows can be iconified, can be enlarged/reduced, and have scroll bars.

• The operator can move the cursor via mouse or keyboard through the windows.

NOTE: The next two bullets apply to the validation of data entries that do not require access to
the database, thus only apply to windows that require the entry of data.

• The entry of values that are not in the allowed format for the given field are properly
reported to the operator (i.e., numerical values in alphabetic fields, special characters,
blanks, etc.).

• The entry of values that are in the allowed format, but are out of range for the given
field are properly reported to the operator (i.e., DOY over 366, menu option F where the
highest option is E, etc.).

1.0 SETUP

1.1 Identify all windows associated with Network Monitor subsystem.

2.0 GENERAL WINDOW VALIDATION

2.1 Access a TDRS Summary Menu window.

The TDRS Summary Menu window appears on the screen in the expected format.

2.2 Select each menu option and icon available on the window.

The applicable menu options and or icons are operational.  Control is sent to a
lower level window when applicable.

2.3 Iconify and restore the window.

Pertinent windows can be iconified and restored.
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2.4 Move through the window using the scroll bars.

Pertinent windows have scroll bars.

2.5 Attempt to enlarge and reduce the window.

Pertinent windows can be enlarged and reduced.

2.6 Obtain a hard copy of the window.

Hard copies can be obtained and accurately reflect the contents of the window.
Place the hard copies in the Hard Copy Archive binder.

3.0 DATA ENTRY WINDOW VALIDATION

3.1 Move the cursor using the mouse and click on a data entry field.  Perform the same action
using the keyboard.

The operator can move the cursor via mouse or keyboard through the window.

3.2 Select a field in which to enter data.  Enter a numeric value in an alphabetic field, special
characters and blanks in any field, and any other values not in the allowed format for the
given field.

The entry of values that are not in the allowed format for the given field are
properly reported to the operator.

3.3 Select a field in which to enter data.  Enter values that are in the allowed format, but are
out of range or not allowed for the given field (i.e., DOY over 366, menu option F where
the highest option is E, etc.).

The entry of values that are in the allowed format, but are not allowed for the
given field is properly reported to the operator.

4.0 ALL APPLICABLE WINDOWS

4.1 Repeat this test item for each window associated with Network Monitor subsystem.  The
applicable windows are:  TDRS Summary, MAF ODM, MAR ODM, SSAF ODM, SSAR
ODM, KSAF ODM, KSAR ODM, and User Performance Data Request Summary.

The windows meet the general and data entry window validation criteria.
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1.14.1.2 Detailed Test Procedure for Test Item INCC118-B1.2
USER’S GUIDE
CSCI 2306, 3302

Pass/Fail Criteria:

• The operator actions necessary to execute the applicable major functions are explained in
the user’s guide.

• Copies of all applicable windows are included in the user’s guide.

1.0 SETUP

1.1 Obtain a copy of the CCS User’s Guide.

The CCS User’s Guide is available for review by the Integration Test Team.

1.2 Obtain a copy of any related DCNs.

The related DCNs are available for review by the Integration Test Team.

2.0 NORMAL PROCEDURES

2.1 Review the Network Monitor Subsystem normal procedures section of the CCS User’s
Guide.

The instructions for performing the major functions of the Network Monitor
Subsystem are included in the document.  Copies of all applicable windows are
included in the document.

3.0 ERROR CONDITIONS

3.1 Review the Network Monitor Subsystem error recovery procedures section of the CCS
User’s Guide.

The user’s guide includes adequate error recovery actions for the Network
Monitor Subsystem.
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1.14.1.3 Detailed Test Procedure for Test Item INCC118-B1.3
UPD REQUEST SUMMARY WINDOW
CSCI 2306, 3302

Pass/Fail Criteria:

• The operator and the customer have the capability to enable/disable UPD.

• UPD is transmitted to enabled sites.

• The User Performance Data Request Summary window correctly reflects the customer’s
enable/disable UPD status.

• The User Performance Data Request Summary window correctly reflects a site’s
up/down status.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the PA group.

1.3 Submit schedule requests associated with several sites, including JSC/MSFC.

1.4 From NTS, transmit ODMs for the scheduled services.

2.0 VALID UPD REQUESTS

2.1 Select "UPD" from the Performance subpanel on the Main Panel.

The User Performance Data Request Summary window appears and contains all
of the appropriate Site IDs.  The "As of" time reflects the time the window was
opened.

2.2 Select a Site ID supporting an event scheduled in step 1.3.  From the SUPIDEN box,
enter a SUPIDEN corresponding to the scheduled event and click the "Enable UPD"
button.  Note the time.

The SUPIDEN field of the selected site is updated with the SUPIDEN entry, the
Enable/Disable Status field is updated to “Enabled” and the “As of” time reflects
the time the updates were saved.  The operator receives an alert indicating that
UPD was enabled for the site.

2.3 From NTS, transmit a 92/04 Enable UPD request for another site.

The operator receives an alert indicating that UPD was enabled for the site.
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2.4 From the User Performance Data Request Summary window, click the "Refresh" button.
Note the time.

The SUPIDEN field of the site enabled for UPD in the previous step is updated
with the SUPIDEN entry and the Enable/Disable Status field is updated to
“Enabled”.  The "As of" time reflects the time the window was refreshed.

2.5 From NTS, access the IN window.

The NCCDS is transmitting UPD to the enabled sites for the active services.

2.6 From the User Performance Data Request Summary window, select the Site ID of a
currently enabled site, from the SUPIDEN box use the scroll bar (if needed) to find and
select the corresponding SUPIDEN, and click the "Disable UPD" button.  Note the time.

The Enable/Disable Status is updated to “Disabled" and the “As of” time reflects
the time the updates were saved.  The operator receives an alert indicating that
UPD was disabled for the site.

2.7 From NTS, transmit a 92/04 Disable UPD request for one of the sites enabled from the
window.

The operator receives an alert indicating that UPD was disabled for the site.

2.8 From the User Performance Data Request Summary window, click the "Refresh" button.

The Enable/Disable Status field of the site used in the previous step is updated to
“Disabled”.  The "As of" time reflects the time the window was refreshed.

2.9 From NTS, access the IN window.

The NCCDS is no longer transmitting UPD to the customers.

3.0 UPD TO SITE FROM MULTIPLE SUPIDENS

3.1 From the User Performance Data Request Summary window, select a Site ID/SUPIDEN
combination supporting an event scheduled in step 1.3 and click the "Enable UPD"
button.  Note the time.

The Enable/Disable Status field is updated to “Enabled”.

3.2 Select the same Site ID from the previous step.  From the SUPIDEN box, use the scroll
bar (if needed) to find and select the corresponding SUPIDEN which is valid for the site
and click the "Enable UPD" button.  Note the time.

The selected site is updated with the Enable/Disable Status field for both
SUPIDENs (one row each) now updated to “Enabled” and the “As of” time
reflects the time the updates were saved.  The operator receives an alert indicating
that UPD was enabled for the site.
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3.3 From NTS, access the IN window.

The NCCDS is transmitting UPD to the enabled site for both SUPIDENs.

3.4 From the User Performance Data Request Summary window, select the previous Site
ID/SUPIDEN combination that was enabled above and click the "Disable UPD" button.
Note the time.

The SUPIDEN's Enable/Disable Status field is updated to “Disabled" and the “As
of” time reflects the time the updates were saved.  The operator receives an alert
indicating that UPD was disabled for the site.

3.5 Click the “Refresh” button.

The Site ID, site status, and Enable/Disable Status (disabled) remain for the Site
ID/SUPIDEN combination disabled above.  The SUPIDEN field is now blank.

4.0 UPD TO MULTIPLE SITES FOR A SUPIDEN

4.1 From the User Performance Data Request Summary window, select JSC.  From the
SUPIDEN box enter the SUPIDEN for Shuttle (M2009MS) and click the "Enable UPD"
button.  Note the time.

The SUPIDEN fields for JSC and MSFC are updated with the SUPIDEN entry,
the Enable/Disable Status field for both sites is updated to “Enabled” and the “As
of” time reflects the time the updates were saved.  The operator receives an alert
indicating that UPD was enabled for both sites.

4.2 From NTS, access the IN window.

The NCCDS is transmitting UPD to JSC and MSFC.

4.3 From the User Performance Data Request Summary window, select JSC.  From the
SUPIDEN box use the scroll bar to find and select M2009MS and click the "Disable
UPD" button.  Note the time.

The Enable/Disable Status fields for JSC and MSFC are updated to “Disabled"
and the “As of” time reflects the time the updates were saved.  The operator
receives an alert indicating that UPD was disabled for the sites.

4.4 From NTS, access the IN window.

The NCCDS is no longer transmitting UPD to JSC and MSFC.

4.5 From NTS, transmit a 92/04 Enable UPD request for M2009MS/JSC.

The operator receives an alert indicating that UPD was enabled for JSC and
MSFC.
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4.6 From the User Performance Data Request Summary window, click the "Refresh" button.

The Enable/Disable Status field of JSC and MSFC is updated to “Enabled”.  The
"As of" time reflects the time the window was refreshed.

4.7 From NTS, access the IN window.

The NCCDS is transmitting UPD to JSC and MSFC.

4.8 From NTS, transmit a 92/04 Disable UPD request for M2009MS/JSC.

The operator receives an alert indicating that UPD was disabled for JSC and
MSFC.

4.9 From the User Performance Data Request Summary window, click the "Refresh" button.

The Enable/Disable Status field of JSC and MSFC is updated to “Disabled”.  The
"As of" time reflects the time the window was refreshed.

4.10 From NTS, access the IN window.

The NCCDS is no longer transmitting UPD to JSC and MSFC.

5.0 SITE STATUS

5.1 Access the Network Site Status window and down a site currently receiving UPD.

5.2 From the User Performance Data Request Summary window, click the "Refresh" button.

The window is updated with the current site status.  The “As of” field indicates
the time the window was refreshed.  The Enable/Disable Status field for the
downed site maintains the “Enabled” status.

5.3 From the Network Site Status window, up the site.

The User Performance Data Request Summary window is updated with the
current site status.

6.0 HELP MENU

6.1 Use the HELP menu from the User Performance Data Request Summary window to find
out how to enable the transmission of UPD to a customer.

HELP clearly and correctly explains how to enable UPD.
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1.14.1.4 Detailed Test Procedure for Test Item INCC118-B1.4
TDRS SUMMARY MENU
CSCI 2306, 3302

Pass/Fail Criteria:

• TDRS assignments changes are reflected on the TDRS Summary Menu.

• The TDRS Summary windows are accessible through the TDRS Summary Menu.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to workstation as an operator that belongs to the PA and DBA groups.

2.0 MODIFY TDRS ASSIGNMENTS

2.1 Select "ODM" from the Performance subpanel on the Main Panel.

The TDRS Summary Menu appears and contains the current TDRS assignments.

2.2 From the TDRS Operational Names and Mappings window, change the TDRS ID for
041, the SGLT for 046, and both for TDW.

2.3 From the TDRS Summary Menu, click the “Refresh” button.

The modified TDRS assignments are displayed.  The “As of” field corresponds to
the time the menu was refreshed.

2.4 Select "Close" from the "File" Menu.

The TDRS Summary Menu window closes.

2.5 Repeat step 2.2 for 192, 174, and TDE.

2.6 Re-access the TDRS Summary Menu.

The modified TDRS assignments are displayed.

3.0 TDRS SUMMARY WINDOW

3.1 From the TDRS Summary Menu, select a TDRS.

The field is highlighted.
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3.2 From the TDRS Summary Menu, select another TDRS.

That field is now highlighted and the TDRS selected in step 3.1 is no longer
highlighted.

3.3 From the TDRS Summary Menu, double-click TDRS 171.

The TDRS Summary window appears with the “As of” field indicating the time
that the window was accessed.  The appropriate TDRS operational name is
displayed at the top of the window.  The appropriate TDRS/SGLT mapping is
displayed in the top left corner of the window.  The SUPIDEN fields contain
asterisks and the ODM Status fields are blank since there are no active services
for this TDRS.  All applicable service type/antenna combinations are listed in this
window.

3.4 Select “Close” from the File menu.

The TDRS Summary window closes and control returns to the TDRS Summary
Menu window.

4.0 HELP MENU

4.1 Use the Help menu on the TDRS Summary Menu window to find out how to access the
TDRS Summary window.

Help indicates that you have to double-click on the TDRS to access the
corresponding TDRS Summary window; that the desired TDRS may be accessed
by mouse or by highlighting the desired service using the tab keys; and that the
desired TDRS may be selected by clicking the mouse button or using the
designated keyboard action key ("Enter").
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1.14.1.5 Detailed Test Procedure for Test Item INCC118-B1.5
TDRS SUMMARY WINDOW
CSCI 2306, 3302

Pass/Fail Criteria:

• The TDRS Summary window accurately reflects ODM status for active services.

• The operator is able to access an ODM window from the TDRS Summary window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to a PA group.

1.3 Schedule several events to start as soon as possible.  Some should terminate during this
test item.

2.0 MONITOR ODM STATUS

2.1 Select "ODM" from the Performance subpanel on the Main Panel.

The TDRS Summary Menu appears and contains the current TDRS/SGLT
assignments.

2.2 Double click the TDRS used in step 1.3.

The resulting TDRS Summary window reflects the correct mapping of
SUPIDENs to Services for the events scheduled in step 1.3.  The display
dynamically updates every 5 seconds.  Services not receiving ODMs are color-
coded in red and white and are marked “Stale”.

2.3 From NTS, transmit ODMs specifying valid ODM Validity values.  Review the TDRS
Summary window.

The ODM Status field is marked “Good” and color-coded in green.

2.4 From NTS, halt the ODM transmission and transmit ODMs specifying
“acquisition/reacquisition” for the Link Status field.  Review the TDRS Summary
window.

The ODM Status field is marked “Warning” and displayed in yellow.

2.5 From NTS, halt the ODM transmission and transmit ODMs specifying invalid BER
Status values.  Review the TDRS Summary window.

The ODM Status field is marked “Out of Tolerance” and color-coded in red.
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2.6 From NTS, halt the ODM transmission.  Review the TDRS Summary window.

The ODM Status field is marked “Stale” and displayed in red stripes for that
active service.

2.7 From NTS, transmit ODMs for an active non-shuttle return service not containing I or Q
channel information.

The ODM Status field is marked "No I or Q Data" and color-coded in green.

3.0 MONITOR SERVICE STATUS

3.1 When the services are about to terminate, access the corresponding TDRS Summary
window.

The ODM status is marked "Service Ended"  and displayed in gray.  The
SUPIDEN field is replaced with asterisks.

3.2 Double click one of the ODM Status bars marked "Service Ended".

The "Service Ended" status is removed and the bar is displayed in gray.

3.3 Double click the ODM Status bar for an active service.

The applicable ODM window appears.  The “ODM Validity” and service
information correspond to the information in the TDRS Summary window.

3.4 Select Close from the FILE menu.

The ODM window closes and control returns to the TDRS Summary window.

4.0 HELP MENU

4.1 Use the HELP menu from the TDRS Summary window to find out how to access an
ODM window.

HELP indicates that you have to double-click the corresponding ODM Status bar;
that the ODM Status bar may be accessed by mouse or by highlighting the desired
service using the tab keys;  and that the Status bar may be selected by clicking the
mouse button or using the designated keyboard action key ("Enter").

4.2 Select Close from the file menu.

The TDRS Summary window closes.
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1.14.1.6 Detailed Test Procedure for Test Item INCC118-B1.6
ODM WINDOW
CSCI 2306, 3302

Pass/Fail Criteria:

• ODM data is accurately reflected in the ODM window.

• Stale data is indicated in the ODM window.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the PA group.

1.3 Schedule an event containing an SSAR and a KSAR service to start as soon as possible.

1.4 From NTS, transmit ODMs for the event scheduled in step 1.3, specifying DG1 data for
the KSAR service.

2.0 SSAR ODM WINDOW

2.1 Select "ODM" from the Performance subpanel on the Main Panel.

The TDRS Summary Menu appears and contains the current TDRS/SGLT
assignments.

2.2 From the TDRS Summary Menu, double-click the TDRS used in step 1.3.

The TDRS Summary window appears and displays the current active services.

2.3 From the TDRS Summary window, double-click the ODM Status bar for the SSAR
service.

The applicable SSAR ODM window appears.  The display dynamically updates
every 5 seconds.  The “ODM Validity” and the “Time Tag” fields indicate the
ongoing receipt of ODMs.

2.4 From NTS, halt the ODM transmission.  Review the SSAR ODM window.

The “As of” field in the ODM window stops updating and indicates the time the
last ODM was received.

2.5 From NTS, transmit ODMs specifying “All data Valid” for the ODM Validity field.
Review the SSAR ODM window.

The ODM Validity field is marked “All Data Valid” and is displayed in green.
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2.6 From NTS, halt the current ODM transmission and transmit ODMs specifying “data
invalid” for the ODM Validity field.  Review the SSAR ODM window.

The ODM Validity field is marked “Data Invalid”.

2.7 From NTS, halt the current ODM transmission and transmit ODMs specifying “active”
for the Link Status field.  Review the SSAR ODM window.

The Link Status field is marked “ACTIVE” and displayed in green.

2.8 From NTS, halt the current ODM transmission and transmit ODMs specifying
“acquisition/reacquisition” for the Link Status field.  Review the SSAR ODM window.

The Link Status field is marked “ACQUISITION/REACQUISITION” and
displayed in yellow.

2.9 From NTS, halt the current ODM transmission and transmit ODMs specifying “pending”
for the Link Status field.  Review the SSAR ODM window.

The Link Status field is marked “PENDING” and displayed in red.

3.0 KSAR ODM WINDOW

3.1 From the TDRS Summary window, double click the ODM status bar for the KSAR
service.

The applicable KSAR ODM window appears.  The “DG1 Only” field accurately
reflects the DG data specified in step 1.4 and the “DG2 Only” field is blank.  The
display updates every 5 seconds.

3.2 From NTS, halt the current ODM transmission and transmit ODMs specifying DG2 for
the KSAR service.  Access the KSAR ODM window.

The “DG1 Only” field is now blank and the “DG2 Only” field accurately reflects
the DG data specified in the ODMs.

3.3 From NTS, halt the current ODM transmission and transmit ODMs specifying valid BER
Status parameters.  Review the KSAR ODM window.

The BER Status field is displayed and color-coded in green.

3.4 From NTS, halt the current ODM transmission and transmit ODMs specifying BER
Status parameters not in an acceptable range for this service.  Review the KSAR ODM
window.

The BER Status field is displayed and color-coded in red.

3.5 From NTS, halt the current ODM transmission and transmit ODMs specifying an invalid
BER Status parameter.  Review the KSAR ODM window.

The BER Status field is marked "Not valid" and color-coded in red.
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4.0 HELP MENU

4.1 Use the HELP menu from the ODM window to find out how to access an ODM window.

HELP indicates which ODM parameters will be highlighted.  The highlighting
colors will be identified with the corresponding values (range or discreet).

4.2 Select Close from the file menu.

The ODM window closes.
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1.14.1.7 Detailed Test Procedure for Test Item INCC118-B1.7
PERFORMANCE DATA - EVENT TERMINATION
CSCI 2306, 3302

Pass/Fail Criteria:

• Network Monitor is updated when pertinent events terminate on the SPSR.

1.0 SETUP

1.1 Establish the NCCDS test configuration.

1.2 Logon to a workstation as an operator that belongs to the PA and SCHD groups.

1.3 Schedule two events (1 service per event) on the same TDRS, for a short duration, to start
as soon as possible.

1.4 From NTS, transmit ODMs for the services scheduled in step 1.3.

1.5 Access the User Performance Data Request Summary window and enable UPD for the
sites used in step 1.3.

2.0 NORMAL EVENT TERMINATION

2.1 Select "ODM" from the Performance subpanel on the Main Panel.

The TDRS Summary Menu appears and contains the current TDRS/SGLT
assignments.

2.2 From the TDRS Summary Menu, double-click the TDRS used in step 1.3.

The TDRS Summary window appears and displays the current active services.

2.3 From the TDRS Summary window, double-click the ODM status bar for one of the active
services.  Maintain the window throughout the duration of the service.

The display dynamically updates every 5 seconds.  The “ODM Validity” and the
“Time Tag” fields indicate the ongoing receipt of ODMs.

2.4 Review the TDRS Summary window.

Upon termination of the service, the ODM status is marked "Service Ended" and
displayed in gray.  The SUPIDEN field is replaced with asterisks.
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2.5 Review the ODM window when the service terminates.

The “Time Tag” field indicates the last ODM received prior to service
termination.   An alert appears indicating that ODMs are received for an inactive
service.  A dialog box appears indicating the service displayed in this window has
terminated normally.  A dialog box appears indicating a normal event termination
for the service displayed in this window.

2.6 Click the prompt button on the dialog box to acknowledge the alert.

The ODM window is closed.

2.7 Perform a delog for the timeframe beginning at service stop time.

The NCCDS is no longer transmitting UPD to the customer.

3.0 EMERGENCY EVENT TERMINATION

3.1 From the TDRS Summary window, review the remaining event scheduled in step 1.3.

The window reflects the correct mapping of SUPIDEN to Service for the
scheduled event.

3.2 From the TDRS Summary window, double-click the ODM status bar for the remaining
active service.  Maintain the window throughout the duration of the service.

The display dynamically updates every 5 seconds.  The “ODM Validity” and the
“Time Tag” fields indicate the ongoing receipt of ODMs.

3.3 From the SPSR, delete the event.

3.4 Review the TDRS Summary window.

Upon termination of the service, the ODM status is marked "Service Ended" and
displayed in gray.  The SUPIDEN field is replaced with asterisks.

3.5 Review the ODM window when the service terminates.

The “Time Tag” field indicates the last ODM received prior to service
termination.   An alert appears indicating that ODMs are received for an inactive
service.  A dialog box appears indicating an emergency event termination for the
service displayed in this window.

3.6 Click the prompt button on the dialog box to acknowledge the alert.

The ODM window is closed.

3.7 Perform a delog for the timeframe beginning at service stop time.

The NCCDS is no longer transmitting UPD to the customer.
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